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ABOUT HONEYWELL 
SPYDER  
This document serves as a guide to configure and use 
the honeywellSpyderTool. The HoneywellSpyderTool 
is an add-on module to the existing Niagara 

Framework™ modules. It provides a graphical 
environment to program, Honeywell Spyder Controllers.  

It provides the following features:  

• Graphical environment to program a Honeywell 
Spyder controller  

• Libraries of function blocks to create an application 
logic  

• Calibration of inputs, and diagnostics of outputs  

• Offline simulation  

• Online debugging  

Abbreviations  
A 

AI: Analog Input 

AO: Analog Output 

AV: Analog Variable 

B 

BAJA: Building Automation Java Architecture 

BI: Binary Input 

BO: Binary Output 

BTU/LB: British Thermal Unit per pound 

BV: Binary Variable 

C 

CPH: Cycle Per Hour 

CRC: Cyclic Redundancy Check 

D 

DI: Digital Input 

G 

GUID: Globally Unique Identifier 

H 

hrs: Hours 

I 

IOs: Inputs Outputs 

 

 

J 

JACE: Java Application Control Engine  

JVM: Java Virtual Machine 

L 

LAN: Local Area Network 

LNML: Lon Markup Language 

M 

MAC address: Media Access Control address 

min: Minutes 

MSTP: Master-Slave/Token-Passing 

MSV: Multi State Variable 

N 

NaN: Not a Number 

NRE: Niagara Runtime Environment  

NV: Network Variable 

P 

P or PI: Proportional l or Proportional Integral 

PCLTA card: Personal Computer Lon Talk Adaptor 

PCMCIA card: Personal Computer Memory Card 
International Association 

PID: Proportional Integral and Derivative 

R 

RAM: Random Access Memory 

S 

sec: Second/Seconds 

SLTA: Serial Lon Talk Adaptor 

SNVT: Standard Network Variable Types 

SRB: Software Release Bulletin 

T 

TUNCOS: Time Until Next Change of State 

U 

UNVT: User Network Variable Types 

UI: Universal Input 

W 

WM: Wall Module 

X 

XIF: External Interface Files 

Z 

Zeb: Zero Energy Band 
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Domain Dictionary  
1. Application: An application is a group of function 

blocks that are interconnected to form control logic. 
This application is then downloaded to the controller 
to run the control logic in the controller. 

2. BAJA (Building Automation Java Architecture): The 
core framework built by Tridium is designed to be 
published as an open standard. This standard is being 
developed through Sun's Java Community Process as JSR 
60. Refer Baja vs. Niagara in the Developer Guide for more 
information. 

3. Commission: This is the process of downloading the 
application (program logic + network image) to the 
Honeywell Spyder Lon controller.  

4. Fox Protocol: This is Tridium’s proprietary protocol 
for communication between the workbench and the 
station.  

5. Functional blocks: Functional blocks are the 
automatic program objects that define a specific 
function.  

6. Host: The host is a hardware platform or the 
computer on which the Niagara software runs. 
Niagara can run on a computer or a JACE controller.  

7. JACE: Java Application Control Engine. The Tridium 
manufactured controller that runs the core runtime 
Niagara software in a JVM (Java Virtual Machine), by 
providing station with the direct support for field 
device integration and enterprise LAN connectivity.  

8. Macros: Macros are a set of functional blocks that 
define a specific functionality.  

9. Programming environment/Graphical 
environment: A wiresheet view that allows, defining 
the application logic for the Honeywell Spyder 
controller.  

10. Station: The Niagara station is a JVM that hosts the 
running of objects.  

11. TUNCOS: Time until the next change of state. 
Schedule TUNCOS is the time (in mins) until the next 
change of state. The Honeywell Spyder controller 
uses this to perform setpoint recovery. 

12. Wiresheet: Wiresheet is the view in the Workstation 

that allows dragging and dropping of functional blocks 
and macros to define application logic.  

Scenarios 
The HoneywellSpyderTool provides the programming 
environment for the Honeywell Spyder controllers. It is 
developed by using the Niagara Framework® developed 
by Tridium and runs in the Niagara Runtime 
environment. 

The honeywellSpyderTool can be used to program the 
Spyder controller in the following two ways:  

1 Through JACE: 

JACE (Java Application Control Engine) controller 
bundles the software capability of the framework in a 
hardware platform. JACEs connect to system field buses 
on the other end. Also at the same time JACE provide 
real time control functions. The honeywellSpyderTool 
can be hosted on a computer loaded with the Niagara 
Framework® as well as JACE. JACE is loaded with the 
framework, the station database, and all the modules 
available in the computer. The honeywellSpyderTool 
communicates with the Honeywell Spyder controller 
through JACE on Fox Protocol (on LAN). JACE is 
connected to the same LAN as the PC. On the other end, 
it communicates to the Honeywell Spyder controller on 
the Lon® bus. 

The workbench in the computer also communicates with 
the JACE by dialing into the on-board modem of the 
JACE. However, this can be a slow connection.  

2 Through Engineering computer: 

In this case, Niagara Framework® runs on the computer. 
The computer connects to the system field buses directly 
through the appropriate network interface. This is the soft 
JACE option. 

The honeywellSpyderTool can be hosted on a 
computer loaded with the Niagara Framework®. The 
station database resides on the same computer and 
connects to the Honeywell Spyder controller on the 
LonNetwork/BACnetNetwork using the 
PCLTA/PCMCIA card or through SLTA. 

Station databases are typically engineered on the 
engineering computer (this is called Offline Mode), then 
installed to a JACE and it is associated with Web 
Supervisor computer, if any. 
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GETTING STARTED 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Digital Signature 
IMPORTANT: 
All the Honeywell WEBs software tools are now signed. Users can verify the signature using any OpenSSL tool. Below 
are the steps to verify signature using OpenSSL community distribution. 
Prerequisites: 
• Download the Honeywell public key BuildingsCommonSupervisor.crt from location- same location as the software 

release location 
• Download the batch file “VerifyWEBsToolsSignature.bat” from location- same location as the software release 

location. This file has the commands to verify the module signature using the public key specified in Step 1 
• Download OPENSSL from this link- https://www.openssl.org/source/openssl-1.0.2o.tar.gz 
• Extract the file using any ZIP utility to get the folder “openssl-1.0.2o” 
• In the extracted folder find the file “openssl.cnf” 
• Set Windows environment variable OPENSSL_CONF=<PATH TO openssl.cnf>, for example 

OPENSSL_CONF=C:\openssl-1.0.2o\apps\openssl.cnf 
Steps to verify the signature: 
1. Place the files BuildingsCommonSupervisor.crt, VerifyWEBsToolsSignature.bat, WEBs tools modules and 

signature file in the same location. For example: Following files are in one place 
a. BuildingsCommonSupervisor.crt 
b. VerifyWEBsToolsSignature.bat 
c. honeywellSpyderTool.jar 
d. honeywellSpyderTool.jar.sig 

2. Open the command prompt and navigate to the location of the above files. 
3. Execute the batch file VerifyWEBsToolsSignature.bat against a module for verifying its signature, for example - 

C:\Spyder_RELEASE\ > VerifyWEBsToolsSignature.bat   honeywellSpyderTool.jar 
4. OpenSSL will verify this module’s signature and printout the below verification details: 

 
5. If the Niagara module is compromised then user will get the below log, where verification has failed: 
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Installation 

Installing Spyder tool in Soft JACE - 
Installer EXE Method 
1. Install Java Runtime Environment (JRE) v1.8 on the 

system. It is mandatory. 

2. Stop all running stations and close the workbench. 
Close any other application accessing the jar files 
from the Niagara Home\modules folder. 

3. Browse to the location of the release folder of the 
tool. 

4. It displays the Installer file called  
LonBacnetInstaller<versionNo>.exe. 

5. Double click the installer executable file. 

6. An installation screen appears. The installer detects 
the current Niagara Home path and displays it on the 
screen. If there are more than one Niagara versions 
installed, the installer picks the higher version. The 
path can be changed as per requirement to install the 
jar files using the Browse button next to the WEBs-
N4 Home option. 

7. Click Install for the Installer to start the installation. 
The installer installs the required jar files in the 
Niagara modules folder. As the installation proceeds, 
it displays the installation status. After the completion 
of installation, Install Status text in the screen 
changes to Installation complete and the progress 
bar indicates 100% completion. 

8. Refer the Installation Instructions section in the 
Software Release Bulletin for more details on the 
installation procedure. 

Upgrading Hard JACE 
Stop the station running on the JACE and start the 
workbench before starting of the hard JACE upgrading. 

1 Select the files. 

2 Run the file using Niagara Platform’s Distribution 
File Installer option. The Distribution File Installer 
installs the required modules in the JACE. 

 
Note:  

From this release, only the following jar files are 
required: 

• honeywellSpyderTool.jar 

• docHoneywellSpyder.jar 

• honeywellBacnetSpyder.jar 

• genericUIFramework.jar 

• wsVavBalancer.jar 

• wsStdLonDeviceTemplates.jar 

• honeywellSpyderMigrator.jar 

• airFlowBalancer.jar 

 

To free up JACE memory, old, unused .jar files such as 
the following can be deleted: 

• flowBalancer.jar 

• docFlowBalancer.jar 

• niagaraDynamicBean.jar 

• wsAppliance.jar 

• wsBacnetChannel.jar 

• wsCommon.jar 

• wsDeviceMgmt.jar 

• wsLonChannel.jar 

• wsValidationFw.jar 

• wsStdBACNetDevTemplates.jar 

• Lon SpyderTemplates.jar 
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Start WEBStation-N4 
To start working with HoneywellSpyderTool,  

1. Go to Start Menu. 

2. Select All Programs, navigate and click 
WEBStation-N4 4.x.xx.x.  

3. Click Install Platform Daemon. Wait for few 
seconds until it will install software completely.  

4. Repeat step no. 2 

Click WEBStaion-N4 Workbench. It will open WEBs – 
N4 Workbench window. Refer Figure 1 

 

 
Figure 1: WEBStation-N4 Main Window 
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Open Platform 
On the Workbench:  

1. On the Nav tree, navigate to My Host. Right click 
My Host. Refer Figure 2 

 
Figure 2: Open Platform Option 

 

2. Select Open Platform. The Connect window will 
pop up. Refer Figure 3 

 

 
Figure 3: Connect Platform Window 

3. Select platform Type as Platform or Platform TLS 
from drop down menu. By default, it is Platform TLS 
Connection. 

4. Select Host as IP or Tunnel (IP) as per requirement 
and enter Host address in text field next to the drop 
down menu of Host. By default, it is IP. 

5. Enter Port number. Click OK. The authentication 
window will pop up. By default, it is 5011. Refer 
Figure 4. 

 
Figure 4: Authentication Window of Platform 

6. Enter Username and Password.  

 
Note:  

Enter the Username of a user who is a member 
of the local Windows machine's Administrators 
group.  

Type in the password for this user.  

 

7. Select Remember these credentials if required so 
that Workbench remembers these platform 
credentials details.  

8. Click OK to complete the procedure. It will open 
connected platform. Refer Figure 5. 

 
Figure 5: Connected JACE platform (SSL session) 
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Adding New Station 
On the Workbench:  

1 Click Tools > New Station. The New Station Wizard 
appears. Refer Figure 6. 

 
Figure 6: Tools Tab > New Station 

 

2 Type the name in the Station Name. Refer Figure 7. 

 
Figure 7: New Station Wizard > Station Name 

3 The Station Directory path is updated that is just 
entered with the name and displays the location 
where the files are stored. Click Next.  

4 Type a password in the Admin Password field.  

5 Re-type the same password in the Admin Password 
Confirm field. Refer Figure 8. 

 
Figure 8: Enter Password and Port Number  

 
Note:  

The Password must contain: 

1. At least 10 character(s) 

2. At least 1 digit(s) 

3. At least 1 lower case character(s) 

4. At least 1 upper case character(s) 
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If wrong password is entered then the application 
displays an error window as shown in Figure 9 

 
Figure 9: Error message window 

6 Click Finish to complete adding a station. The station 
is added and the Property Sheet of the station is 
displayed on the right portion of the screen. 

Starting the Station  
1 On the Nav tree, double click Platform. The 

Authentication dialog box appears.  

 
Note:  

If the Nav tree is not visible on the left pane, from 
the Menu bar, select Window > Sidebars > Nav 
to display the Nav tree.  

 

2 Type the administrative User Name, Password, in 
respective fields and click OK. The right portion of 
screen displays a list of object names and their 
description. 

3 Double-click Application Director. The list of 
available stations appears. Refer Figure 10. 

 
Figure 10: List of Stations 

4 Select the station which is added and click Start. 

5 Double-click the Station under Application Director. 
The Authentication dialog box appears.  
Refer Figure 11. 

6 Type the User Name and Password for that station 
in respective fields and click OK. The Station that is 
in to the application is launched and the Station 
Summary Property view appears on the right portion 
of the screen.  

 
Figure 11: Authentication Window for Station Access 

 



HONEYWELL SPYDER USER GUIDE 

 9 31-00089—02 

Launching the Workbench 
• Click Start > All Programs > WEBStation-N4 

4.x.xx.x >WEBStation-N4 Workbench to launch the 
workbench. 

Adding a Network 
To add a Lon Network:  
1. Click Window > Side Bars > Palette to add the 

Palette if it is not visible on the left pane.  
Refer Figure 12. 

 
Figure 12: Windows > Side Bars > Palette Option 

2. Click the Open Palette button  on the Palette. 
The Open Palette dialog box appears.  

3. Select Lonworks from the available options and click 
OK. Refer Figure 13.  

 

 
Figure 13: Open Palette Screen for LonWorks® 

4. Once it is added, it gets reflected in Palette.  
Refer Figure 14. 

 
Figure 14: lonworks in Palette 

5. Expand Config in the Nav tree to display Drivers.  

6. Select LonNetwork from the Palette and drag it on 
Drivers in the Nav tree.  

7. Type a name in the respective field for the 
LonNetwork and click OK. Refer Figure 15.  

 
Figure 15: Enter Name for Lon Network 
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8. Expand Drivers and verify that the LonNetwork is 
added.  

To add a BACnet Network:  

1. Click Window > Side Bars > Palette, to add the 
Palette menu on the left pane if it is not visible. Refer 
Figure 12. 

2. Click the Open Palette button  on the Palette. 
The Open Palette dialog box appears.  

3. Select bacnet from the available options and click 
OK. Refer Figure 16. 

4. Once it is added, it gets reflected in Palette. Refer 
Figure 17Figure 17: bacnet in Palette 

  

Figure 16: Open Palette Screen for BACnet 
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Figure 17: bacnet in Palette 

5. Expand Config in the Nav tree to display Drivers.  

6. Select BacnetNetwork from the Palette and drag it 
on Drivers in the Nav tree. Refer Figure 18. 

 
Figure 18: Enter Name for Bacnet Network 

7. Type a name for the BacnetNetwork in the 
respective field and click OK.  

8. Expand Drivers and verify that the BacnetNetwork 
is added.  

 

Adding a Controller 
To add a Honeywell Spyder controller:  

1. Click the Open Palette button on the Palette. 
The Open Palette dialog box appears.  
Refer Figure 12. 

2. Select honeywellSpyderTool from the available 
option. Refer Figure 19. Click OK. 

OR 

9. Once it is added, it gets reflected in Palette. Refer 
Figure 20. 

.
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Figure 19: Open Palette Screen > Add Controller

 
Figure 20: honeywellSpyderTool in Palette 

3. To add Lon Spyder controller, select LonSpyder 
controller from the Palette (tool library) and drag it 
onto the LonNetwork. The name window will pop up. 
Refer Figure 21. Enter the name and click OK. To 
verify the added Lon controller, expand LonNetwork 
tree.  

 
Figure 21: Enter Name for Lon Device 

 

To add BACnet controller, select BACnetSpyder 
controller from the Palette (tool library) and drag and 
drop it on BacnetNetwork. The name window will 
pop up. Refer Figure 22. Enter the name and click 
OK. To verify the added of BACnet controller, expand 
BACNetwork tree.  

 
Figure 22: Enter Name for BACnet Device 
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Viewing/Modifying Controller Summary 
Details 
To view or modify the summary details of the LonSpyder 
controller:  

1. Double-click Spyder controller added on the 
LonNetwork to display the Controller Summary 
View on the right side of the screen. For Lon Spyder, 
refer Figure 23. Device Name is an editable field.  

 

 
Figure 23: Viewing/Modifying Lon Controller Summary Details 

 

1. Click the drop-down list to select a Device Model 
from the list. Drop down list shows all available 
options of Lon Spyder device. Select appropriate 
device as per requirement. 

2. Select Enable Daylight Savings only when it is 
required for the application. If this option is selected 
then specify the following information when the 
daylight savings have to come into effect:  

• Start Month  

• End Month  

• Start Day  

• End Day  

3. Click Save to save the changes made to the 
Controller Summary View. 

To view or modify the summary details of the 
BACnetSpyder controller: 

1. Double-click Spyder controller added on the 
LonNetwork or BACNetwork treetop display the 
Controller Summary View on the right portion of the 
screen. Device Name is an editable field. For 
BACnetSpyder refer Figure 24.  
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Figure 24: Viewing/Modifying BACnet Controller Summary Details 

2. Click the drop-down list to select a Device Model 
from the list. Drop down list shows all available 
options of BACnet Spyder device. Select appropriate 
device as per requirement.  

3. Click the Set button to change the Global Update 
Rate. 

 
Note:  

• Global Update Rate is enabled only in 
Engineering Mode. In Normal Mode, it is in 
disabled condition. 

• Setting the Global Update Rate, changes 
all the individual update rates, including the 
update rates for Network Input points, 
Analog Outputs, Binary Outputs that are 
enabled for Fail Detect. 

• Global Update Rate has a default value of 
60 seconds.  

• The value ranges from 0 - 3600 sec. 

 

4. Click the Set button to change the Global Send 
HeartBeat. 

 
Note:  

• Global Send HeartBeat is enabled only in 
Engineering Mode. In Normal Mode it is in 
disabled condition. 

• Global Send HeartBeat is set at the device 
level and the change made to this value is 
applied automatically to all the objects. 
Global Send HeartBeat has a default value 
of 60 seconds. The value ranges from 0 - 
3600 sec. 

 

5. Select Enable Daylight Savings option and specify 
the following information when the day light savings 
have to come into effect:  

• Start Month  

• End Month  

• Start Day  

• End Day  

4. Click Save to save the changes made to the 
Controller Summary View. 
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Migration 

From Spyder II to Spyder Lon Micro 
To migrate spyder from any of the earlier Lon Spyder 
models, that is, Spyder I (PVL6436A, PVL6438N, or 
PUL6438) and Spyder II (PVL6436AS, PVL6438NS, or 
PUL6438S) to the latest Lon models supported by 
Spyder, that is Spyder Lon Micro (PVL4024NS, 
PVL4022AS, PUL4024S, PUL1012S, or PVL0000AS), 
following are the steps: 

1. Replace the existing Spyder controller in the field with 
the new Spyder Lon Micro controller. It could be any 
one of the Spyder I or Spyder II models. 

2. Right-click the LonNetwork in the Nav tree. 

3. Select Views > Lon Device Manager. It displays the 
list of controllers on the right portion of the screen. 
Refer Figure 25. 

 
Figure 25: Views > Lon Device Manager Option 

4. Select the controller from the list and click Discover. 
The device appears under Discovered on the top 
portion of the screen. 

5. Select the controller under Discovered and click 
Match to match the neuron ID of the field controller 
with the device in the station.  

6. If required, load an application from the spyder 
library. 

7. Right click on the device and select Spyder 
Download menu option to download the 
configuration to the new Spyder Lon Micro controller 
model. 

From Lon Spyder to BACnet Spyder-I 
To migrate from any of the Lon Spyder models (Spyder I, 
Spyder II, Spyder Lon Micro) to the BACnet models 
(PVB6436AS, PVB6438NS, or PUB6438S) supported by 
Spyder, following are the steps: 

1. Replace the existing Spyder Lon controller in the field 
with the new Spyder BACnet controller. A new device 
ID is assigned to the Spyder BACnet device in the 
station. Select the new model in the tool. 

2. Right click the BACnetNetwork in the Nav tree. 

3. Select Views > Bacnet Device Manager. The list of 
controllers is displayed on the right portion of the 
screen. Refer Figure 26. 

 
Figure 26: Views > BACnet Device Manager Option 

4. Select the controller from the list and click Discover. 
The device appears under Discovered on the top 
portion of the screen. 

5. Select the controller under Discovered and click 
Match to match the MAC address or device instance 
number of the field controller with the device in the 
station.  

6. If required, load an application from the spyder 
library. 

7. Right click on the device and select Spyder 
Download menu option to download the 
configuration to the new Spyder Micro controller 
model  

BACnet Spyder can be used in one of the following 
ways: 

• Create a new application in the BACnet Spyder 
controller. 

OR 

• Convert an existing Lon Application to corresponding 
BACnet Application. Refer  



HONEYWELL SPYDER USER GUIDE 

31-00089—02 16  

From Spyder II to Spyder BACnet Micro 
To migrate from any of the earlier BACnet Spyder 
models, that is, Spyder I (PVB6436A, PVB6438N, or 
PUB6438) and Spyder II (PVB6436AS, PVB6438NS, or 
PUB6438S) to the latest BACnet models supported by 
Spyder, that is Spyder BACnet Micro (PVB4024NS, 
PVB4022AS, PUB4024S, PUB1012S, and PVB0000AS), 
following are the steps: 

1. Replace the existing Spyder Lon controller in the field 
with the new Spyder BACnet controller. A new device 
ID is assigned to the Spyder BACnet device in the 
station. Select the new model in the tool. 

2. Right click the BACnetNetwork in the Nav tree. 

3. Select Views > Bacnet Device Manager. The list of 
controllers is displayed on the right portion of the 
screen. Refer Figure 26. 

4. Select the controller from the list and click Discover. 
The device appears under Discovered on the top 
portion of the screen. 

5. Select the controller under Discovered and click 
Match to match the device ID of the field controller 
with the device in the station.  

6. If required, load an application from the spyder 
library. 

7. Right click on the device and select Spyder 
Download menu option to download the 
configuration to the new Spyder BACnet Micro 
controller model  

From Lon Spyder to BACnet Spyder - II 
To migrate from any of the Lon Spyder models (Spyder I, 
Spyder II, Spyder Lon Micro, or Spyder BACnet Micro) to 
the BACnet models (PVB6436AS, PVB6438NS, or 
PUB6438S) supported by Spyder, following are the 
steps: 

1. Replace the existing Spyder Lon controller in the field 
with the new Spyder BACnet controller. A new device 
ID is assigned to the Spyder BACnet device in the 
station. Select the new model in the tool. 

2. Right click the BacnetNetwork in the Nav tree. 

3. Select Views > Bacnet Device Manager. The list of 
controllers is displayed on the right portion of the 
screen. Refer Figure 26. 

4. Select the controller from the list and click Discover. 
The device appears under Discovered on the top 
portion of the screen. 

5. Select the controller under Discovered and click 
Match to match the device ID of the field controller 
with the device in the station.  

6. If required, load an application from the Spyder 
library.  

7. Right click on the device and select Spyder 
Download menu option to download the 

configuration to the new Spyder BACnet micro 
controller model. 

To create a BACnet Spyder application 
1. Drag a BACnetSpyder controller from 

honeywellSpyderTool to the BacnetNetwork of 
given station. The name window will pop up. Enter 
name in the respective field. To verify added 
controller, expand BacnetNetwork. 

2. Double-click on the controller. Normal Mode 
summary screen will appear on right pane. For 
details, refer Viewing/Modifying Controller Summary 
Details section. 

3. Click Engineering Mode button to develop the 
program. Now, controller is in Engineering Mode and 
Global Update Rate and Global Send HeartBeat can 
be set.  

Select mode as per application requirement. 

4. Expand the BACnet controller. Double click on 
ControlProgram or right click the ControlProgram 
then select Views > Wiresheet. Drag function blocks 
from honeywellSpyderTool and create required 
application.  

5. Browse to Bacnet Device Manager view on 
BacnetNetwork and discover the online 
BACnetSpyder devices. 

6. Match the device in Niagara Home to appropriate 
discovered device. 

 
Note:  

Alternately, instead of creating an application 
user can load a suitable application from Spyder 
library or from Standard Applications Library in 
palette. 

 

7. Download the configuration to the online device using 
Download option on the device. 

To use an existing Lon Application in a BACnet 
Spyder device 
1. Drag a BACnetSpyder device to the station under a 

BacnetNetwork. 

2. Double-click the added device or right-click the device 
then select the Views > Controller Summary View. 
Refer Figure 24. 

3. Select a model from the list. Click Save and click on 
Engineering Mode. 

4. Browse to the ControlProgram of the 
BACnetSpyder device. 

5. Drag an existing Lon Application from Spyder Library 
to the ControlProgram under the BACnet Spyder 
device. The tool automatically creates a BACnet 
interface for the Lon application. (If it is an application 
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in the library, the tool would have automatically 
created the BACnet interface in the library). Review 
the BACnet interface that the tool has created and 
make necessary changes, if any. 

6. Browse to Bacnet Device Manager View on 
BacnetNetwork and discover the online BACnet 
Spyder devices. 

7. Match the device in Niagara to appropriately 
discovered device. 

8. Download the configuration to the online device using 
Download option on the device. 

From Conventional Wall Module to  
S-Bus Wall Module  
To replace the existing conventional wall module (T7770 
and TR20 series) with the S-Bus Wall module, use 
following steps. 

1. Drag ConventionalWallModule function block from 
Palette -> BuiltIn onto wiresheet of controller.  

2. Right-click the conventional wall module blocks and 
selects Configure Properties. General Settings 
screen appears. 

3. Select wall module from Select Model drop down list. 
Refer Figure 27 for available options of models. This 
changes Conventional wall module to S-Bus wall 
module.  

4. Set Sylk device address and other required 
parameters. 

 
Figure 27: Available Options for the Selection of  

S-Bus Wall Module

 

 
Figure 28: Warning Window 

 

After selecting model, the application gives warning 
message as shown in Figure 28. Click Yes to confirm 
conversion of wall module. 

5. Click Finish to complete procedure. 

 

 

 

 
Note:  

• Addresses for two Sylk devices should not be 
same if more than one Sylk devices are 
added on the Sylk bus 

 

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 18  

PROGRAMMING 
HONEYWELL SPYDER 
The honeywellSpyderTool offers a graphical 
environment to program the Honeywell Lon and BACnet 
Spyder controller. This tool has following components: 

1. BACnet Controllers 

2. Lon Controllers 

3. Physical points 

4. Software Points 

5. Functional Blocks 

6. Other components such as Schedule, Wall Modules. 

 

Using Spyder Tool and all its components user can add a 
controller on required network and create the application 
as per the requirement. 

Simulation mode and debugging mode are available for 
testing the application and its function offline. After 
compiling the program other operations such as 
download, upload, and online testing can be performed 
on live controller installed in the field. 

 

 
Note:  

Changing NCI values, configuration of a 
Schedule block, or Daylight Savings option, 
puts the application in a quick download pending 
state. As long as the application has been 
downloaded at least once to the controller, these 
changes only trigger a quick download to the 
controller. 

 

Wiresheet View 
Use the ControlProgram option to program the 
honeywellSpydertool 

Following are the steps to do this:  

1. Expand LonNetwok or BacnetNetwork in the Nav 
tree.  

2. Right click the controller (it is LonSpyder or either 
BACnetSpyder as per application requirement) then 
select View > Wiresheet View. Wiresheet displayed 
on right pane of the screen.  

Honeywell Spyder Tool 
Components 
Following are the components of Spyder controller: 

1. LonSpyder: To add LonSpyder controller, drag 
LonSpyder from honeywellSpyderTool to the 
LonNetwork in Nav tree. It will appear in Station > 
Drivers > LonNetwork > LonSpyder. 

 
Note:  

• Lon Spyder controller is added to only 
LonNetwork.  

• This controller cannot be dragged onto the 
wiresheet. 

 

2. BACnetSpyder: To add BACnetSpyder controller, 
drag BACnetSpyder from honeywellSpyderTool to 
the BacnetNetwork in Nav tree. It will appear in 
Station > Drivers > BacnetNetwork > 
BACnetSpyder. 

 
Note:  

• BACnet Spyder controller is added to only 
BacnetNetwork 

• This controller cannot be dragged onto the 
wiresheet. 

 

3. PhysicalPoints: This component provides 
modulating input/output and binary inputs/outputs. 
Drag these inputs/outputs onto the wiresheet as per 
requirement and performed additional settings if 
required.  

4. SoftwarePoints: This component provides Network 
Input, Network Setpoints, or Network Output. Drag 
these inputs/outputs/setpoints onto the wiresheet as 
per requirement and performed additional settings if 
required. 

5. Function Blocks: Use this to create logic. Following 
are the types of function block categories: 

• Analog: Analog function blocks  

• Logic: Logic function blocks  

• Math: Math function blocks  

• Control: Control function blocks  

• DataFunction: Data Function blocks  

• ZoneArbitration: Zone Arbitration function 
blocks  

• BuiltIn: Built-In function blocks  
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• Macro: A Macro is a group of functional blocks 
grouped together that define a specific 
functionality. Commonly used programs 
elements can be defined as macros so that they 
could be reused across applications.  

• Application: This includes macros and logic that 
can be defined and used in the applications. 

• StandardApplications: Standard applications 
shipped by Honeywell which can be used to build 
application logic  

Any of these items can be dragged on to the wiresheet of 
a ControlProgram in its Engineering Mode. Make the 
connections between Physical points, Software points, 
and function blocks to create a ControlProgram or an 
Application.  

Use this wiresheet view to drag the Physical points and 
Function blocks to build required application logic. The 
logic can be saved and used later. Several applications 
can be built using Honeywell supplied standard 
applications and store them in a Spyder Library. 

Downloading Application Logic 
After application is created onto the wire sheet and 
tested it in simulation mode and correcting it in debug 
mode, then application logic can be downloaded to the 
controller. To download the application logic follows the 
steps:  

1. On the Nav tree, right click the device and select 
Spyder Download menu option. Refer Figure 29. 

 
Figure 29: Spyder download Option 

2. Select Full Download and click on OK.  
Refer Figure 30. 

 
Figure 30: Spyder Download Screen 

 
Note:  

A Quick Download only downloads the modified 
items from a previous download whereas with a 
Full Download the entire configuration is 
downloaded to the controller replacing the 
existing configuration. However, if changes have 
been made to the S-Bus wall module by an 
operator/tenant locally from the display on the 
wall module, and a full download is performed, 
Spyder tool downloads the entire configuration to 
the controller except the S-Bus wall module 
configuration. This is done to avoid losing any 
changes made locally on the S-Bus wall module 
during a download operation. 

 

3. Click OK. The application logic is downloaded to the 
controller based on selection. 

Points to note: 

i. If S-Bus wall module is used or invalid options 
are ignored for function block; then the models 
selected are Lon Spyder II, or Spyder Lon Micro, 
or Spyder BACnet Micro, or BACnet Spyder. The 
S-Bus wall module cannot be downloaded to the 
Lon Spyder I models. 

ii. If there are unassigned physical Inputs/Outputs 
on the wiresheet, then the tool will only provide a 
warning message. Download will continue, but 
the unassigned IOs will not be considered while 
executing the application. 

When using Spyder II, or Spyder Lon Micro, or Spyder 
BACnet Micro, or BACnet Spyder models, if S-Bus wall 
module settings are modified from the display in the wall 
module, and if the program is uploaded then the settings 
are also uploaded.  

Updating Modules 
Follow this procedure to install updates of Standard 
Applications. This is the StandardApps.jar file which will 
be received and need to be installed to begin using the 
latest Standard Applications provided.  

1. Connect to the platform of the station.  

2. Navigate to File transfer Client and transfer the 
StandardApps.jar file from the local drive to the 
Modules folder of the Station.  

3. Restart the workbench/webworkbench.  

4. Expand StandardApplications in the 
HoneywellSpyderTool palette. The latest Standard 
Applications are displayed.  
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Error View on Lon Spyder device 
This view displays all the alarms generated by the 
Honeywell Spyder controller. There are 7 categories of 
alarms:  

• Sensor Alarms: These errors are generated for all 
the sensors configured in the logic. All input blocks 
assigned to pins UI0 to UI6 are listed in this category.  

• Invalid Configuration Alarms: This error occurs if 
there is an error in the configuration that was 
downloaded.  

• Network Communication Alarms: These errors 
occur only for NVIs and Object inputs configured as 
fail detect. The network variable names are listed in 
this category.  

• Control Alarms: All the error blocks configured in the 
logic are listed in this category. If an alarm block does 
not have any incoming link, then the status is always 
NORMAL.  

• S-BUS WM Communication Alarm: These alarms 
occur when the communication link between the  
S-Bus wall module and the controller is lost.  

• S-BUS WM Fail Detect Alarms: These errors occur 
for the linked outputs of the S-Bus wall module. All 
the linked outputs are listed in this category.  

• Control execution Alarm: This error is reported if 
the execution of application takes more than one 
second per cycle. 

 
Note:  

The S-BUS WM Communication Alarm  and the 
S-BUS WM Fail Detect Alarms are shown only 
for:  

• Spyder II models: PVL6436AS, 
PVL6438NS, PUL6438S  

• Spyder Lon Micro models: PVL4024NS, 
PVL4022AS, PUL4024S, PUL1012S, 
PVL0000AS. 

 

To view the Error View of a controller, right click the 
Device Name in the Nav tree and select Views > Error 
View. Refer Figure 31. 

 

 
Figure 31: Views > Error View Option for LonSpyder 

 

The Error View is displayed on the right half of the 
screen. The Error view is static and refreshes the view to 
get the latest update.  

To refresh the alarm automatically, check Enable auto 
alarm refresh, auto alarm setting window will pop up. 
Enter rate in seconds to refresh the alarm. Click OK. 
Refer Figure 32. 

 
Figure 32: Set Time to Refresh Alarm 

 

Click Refresh to complete the refresh Error View 
process. Refer Figure 33. 
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Figure 33: Error View Screen 

nvoError 
The honeywellSpyderTool provides a multi-byte 
network variable, nvoError, which indicates errors. The 
nvoError map can be accessed on the Property Sheet 
view of the controller. The nvoError map consists of 10 
fields of one byte each. As each byte is 8 bits long, there 
are a maximum of 80 bits that are used to indicate errors. 
Each bit is mapped to an alarm. 

There are 7 categories of alarms shown in Table 1 

Table 1: Categories of Alarms for Lon Spyder 

Alarm Type Description 

Sensor Alarms These alarms are generated for all those sensors which are configured in 
the logic. All input blocks assigned to pins UI0 to UI6 are listed in this 
category. 

Invalid Configuration Alarms These alarms occur, if there is an error in the configuration that was 
downloaded. 

Network Communication 
Alarms 

These alarms occur only for NVIs and Object Inputs configured as fail 
detect. The network variable or object input names are listed in this 
category.  
In the Lon Spyder I and Spyder II models, up to 32 input network variables 
can be defined with fail detect. On detection of an error condition, the Lon 
Spyder I and Spyder II models fill a number between 16 and 47. 
In the Spyder Lon Micro models and Spyder BACnet Micro models, up to 
150 input network variables can be defined with fail detect. Spyder Lon 
Micro models and Spyder BACnet Micro models fill a number between 48 
and 197. 
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Alarm Type Description 

Control Alarms All the error blocks configured in the logic are listed in this category. If an 
error block does not have any incoming link, then the status is always 
NORMAL. Up to 32 alarms function blocks can be defined. in Lon Spyder I, 
Spyder II, Spyder Lon Micro models and Spyder BACnet Micro models  
On detection of an error condition, the Lon Spyder I and Spyder II models 
fill a number between 48 and 79.  
Spyder Lon Micro models and Spyder BACnet Micro models fill a number 
between 16 and 47. 

S-BUS WM Communication 
Alarm 

These alarms occur when there is a communication break between the 
device and the wall module. 

S-BUS WM Fail Detect 
Alarms 

These alarms are shown only for, Lon Spyder II, Spyder Lon Micro models 
and Spyder BACnet Micro models. These alarms occur for the linked 
outputs of the S-Bus wall module. All the linked outputs are listed in this 
category.  
In the Lon Spyder II models, up to 168 alarm function blocks can be 
defined. On detection of an alarm condition, the Lon Spyder II models fill a 
number between 80 and 247.  
In the Spyder Lon Micro models and Spyder BACnet Micro models, up to 
50 alarm function blocks can be defined. Spyder Lon Micro models and 
Spyder BACnet Micro models fill a number between 198 and 247. 

Control execution Alarm Shown only for, Lon Spyder Relay and Spyder BACnet Relay models. 

This error is reported if the execution of application takes more than one 
second per cycle. 

As Spyder Relay models support more resources, execution time can 
exceed 1 second per cycle. This error is reported in such cases. 

 

 
Note:  

It is not necessary that two consecutive bits are 
filled during two consecutive alarm conditions. 
The tool allocates any bit position within the 
specified range. For example, in the case of  
S-Bus WM Fail Detect Alarms in Spyder Lon 
Micro models and Spyder BACnet Micro models, 
it is not necessary that the bit position 198 is 
filled and then 199 and so on. Honeywell Spyder 
allocates any bit position between 198 and 
247.Similarly is the case for all the models in 
Network Communication Alarms, Control Alarms 
and S-Bus WM Fail Detect Alarms. 

To view the latest updated Error View, refresh it by 
clicking Refresh button. The Table 2 indicates the bit 
positions and the errors they are used to represent

 

Table 2: Bit Positions used to represent Error  

Bit 
Position Error Type Description 

0-7 Sensor Alarm Indicates an error condition on Modulating inputs or outputs 

0 Sensor Alarm The on-board pressure sensor is open or shorted. 

1 Sensor Alarm Universal Input 1 exceeds the user defined range, that is, it is 
open or shorted. 
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Bit 
Position Error Type Description 

2 Sensor Alarm Universal Input 2 exceeds the user defined range 

3 Sensor Alarm Universal Input 3 exceeds the user defined range 

4 Sensor Alarm Universal Input 4 exceeds the user defined range 

5 Sensor Alarm Universal Input 5 exceeds the user defined range 

6 Sensor Alarm Universal Input 6 exceeds the user defined range 

7 Sensor Alarm Universal Input 7 exceeds the user defined range 

8-14 No mapping The on-board thermistor is open or shorted 

15 Invalid Configuration Alarm The configuration downloaded to the controller is illegal. One 
or more file sections have a CRC (Cyclic Redundancy Check) 
error 

16-47 Network Communication Alarm The input network variable represented by this bit is not being 
received within the fail detect time 

48-79 Control Alarm The error function blocks reporting the alarm represented by 
this bit 

80-247 S-BUS WM Fail Detect Alarms The output of the S-Bus wall module represented by this bit is 
not being received within the fail detect time. 

 

The range and bit positions differ for Spyder Lon Micro 
models and Spyder BACnet Micro models.

Table 3 indicates the bit positions for the Control Alarms, 
Network Communication Alarms, and  
S-Bus WM Fail Detect. 

Table 3: Bit Positions used to represent Error for Micro Models 

Bit Position Alarm Type Description 

16-47 Control Alarm The alarm functions block reporting the error 
represented by this bit. 

48-197 Network Communication Alarm The input network variable represented by this bit is not 
being received within the fail detect time. 

198-247 S-BUS WM Fail Detect Alarms The output of the S-Bus wall module represented by 
this bit is not being received within the fail detect time. 

 

 
Note:  

UI 0 is displayed only for models that support UI 
0. UI 7 is not shown on the Error View. 

 

Error View on BACnet Spyder 
device 
This view displays all the errors generated by the 
Honeywell Spyder controller. There are 7 categories of 
errors:  

• Sensor Alarms: These errors are generated for all 
the Sensors configured in the logic. All input blocks 
assigned to pins UI0 to UI6 are listed in this category.  

• Invalid Configuration Alarm: This error occurs if 
there is an error in the configuration that was 
downloaded.  

• Network Communication Alarms: These errors 
occur only for object inputs configured as fail detect. 
The object names are listed in this category.  

• Control Alarms: All the error blocks configured in the 
logic are listed in this category. If an error block does 
not have any incoming link, then the status is always 
NORMAL. 
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• S-BUS WM Communication Alarm: These errors 
occur when the communication link between the  
S-Bus wall module and the controller are lost.  

• S-BUS WM Fail Detect Alarms: These errors occur 
for the linked outputs of the S-Bus wall module. All 
the linked outputs are listed in this category.  

• Control execution Alarm: This alarm is reported if 
the execution of application takes more than one 
second per cycle. 

 
Note:  

The S-BUS WM Communication Alarm and the 
S-BUS WM Fail Detect Alarms are shown only 
for: 

• Spyder BACnet models: PVB6436AS, 
PVB6438NS, PUB6438S 

• Spyder BACnet Micro models: PVB4024NS, 
PVB4022AS, PUB4024S, PUB1012S, 
PVB0000AS 

To view the Error View of a controller right click the 
Device Name in the Nav tree and select Views > Error 
View. Refer Figure 34. 

 
Figure 34: Views > Error View Option for 

BACnetSpyder 

The error view is displayed on the right half of the 
screen. The Error view is static and refreshes the view to 
get the latest update. To refresh the alarm automatically, 
check Enable auto alarm refresh 

Auto alarm setting window will pop up. Enter rate to 
refresh the alarm and click OK. Refer Figure 32. 

Click Refresh to complete the refresh Error View 
process. Refer Figure 33. 

Error Objects 
The HoneywellSpyderTool provides 248 error bits 
which indicate errors. Spyder BACnet supports the 16 
error objects, AV_Error0 to AV_Error15. Each error 
object is 16-bit long except for the 16th Error Object 
(AV_Error15) which is 8-bit long. 

To access the error objects:  

1. Expand the BACnet device on the Nav tree.  

2. Right click Points and select Bacnet Spyder Point 
Manager.  

3. The Point Manager view appears on the right pane.  

4. Click the Discover button to discover all the points on 
the device. 

5. The points are listed under Discovered on the 
screen.  

6. Click the Add button to add the points to the 
database. 

There are 7 categories of alarms as shown in Table 4. 

Table 4: Categories of Alarms 

Alarm Type Description 

Sensor Alarms These alarms are generated for all those sensors which are configured 
in the logic. All input blocks assigned to pins UI0 to UI6 are listed in 
this category.  

On detection of an error on modulating inputs, the BACnet spyder 
models fill a number between 0 and 7.  

Invalid Configuration Alarms These alarms occur if there is an error in the configuration that was 
downloaded. 

Control Alarms All the alarm blocks configured in the logic are listed in this category. If 
an alarm block does not have any incoming link, then the status is 
always NORMAL. Up to 32 input objects can be defined with fail 
detect.  

On detection of an error condition, the BACnet spyder models fill a 
number between 16 and 47. 
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Alarm Type Description 

Network Communication 
Alarms 

These alarms occur only for object inputs configured as fail detect. 
The network variable or object input names are listed in this category. 
Up to 32 alarms function blocks can be defined. 

On detection of an error condition, the BACnet spyder models fill a 
number between 48 and 197. 

S-BUS WM Communication 
Alarm 

These alarms occur when there is a communication break between 
the device and the wall module. 

S-BUS WM Fail Detect Alarms These alarms occur for the linked outputs of the S-Bus wall module. 
All the linked outputs are listed in this category. Up to 168 alarms 
function blocks can be defined.  
On detection of an alarm condition, the BACnet spyder models fill a 
number between 198 and 247. 

Control Execution Alarm These alarms shown only for, Lon Spyder Relay and Spyder BACnet 
Relay models. 
This alarm is reported if the execution of application takes more than 
one second per cycle. 
As Spyder Relay models support more resources, execution time can 
exceed one second per cycle. This alarm is reported in such cases. 

 
To view the Error View of a controller, right click the 
Device Name in the Nav tree and select Views > Error 
View. The Error view is displayed on the right half of the 
screen. The Error view is static and refreshes the view to 
get the latest update. To refresh the alarm automatically, 
check Enable auto alarm refresh, auto alarm setting 

window will pop up. Enter rate to refresh the alarm rate 
and click OK. Refer Figure 32. 
Table 5 indicates the bit positions and the alarms they 
are used to represent. 
 

Table 5: Bit Positions used to represent Alarms 

Bit Position Alarm Type Description 

0 Sensor Alarm The on-board pressure sensor is open or shorted. 

1 Sensor Alarm Universal Input 1 exceeds the user defined range, that 
is, it is open or shorted. 

2 Sensor Alarm Universal Input 2 exceeds the user defined range 

3 Sensor Alarm Universal Input 3 exceeds the user defined range 

4 Sensor Alarm Universal Input 4 exceeds the user defined range 

5 Sensor Alarm Universal Input 5 exceeds the user defined range 

6 Sensor Alarm Universal Input 6 exceeds the user defined range 

7 Sensor Alarm Universal Input 7 exceeds the user defined range 

8 Invalid Configuration Alarm The configuration downloaded to the controller is 
illegal. One or more file sections have a CRC error  

9 S-BUS WM Communication Alarm The input to the S-Bus wall module represented by this 
bit is not being received from the controller output 

10-15 No mapping The on-board thermistor is open or shorted 

16-47 Control Alarm The alarm function blocks reporting the alarm 
represented by this bit. 
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Bit Position Alarm Type Description 

48-197 Network Communication Alarm The input network variable represented by this bit is 
not being received within the fail detect time. 

198-247 S-BUS WM Fail Detect Alarms The output of the S-Bus wall module represented by 
this bit is not being received within the fail detect time. 

 

 

 
Note:  

UI 0 is displayed only for models that support UI 
0. UI 7 is not shown on the Alarms View. 

ControlProgram Details View 
This view provides details of the ControlProgram, 
Application or the Macro for which it is selected. It 
displays details such as the Name, Version number, and 
a brief description. 

To access the Details View of the controller:  

1. For Lon Spyder, on the Nav tree, browse to Station > 
Config > Drivers> LonNetwork > LonSpyder. Refer 
Figure 35. 

 
Figure 35: Views > Details Option of Lon Spyder 

For BACnet Spyder, on the Nav tree, browse to 
Station > Config > Drivers> BacnetNetwork > 
BACnetSpyder. Refer Figure 35. 

 

 
Figure 36: Views > Details Option of BACnet Spyder 

2. Right click ControlProgram and select Views > 
Details. Refer Figure 37: 

• Name: The name specified for the 
ControlProgram while creating it. It is non 
editable.  

• Type: Indicates the air conditioning type used. 
One of the following options can be selected as 
shown in Table 6. 

 

 
Figure 37: Details Screen 
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Table 6: Air Conditioning Application Types 

Application Type 

General application 

VAV Zone Terminal Single Duct Application 

CVAHU Single Duct Application 

VAV Zone Terminal Double Duct Application 

VAV Zone Flow Tracking Application 

Water Source Heat Pump AHU Application 

Unit Vent AHU Application 

FCU Application 

CVAHU Double Duct Application 

VAV AHU Single Duct Application 

VAV AHU Double Duct Application 

Multi Zone AHU Application 

CZS (Rapid Zone) AHU Application 

CZS Zone Terminal Application 

 

 
Note:  

Exercise caution while changing the Type as it 
could modify the application. 

• Features: It provides the features of the 
selected application type. Table 7 shows the 
features are available for selection when the 
application type selected is VAV Zone 
Terminal Single Duct Application. 

 

• Features: Table 7 shows listed features. 

A check mark appears against the feature that is 
selected from the list. To use the Flow Balancing 
View, the feature Air Balance Supported must 
be selected under VAV Zone Terminal Single 
Duct Application type.  

To override the reheat valve and peripheral heat 
valve values, select the features Reheat Valve 
Override Supported and Peripheral Heat Valve 
Override Supported under VAV Zone Terminal 
Single Duct Application type. The option to 
override the values of reheat valve and peripheral 
heat valve is enabled in the Flow Balancing 
View.  

 

 

 

Table 7: Features of VAV Zone Terminal Single Duct 
Application 

Features  

Air Balance Supported 

Reheat Valve Override Supported 

Peripheral Heat Valve Override Supported 

Serial Fan speed Supported 

Fan Override Supported 

Series Fan 

Parallel Fan 

 

For details, refer Figure 37 

• Version: Indicates the version number.  

• Description: Indicates a brief description of the 
application. Use this field to briefly describe the 
purpose of this ControlProgram. 

• Features: Indicates attributes of selected 
controller. 

Controller Summary View 
Use Controller Summary to view or modify the Device 
Name, Device Model, and select the period when 
daylight savings are in effect. 

To view or modify the summary details of the controller:  

1. Double-click the LonSpyder or BACnetSpyder in the 
Nav tree. Controller Summary View will appear on 
the right of the screen. Refer, Figure 23 

2. Enter Device Name.  

3. Select a Device Model.  

4. Engineering Mode\Normal Mode: Use this option to 
switch from Engineering Mode to Normal Mode and 
vice versa. 

For more details, Device Menus items Explained. 

Lon Controller 
One of the following Lon models can be selected: 

• Spyder I models:  

 PVL6436A  
 PVL6438N  
 PUL6438 

• Spyder II models:  

 PVL6436AS  
 PVL6438NS  
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 PUL6438S  
• Spyder Lon Micro models:  

 PVL4024NS  
 PVL4022AS  
 PUL4024S 
 PUL1012S  
 PVL0000AS  

• Spyder Lon Relay models: 

 PUL6438SR 

BACnet Controller 
• Spyder II models:  

 PVB6436AS  
 PVB6438NS  
 PUB6438S 

• Spyder BACnet Micro models:  

 PVB4024NS  
 PVB4022AS  
 PUB4024S  
 PUB1012S  
 PVB0000AS  

• Spyder BACnet Relay models: 

 PUB6438SR 
5. Use Model Description to view the device details 

such as controller details, number of universal inputs, 
number of binary inputs, number of modulating 
outputs, the number of binary outputs, type of wall 
module, number of functional blocks, etc. 

6. Use Download Status to displays download status 
for the added devices. Application displays 
‘Download is in progress’ status when application is 
downloading to the controller. When download is 
successfully completed, it shows ‘Download is 
successful’. Following are two symbols used to 
denote download status: 

a. When Download is pending, it displays  with 
red arrow. 

b. When Download is successful, it displays 

symbol with green arrow. 

Following are five types of download status on 
screen: 

• Validation Pending 

• Compilation Pending 

• Download Pending 

• Validation Error  

• Download Successful 

7. Select the Enable Daylight Savings option and 
specify the following information when the daylight 
savings must come into effect:  

• Start Month  
• End Month  
• Start Day  
• End Day 

 
Note:  

Clear the Day Light Savings check box and 
download it to the controller, for the controller to 
stop using daylight savings. 

 

8. Click Save to save the changes or Cancel to revert to 
the previous settings.  

 

 
Note:  

• Any model from the available device model 
can be selected even if the application 
created which does not meets the memory 
requirements of the target model. The 
honeywellSpyderTool performs necessary 
actions on model change and gives a report 
of the same. 

• The Lon Spyder I models do not support the 
S-Bus wall module. On selecting any of 
these models, the Model Description 
indicates that the selected model does not 
support S-Bus wall module.  

• The Spyder II, and Spyder Micro models 
support S-Bus wall module and the Model 
Description for these models indicates the 
same. 

 

ControlProgram NV Configuration 
View 
A Network Variable (NV) is a data item such as a 
temperature, a switch value or actuator state. NVs can 
be thought of simply as point parameters. LonMark 
functional profiles define Standard Network Variable 
Types (SNVTs), but additional non-standard NVs are 
usually available, depending on the device, to store 
additional non-standard data. There are two categories 
of NVs that the Lon Spyder supports. They are:  

• Fixed_Dropable: Fixed_Dropable NVs can be used 
while creating application logic, but can edit only its 
Internal Data Type. Also, Fixed Droppable NVs can 
be displayed on the wiresheet. Following are the 
Fixed Droppable NVs as shown in Figure 38. 
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Figure 38: Fixed Droppable NVs 

• Custom: The NVs created while developing 
application logic are custom NVs. As per requirement 
user can create, edit and delete the Custom NVs.  

The Lon Spyder provides the following four built-in 
network variables that can be used in the application 
logic.  

• NVI: Network Variable Inputs  

• NVO: Network Variable Output  

• NCI: Network Configuration Input 

• Many to One NV: Many to One Network Variable  

The Lon Spyder provides built-in functions, Network 
Variable Inputs, to allow the selection of variables that 
are available from/to the network. The configured 
network variables are mapped to the Function Block 
memory space to be used by any Function Block. Each 
Network variable may be configured with a name.

 

Viewing the List of Network 
Variables 
1.  Double click the LonSpyder. Normal Mode screen 

appears. Click Engineering Mode button. It displays 
wiresheet view of the controller.  

2. Right click Control Program > Views > NV 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom NVs in a tabular format. Refer Figure 39 

 
Figure 39: Views > NV Configuration View Option 

 

Figure 40 shows the table having the following 
columns  

• NV Name: Indicates the name of the network 
variable. 

• Type: Indicates if the NV is of type NVI, NVO, NCI 
or Many to One NV.  

• Category: Indicates if the NV is Mandatory, Fixed, 
or Custom.  

• NV Container: Indicates where the NV is used. 
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Figure 40: NV Configuration View screen 

3. Following are the options to:  

• Show Mandatory and Fixed NVs 

• Show on the wiresheet as points –  

• Add NV  

• Edit NV  

• Delete NV 

4. The bottom half of the NV Configuration Views 
display the software points available on the wiresheet 
in a tabular format. The table has the following 
columns:  

• Point Name: The name of the network point 
(Network Input/Network Setpoint/Network Output) 
as it appears on the wiresheet. 

• Field Names: Indicates if the NV is of type NVI, 
NVO, NCI or Many to One NV.  

• Point Container: Indicates where the software 
point is used. All software points that are used in a 
Program within an application are also listed. 

5. Following are the options to:  

• Group as NV 

• Edit Point 

• Remove points from wiresheet 
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Group as NV 
The points belonging to types NVI, NCI, NVO, Constants, 
and Invalid points can be grouped to form a new NVI, 
NCI, or NVO.  

 
Note:  

Use the CTRL key to select multiple points to the 
group. This button is disabled in the following 
cases: 

• If one or more, selected points belong to a 
Fixed NV. 

• If one or more, selected points belong to a 
Many to One NV. 

• If one or more, the selected points are 
configured as Bit field. 

• If selection is an input point and an output 
point. 

• If the point belongs to nciTempSetpoints 

 

For details, refer the Add NVI, Add NCI, Add NVO, or 
Add Many to One NV topics for more details. 

 

Points to note:  

1. In a Fixed Droppable NV, only Internal Data Type can 
be modified. 

2. Custom NV is the user defined NV. A Custom NV can 
be edited or deleted.  

3. Fixed Droppable NVs marked as Fixed_Dropable can 
be exposed on the wiresheet. Other fixed NVs cannot 
be exposed as points. 

4. Network Input with Point Type configured as 
Constant in a macro is not shown in the lower pane of 
the NV Configuration View.  

For each point that is copied and pasted on the 
wiresheet: 

1. If the network type is a scalar SNVT, the new NV 
created is SNVT of the network type.  

2. If the network type is a Bit field, the new NV of SNVT 
type nearest to the selected internal data type is 
created automatically. 

3. In all other cases, a single-field UNVT with the same 
configuration as the point being copied is created. 

BACnet Object Configuration 
View 
An Object is a data item such as a temperature, a switch 
value or actuator state. Objects can be thought of as 
point parameters.  

The two categories of Objects supported by BACnet 
Spyder are:  

1. Fixed_Dropable: Fixed Droppable Objects can be 
used while creating application logic and only its 
Internal Data Type can be edited. Fixed Droppable 
Objects can also be displayed on the wiresheet.  

2. Custom: Custom Objects are the objects that are 
created while creating application logic. They can be 
created, edited, and deleted based on requirements.  

The BACnet Spyder supports the following object types.  

• AVI: Analog Value Input  

• AVO: Analog Value Output  

• AV Setpoint: Analog Value Setpoint  

• BVI: Binary Value Input  

• BVO: Binary Value Output  

• BV Setpoint: BinaryValue Setpoint  

• MVI: Multi-state Value Input  

• MVO: Multi-state Value Output  

• MV Setpoint: Multi-state Value Setpoint  

The configured objects are mapped to the Function Block 
memory space to be used by any Function Block. Each 
Object is configured with a name.  

Viewing the List of BACnet 
Objects 

1. Browse to Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder. Double click the 
LonSpyder. Normal Mode screen appears. Click 
Engineering Mode button. It displays wiresheet view 
of the controller. 

2. Right click Control Program > Views > Object 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom Objects in a tabular format. Refer Figure 41. 

 
Figure 41: Views > Object Configuration View Option 
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Figure 42 shows the table which has the following 
columns: 

• Name: Indicate the name of the object. 

• Type: Indicates if the object is of type AVI, AVO, 
AV Setpoint, BVI, BVO, BV Setpoint, MVI, MVO, 
or MV Setpoint.  

• Category: Indicates if the Object is Mandatory, 
Fixed, or Custom.  

• Object Container: Indicates where the Object is 
used. 

• Object Instance: A unique number that is 
automatically assigned to the object. 

• Update Rate: The rate at which inputs are sent to 
the network. 

• Send Heartbeat: The rate at which a Network 
object value is sent to the network regardless of 
whether its value is changed or not. The timeout 
value is equal to the value entered in this field 
multiplied by 5. This value should be configured 
as multiples of 5 only, else tool rounds it off to the 
nearest multiple of 5 during download.  

 
Figure 42: Object Configuration View Screen 

3. Following are the options to:  

• Show Mandatory and Fixed Objects  

• Show on the wiresheet as points  

• Add Object  

• Edit Object  

• Delete Object  

4. The bottom half of the Object Configuration Views 
display the physical and software points available on 
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the wiresheet in a tabular format. The table has the 
following columns:  

• Point Name: The name of the physical /software 
point as it appears on the wiresheet. 

• Field Names: Indicates the Object type.  

• Point Container: Indicates where the physical 
/software point is used. All physical /software 
points that are used in a Program within an 
application are also listed.  

5. Following are the options to:  

• Create BACnet Object from Point: Use this 
button to convert an invalid point into a valid 
BACnet object. 

• Edit Point: Select a point and click this button to 
edit its configuration. 

• Remove points from wiresheet: Use this button 
to remove a point from the wiresheet.  

 

 
Note:  

• In a Fixed Droppable Object, only Internal 
Data Type can be modified. 

• Custom Object is the user defined Object. A 
Custom Object can be edited or deleted.  

• Fixed Objects marked as Fixed_Dropable 
can be exposed on the wiresheet. Other 
fixed objects cannot be exposed as points. 

• Network Input with Point Type configured 
as Constant in a macro are not shown in the 
lower pane of the Object Configuration 
View 

 

ControlProgram Wiresheet View 
The wiresheet is the view where required application 
logic is developed using HoneywellSpyderTool 
components and function blocks. 

Components are added by dragging and dropping on the 
wiresheet. To implement the required application logic, 
add the components on the wiresheet and connect them 
for data transfer.   

The logic which is created on the wiresheet can be 
copied and added into the library and Micros for reuse. 

 

 
Note:  

Names of Physical points must be unique. No 
two Physical points can have the same name. 

 

To view the Wiresheet View of the Lon controller:  

1. On the Nav tree, browse Station > Config > Drivers 
> LonNetwork > LonSpyder.  

2. Expand LonSpyder and select ControlProgram.  

3. Right click ControlProgram and select Views > 
Wiresheet. Refer Figure 43. 

 
Figure 43: Views > Wire Sheet Option for Lon 

 

To view the Wiresheet View of the BACnet controller:  

1. On the Nav tree, browse Station > Config > Drivers 
> BacnetNetwork > BACnetSpyder.  

2. Expand BACnetSpyder and select ControlProgram.  

3. Right click ControlProgram and select Views > 
Wiresheet. Refer Figure 44. 

 
Figure 44: Views > Wire Sheet Option for BACnet 

 

The wiresheet is displayed on the right pane of the 
screen in the Engineering Mode. The Wiresheet View 
consists of a wiresheet like appearance on the right 
pane. The function blocks, Physical points, and NVs or 
Objects can be dragged onto this wiresheet. The 
connections can be made, to and from Physical points 
and function blocks to build required logic on the 
wiresheet. It also consists of fixed Physical points. It also 
consists of a snapshot view of the entire wiresheet page 
on the top right corner. This helps to have an overview 
when logic on the wiresheet is too large to fit in the 
screen.  

 
Note:  

All the Fixed Physical points are visible on the 
ControlProgram Wiresheet View of the 
Controller 
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Designing the Application Logic 
 

 
Note:  

The Windows mechanism of cut/ copy/ paste/ 
paste special/ duplicate/ delete can be used for 
Function blocks, NVs, and IOs on the wiresheet. 

 

To design an application:  

1. Decide the Physical points.  

2. Develop Sequence.  

3. Decide the interface requirements for the open Lon 
connection or with other Lon devices.  

4. Develop software logic using modules or import the 
modules that user wants to use.  

5. Interconnect Physical points to other modules and to 
the outside connections.  

6. Test the logic through Simulation.  

7. Correct any changes to the design or modifications to 
the Macros.  

8. Save the Macros that are common and can be 
reused for other applications.  

9. If the application is common or standard, then save 
the device in the library so that it can be reused for 
similar applications later and will reduce time required 
to develop other application. 

 
Note:  

If application logic configured using a function 
block with the Ignore Invalid Input property is 
dropped onto the wiresheet of a controller with 
any of these Lon Spyder I models: PVL6436A, 
PVL6438N, or PUL6438, then a warning 
message appears. 

 

ControlProgram Resource Usage 
View 
The ControlProgram, Spyder Libraries and Macros 
that are created consume memory. The function blocks, 
Physical points and NVs or Objects have different 
memory usage. Some elements of a function block may 
use a Float RAM while some others could be using 
memory in the Non-Volatile RAM. 

The Resource Usage View provides details of the total 
memory and the used memory as a result of all the 
ControlProgram, Spyder Libraries and Macros 
created. 

 Figure 46 shows the memory usage at different levels:  

• ControlProgram Resource Usage  

• Application Resource Usage  

• Macro Resource Usage  

• Spyder library Resource Usage  

 
Note:  

At each of these levels, the memory used up by 
the entire application is shown. 

 

ControlProgram Resource Usage 
To view the Resource Usage View of the controller:  

1. On the Nav tree, browse Station > Config > Drivers 
> LonNetwork > LonSpyder. 

OR 

Browse Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder 

2. Right click LonSpyder or BACnetSpyder. 

OR 

Expand LonSpyder or BACnetSpyder and select 
ControlProgram. Right click ControlProgram. Refer 
Figure 45. 

 
Figure 45: Views > Resource Usage Option 

3. Select Views > Resource Usage. The Controller 
Details appear on the right half of the screen.  

4. Select the controller Device model as per 
requirement. This is the model number or make of the 
controller, which are programmed using this tool.  

The Memory Usage chart graphically displays a bar 
chart of the total memory and used memory details. Click 
the Tabular View button to view the breakup of RAM 
pool usage in a tabular format. Click the Tabular View 
button to hide/display the tabular view. Refer Figure 46. 
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Figure 46: Resource Usage Screen 

 

 
Note:  

The upper limit range of total memory for Float 
RAM, Byte RAM, Flash, Non Volatile RAM, and 
RAM pool is higher in case of Spyder Lon Micro 
models and Spyder BACnet Micro models 
controllers.  

 

5. The Blocks Usage table displays the number of 
Function blocks, Network variables or Objects, and 
Physical IOs used at the device level. Physical IOs 
indicate the number of hardware pins used.  

 

 
Note:  

1. The number of blocks supported by Lon 
Spyder Micro and BACnet Spyder Micro is 
200. While Lon Spyder Micro supports 220 
Network Variables, there is no such limit for 
the BACnet Spyder Micro as it is dependent 
on the memory usage as in any other BACnet 
Spyder model. 

2. Lon Spyder Relay supports 300 function 
blocks while and those supported by BACnet 
Spyder Relay are 200. While Lon Spyder 
Relay models support 175 Network Variables, 
there is no such limit for BACnet Spyder 
Relay models as it is dependent on the 
memory usage as in any other BACnet 
Spyder model. 

 

6. Click the Resource usage details button to view 
details of the different memory types. The Block 
Resource Details tab displays memory usage details 
of the Function blocks, NVs or Objects, and Physical 
IOs used in the device in a tabular format.  
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Refer Table 8. 

Table 8: Block Memory Details 

Name Definition 

Block Indicate the name of the 
Function block, IO, or NV. 

Type Indicate the type of the 
Function block, IO, or NV. 

Float RAM Indicate the Float RAM usage 
of the Function block, IO, or 
NV. 

Byte RAM Indicate the Byte RAM usage 
of the Function block, IO, or 
NV. 

Flash Indicate the Flash memory 
usage of the Function block, 
IO, or NV. 

NV RAM Indicate the NV RAM usage of 
the Function block, IO, or NV. 

Valid Indicate if the point is valid/ 
invalid. 

Block Container Indicates the location of the 
Function block, IO, or NV 

 

7. Click the RAM Pool Usage Details tab to view the 
memory usage status of the controller. The Tabular 
View button can be clicked to view the breakup of 
RAM pool usage details in a tabular format. Click the 
Tabular View button to hide/display the tabular view. 

8. Click the Validate button to find out the Error 
messages and Warning messages, if any, in a new 
window. Typically, user will find messages pertaining 
to warnings, errors and detailed report of invalid 
points, IOs, excess memory counters, excess NVs 
created, excess engineering units configured and so 
on. Click OK to close the window. Clear all errors that 
are appeared during validation. If no errors are occur, 
then follow step 9. 

9. Click Save if any changes are made to the Controller 
Model for the changes to take effect. 

Device Terminal Assignment View 
This view provides a layout of the physical arrangement 
of the pins on the controller. Use this view to view or 
modify the configuration of inputs or outputs of the 
selected controller. According to the selected controller 
model, inputs or outputs which are assigned to the pins 
can be selected. The IO pins for Spyder I, Spyder II, and 
Spyder BACnet models are:  

• Universal Inputs (UI) 1 to 6  

• Digital Inputs (DI) 1 to 4  

• Analog Outputs (AO) 1 to 3  

• Digital Outputs (DO) 1 to 8 

The inputs or outputs that are used to build the 
application logic along with invalid IO points are available 
as options for UI, DI, AO, and DO. The inputs or outputs 
can be selected that are used to build the application 
logic, to be assigned to the physical pins of the controller. 
Invalid IOs can be selected and reassign them to valid 
terminals. 

 
Note:  

UI 0 and UI 7 for Spyder I, Spyder II, and Spyder 
BACnet models are not shown on the Terminal 
Assignment View. 

 

Example: 

Suppose four Modulating Inputs named Modulating Input 
1, Modulating Input 2, Modulating Input 3, Modulating 
Input 4 and two Binary Inputs named BinaryInput 1 and 
BinaryInput 2 are used. On the Terminal Assignment 
View, for each Universal Input (UI 0 to 7), the options are 
available to select Modulating Inputs 1 to 4 or Binary 
Inputs 1 to 2.  

The IO pins for Spyder Lon Micro models and Spyder 
BACnet Micro models are:  

• Universal Inputs (UI) 1 to 4  

• Analog Outputs (AO) 1 and 2  

• Digital Outputs (DO) 1 to 4  

The input pin UI1 is fixed for Pulse_Meter or Counter 
type sensors, or Momentary type binary input. If the pin 
is not available or is currently assigned to another point, 
the tool creates the point as an invalid point. 

To view the Terminal Assignment View of the controller 
follows the steps:  
1. On the Nav tree, browse Station > Config > Drivers 

> LonNetwork > LonSpyder. 
OR 

 Browse Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder  

2. Right click LonSpyder or BACnetSpyder.  
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3. Select Views > Terminal Assignment View. The 
view appears on the right side of the screen. For Lon 
Spyder refer Figure 47 and for BACnet Spyder refer 
Figure 48.  

 
Figure 47: Views > Terminal Assignment View for 

Lon 

 
Figure 48: Views > Terminal Assignment View for 

Bacnet 

4. Assign all the inputs and outputs and click Save to 
save the details or Reset to revert to the last saved 
changes.  

 
Points to note: 
1. If the device model is changed, then the physical IOs 

continue to retain the IO pins previously assigned 
except in the following scenarios:  
i. If a custom IO has been assigned a pin that is 

fixed in the target model, then the Honeywell 
Spyder assigns a free pin, if available. If no free 
pin is available, then the IO becomes an invalid 
IO. 

ii. If there was a fixed pin assigned to a fixed IO in 
the source model and is different in the target 
model, then the Honeywell Spyder reassigns the 
fixed pin in the target model to that IO. However, 
if the fixed pin is already in use in the target 
model, then the Honeywell Spyder converts the 
IO to the nearest custom type and reassigns a 
valid pin available. If there is no valid pin 
available, then the IO becomes unassigned. 

iii. If the target model supports a less number of IOs 
than the source model, then the Honeywell 
Spyder unassigns the pins for the IOs that are in 
excess in the target model. 

iv. If the target model supports more number of IOs 
than the source, then the Honeywell Spyder 
assigns available free pins to any invalid IOs 
present. 

2. The UI0 pin is not displayed on the Terminal 
Assignment View. 

A report of all actions taken is generated. 

If the name of a custom NV or Object clashes with a 
fixed NV or Object name in the target model, Honeywell 
Spyder generates a new unique name for the custom NV 
or Object and creates the new fixed NV or Object. 

Macro Details View 
This view provides details of the Macro. It displays details 
such as the Name, Type, Version number, and a brief 
description.  

To access the Details View of the macro:  

1. On the Nav tree, browse Station > Config > Drivers 
> LonNetwork > LonSpyder. 

OR 

Browse Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder 

2. Expand ControlProgram and drag and drop Macro 
on wire sheet, right-click Macro.  

 
 

Figure 49: Views > Details Option 

3. Select Views > Details. The following fields appear:  

• Name: The name specified for the Program while 
creating it. It is non editable.  

• Type: The type of Program. It is non editable.  

• Version: The version number. It is non editable.  

• Description: A brief description of the macro. Use 
this field to briefly describe the purpose of this 
macro. 

 
Figure 50: Macro Details View Screen 

Macro Resource Usage View 
The ControlProgram, Spyder Libraries and Macros 
that are created consume memory. The function blocks, 
Physical points, and NVs or Objects have different 
memory usage. Some elements of a function block may 
use a Float RAM while some others could be using Non-
Volatile RAM. 
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The Resource Usage View provides details of the total 
memory and the used memory as a result of all the logic 
that are used in creating the macro. 

To view the Resource Usage View of the macro:  

1. On the Nav tree, right click the Macro and select 
Views > Resource Usage. The Resource Usage 
View is displayed on the right of the screen. Refer 
Figure 51.  

 
Figure 51: Views > Resource Usage Option 

2. The Memory Usage chart graphically displays a bar 
chart of the total memory and used memory details. 
Refer Figure 52. 

 
Figure 52: Resource Usage for Macro 

3. The memory usage details of the different memory 
types are also displayed in a tabular format. 

Macro Wiresheet View 
To view the Macro wiresheet:  

1. On the Palette, expand Util to view the list of utility 
functions. 

2. Right click Macro and select Views > Wiresheet. 
The Wiresheet is displayed on the right of the screen.  
To build require logic using Physical points and 
Function Blocks use this screen. Refer Figure 53. 

 

 
Figure 53: Views > Wiresheet Option 

Application Details View 
This view provides details of the Application. It displays 
details such as the Name, Type, Version number, and a 
brief description.  

To access the Details View of the Application:  

1. For Lon Spyder on the Nav tree, browse Station > 
Config > Drivers > LonNetwork > LonSpyder.  

OR 

For BACnet Spyder on the Nav tree, browse Station 
> Config > Drivers > BacnetNetwork > 
BACnetSpyder 

2. Expand ControlProgram, drag and drop Application 
on wire sheet, right-click Application.  
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Refer Figure 54. 

 
Figure 54: Views > Details Option 

 

3. Select Views > Details. The following fields appear:  

• Name: The name which is specified for the 
Program while creating it. It is non editable.  

• Type: Indicates the type used. It is non editable.  

• Version: The version number. It is non editable.  

• Feature: as shown in Figure 55, features are 
available for VAV applications. These features are 
not available for any other application. User can 
‘check’ the required feature to add them. In Flow 
Balancing View, selected feature will appear. 

• Description: A brief description of the application. 
Use this field to briefly describe the purpose of this 
Program. 

Refer Figure 55. 

 

 
Figure 55: Application Details View Screen 

Application Programming View 
The Wiresheet View for the Sub Application that is a 
screen /view of the honeywellSpyderTool interface is 
used to engineer the tool. The Program can be created 
by connecting function blocks to network 
inputs/setpoints/outputs and physical inputs/outputs.  

To view the Application Wiresheet view of the controller:  

1. On the Nav tree, browse Station > Config > Drivers 
> LonNetwork > LonSpyder. 

OR 

Browse Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder 

2. Expand LonSpyder or BACnetSpyder and select 
ControlProgram.  

3. Expand the ControlProgram and right-click the 
Application to view its wiresheet view and select 
Views > Wiresheet. The wiresheet is displayed on 
the right of the screen. Refer Figure 56. 

 
Figure 56: Views > Wiresheet Option 

4. Use this screen to build Program using Physical 
points and Function Blocks. 

 
Note:  

If an Application is dragged from the Nav tree 
onto the Wiresheet of a ControlProgram, 
Physical points are not visible. 

If an Application is dragged from a library to the 
ControlProgram’s Wiresheet View, Physical 
points are visible in the wiresheet of the Program 
and not on the ControlProgram Wiresheet 
View of the palette. 

If the Program is deleted, fixed Physical points 
will appear in the Wiresheet View of the 
ControlProgram. 

Application Resource Usage View 
The application logic, Spyder libraries and macros that 
are created consumes memory. The function blocks, 
Physical points and NVs / Objects have different memory 
usage. Some elements of a function block may use a 
Float RAM while some others could be using Non-
Volatile RAM. 

The Resource Usage View provides details of the total 
memory and the used memory as a result of all the 
application logic, Spyder libraries and macros that are 
used in creating the Program. 
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To view the Resource Usage View of the Program:  

1. For Lon Spyder on the Nav tree, browse Station > 
Config > Drivers > LonNetwork > LonSpyder. 

OR 

For BACnet Spyder on the Nav tree, browse Station 
> Config > Drivers > BacnetNetwork > 
BACnetSpyder 

2. Browse LonSpyder > ControlProgram or 
BACnetSpyder > ControlProgram.  

3. Right click ControlProgram and select Views > 
Resource Usage. Refer Figure 57. The Resource 
Usage details appear on the right half of the screen. 

 
Figure 57: Views > Resource Usage Option 

 

4. The Controller Model is non editable. This is model 
number or make of the controller in which 
programming is done using this tool.  

5. The Memory Usage chart graphically displays a bar 
chart of the total memory and used memory details.  

6. The Memory Usage details of the different memory 
types are also displayed in a tabular format. Refer 
Figure 58. 

 

 
Figure 58: Resource Usage for Application 

Application Lon NV Configuration 
View 

 
Note:  

This screen displays only those NVs that are 
used in this Application. 

 

A Network Variable (NV) is a data item such as a 
temperature, a switch value or actuator state. NVs can 
be thought of simply as point parameters. LonMark® 
functional profiles define Standard Network Variable 
Types (SNVTs), but additional non-standard NVs are 
usually available, depending on the device, to store 
additional non-standard data. 

There are two categories of NVs that the Lon Spyder 
supports. They are:  

1. Fixed Droppable: Fixed Droppable NVs can be used 
while creating application logic, but can edit only its 
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Internal Data Type. Also, display Fixed Droppable 
NVs on the wiresheet. 

2. Custom: Custom NVs are the NVs that are created 
while creating application logic. They can be created, 
edited, and deleted based on requirements.  

The honeywellSpyderTool provides the following four 
built-in functions that enable to connect function blocks 
with other function blocks.  

• NVI: Network Variable Inputs  

• NVO: Network Variable Output  

• NCI: Network Configuration Input 

• Many to One NV: Many to One Network Variable  

The honeywellSpyderTool provides built-in functions, 
Network Variable Inputs, to allow the selection of 
variables that are available from/to the network. The 
configured network variables are mapped to the Function 
Block memory space to be used by any Function Block. 
Each Network variable may be configured with a name. 

Application BACnet Object 
Configuration View 

 
Note:  

This screen displays only those BACnet Objects 
that are used in this Application. 

 

An Object is a data item such as a temperature, a switch 
value or actuator state. Objects can be thought of as 
point parameters.  

There are two categories of Objects that the BACnet 
Spyder supports. They are:  

1. Fixed_Dropable: Fixed_Dropable Objects can be 
used while creating application logic and only its 
Internal Data Type can be edited. Fixed Droppable 
Objects can also be displayed on the wiresheet.  

2. Custom: Custom Objects are the objects that are 
created while creating application logic. They can be 
created, edited, and deleted based on requirements.  

The BACnet Spyder supports the following object types.  

• AVI: Analog Value Input  

• AVO: Analog Value Output  

• AV Setpoint: Analog Value Setpoint  

• BVI: Binary Value Input  

• BVO: Binary Value Output  

• BV Setpoint: BinaryValue Setpoint  

• MVI: Multi-state Value Input  

• MVO: Multi-state Value Output  

• MV Setpoint: Multi-state Value Setpoint  

The configured objects are mapped to the Function Block 
memory space to be used by any Function Block. Each 
Object is configured with a name. 

Viewing the List of BACnet 
Objects 
Browse Station > Config > Drivers > BacnetNetwork > 
BACnetSpyder 

Expand ControlProgram and right-click Application 
and select Views > Object Configuration View (Refer 
Figure 41). The summary page appears with a list of 
Objects used in the Program.  

1. The table has the following columns:  

• Name: Indicates the name of the object.  

• Type: Indicates if the object is of type AVI, AVO, AV 
Setpoint, BVI, BVO, BV Setpoint, MVI, MVO, or MV 
Setpoint.  

• Category: Indicates if the Object is Mandatory, Fixed, 
or Custom.  

• Object Container: Indicates the location of the 
Object.  

• Object Instance: A unique number that is 
automatically assigned to the object.  

• Update Rate: The rate at which inputs are sent to the 
network.  

• Send Heartbeat: The rate at which a Network object 
value is sent to the network regardless of whether its 
value is changed or not. The timeout value is equal to 
the value entered in this field multiplied by 5. This 
value should be configured as multiples of 5 only, 
else tool rounds it off to the nearest multiple of 5 
during download 

Following are the options to:  

• Show Mandatory and Fixed Objects 

• Show on the wiresheet as points  

• Add Objects 

• Edit Objects 

• Delete Objects 

2. The bottom half of the Object Configuration View 
displays the software points available on the 
wiresheet in a tabular format.  

The table has the following columns:  

• Point Name: The name of the physical /software 
point as it appears on the wiresheet.  

• Field Names: Indicates the Object type.  

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 42  

• Point Container: Indicates where the physical 
/software point is used. All physical /software points 
that are used in a Program within an application are 
also listed.  

Following are the options to:  

• Create BACnet object from the point 

• Edit point 

• Remove points from Wiresheet 

 
Note:  

• Mandatory Objects and Fixed Objects are 
not displayed in the Object Configuration 
View. Only Fixed_Dropable Objects are 
displayed in the Object Configuration 
View. 

• In a Fixed Droppable Objects, only Internal 
Data Type can be modified. 

• Custom Object is the user defined Object. A 
Custom Object can be edited or deleted. 

• Fixed Objects marked as Fixed_Dropable 
can be exposed on the wiresheet. 

 

Lon Spyder Actions  
To perform actions on Lon Spyder, follow the steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > LonNetwork > LonSpyder. 

2. Right click the LonSpyder controller. Select Actions 
(Refer Figure 60) to perform following actions 

 
Figure 59: Options for LonSpyder Action Generate 

NVs 

To perform Generate NVs action, follow the steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > LonNetwork > LonSpyder. 

2. Right click the LonSpyder controller. Select Actions 
> Generate NVs. Refer Figure 60. 

 
Figure 60: Generate NVs Option of LonSpyder 

This device action is enabled only in the Engineering 
Mode. Generate Network Variables action creates 
network references from the ControlProgram. This 
creates binding between the input, output variables. 

Generate XIF 
To perform Generate NVs action, follow the steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > LonNetwork > LonSpyder. 

2. Right click the LonSpyder controller. Select Actions 
> Generate XIF. Refer Figure 61. 

 
Figure 61: Generate XIF Option of LonSpyder 

This device action is enabled only in the Engineering 
Mode. Invoking this action generates an XIF file as per 
the application's network interface. The XIF format is a 
standard format published for Lon devices to allow 
interoperability with other Lon based configuration and 
monitoring tools. 

The XIF file is created in a folder named XIF which is 
placed in the Niagara Home folder. 

For details, refer “Generate XIF File”. 

Generate Lnml  
To perform Generate Lnml action, follow the steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > LonNetwork > LonSpyder. 

2. Right click the LonSpyder controller. Select Actions 
> Generate Lnml. Refer Figure 62. 
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Figure 62: Generate Lnml Option of LonSpyder 

This device action is enabled only in the Engineering 
Mode. The generated Lnml file is the format that Niagara 
requires to specify the type of a Dynamic Device. 
Invoking this action creates an Lnml file as per the 
application's network interface in a folder named 
DeviceLnml placed in the Niagara Home folder.  

BACnet Spyder Actions  
To perform actions on Lon Spyder, follow the steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > BacnetNetwork > BACnetSpyder. 

2. Right click the BACnetSpyder controller. Select 
Actions to perform following actions 

 

Generate Network Objects 
1. To perform Generate Network Objects action, 

follow the steps: On the Nav tree, browse Station > 
Config > Drivers > BacnetNetwork > 
BACnetSpyder. 

2. Right click the BACnetSpyder controller. Select 
Actions > Generate Network Objects. Refer 
Figure 63. 

 
Figure 63: Generate Network Objects Option of 

BACnet Spyder 

Generate Network Objects action at the device level 
creates object references from the ControlProgram to 
create a binding between the objects. These Object 
references are listed and used in the Add Bindings 
dialog to bind the devices.  

The Input point object references are displayed in the 
Target details of the Add Bindings dialog box. 

The Output points object references are displayed in the 
Source details of the Add Bindings dialog box. 

The Binary Output and Modulating Output points have 16 
priority input object references and an output object 

reference at the device level. The priority object 
references are displayed in Target details and output 
object reference are displayed in Source details of the 
Add Binding dialog box. 

On restarting the station, the object references are 
removed from the device if the device is not involved in 
binding. 

Clear slots 
To perform Generate Network Objects action, follow the 
steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > BacnetNetwork > BACnetSpyder. 

2. Right click the BACnetSpyder controller. Select 
Actions > Generate Network Objects. Refer 
Figure 64 

 
Figure 64: Clear Slots Option of BACnet Spyder 

The object references for binding are created using the 
Generate network objects action at the device level (refer 
Generate Network Objects). 

The Clear Slots action is used to remove the object 
references that are not involved in binding.  

Fetch Object Names 
To perform Generate Network Objects action, follow the 
steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > BacnetNetwork > BACnetSpyder. 

2. Right click the BACnetSpyder controller. Select 
Actions > Fetch Object Names. Refer Figure 65. 

 
Figure 65: Fetch Object Names Option of BACnet 

Spyder 

The ‘Learn Links’ action first checks if the device from 
which the link is learnt is having the object reference at 
the device level, if it’s not present it will look for the object 
in the ControlProgram. However, for the other device 
involved in binding it only checks for the object reference 
at the device level and if the reference is not found it 
would create default object references. In this case, the 
Fetch Object Names action loads the ControlProgram, 
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fetches the exact name of the object, and renames the 
default name. 

• Name: The name which is specified for the Program 
while creating it. It is non editable.  

• Type: Indicates the type used. It is non editable.  

• Version: Indicates the version number. It is non 
editable.  

• Description: Indicates a brief description of the 
application. Use this field to briefly describe the 
purpose of this Program. 

Write Device Instance 
To perform Generate Network Objects action, follow the 
steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > BacnetNetwork > BACnetSpyder. 

2. Right click the BACnetSpyder controller. Select 
Actions > Write Device Instance. Refer Figure 66.  

 
Figure 66: Write Device Instance Option of 

BACnetSpyder 

Perform this action to change the device instance 
number in the online device through Niagara. Change 
the Device Instance number in Device Object under the 
Config Object of a device and click Action to write the 
changed value to the controller. 

Clear Bindings 
To perform Generate Network Objects action, follow the 
steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > BacnetNetwork > BACnetSpyder. 

2. Right click the BACnetSpyder controller. Select 
Actions > Clear Bindings. Refer Figure 67. 

 
Figure 67: Clear Bindings Option of BACnet Spyder 

The Clear Bindings action on device level removes the 
binding information from the controller. 

The Clear Binding action changes the bound links to 
new Links. If the device is having the obsolete Links then 
the obsolete links are removed from the controller. These 
can be observed in Bacnet Link Manager view (refer 
Types of Link Status section for more information). 

The Clear Binding action can be performed only in the 
following conditions: 

• Device should be online. 

• Device should be in the downloaded state. 

• Device should not be in use. 

Learn Links 
To perform Generate Network Objects action, follow the 
steps: 

1. On the Nav tree, browse Station > Config > 
Drivers > BacnetNetwork > BACnetSpyder. 

2. Right click the BACnetSpyder controller. Select 
Actions > Clear Bindings. Refer Figure 68. 

 
Figure 68: Learn Links Option of BACnetSpyder 

The Learn Links action on device level learns the bound 
links from the device. 

When the bound link is deleted from the Link Manger 
view, then the link is displayed as obsolete link. To 
restore the bound link, the Learn Links action can be 
performed on the device. After Learn Links, the obsolete 
link is changed to bound link. 

The Learn Links action can be performed only in the 
following conditions: 

• Device should be online. 

• Device should be in the downloaded state. 

• Device should not be in use. 

SpyderConfiguration View 
In SpyderConfiguration View, Spyder tool related 
options such as setting free heap memory and the 
number of download retries are configurable 

To open SpyderConfiguration view:  

1. On the Nav tree, browse Station > Config > 
Services > Spyder Configuration. Refer Figure 69. 
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Figure 69: NAV Tree > Spyder Configuration Option 

2. The Spyder Configuration View page appears. Refer 
Figure 70. 

 
Figure 70: Spyder Configuration View Screen 

3. Compile While Unload: Select Compile While 
Unload option. The available options are True and 
False. 

 
Note:  

Setting Compile While Unload to true will 
compile the logic each time the device is set to 
Normal Mode. This enables background 
compilation without having the user to invoke 
compile explicitly. 

Setting Compile While Unload to false will not 
compile the logic each time the device is set to 
Normal Mode. This disables background 
compilation without having the user to invoke 
compile explicitly. 

 

4. Download Retries: Enter the number of Download 
Retries. Up to maximum of five retries are possible. 

5. Free Heap To Maintain: When Engineering Mode is 
invoked, then the tool checks to ensure that the Free 
heap in the station is greater than Free Heap To 
Maintain parameter value and then loads 
ControlProgram into the station.  

 
Note:  

This field applies to JACE only, can be 
configured, if the station is running in the JACE. 

 

6. Validate for Warnings: When Validate option is 
invoked on a Spyder device or set as True, apart 
from errors in the tool. It also validates the Control 
Program application for warnings. Else, validation 
does not look for warnings.  

When Validate for Warnings field is set to False, 
Validation completes a little quicker. 

7. Click Save to save the configuration settings. 

Device Menu Items  
Following are the Device Menus: 

To view the mode, right click the Spyder controller. 
Select an Engineering Mode or Normal Mode as per 
the requirement. Refer Figure 71.  

 
Figure 71: Mode Options for Controller
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Note:  

In menu list, user can switch between modes by 
clicking required mode option. 

Grey font indicates the Current mode and Black 
font indicates free mode. 

 is used for Normal Mode. 

 Is used for Engineering 
Mode.  

 

Engineering Mode 
For details, refer Engineering Mode. 

Normal Mode 
For details, refer Normal Mode. 

Spyder Download 
Use this menu item to download the logic to the 
ControlProgram of an online device. If logic is not 
modified from a previous download to that controller 
except Setpoints value changes, then the Schedule block 
configuration changes, Wall module block configuration 
changes, Day Light Savings, the tool performs a quick 
download of the configuration. This device item is 
enabled in both the Engineering and Normal modes. 

Compile 
Perform this action to compile the logic. It compiles the 
application under ControlProgram, validates the 
application, if not already validated, and generates 
binaries that can be downloaded to the controller at a 
later point in time.  

This action can be invoked even if the device is offline. 
This is useful in offline engineering and increase 
download performance. The application logic can be 
created, compile the logic offline to the device, transfer 
the station to the JACE, and perform a download.  

This device action is enabled only in Engineering Mode.  

To compile:  
1. For Lon Spyder, on the Nav tree, browse Station > 

Config > Drivers > LonNetwork > LonSpyder. 
Refer Figure 72. 

 
Figure 72: Compile option for LonSpyder 

 

For BACnet Spyder, on the Nav tree, browse Station 
> Config > Drivers > BacnetNetwork > 
BACnetSpyder. Refer Figure 73. 

 
Figure 73: Compile Option for BACnetSpyder 

2. Right click the device item and select Compile. A 
status bar showing compilation progress appears. 
Refer Figure 74. 

 
Figure 74: Compilation Progress 

Click Close to exit from the compilation progress dialog. 
Compilation job continues to run in the background 
whose progress can be viewed in the Job Sidebar. When 
Compile is invoked on a device residing in the Station, 
completion of Compile operation is indicated by the job 
completion status pop-up. When invoked on a device 
residing in Spyder Library, job completion pop-up is not 
displayed, to view this status go to device's Controller 
Summary View. 
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Sync from DB device to wiresheet 
Perform this action to synchronize wiresheet values of 
Network Setpoints with the device level Network Setpoint 
values.  

This operation marks the updated Network Setpoints to 
be downloaded during the next download. 

This action can be invoked even if the 
ControlProgram's application has been modified. 

Learn Logic 
Perform this action to upload application logic from the 
controller to Control Program. 

During the operation, the tool searches for matching 
application Library. If a matching application is found, it 
simply uploads the application logic from the library and 
performs the quick upload. This helps to retain the 
position and structure of the application the way it was 
created. If the application is not found in the library, the 
tools upload the entire application from the online 
controller. In this case, the position and structure of the 
application are not retained the way it was created. 

The tool warns the user before proceeding with the 
LearnLogic operation that the ControlProgram 
application could be overridden with application present 
in the online device. To cancel the operation, Learn 
Logic operation is aborted. 

Quick upload means tool only uploads Network Setpoint 
values, Schedule, Wall Module, and Day Light Savings. 
For BACnet Spyder, it also uploads Relinquish Default 
values of AO and BO objects. If the application in the 
device is same as that in the Control Program, invoking 
LearnLogic performs only quick upload. This device 
action is enabled for both LonSpyder and 
BACnetSpyder in the Engineering mode.  

Save To Library 
For details, refer Saving Library Items. 

Calibrate Sensors 
For details, refer CALIBRATE SENSORS.  

Diagnose Outputs 
For details, refer Diagnose Outputs 

Set Mode to Auto 
In the Auto Mode, the physical output can be controlled 
from the application in the device. This device action is 
enabled only for LonSpyder in the Engineering Mode. 

For details, refer Diagnose Outputs for a Lon Device. 

Set Outputs to Auto 
Perform this action to set physical outputs of the device 
to the Auto Mode. This sets the value of priority 8 

elements of the physical output's priority array to null so 
that the next lower priority values are in effect. This 
device action is enabled only for BACnetSpyder in the 
Engineering mode. 

For details, refer “Diagnose Outputs for a BACnet 
Device”.  

Set Time 
This option allows specifying the time zone based on the 
location of the controller. It also allows to perform UTC 
time sync operation to set the UTC_Offset property of 
the BACnet Device object and send the UTC time to the 
controller based on the selected time zone. The 
controller determines the local time, according to the 
UTC time. 

 
Caution: 

The controller must be online while  setting the 
time. 

 

1. On the Nav tree, right click the controller and select 
Set Time. 

The Time Set dialog box is displayed.  
Refer Figure 75 and Figure 76. 

 
Figure 75: Time Set screen (For Lon Controller) 

 

 
Figure 76: Time Set screen (For BACnet Controller) 
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2. Select the Set UTC offset check box. 

3. Select the Time Zone from the drop down list. 

4. Click the UTC Time Sync button. A confirmation 
message is displayed. 

5. Click OK to update the controller with the new time. 
The Controller Time section displays the current 
time in the controller. 

6. Click Close to exit the Time Set dialog box. 

Points to note:  

i. The UTC_Offset property is written to the controller 
only if the Set UTC Offset checkbox is selected. 

ii. The Time Zone drop down list is enabled only if the 
Set UTC Offset checkbox is selected. 

iii. The time zone can also be configured in the 
Controller Summary View of the device. 

iv. The Spyder Download operation writes the 
UTC_Offset property based on the selected Time 
Zone in the controller. However, the controller starts 
applying the UTC_Offset when the UTCTimeSync 
command is received. Initiate sync explicitly from the 
Set Time dialog box is required. 

v. The Sync From Field Device/Learn Logic 
operation reads the UTC_Offset property in the 
controller and updates the Time Zone field in the 
Controller Summary View/Set Time dialog box.  

Spyder Batch Operations view 
In Spyder Batch Operations view, batch operations can 
be invoked on selected Lon\BACnet Spyder devices. The 
device manager is enabled in both the Engineering and 
Normal Modes. To perform batch operations with the 
Spyder Batch Operations view following are the 
options: 

• Batch Download  

• Batch Learnlogic 

• Batch Sync From Field device to Wiresheet  

• Batch Sync From Database device to Wiresheet 

• Batch Set Outputs to Auto (BACnetNetwork) 

• Batch Set Mode to Auto (LonNetwork) 

• Batch Compilation 

• Batch Validation  

 

 
Note:  

When using the batch download feature, now an 
option to check the database revision and abort 
download is available.  

If this option is selected, the tool checks and 
aborts download only for those controllers where 
the database revision in the controller is found to 
be different, compared to what was last 
downloaded from the tool.  

The batch download for other controllers, 
however proceeds without interruption.  

 

To view the Spyder Batch Operations view:  

1. For Lon Spyder, in the Nav tree, browse Station > 
Drivers > LonNetwork > Views > Spyder Batch 
Operations. Refer Figure 77. 

 
Figure 77: Spyder Batch Operations for LonNetwork 

OR 

For BACnet Spyder, in the Nav tree, browse to 
Station > Drivers > BACnetNetwork > Views > 
Spyder Batch Operations. Refer Figure 78. 

 
Figure 78: Spyder Batch Operation for 

BACnetNetwork 

The Spyder Batch Operations page appears.  The 
device download status and the device mode status can 
be viewed in a tabular format. For Lon, refer Figure 79 
and for BACnet refer Figure 80 
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Figure 79: Spyder Batch Operations Screen for Lon 

 
Figure 80: Spyder Batch Operations Screen for BACnet 
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Details of Figure 79 and Figure 80 are as follows: 

1. Device: Displays the list of devices added in the 
network.  

2. Download Status: Displays the download status for 
the added devices. It can be in one of the five states. 

• Validation Pending: When the Control Logic is 
not yet validated. 

• Compilation Pending: When Validation is 
complete and successful, Compilation is yet to be 
performed. 

• Download Pending: When Compilation is 
completed successfully and ready for the 
download. 

• Validation Error: When Validation has failed, the 
user has to correct the validation errors available 
in the validation report. 

• Download Successful: When Control logic is 
downloaded to the controller successfully. 

3. Mode Status: Displays the three types of mode 
status for the added devices: 

• Auto: Spyder controller derives the outputs 
automatically. 

• Manual: User manually commands the outputs 
using Diagnostics option. 

• Unknown: When the output status is unknown. 
The following are the possible reasons:  

 The device is offline. 

 Not able to communicate to the device with the 
given Device Object ID / MAC address.  

2. Click Select All to select all the devices and to 
perform all the batch commands at one go. 

For details of Batch Command Operations, refer Device 
Menus items Explained 

Job Progress Indicators 
The top right corner of the menu bar shows the Job 
Progress indicator. Refer Figure 81. 

 

 

 
Figure 81: Job Progress Indicators 
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Following are the features of Job progress indicators: 

Progress Dialog: For lengthy operations, Spyder tool 
presents a progress dialog that has a Close, Cancel and 
Help button.  

• Close: When the dialog is closed using Close button, 
the operation continues to execute as a job in the 
background in the Station. The progress of the job 
can be viewed in the standard job sidebar or with the 
visual indication in the toolbar with Job Progress 
toolbar icon. 

• Cancel: When the dialog is closed using Cancel 
button, the current Job in progress is cancelled. For 
example, during validation, when the dialog is closed 
using Cancel button, validation operation in progress 
is cancelled and any errors/warnings found in the 
control logic until that point of time are reported. 

• Help: Click on the Help button to view help on the 
progress dialog. 

Job Progress toolbar icon: This toolbar icon appears 
for all the Spyder views of device and ControlProgram. 
This indicates if any, operations are running at any given 
point of time. The Job Progress indicator turns to red, if 
any, of the operations are in progress. Else, it turns to 
green, when no operations (that run as jobs) are in 
progress. The tool tip indicates the current operation 
name that is in progress. 
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PHYSICAL POINTS 
Physical points are logical objects that are used in 
building application logic. Depending on the model 
selected, default (Fixed) Physical points are made 
available.  

Example: For the Lon Spyder I model PVL6436A, 
Actuator and On Board Pressure Sensor can be 
configured as fixed physical points. For the Lon Spyder I 
model PVL 6438N, only On Board Pressure Sensor can 
be configured only as a fixed physical point.  

The honeywellSpyderTool automatically validates rules, 
based on the model selected. In honeywellSpyderTool 
four types of physical points are available to configure in 
to the required application:  

• Binary Inputs  

• Binary Outputs  

• Modulating Inputs  

• Modulating Outputs  

 
Note:  

Select Lon Spyder or BACnet Spyder controller 
as per requirement to view Physical points 

 

Binary Inputs 
A BinaryInput is a physical input. BinaryInput blocks 
can be configured and used them while creating 
application logic. Refer Figure 82 

 
Figure 82: Binary Input Function Block 

 
Note:  

A BinaryInput cannot be dropped under a 
macro 

 

To add and configure a binary input block.  

1. Right click ControlProgram of Honeywell Spyder in 
the Nav tree and select Views > Wiresheet View to 
view the wiresheet.  

 

2. Drag the BinaryInput block from the 
honeywellSpyderTool palette > Physical Points 
onto the wire sheet. A name window will pop up. 
Refer Figure 83. 

 
Figure 83: Enter Name for Binary Input  

3. Type the desired name for the BinaryInput block and 
click OK. The block appears as a container on the 
wire sheet, similar to any function block.  
Refer Figure 82. 

4. Right click the container and select Configure 
Properties. Refer Figure 84. The Configure 
Properties dialog box appears. For Lon Spyder refer 
Figure 85 and for BACnet Spyder refer Figure 86.  

 
Figure 84: Binary Input > Configure Properties 

Option  

 

The Table 9 defines the fields shown in the Figure 85 if 
Lon Spyder is selected. 

 

 
Figure 85: Configure properties Screen of Lon 

Spyder 
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Table 9: BinaryInput Configure Properties for Lon Spyder 

Name Definition 

Point Name Type a name of the function block or use the 
default names given by the tool. 

Point Type 

 

Binary Input is the default selection. Other 
options for Point Type are  

• Constant 

• Network Input 

• Network Setpoint 

• Binary Input  

• Modulating Input  

Refer Table 12 to change the point type from 
BinaryInput to any other point type during 
development. 

Input Type 

 

When the Input Type is selected as 
Momentary. This input can be assigned only to 
the UI1 pin in Spyder Lon Micro models: 
PVL4024NS, PVL4022AS, PUL4024S, 
PUL1012S, and PVL0000AS. 

When the input type is selected as Momentary. 
This input can be assigned only to the UI1 pin in 
Spyder BACnet Micro models: PVB4024NS, 
PVB4022AS, PUB4024S, PUB1012S, and 
PVB0000AS. 

When the input type is selected as Momentary. 
This input can be assigned to any digital pin in 
Lon Spyder Relay models: PUL6438SR. 

In other Spyder models if Momentary is 
selected as input type, then the point will be an 
invalid point. When Maintained is selected, this 
pin (input terminal of the controller) can be 
assigned to any input pin. 

Input State 

 

• Normally Open 

• Normally Closed 

Note:  

Input state configuration can be ignored for 
BinaryInput assigned to digital pins. 

OK Saves the entered information and exits the 
dialog box. 

Cancel Exit the dialog box. Any information entered is 
lost. 
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Note:  

If the Input Type is Momentary for a Binary 
Input and if the UI1 pin is not available, or is 
assigned another point, then the tool creates the 
point as an invalid point. 

For a Momentary type binary input, when there 
is an OPEN to CLOSE and CLOSE to OPEN 
transition on the physical input, the input state 
changes from FALSE to TRUE (or) TRUE to 
FALSE. 

The Momentary type binary input can be 
configured to be Normally Open or Normally 
Close. This reverses the TRUE/FALSE logic. 

 

 

Table 10 defines the fields shown in the Figure 86 if 
BACnet Spyder is selected. 

 
Figure 86: Configure Properties Screen of BACnet 

Spyder 

 

 

Table 10: BinaryInput Configure Properties for BACnet Spyder Controller 

Name Definition 

Point Name  Type a name of the function block or use the 
default names given by the tool.  

Point Type 

 

Binary Input is the default selection. Other 
options for Point Type are  

• Constant 

• Network Input 

• Network Setpoint 

• Binary Input  

• Modulating Input  

To change the point type from BinaryInput to 
any other option during development, refer  
Table 12. 

Input Type 

 

When the input type is selected as Momentary. 
This input can be assigned only to the UI1 pin in 
Spyder Lon Micro models: PVB4024NS, 
PVB4022AS, PUB4024S, PUB1012S, and 
PVB0000AS.  

When the input type is selected as Momentary. 
This input can be assigned only to the UI1 pin in 
Spyder BACnet Micro models: PVB4024NS, 
PVB4022AS, PUB4024S, PUB1012S, and 
PVB0000AS.  
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Name Definition 

In other Spyder models if Momentary is 
selected as input type, then the point will be an 
invalid point. When Maintained is selected, this 
pin (Input terminal) can be assigned to any input 
pin. 

Input State 

 

Normally Open 

Normally Close 

Advanced Displays the BACnet object details. Following 
fields are provided 

• Object Name: It is automatically provided 
by the tool and can be edited.  

• Object Instance: The number can also be 
edited. 

• Object Type: It is a read only field and 
cannot be edited. 

If the GPU option in the advanced dialog box is 
set to True, then Send Heartbeat is enabled. 

OK  Saves the entered information and exits the 
dialog box. 

Cancel  Exit the dialog box. Any information entered is 
lost. 

 

Table 11 defines the fields shown in the Figure 87 of 
Advanced screen of a BinaryInput point. 
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Figure 87: Advanced Screen of BinaryInput for BACnet Spyder Controller 

 

Table 11: Advanced Screen of BinaryInput for BACnet Spyder Controller 

Name Description 

Object Name Display the name of the BinaryInput point. The object name can be edited. 

Field Name Displays the name of the backend object created for the input point. It is non-
editable. 

Object Type Display the object type as BinaryInput. It is non-editable. 
Object Instance Indicate a unique number that is automatically assigned to the object. This 

field is editable and user can assign different instance number other than 
default.  
Note: 

Every object has unique instance number. 

The two objects should not have the same instance number. 

Update Interval The rate at which the controller compares the last value propagated to the 
network against the current value to determine whether a change has 
occurred that warrants the new value to be propagated. Update Interval can 
be used to throttle back the information propagated to the network. 

Recommended default value is 1 second. 

GPU Set the GPU (guaranteed periodic update) to either True or False.  

• True means that the PresentValue of the object has to be sent 
periodically (at the configured 'SendHeartbeat' rate) to the target 
controller that is bound, regardless of whether a change has occurred. 

• False means the PresentValue is NOT sent periodically. The value will be 
sent to the target controller only when the value changes.  

Send Heart Beat The rate at which a network object value is sent to the network regardless of 
whether its value has changed or not. The SendHeartBeat must be 
configured to be equal to or greater than the 'update rate' expected by the 
target controller. This value should be configured as multiples of 5 seconds 
only, else tool rounds it off to the nearest multiple of 5 during download. 
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Note:  

• If the Input Type is Momentary for a Binary Input and if the UI1 pin is not available, or is assigned to another 
point, then the tool creates the point as an invalid point. 

• IOs can be drag on to the wiresheet even when all pins are used up. Honeywell Spyder allows IOs to be dropped 
but they are not assigned with a pin. Such IOs are termed as invalid IOs. A message indicating that “The IO does 
not get a pin is displayed”. 

• When a physical IO (Modulating input, Binary input, Modulating output, Binary output) with a valid IO pin is copied 
and pasted in the wiresheet, the resulting IO gets the same configuration as the source and a new available pin. If 
no free pin is available, the resulting IO becomes an invalid IO. 

• When an invalid physical IO (Modulating input, Binary input, Modulating output, Binary output) is copied and 
pasted in the wiresheet, the resulting IO gets the same configuration as the source and it is also an invalid IO. 

 

Point Conversion of Binary Input 
Table 12 shows the conversion of BinaryInput to other physical points 

Table 12: Binary Input Point Conversion  

Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

Binary Input Constant 1. Right-click the 
BinaryInput block and 
select Configure 
Properties.  

2. Select Constant from the 
Point Type list. 

3. Select Point Category. 
4. Select Units to be used 

within Logic. 
5. Enter a Value. 
6. Click OK. 

1. If the Binary Input was connected 
to a slot of a function block, the 
slot is converted from Connector 
type to Constant. 

2. Any IO pins used by the Binary 
input are freed. Refer note. 
Note: 
• To check IO pins 

configuration, go to terminal 

assignment view, click  
refresh button. It reflects 
changes on terminal.  

• Terminal assignment view 
shows only physical points. 

Binary Input Network 
Setpoint 

1. Right-click the 
BinaryInput block and 
select Configure 
Properties.  

2. Select NetworkSetpoint 
from the Point Type list. 

3. Select Point Category 
4. Select Unit to be used 

within logic 
5. Enter a Value. 
6. Click OK. 

1. The IO pins used by the Binary 
Input are freed. Refer note  
Note: 
• To check IO pins 

configuration, go to terminal 

assignment view, click  
refresh button. It reflects 
changes on terminal.  

• Terminal assignment view 
shows only physical points. 

2. A new NCI of type SNVT is 
created, determined by the Data 
Category, Internal Data Type unit 
selected. 

3. The new NCI is seen in the NVs 
table in the NV Configuration 
View / Object Configuration 
View. Refer note. 

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 58  

Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

Note: 
• Follow step 1 and 2 for Lon 

and BACnet Spyder. 
• For Lon Spyder, NCI are seen 

in NV Configuration View 
• For BACnet Spyder, NCI are 

seen in Object Configuration 
View 

Binary Input Network Input 1. Right-click the 
BinaryInput block and 
select Configure 
Properties.  

2. Select NetworkInput from 
the Point Type list. 

3. Select Point Category. 
4. Select Units to be used 

within Logic. 
5. Click OK. 

1. The IO pins used by the Binary 
Input are freed. Refer note. 
Note: 
• To check IO pins 

configuration, go to terminal 

assignment view, click  
refresh button. It reflects 
changes on terminal.  

• Terminal assignment view 
shows only physical points. 

2. A new NVI of type SNVT is 
created, determined by the Data 
Category, Internal Data Type unit 
selected. 

3. The new NVI is seen in the NVs 
table in the NV Configuration 
View / Object Configuration 
View. Refer note. 
Note: 
• Follow step 1 and 2 for Lon 

and BACnet Spyder. 
• For Lon Spyder, NCI are seen 

in NV Configuration View 
• For BACnet Spyder, NCI are 

seen in Object Configuration 
View 

Binary Input Modulating 
Input 

1. Right-click the 
BinaryInput block and 
select Configure 
Properties.  

2. Select ModulatingInput 
from the Point Type list. 

3. Select Type. Refer note. 
Note:  

• This field is enabled 
only when select 
‘Custom Sensor’ is 
selected   

• For pre-defined 
sensor, it is set to 
default data category. 

1. If there are no IO pins available for 
the target physical IO (in this case, 
the Modulating input that is 
created), the point becomes an 
invalid IO. 

2. A warning message appears 
indicating that “There are no 
more pins to allocate, and an 
unassigned IO is created”. 
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Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

• For example, if 
Temperature sensor 
is selected then 
‘temperature’ is data 
category 

4. Select Data Category 
5. Select Data Type 
6. Click OK. 

 

Binary Outputs 
A BinaryOutput is a physical output. BinaryOutput 
blocks can be configured and use them while creating 
application logic. Refer Figure 88. 

 
Figure 88: Binary Output Function Block 

To add and configure a BinaryOutput block:  

1. Right click ControlProgram under LonSpyder or 
BACnetSpyder in the Nav tree and select Views > 
Wiresheet View to view the wiresheet.  

2. Drag the BinaryOutput block from the 
honeywellSpyderTool palette onto the wire sheet. A 
name window will pop up. Refer Figure 89. 

 
Figure 89: Enter Name for Binary Output 

 

3. Type the desired name for the BinaryOutput block 
and click OK. The block appears as a container on 

the wire sheet, similar to any function block. Refer 
Figure 88. 

4. Right click the container and select Configure 
Properties. Refer Figure 90. The BinaryOutput 
dialog box appears. For Lon Spyder refer Figure 91, 
and for BACnet Spyder refer Figure 92.  

 
Figure 90: Binary Output > Configure Properties 

Option 

 
Figure 91: Configure properties Screen for Lon 

Spyder  

 

Table 13 defines the fields shown in the Figure 91 if Lon 
Spyder is selected. 

 

 

Table 13: BinaryOutputs Configure Properties for Lon Spyder Controller  

Name Definition 

Point Name Type a name or use the default names given by the tool. 

Point Type Binary Output is the default selection. Other options for Point Type are  

• Network Output 
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Name Definition 

• Binary Output 

• Modulating Output 

To change the point type from BinaryOutput to any other output during development, 
refer Table 16. 

OK Saves the entered information and exits the dialog box. 

Cancel Exit the dialog box. Any information entered is lost. 

 

 
Figure 92: Configure properties Screen for BACnet 

Spyder  

 

Table 14 defines the fields shown in the Figure 92 if 
BACnet Spyder is selected. 
 

Table 14: BinaryOutputs Configure Properties Screen for BACnet Spyder Controller  

Name Definition 

Point Name  Type a name or use the default names given by the tool.  

Point Type Binary Output is the default selection. Other options for Point Type are  

• Software Output 

• Binary Output 

• Modulating Output 

To change the point type from BinaryOutput to any other output during development, 
refer Table 16. 

Advanced Display the BACnet object details. Object Name, Object Type and Object Instance 
are the fields provided.  
• Object Name: It is automatically provided by the tool and can be edited.  
• Object Instance: The number can also be edited.  
• Object Type: It is a read only field and cannot be edited. 
If the GPU option in the advanced dialog box is set to True, Send Heartbeat is 
enabled. Refer Figure 93. 

OK  Saves the entered information and closes the dialog box. 

Cancel  Exit the dialog box. Any information entered is lost. 

 
Table 15 defines the fields shown in the Figure 93 of 
Advanced screen of a Binary Output point. 
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Figure 93: Advanced Screen of BinaryOutput for BACnet Spyder Controller 

 

Table 15: BinaryOutput Advanced for BACnet Spyder Controller 

Name Description 

Object Name Displays the name of the BinaryOutput point. The object name can be edited. 

Field Name Displays the name of the backend object created for the output point. It is non-
editable. 

Object Type Displays the object type as BinaryOutput. It is non-editable. 

Object Instance Indicate a unique number that is automatically assigned to the object. This field 
is editable and user can assign different instance number other than default.  
Note: 

Every object has unique instance number. 

The two objects should not have the same instance number.  

Relinquish Default A default value can be set for the BinaryOutput when all the priority slots in 
the Priority Override function block are set to null. 

Logic Command Priority Priority for the selected BinaryOutput can be assigned from 1 (highest 
priority) to 16 (lowest priority). The point is mapped to the priority level in the 
Priority Override function block. 

Update Interval The rate at which the controller compares the last value propagated to the 
network against the current value to determine whether a change has occurred 
that warrants the new value to be propagated. Update Interval can be used to 
throttle back the information propagated to the network. 
Recommended default value is 1 second. 
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Name Description 

GPU Set the GPU (Guaranteed Periodic Update) to either True or False.  
• True means that the present Value of the object has to be sent periodically 

(at the configured 'Send Heartbeat' rate) to the target controller that is 
bound, regardless of whether a change has occurred. 

• False means the present Value is NOT to be sent periodically. The value 
will be sent to the target controller only when the value changes. 

Send Heart Beat The rate at which a Network object value is sent to the network regardless of 
whether its value has changed or not. The SendHeartBeat must be configured 
to be equal to or greater than the 'update rate' expected by the target 
controller. This value should be configured as multiples of 5 seconds only, else 
tool rounds it off to the nearest multiple of 5 during download. 

Fail Detect Enabled Set the Fail Detect Enabled to either True or False.  
• True means, if the object is bound and has not received an update from the 

BACnet network source in the fail detects time, then an alarm is generated 
and the present Value is set to Invalid. Note that fail detect time depends 
on the update rate configured. 

• False means the object retains the last value that was written to it until a 
BACnet network source change it or the Honeywell Spyder has a power 
outage or resets. 

Update Rate This is the rate at which the object expects an update from the BACnet 
network. When 'Fail Detect' is enabled, the controller will report an alarm if 5 
consecutive updates are not received. 
If binding is accomplished by polling the source device, then the poll rate is set 
to the configured 'Update rate'. If 5 successive polls fail, then the controller will 
report an alarm. 
(Refer the ‘Poll/Push’ column in the Bacnet Link Manager view). 

 

 
Note:  

• The IOs can be dragged onto the wiresheet even when all pins are used up. Honeywell Spyder allows IOs 
to be dropped but they are not assigned with a pin. Such IOs are termed as invalid IOs. A message 
indicating that the IO does not get a pin is displayed. 

• When a binary output is deleted, if it had a valid IO pin assigned, the freed pin is automatically assigned to 
an invalid Modulating output configured as PWM type or to an invalid binary output, if any. 

• When a physical IO (Modulating input, Binary input, Modulating output, Binary output) with a valid IO pin is 
copied and pasted in the wiresheet, the resulting IO gets the same configuration as the source and a new 
available pin. If no free pin is available, the resulting IO becomes an invalid IO. 

• When an invalid physical IO (Modulating input, Binary input, Modulating output, Binary output) is copied and 
pasted in the wiresheet, the resulting IO gets the same configuration as the source and it is also an invalid 
IO. 
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Point Conversion of Binary Output 

Table 16 shows the conversion of BinatyOutput to other physical points.  

Table 16: BinaryOutput Point Conversion  

Source 
Point  

Destination 
Point 

Step for conversion Effect of Conversion 

Binary 
Output 

Network 
Output  

1. Right-click the BinaryOutput 
block and select Configure 
Properties.  

2. Select NetworkOutput from 
the Point Type list. 

3. Select a Point Category. 
4. Select Units to be used 

within logic. 
5. Click OK. 

1. The IO pins used by the Binary 
output are freed. Refer note.  
Note: 
• To check IO pins 

configuration, go to terminal 

assignment view, click  
refresh button. This action 
reflects changes on terminal.  

• Terminal assignment view 
shows only physical points. 

2. A new NVO of type SNVT is 
created, determined by the Data 
Category, Internal Data Type unit 
selected. 

3. The new NVO is seen in the NVs 
table in the NV Configuration 
View / Object Configuration 
View. Refer note. 
Note: 
• Follow step 1 and 2 for Lon 

and BACnet Spyder. 
• For Lon Spyder, NCI are 

seen in NV Configuration 
View 

• For BACnet Spyder, NCI are 
seen in Object 
Configuration View 

Binary 
Output 

Modulating 
Output 

1. Right-click the BinaryOutput 
block and select Configure 
Properties.  

2. Select ModulatingOutput 
from the Point Type list. 

3. Select Type. 
4. Select Analog Type. 
5. Select Output Values/PWM 

Configuration/ 
FloatingMotorConfiguration 

6. Click OK. 

1. If there are no IO pins available 
for the target physical IO (in this 
case, the Modulating output that 
is created), the point becomes an 
invalid IO. 

2. A warning message appears 
indicating that “There are no 
more pins to allocate, and an 
unassigned IO is created”. 

 

Modulating Inputs 
A ModulatingInput is a physical input. ModulatingInput 
function blocks can be configured and used while 
creating application logic. Refer Figure 94.  

Figure 94: Modulating Input Function Block 
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To add and configure a ModulatingInput block:  

1. Right click ControlProgram under LonSpyder or 
BACnetSpyder in the Nav tree and select Views > 
Wiresheet View to view the wiresheet.  

2. Drag the ModulatingInput block from the 
honeywellSpyderTool palette onto the wire sheet. 
The name window will pop up. Refer Figure 95. 

 
Figure 95: Enter Name of ModulatingInput 

 

3. Type the desired name for the ModulatingInput 
block and click OK. The block appears as a container 
on the wire sheet, similar to any function block. Refer 
Figure 94.

 

4. Right click the container and select Configure 
Properties. Refer Figure 96. The ModulatingInput 
dialog box appears. For Lon Spyder, refer Figure 97 
and for BACnet Spyder, refer Figure 98. 

 
Figure 96: ModulatingInput > Configure Properties 

Option  

 

 

 
Figure 97: Configure Properties Screen for Lon Spyder 

 

Table 17 defines the fields shown in the Figure 97 if Lon 
Spyder is selected. 

 

 
Table 17: ModulatingInputs Configure Properties Screen for Lon Spyder Controller  

Name Definition 

Point Name  Enter a name of the function block or use the default names i.e. ModulatingInput 
provided by the tool. 

Point Type Modulating Input is the default selection. Other options for Point Type are  

• Constant 

• Binary Input  

• Network Setpoint 



HONEYWELL SPYDER USER GUIDE 

 65 31-00089—02 

Name Definition 

• Network Input 

• Modulating Input  

To change the point type from BinaryInput to any other option during development, 
refer Table 20. 

Type  Display the list of sensors that can be connected. Select a sensor type. 

Data Category Displays the unit of measurement for the Type. This is enabled when Custom 
Resistive or Custom Voltage is selected in the Type field.  

Data Type Displays the engineering unit based on the Point Category. 

Input State Use this to edit sensor characteristics. The Input State is editable only when a 
Custom Resistive or Custom Voltage is selected in the Type field. Enter the 
values for:  

• Input Low 

• Input High 

• Output Low 

• Output High  

Sensor Limits  Click the Sensor Limits button to view and set the upper and lower limits for 
sensors.  

• Enter a lower limit in the Low Limit field.  

• Enter an upper limit in the High Limit field.  

Sensor Readings Outside Limit  

• If ‘Value is INVALID outside High Limit’ option is selected, and when output 
crosses the limit, then output becomes invalid.  

• If ‘Clamp Value as High and Low Limits’ option is selected and if output 
crosses the High Limit or Low Limit, then output is clamped to Low or High Limit 
and it doesn’t become invalid 

OK  Saves the entered information and exits the dialog box. 

Cancel  Exit the dialog box. Any information entered is lost. 

 

 
Note:  

• For Spyder Lon Micro models (PVL4024NS, PVL4022AS, PUL4024S and PUL1012S), or for Spyder 
BACnet Micro models (PVB4024NS, PVB4022AS, PUB4024S and PUB1012S), if Pulse_Meter or 
Counter as the sensor type is selected, then the default pin UI1 is assigned. If the pin is not available, or 
is currently assigned to another point, the tool creates the point as an invalid point. 

• When the modulating input is configured to type Counter in a Spyder Lon Micro, Spyder BACnet Micro, or 
Spyder Lon Relay, it reads the number of counts received in the last second. For example, if a 10Hz 
signal is connected to the input, the input reads 10 counts each second. Another example, suppose a 
0.5Hz signal is connected to the input, the input reads a 0 in the 1st second, a 1 in the 2nd second, a 0 in 
the 3rd second, a 1 in the 4th second, and so on. The maximum frequency of the signal allowed is 15Hz 
that is, maximum counts per second that can be wired to the input is 15 counts per second. The user can 
connect this to the function block logic and accumulate counts. 
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1. When the modulating input is configured to type 
Pulse_Meter in a Spyder Lon Micro, Spyder BACnet 
Micro, or Spyder Lon Relay, it reads the number of 
pulses per hr. The algorithm averages the readings 
depending on the rate at which the pulses come in.  

2. For fast pulses (< 20 seconds apart), the average of 
the last 4 readings is taken.  

3. For medium pulses (< 40 seconds apart), the average 
of the last 2 readings is taken.  

4. For slow pulses (>40 seconds apart), the last reading 
is taken. 

5. When the pulses stop coming in, the power gradually 
decreases and goes to 0 in about 11 mins. The 
maximum measured rate is 54000 pulses per hr. The 
calculated output of a pulse meter input is in pulses 
per hour. This can be connected to the function block 
logic (multiply by scale factor) to the computer power. 

For example, 1 pulse = 1 W and then 10 added as a 
scale factor to the pulse. If pulse meter receives 3600 
pulses per hr then actual power consumption is  
3600 * 10 = 36 KW 

6. Custom Sensor:  If the sensor does not meet any 
standard characteristics, then Type can be selected 
as ‘Custom Sensor’ and its user can set its 
characteristics. 

Procedure to define Custom Sensor: 

1. Right click on the Modulating input which is 
dropped on the wiresheet. Select 
Configure_Properties. Configure_Property 
window will open. 

Table 18 defines the fields shown in the Figure 98 if 
BACnet Spyder is selected. 

 

 

 
Figure 98: Configure Properties Screen for BACnet Spyder

2. Select ‘Custom Sensor’ type. ‘Custom Sensor 
Configuration’ button will appear at the right side 
of the screen as shown in Figure 99. 

 
Figure 99: Selecting Custom Sensor Type
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3. Click on ‘Custom Sensor Configuration’ button. 
‘Linearization Points’ window will appear. As 
shown in Figure 100.

 
Figure 100: Custom Sensor Configuration 

4. Select Sensor Type as a Restive or Voltage as 
per requirement. Specification Unit option in the 
drop down depends upon the Data Type 
selected in the Configure_Property screen. 

5. 10 linearization points are provided to define the 
characteristics of the sensor. On the left side 
enter the value of electrical signal of the sensor 

(either Resistance or Voltage), and at the right 
side, enter the corresponding value of the 
parameter which is being sensed. Up to 10 
points, values can be entered.  

6. Once required values are entered, click on 
Save button. 

 

Table 18: ModulatingInputs Configure Properties for BACnet Spyder Controller  

Name Definition 

Point Name  Enter a name of the function block or use the default names i.e. ModulatingInput 
provided by the tool. 

Point Type Modulating Input is the default selection. Other options for Point Type are  

• Constant 

• Network Input 

• Network Setpoint 

• Binary Input  

• Modulating Input  

To change the point type from BinaryInput to any other option during development, 
refer Table 20. 

Type  Display the list of sensors that can be connected. Select a sensor type. 
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Name Definition 

Data Category  Displays the unit of measurement for the Type. This is enabled when Custom 
Resistive or Custom Voltage is selected in the Type field.  

Data Type Displays the Units of the sensor that need to be read. 

Unit Displays the engineering unit based on the Point Category. 

Input State Use this to edit sensor characteristics. The Input State is editable only when a 
Custom Resistive or Custom Voltage is selected in the Type field. Enter values 
for:  

• Input Low  

• Input High  

• Output Low  

• Output High  

Sensor Limits  Click the Sensor Limits button to view and set the upper and lower limits for 
sensors.  

• Enter a lower limit in the Low Limit field.  

• Enter an upper limit in the High Limit field.  

Sensor Readings Outside Limit  

• It ‘Value is INVALID outside High Limit’ option is selected, and when output 
crosses the limit, then output becomes invalid.  

• If ‘Clamp Value as High and Low Limits’ option is selected and if output 
crosses the High Limit or Low Limit, then output is clamped to Low or High Limit 
and it doesn’t become invalid 

Advanced Display the BACnet object composition. Following fields are provided:  

• Object Name: It is automatically provided by the tool and can be edited.  

• Object Instance: The number can also be edited.  

• Object Type: It is a read only field and cannot be edited.  

• Sen Delta 

• Update Interval 

If the GPU option in the advanced dialog box is set to True, Send Heartbeat is 
enabled. Refer Figure 101. 

OK  Exits the entered information and closes the dialog box. 

Cancel  Exit the dialog box. Any information entered is lost. 

Table 19 defines the fields shown in the Figure 101 of 
Advanced screen of a Binary Output point. 
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Figure 101: Advanced Screen of ModulatingInput 

Table 19: Advanced Screen of ModulatingInputs for BACnet Spyder Controller 

Name Description 

Object Name Display the name of the ModulatingInput point. The object name can be edited. 

Field Name Displays the name of the backend object created for the input point. It is non-
editable. 

Object Type Display the object type as Modulating Input. It is non-editable. 

Object Instance Indicate a unique number that is automatically assigned to the object. This field is 
editable and user can assign different instance number other than default.  
Note: 

Every object has unique instance number. 

The two objects should not have the same instance number.  

Sen Delta The delta value for Significant Event Notification is also known as Sen Delta.  

The controller refreshes/updates the ‘present Value’ property of this object when 
the value changes by the configured Sen Delta. This can be used to tune the 
controller such that small changes of value are not propagated to the BACnet 
network.  

If this object is bound to another controller, then the value is sent on the BACnet 
Network to the target controller whenever it changes by an amount exceeding the 
Sen Delta.  

A Sen Delta of zero means that any change of value is considered significant and 
is propagated to the network.  



HONEYWELL SPYDER USER GUIDE 

31-00089—02 70  

Name Description 

Update Interval The rate at which the controller compares the last value propagated to the network 
against the current value to determine whether significant change has occurred that 
warrants the new value to be propagated. Update Interval works with Sen Delta to 
throttle back the information propagated to the network. 

The recommended value is 1 second. 

GPU Set the GPU (guaranteed periodic update) to either True or False.  

• True means that the present Value of the ModulatingInput has to be sent 
periodically (at the configured 'Send Heart Beat' rate) to the target controller 
that is bound, regardless of whether a significant change, as defined by Sen 
Delta, has occurred. 

• False means the ModulatingInput is NOT to be sent periodically. The value will 
be sent to the target controller only based on the Sen Delta value configured.  

Send Heart Beat The rate at which a Network object value is sent to the network regardless of 
whether its value has changed or not. The send heart beat must be configured to 
be equal to or greater than the 'update rate' expected by the target controller. This 
value should be configured as multiples of 5 seconds only, else tool rounds it off to 
the nearest multiple of 5 during download. 

 

 
Note:  

• IOs can be dragged and dropped on to the wiresheet even when all pins are used up. Honeywell Spyder allows 
IOs to be dropped, but they will not be assigned with a pin. Such IOs are termed as invalid IOs. A message 
indicating that the IO does not get a pin is displayed. 

• When a ModulatingInput is deleted, if it had a valid IO pin assigned, then the freed pin is automatically 
assigned to any invalid modulating input or an invalid binary input. 

• When a physical IO (Modulating input, Binary input, Modulating output, Binary output) with a valid IO pin is 
copied and pasted in the wiresheet, then the resulting IO gets the same configuration as the source and a new 
available pin. If no free pin is available, the resulting IO becomes an invalid IO. 

• When an invalid physical IO (Modulating input, Binary input, Modulating output, Binary output) is copied and 
pasted on the wiresheet, then the resulting IO gets the same configuration as the source and it is also an invalid 
IO. 

• When a ModulatingInput of type standard and custom sensors is copied and pasted on the wiresheet, then the 
same configuration is retained. Even though an On Board Pressure Sensor can be configured, it will not be as 
a consequence of the copy and paste action on the wiresheet. 

 

Adding an On-Board Pressure Sensor 
The On-Board Pressure Sensor is always assigned to 
the Universal Input # 0. On-Board pressure sensor is 
only available for the models which have pressure tubes 
to measure velocity pressure. These models are mostly 
used for VAV applications. 

 
Note:  

The numbers of On Board Pressure Sensors can 
be added are depend on the Controller model 

selected. If the allowed limit of On Board Pressure 
Sensors in application logic is exceeded, then the 
ModulatingInputs as On Board Pressure Sensor 
are not configurable.  

 
Example: To the Lon Spyder I model PVL6436A, if more 
than six modulating inputs are added in logic; then the 
seventh ModulatingInput added is automatically 
configured as an On Board Pressure Sensor and is 
assigned to Pin0. 

To add an Onboard Pressure Sensor:  
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1. Drag a ModulatingInput from the 
honeywellSpyderTool palette onto the wiresheet. 
The name window will pop up. Refer Figure 95. Type 
the desired name for the ModulatingInput block and 
click OK.  

2. Right-click the ModulatingInput that is just added 
and select Configure Properties.  

3. Select On_Board_Pressure from the Type list.  

4. Click OK to complete adding an On Board Pressure 
Sensor. 

Point Conversion of Modulating Input 
Table 20 shows the conversion of ModulatingInput to other points. 

Table 20: ModulatingInput Point Conversion 

Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

Modulating Input Constant 1. Right-click the 
ModulatingInput block 
and select Configure 
Properties.  

2. Select Constant from the 
Point Type list. 

3. Select a Point Category. 
4. Select Units to be used 

within logic. 
5. Enter Value. 
6. Click OK. 

1. If the Modulating Input was 
connected to a slot of a 
function block, the slot is 
converted from Connector type 
to Constant. 

2. IO pins used by the Modulating 
input are freed. Refer Note.  
Note: 
• To check IO pins 

configuration, go to 
terminal assignment view, 

click  refresh button. 
This action reflects 
changes on terminal.  

• Terminal assignment view 
shows only physical 
points. 

Modulating Input Network 
Setpoints  

1. Right-click the 
ModulatingInput block 
and select Configure 
Properties.  

2. Select Network Setpoint 
from the Point Type list. 

3. Select Point Category 
4. Select Units to be used 

within logic. 
5. Enter a Value. 
6. Click OK. 

1. The IO pins used by the 
Modulating input are freed. 
Refer Note 
Note: 
• To check IO pins 

configuration, go to 
terminal assignment view, 

click  refresh button. 
This action reflects 
changes on terminal.  

• Terminal assignment view 
shows only physical 
points. 

2. A new NCI of type SNVT is 
created, determined by the 
Data Category, Internal Data 
Type unit selected. 

3. The new NCI is seen in the 
NVs table in the NV 
Configuration View/ Object 
Configuration View 
Note: 
• Follow step 1 and 2 for 

Lon and BACnet Spyder. 
• For Lon Spyder, NCI are 
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Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

seen in NV Configuration 
View 

• For BACnet Spyder, NCI 
are seen in Object 
Configuration View 

Modulating Input Network Input  1. Right-click the 
ModulatingInput block 
and select Configure 
Properties.  

2. Select Network Input 
from the Point Type list. 

3. Select a Point Category. 
4. Select Units to be used 

within logic. 
5. Click OK. 

1. The IO pins used by the 
Modulating input are freed. 
Note: 
• To check IO pins 

configuration, go to 
terminal assignment view, 

click  refresh button. 
This action reflects 
changes on terminal.  

• Terminal assignment view 
shows only physical 
points. 

2. A new NVI of type SNVT is 
created, determined by the 
Point Category, Internal Data 
Type unit selected. 

3. The new NVI is seen in the 
NVs table in the NV 
Configuration View/ Object 
Configuration View 
Note: 
• Follow step 1 and 2 for 

Lon and BACnet Spyder. 
• For Lon Spyder, NCI are 

seen in NV Configuration 
View 

• For BACnet Spyder, NCI 
are seen in Object 
Configuration View 

Modulating Input Binary Input 1. Right-click the 
ModulatingInput block 
and select Configure 
Properties.  

2. Select Binary Input from 
the Point Type list. 

3. Select Input Type. Select 
Input State values (if 
required) 

4. Click OK. 

1. If there are no IO pins 
available for the target physical 
IO (in this case, the Binary 
input that is created), the point 
becomes an invalid IO. 

2. A warning message appears 
indicating that there are no 
more pins to allocate, and an 
unassigned IO is created. 
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Note:  

When one ModulatingInput is configured for 
On-Board Pressure Sensor, and then, copy 
and paste On Board Pressure Sensor 
(Modulating Input) on the wiresheet such that 
the maximum allowed count for that model is 
exceeded, it is converted to a Custom Voltage 
Sensor. 

 

Modulating Outputs 
A ModulatingOutput is a physical output. This function 
block is available in the honeywellSpyderTool. It is 
used to create ModulatingOutput in the application 
logic. Refer Figure 102. 

 
Figure 102: Modulating Output Function Block 

To add and configure a Modulating Output block:  

1. Right click ControlProgram under LonSpyder or 
BACnetSpyder in the Nav tree and select Views > 
Wiresheet View to view the wiresheet.  

2. Drag the ModulatingOutput block from 
honeywellSpyderTool palette onto the wire sheet. 
The name window will pop up. Refer Figure 103. 

3. Type the desired name for the ModulatingOutput 
block and click OK. The block appears as a container 
on the wiresheet, similar to any function block. Refer 
Figure 102. 

 

 
Figure 103: Enter Name of Modulating Output 

5. Right click the container and select Configure 
Properties. Refer Figure 103. The 
ModulatingOutput dialog box appears. For Lon 
Spyder, refer Figure 105 and for BACnet Spyder, 
refer Figure 106. 

 

 
Figure 104: Modulating Output > Configure 

Properties  
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Figure 105: Configure Properties Screen for Lon Spyder 

 

Table 21 defines the fields shown in the Figure 105 if Lon 
Spyder is selected. 

 

Table 21: ModulatingOutputs Configure Properties for Lon Spyder Controller  

Name Definition 

Point Name Enter a name of the function block or use the default names i.e. 
ModulatingOutput provided by the tool.  

Point Type ModulatingOutput is the default selection. Other options for Point Type are  

• Network Output 

• Binary Output  

Refer Table 24, to change ModulatingOutput to any other option during 
development.  

Type Indicate a Modulating Output type. Select one of the following:  

• Analog: Select this option, when the actuator or final control element is of 
analog type and accepts the signal in voltage or current form. 

• Floating: Select this option when actuator or final control element is of 
Floating type. Spyder controller utilizes two BinaryOutputs for Floating 
type signal.  

 One digital output moves the final control element in clockwise direction  

 Other digital output moves the final control element in anticlockwise 
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Name Definition 

direction.  

The time for which the digital outputs are held on is depends upon stroke 
time of the final control element. 

 For example, if the stroke time of the actuator is 90 seconds. and actuator 
is at full close position, if 50 % command is given to the actuator, 
clockwise binary output will be turned on for 45 seconds. At this position, if 
again 0 % command is given to that actuator, anticlockwise BinaryOutput 
will turn on for 45 seconds.  

 In Spyder Relay models, the resolution of the floating control is limited to  
1 second. 

 SyncEdgeTrigger option is available for Spyder Relay models only. 

• PWM: Select this option if the final control element is accepting the signal in 
the Pulse Width Modulation form. 

 This type is not supported in Spyder Relay models. 

• Actuator: This option is only available for the Spyder controller model type 
which has integrated actuator as a fixed physical point. 

• FixedSylkOutput: Spyder controllers also support Sylk actuators. Select this 
type to create output for Sylk actuators. This output is then assigned to output 
pin of the Sylk actuator 

Analog Type This is enabled only when Analog is selected in the Type field. As per actuator’s 
requirement, select one of following:  

• Volts: The range is 0 VDC - 10 VDC  

• Amps: The range is 4 mA - 20 mA. 

Output Values This is enabled only when Analog is selected in the Type field. Enter the value 
for Zero Percent and Full Percent.  

Note:  

Each ModulatingOutput can be configured for the output voltage/current at 0 % 
and at 100 %. Each modulating output circuit operates in current mode for loads 
up to 600 Ω. For loads of 600 Ω to 1000 Ω, the output transitions to voltage 
mode. For loads above 1000 Ω, the output operates in voltage. 

When full percent is less than zero percent, the motor runs in the reverse 
direction. 

PWM Configuration This is enabled when PWM is selected in the Type field. Enter the values for the 
following: 

• Period: The range is 1 - 3276.7 sec in tenths of seconds. It is the time period 
of the one cycle of the pulse width modulation. 

• Zero time: When 0 % command is given, then the pulse width is equal to the 
value specified in this parameter, 

• Full time: When 100% command is given, then the pulse width is equal to 
the value specified in this parameter. 
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Name Definition 

Floating Motor 
Configuration 

This parameter is enabled when Floating is selected in the Type field. 

• Travel Time: It is maximum specified time for which clockwise or counter 
clockwise output remains ON when 100 % command is given. 

• AutoSyncType: Following options for the AutoSyncType are available: 

 None: Honeywell Spyder assumes the motor is fully closed.  

 Sync Open: The motor is driven, fully open after completion of 
AutoSyncInterval.  

 Sync Closed: The motor is driven, fully closed open after completion of 
AutoSyncInterval.  

 AutoSyncInterval: The Auto Synchronization Interval is configured from 0 
hrs to 255 hrs in one hour increments. The timer is loaded and starts 
counting down right after power up reset and power up delay. When the 
timer expires, the motor is synchronized. This only applies if the user 
configured auto synchronization to be Sync Open or Sync Close.  

• PowerupSyncType: Select one of the following values:  

 None: Honeywell Spyder assumes the motor is fully closed.  

 Sync Open: The motor is driven, fully open.  

 Sync Closed: The motor is driven, fully closed.  

 PowerupDelay: The Power Up Delay is configured from 0 - 3276.7 sec in 
tenths of seconds. Zero (0) means no delay. 

• If SyncEdgeTrigger as the output is selected, then it can be triggered the 
motor point at any point in time using the following values: 

 <=0: No effect 

 1: Sync closed 

 2: Sync open 

 >=3: No effect  

Motor Action This is enabled only when Floating is selected in the Type field. Select one of 
the following values: 

 Direct  

 Reverse  

Reverse Action is configured for  

• True = 100% = full close, 0% = full open.  

• False is the opposite. 0 % = full Open, 100 % = full close. 

OK Saves the entered information and exits the dialog box. 

Cancel Exit the dialog box. Any information entered is lost. 
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Figure 106: Configure Properties Screen for BACnet Spyder  

Table 22 defines the fields shown in the Figure 106 if 
BACnet Spyder is selected. 

 

 

 

Table 22: Configure Properties ModulatingOutputs for BACnet Spyder Controller  

Name Description 

Point Name Enter a name or use the default names provided by the tool. 

Point Type ModulatingOutput is the default selection. Other options for 
Point Type are  

• Network Output 

• Binary Output 

Refer Table 24, to change the point type from ModulatingOutput 
to any other option during development.  

Type  Indicate a ModulatingOutput type. Select one of the following:  

• Analog: Select this option, when the actuator or final control 
element is of analog type and accepts the signal in voltage or 
current form. Floating: Select this option when actuator or 
final control element is of floating type. Spyder controller 
utilizes two binary outputs for Floating type signal.  

 One digital output moves the final control element in 
clockwise direction  

 Other digital output moves the final control element in 
anticlockwise direction.  

The time for which the digital outputs are held on is depends 
upon stroke time of the final control element. 
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Name Description 
For example, if the stroke time of the actuator is 90 seconds 
and actuator is at full close position, if 50 % command is 
given to the actuator, clockwise binary output will be turned 
on for 45 seconds. At this position, if again 0 % command is 
given to that actuator, anticlockwise binary output will turn on 
for 45 seconds. 

 In Spyder Relay models, the resolution of the floating 
control is limited to 1 second.  

 SyncEdgeTrigger option is available for Spyder Relay 
models only. 

• PWM: Select this option if the final control element is accepting 
the signal in the Pulse Width Modulation form. 

 This type is not supported in Spyder Relay models. 

• Actuator: This option is only available for the Spyder controller 
model type which has integrated actuator as a fixed physical 
point. 

• FixedSylkOutput: Spyder controllers also support Sylk 
actuators. Select this type to create output for Sylk actuators. 
This output is then assigned to output pin of the Sylk actuator 

Analog Type This is enabled only when Analog is selected in the Type field. As 
per actuator’s requirement select one of following: 
1. Volts: The range is 0 VDC to10 VDC.  
2. Amps: The range is 4mA to 20 mA.  

Output Values This is enabled only when Analog is selected in the Type field. 
Enter the value for Zero Percent and Full Percent.  
Note: 
Each ModulatingOutput can be configured for the output 
voltage/current at 0 % and at 100 %. Each Modulating Output 
circuit operates in current mode for loads up to 600 Ω. For loads 
of 600 Ω to 1000 Ω, the output transitions to voltage mode. For 
loads above 1000 Ω, the output operates in voltage. When full 
percent is less than 0 %, the motor runs in the reverse direction. 

PWM Configuration This is enabled when PWM is selected in the Type field. Enter the 
values for the following:  

• Period: The range is 1 - 3276.7 sec in tenths of seconds. It is 
the time period of the one cycle of the pulse width modulation. 

• Zero time: When 0 % command is given, then the pulse width 
is equal to the value specified in this parameter, 

• Full time: When 100% command is given, then the pulse 
width is equal to the value specified in this parameter. 
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Name Description 

Floating Motor Configuration This parameter is enabled when Floating is selected in the Type 
field. 

Travel Time: It is maximum specified time for which clockwise or 
counter clockwise output remains ON when 100% command is 
given. 

• AutoSyncType: Following options for the AutoSyncType are 
available: 

 None: Honeywell Spyder assumes the motor is fully closed.  

 Sync Open: The motor is driven, fully open after 
completion of AutoSyncInterval.  

 Sync Closed: The motor is driven, fully closed open after 
completion of AutoSyncInterval.  

• AutoSyncInterval: The Auto Synchronization Interval is 
configured from 0 hrs to 255 hrs in one hour increments. The 
timer is loaded and starts counting down right after power up 
reset and power up delay. When the timer expires, the motor is 
synchronized. This only applies if the user configured auto 
synchronization to be Sync Open or Sync Close 

 PowerupSyncType: Select one of the following values:  
 None: Honeywell Spyder assumes the motor is fully closed.  
 Sync Open: The motor is driven, fully open.  
 Sync Closed: The motor is driven, fully closed.  
 PowerupDelay: The Power Up Delay is configured from 0 -

3276.7 sec in tenths of seconds. Zero (0) means no delay.  
 If SyncEdgeTrigger as the output is selected, then it can be 

triggered the motor point at any point in time using the 
following values: 
 <=0: No effect 

 1: Sync closed 

 2: Sync open 

 >=3: No effect 

Motor Action This is enabled only when Floating is selected in the Type field.  
Select one of the following values:  
 Direct  
 Reverse  
Reverse Action is configured for  

• True = 100% = full close, 0% = full open.  

• False is the opposite. 0 % = full Open, 100 % = full close. 

OK Saves the entered information and exits the dialog box. 

Cancel  Exits the dialog box. Any information entered is lost. 

 

Points to note: 

1. The IOs can be dragged on to the wiresheet even 
when all pins are used up. Honeywell Spyder allows 
IOs to be dropped but they are not assigned with a 

pin. Such IOs are termed as invalid IOs. A message 
indicating that the IO does not get a pin is displayed. 

2. When a ModulatingOutput configured as Floating 
type is deleted and it had a valid IO pin assigned, 
then the freed pin is automatically assigned to any 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 80  

available invalid ModulatingOutput configured as 
Floating type or to an invalid binary output. 

3. When a ModulatingOutput configured as PWM type 
is deleted and it had a valid IO pin assigned, then the 
freed pin is automatically assigned to any available 
invalid ModulatingOutput configured as PWM or to 
an invalid binary output. 

4. When a ModulatingOutput configured as Analog 
type is deleted and it had a valid IO pin assigned, 
then the freed pin is automatically assigned to any 
available invalid ModulatingOutput configured as 
Analog type or to an invalid BinaryOutput. 

5. When a physical IO (Modulating input, Binary input, 
Modulating output, Binary output) with a valid IO pin is 
copied and pasted on the wiresheet, then the 
resulting IO gets the same configuration as the source 
and a new available pin. If no free pin is available, 
then the resulting IO becomes an invalid IO. 

6. When an invalid physical IO (Modulating input, Binary 
input, Modulating output, Binary output) is copied and 
pasted on the wiresheet, then the resulting IO gets 
the same configuration as the source and it is also an 
invalid IO. 

7. When a ModulatingOutput is copied and pasted on 
the wiresheet, then the same configuration is 
retained. When copying an analog type and even if 
digital pins are present, then a pin is not assigned. A 
pin is assigned only when a Floating/PWM type is 
copied and pasted on the wiresheet or when it is 
dragged onto the wiresheet 

 

Table 23 defines the fields shown in the Figure 107 of a 
ModulatingOutput point. 

 

 

 
Figure 107: Advanced Screen of ModulatingOutput for BACnet Spyder 

 

Table 23: Advanced Screen of ModulatingOutput for BACnet Spyder Controller 

Name Description 

Object Name Display the name of the ModulatingOutput point. The object name can be 
edited. 

Field Name Displays the name of the backend object created for the output point. It is 
non-editable. 



HONEYWELL SPYDER USER GUIDE 

 81 31-00089—02 

Name Description 

Object Type Displays the object type as Modulating Output. It is non-editable. 

Object Instance Indicates a unique number that is automatically assigned to the object. This 
field is editable and user can assign different instance number other than 
default.  
Note: 

Every object has unique instance number. 

The two objects should not have the same instance number.  

Relinquish Default A default value can be set for the Modulating Output when all the priority slots 
in the Priority Override function block are set to null. 

Logic Command Priority Priority for the selected ModulatingOutput can be assigned from 1 (highest 
priority) to 16 (lowest priority). The point is mapped to the priority level in the 
Priority Override function block. 

Sen Delta The delta value for Significant Event Notification is also known as Sen 
Delta.  
The controller refreshes/updates the ‘present Value’ property of this object 
when the value changes by the configured Sen Delta. This can be used to 
tune the controller such that small changes of value are not propagated to the 
BACnet network.  
If this object is ‘bound’ to another controller, then the value is sent on the 
BACnet Network to the target controller whenever it changes by an amount 
exceeding the SEN Delta.  
A SENDelta of zero means that any change of value is considered significant 
and is propagated to the network.  
Note: 
If the application logic is driving the output at multiple priority levels using the 
'PriorityOverride' function block, then the configured SenDelta and 
UpdateInterval values would apply to all the priority levels. The 
presentValuecontroller refreshes the present Value property of the object as 
per the configured SenDelta and UpdateInterval values and it is propagated 
to the network as per the SenDelta and GPU settings. 

Update Interval The rate at which the controller compares the last value propagated to the 
network against the current value to determine whether significant change 
has occurred that warrants the new value to be propagated. Update Interval 
works with Sen Delta to throttle back the information propagated to the 
network. 
The recommended value is 1 sec. 

GPU Set the GPU (guaranteed periodic update) either True or False.  
True means that the present value of the object has to be sent periodically 
(at the configured ‘Send Heart beat’ rate) to the target controller that is 
bound, regardless of whether a significant change, as defined by SEN Delta, 
has occurred. 
False means the present value is NOT to be sent periodically. The value will 
be sent to the target controller only based on the Sen Delta value configured. 

Send Heart Beat The rate at which a network object value is sent to the network regardless of 
whether its value has changed or not. The SendHeartBeat must be 
configured to be equal to or greater than the ‘update rate’ expected by the 
target controller. This value should be configured as multiples of 5 seconds 
only, else tool rounds it off to the nearest multiple of 5 during download. 
Note:  
When the ModulatingOutput is the target in a 'binding', then the present 
value is refreshed and propagated to the network as per configured SenDelta 
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Name Description 
and GPU settings. 

Fail Detect Enabled Set the Fail Detect Enabled to either True or False.  
True means if the object is bound and has not received an update from the 
BACnet network source in the fail detect time, then an alarm is generated 
and the presentValue is set to Invalid. Note that fail detect time depends on 
the update rate configured. 
False means the object retains the last value that was written to it until a 
BACnet network source change it or the Honeywell Spyder has a power 
outage or resets.  
Note: 
If the Modulatingoutput is the target in a 'binding', then the configured 
FailDetect and UpdateRate settings will be applicable to any or all of the 
priorityArray elements that are bound. 

Update Rate This is the rate at which the object expects an update from the BACnet 
network. When ‘Fail Detect’ is enabled, the controller will report an alarm if 5 
consecutive updates are not received. 
If binding is accomplished by polling the source device, then the poll rate is 
set to the configured ‘Update rate’. If 5 successive polls fail, then the 
controller will report an alarm. 
(Refer the ‘Poll/Push’ column in the Bacnet Link Manager view) 

 

Adding an Actuator 
Actuator is a fixed output and available only in the 
Spyder Controller models with integrated actuators 
where integrated actuators are used for Spyder models 
and mostly used for VAV application.  

If analog output Type is selected as Actuator, then 
automatically digital output 7 and 8 (DO7 and DO8) is 
assigned to the actuator. Digital outputs are assigned 
because the integrated actuator is of floating type. All 
other parameters related to floating actuator are editable. 
 

 
To add an Actuator:  
1 Drag a Modulating Output from the 

honeywellSpyderTool palette onto the wiresheet. 
The name window will pop up. Refer Figure 103. 

2 Type the desired name for the Modulating Input block 
and click OK. The block appears as a container on 
the wire sheet, similar to any function block. Refer 
Figure 102. 

3 Right-click the Modulating Output which is just 
added and select Configure Properties.  

4 Select Actuator from the Type list. Enter the values 
in the parameters which comes under the 
FlaotingMotorConfiguration 

5 Select FloatingMotorConfiguration details.  
6 Specify Motor Action.  
7 Click OK to complete adding an Actuator. 
 
 
 



HONEYWELL SPYDER USER GUIDE 

 83 31-00089—02 

Point Conversion of Modulating Output 
Figure 31 shows the conversion of ModulatingOutput to other physical points 

 

Table 24: Point Conversion of Modulating Output 

Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

Modulating Output Binary Output 1. Right-click the 
ModulatingOutput block 
and select Configure 
Properties.  

2. Select BinaryOutput from 
the Point Type list. 

3. Click OK. 

1. If there are no IO pins 
available for the target 
physical IO (in this case, 
the Binary output that is 
created), the point 
becomes an invalid IO. 

2. A warning message 
appears indicating that 
there are no more pins to 
allocate, and an 
unassigned IO is created. 

Modulating Output Network Output 1. Right-click the 
ModulatingOutput block 
and select Configure 
Properties.  

2. Select NetworkOutput 
from the Point Type list.  

3. Select a Point Category.  
4. Select the Units to be 

used within logic.  
5. Click OK.  

1. The IO pins used by the 
Modulating output are 
freed.  
Note: 
• To check IO pins 

configuration, go to 
terminal assignment 

view, click  refresh 
button. This action 
reflects changes on 
terminal.  

• Terminal assignment 
view shows only 
physical points. 

2. The new network output is 
seen in the Objects table in 
the NV Configuration 
View/ Object 
Configuration View 
Note: 
• Follow step 1 and 2 for 

Lon and BACnet 
Spyder. 

• For Lon Spyder, NCI 
are seen in NV 
Configuration View 

• For BACnet Spyder, 
NCI are seen in Object 
Configuration View 
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SOFTWARE POINTS 
In honeywellSpyderTool, four software points are 
available in SoftwarePoints. They are as follows: 

• Constant 

• NetworkInput 

• NetworkSetpoint 

• NetworkOutput 

These points are virtual or software points. These points 
can be used in the application logic wherever they are 
required. Except Constant, all other points are available 
for Lon or BACnet communication and can be 
communicated with other devices over a Lon/Bacnet 
network. 

Constant 
A Constant input is a non-physical input which is not 
visible to the network. Constant blocks can be 
configured and use them while creating application 
logic in BACnet Spyder. Refer Figure 108. 

 
Figure 108: Constant Function Block 

To add and configure a Constant block:  

1. On the Nav tree, expand Spyder controller. Right 
click ControlProgram and select Views > Wiresheet 
View to view the wiresheet.  

2. Drag the Constant block from the 
honeywellSpyderTool palette onto the wire sheet. 
The name window will pop up. Refer Figure 109.  

  
Figure 109: Enter Name of Constant 

 

3. Type the desired name for the Constant block and 
click OK. The block appears as a container on the 
wiresheet, similar to any function block. 

Refer Figure 108. 

4. Right click the container and select Configure 
Properties. Refer Figure 110. The Constant dialog 
box appears. Refer Figure 111. 

 
Figure 110: Constant > Configure Properties Option  
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Figure 111: Configure Properties Screen of Constant for Lon and BACnet 

 

Table 25 defines the fields shown in the Figure 111 if 
Spyder controller is selected. 

 

 
Table 25: Constant Configure Properties for Spyder Controller 

Name Description 

Point Name Type a name of the function block or use the default names given by the tool.  

Point Type Constant is the default selection. Other options for Point Type are  

• Constant 

• Binary Input  

• Network Setpoint 

• Network Input 

• Modulating Input  

Refer Table 26, to change the point type from Constant to any other option during 
development,  

Point Category Display the unit of measurement for the Point Type.  

Unit  Displays the engineering unit based on the Point Category. 

Sub-Category Display the enumeration type for the software points. The field Unit is renamed as 
Sub-Category if the point category selection is unitless. 

OK  Saves the entered information and exits the dialog box. 

Cancel  Exit the dialog box. Any information entered is lost. 
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Define Enum 
To define own custom enumeration type for the software 
points:  

1. Right click Constant container, select Configure 
Properties. Refer Figure 110 

2. Select Unit-less from Point Category, and then 
select Custom from the Sub-Category list.  

3. Click the button next to the Sub-Category drop-
down. The Enum dialog box appears. Refer Figure 
112.   

 
Figure 112: Enum Screen 

4. Click the check box Use Frozen Enum in Range list 
to load the range from the standard list. Refer Figure 
113.  

 
Figure 113: Select Check Box to Add Standard Range 

OR 

Click Add to create custom enumeration type. Enter 
the new Enum name and click OK. Refer Figure 114.  

 
Figure 114: Click Add to Set the Custom Enum 

5. Click OK.  
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Note:  

IOs can be dragged on to the wiresheet even when all 
pins are used up. Honeywell Spyder allows IOs to be 
dropped but they are not assigned with a pin. Such 
IOs are termed as invalid IOs. A message indicating 
that, “The IO does not get a pin is displayed”. 

 

A Constant can be added to a macro is also possible.  

 

 

 

 

Point Conversion of Constant 
Table 26 shows the conversion of Constant to other physical points.  

Table 26: Point Conversion of Constant 

Source 
Point  

Destination Point Step for conversion Effect of Conversion 

Constant Network Input 1. Right-click the Constant 
block and select 
Configure Properties.  

2. Select NetworkInput 
from the Point Type list.  

3. Select a Point Category.  

4. Select Units to be used 
within Logic. 

5. Click OK.  

1. If the Functional block slot to 
which the point was connected 
was of type Constant/ 
Connector, the slot is converted 
from Constant type to Connector 
but the link is retained.  

2. If the functional block slot to 
which the point was connected 
was of type Connector only, the 
link is broken.  

3. A network input is created and 
added to the Objects table in the 
NV Configuration View/ Object 
Configuration View 

Note: 

• Follow step 1 and 2 for Lon 
and BACnet Spyder 

• For Lon Spyder, NCI are 
seen in NV Configuration 
View 

• For BACnet Spyder, NCI are 
seen in Object 
Configuration View 

Constant Network Setpoint 1. Right-click the Constant 
block and select 
Configure Properties.  

2. Select NetworkSetpoint 
from the Point Type list.  

3. Select a Point Category.  

4. Select Units to be used 
within logic. 

5. Enter a Value. 

6. Click OK. 

 

1. If the Functional block slot to 
which the point was connected 
was of type Constant/ 
Connector, the slot is converted 
from Constant type to Connector 
but the link is retained.  

2. If the Functional block slot to 
which the point was of type 
Constant only, the link is broken.  

3. A new setpoint input is created 
and added to the Objects table in 
the NV Configuration View/ 
Object Configuration View 
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Source 
Point  

Destination Point Step for conversion Effect of Conversion 

Note: 

• Follow step 1 and 2 for Lon 
and BACnet Spyder 

• For Lon Spyder, NCI are 
seen in NV Configuration 
View  

• For BACnet Spyder, NCI are 
seen in Object Configuration 
View 

Constant Binary Input 1. Right-click the Constant 
block and select 
Configure Properties.  

2. Select BinaryInput from 
the Point Type list.  

3. Select Input Type.  

4. Select Input State values 
(if required) 

5. Click OK.  

 

1. If the Functional block slot to 
which the point was connected 
was of type Constant/ 
Connector, the slot is converted 
from Constant type to Connector 
but the link is retained.  

2. If the Functional block slot to 
which the point was of type 
Constant only, the link is broken.  

3. The resulting physical IO object 
(Binary input in this case) gets 
any free IO pin available. If no 
pin is available, the resulting 
physical IO becomes an invalid 
IO (IO with no pin).  

Constant Modulating Input 1. Right-click the Constant 
block and select 
Configure Properties.  

2. Select ModulatingInput 
from the Point Type list.  

3. Select Type.  

Note:  

• This field is enabled 
only when ‘Custom 
Sensor’ is selected   

• For pre-defined 
sensor, it is set to 
default date 
category. 

• For example, if 
Temperature sensor 
is selected then 
‘temperature’ is data 
category 

4. Select Data Category. 

5. Select Data Type.  

6. Click OK.  

1. If the Functional block slot to 
which the point was connected 
was of type Constant/ 
Connector, the slot is converted 
from Constant type to Connector 
but the link is retained.  

2. If the Functional block slot to 
which the point was of type 
Constant only, the link is broken.  

3. The resulting physical IO object 
(Modulating input in this case) 
gets any free IO pin available. If 
no pin is available, the resulting 
physical IO becomes an invalid 
IO (IO with no pin).  
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Network Inputs 
A NetworkInput is a non-physical input. Configure 
NetworkInput blocks can be configured and used them 
while creating application logic in BACnet Spyder.  

 
Figure 115: Network Input Function Block 

 

To add and configure a network input block:  

1. Right click ControlProgram under Honeywell 
Spyder in the Nav tree and select  
Views > Wiresheet View to view the wiresheet.  
Refer Figure 116 

2. Drag the Network Input block from the 
HoneywellSpyderTool palette onto the wire sheet. 
The name window will pop up. 

3. Type the desired name for the NetworkInput block 
and click OK. The block appears as a container on 
the wiresheet, similar to any function block.  
Refer Figure 115 

 
Figure 116: Enter Name of NetworkInput 

4. Right click the container and select Configure 
Properties. Refer Figure 117. The NetworkInput 
dialog box appears. Refer Figure 118. 

 
Figure 117: Network Input > Configure Properties 

Option  

 
 
 
 
 

 
Figure 118: Configure Properties Screen of Network Inputs 

Table 27 defines the fields shown in the Figure 118. 
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Table 27: NetworkInputs Configure Properties Screen  

Name Description 

Point Name Enter a name of the function block or use the default names given by the tool.  

Point Type NetworkInput is the default selection. Other options for Point Type are  

• Constant 

• Binary Input  

• Network Setpoint 

• Network Input 

• Modulating Input  

Refer Table 30, to change the point type from NetworkInput to any other option 
during development. 

Point Category Displays the unit of measurement for the Point Type.  

Unit Displays the engineering unit based on the Point Category. 

Sub-Category Displays the enumeration type for the software points. The field Unit is renamed as 
Sub-Category if the point category selection is unitless. 

Advanced Displays the BACnet object details. Object Name, Object Type and Object Instance 
are the fields provided.  

• Object Name is automatically provided by the tool and can be edited.  

• Object Instance number can also be edited.  

• Object Type is a read only field and cannot be edited. 

OK  Saves the entered information and exits the dialog box. 

Cancel  Exits the dialog box. Any information entered is lost. 
 

Table 28 defines the fields shown in the Advanced 
screen for Lon Spyder of a Network Input point. 
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Figure 119: Advanced Screen of NetworkInput for Lon 
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Table 28: Advanced Screen of NetworkInput for Lon Spyder Controller  

Name Description 

NVI Name Displays the name of the NetworkInput point. The object name can be edited. 
Copy From Enables the selection of Standard NVs or User Defined NVs (NVs user has created 

and saved earlier). 
• Standard: If Standard is selected, select a list of available NVs from the Select 

list. Standard NVs are pre-defined NVs known as SNVTs. 
• Custom: If Custom is selected, select a list of available NVs from the Select list. 

NVs that are created. This is taken from UNVT Name field.  Following are two 
options to select Custom NVs from:  
• File: Enables the selection of a custom NV that was created and saved 

regardless of the Station or device. Click the File option and click the 
Browse button; navigate to and select the .bog file. From the Select Type 
list, select the custom NV within the .bog file (a single .bog file may contain 
multiple custom NVs).  

• Station: Enables the selection of a custom NV that was created and saved 
only within any device belonging to the same Station. Click the Station 
option and select the device where the custom NV was created and saved. 
From the Select Type list, select the required custom NV. 

Field Properties Displays the following properties for each field:  
• Field Name  
• Data Category  
• Network Data Type  
• Internal Data Type 

Field Name Displays the name of the backend object created for the input object. It is non-
editable. 

Station 
Device/File Ord 

Indicates the path of the station/file as per the selection from where the NVs of other 
device are copied  

Data Category Select the data type for the NV fields. 

Network Data 
Type 

It is the engineering unit received by the Honeywell Spyder controller. Specify the 
Network Data Type. Based on data category selected, the drop-down list changes. 

UNVT Name Enter UNVT Name in case user is creating a new NVI. 

Internal Data 
Type 

It is the unit(s) of the output of the Network Variable. Specify the Internal Data Type. 
Based on data category selected, the drop-down list changes. 

Fail Detect 
Enabled 

Set the Fail Detect Enabled to either True or False.  
True: It means if the object is bound and if it has not received an update from the 
BACnet network source in the fail detect time, then an alarm is generated and the 
presentValue is set to Invalid. Note that fail detect time depends on the update rate 
configured. 
False: It means the object retains the last value that was written to it until a BACnet 
network source change it or the Honeywell Spyder has a power outage or resets.  

To define own custom enumeration type for the software 
points, refer Define Enum section. 

 

 
Note:  

A Network Input with Point Type as Constant can 
be added to a macro is possible. 
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Figure 120: Advanced Screen of NetworkInput for BACnet 

 

Table 28 defines the fields shown in the Advanced screen for BACnet of a Network Input point. 

Table 29: Advanced Screen of NetworkInput for BACnet Spyder Controller 

Name Description 

Object Name Displays the name of the NetworkInput point. The object name can be 
edited.  
By default, it is AV. If selected point is of Binary Value then change AV to BV. 

Field Name Displays the name of the backend object created for the output point. It is non-
editable. 

Object Type Displays the object type as NetworkInput. It is non-editable. 

Object Instance Indicates a unique number that is automatically assigned to the object. This 
field is editable and user can assign different instance number. The two 
objects should not have the same instance number. 

Type Sets Type to either AV (Analog Value) or BV (Binary Value) as per 
requirement.  
By default, it is AV. If selected point is of Binary Value then select BV. 

Update Interval The rate at which the controller compares the last value propagated to the 
network against the current value to determine whether a change has 
occurred that warrants the new value to be propagated. Update Interval can 
be used to throttle back the information propagated to the network. 
Recommended default value is 15 sec. 
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Name Description 

Fail Detect Enabled Set the Fail Detect Enabled to either True or False.  
• True means, if the object is bound and has not received an update from 

the BACnet network source in the fail detects time, then an alarm is 
generated and the present Value is set to Invalid. Note that fail detect time 
depends on the update rate configured. 

• False means the object retains the last value that was written to it until a 
BACnet network source change it or the Honeywell Spyder has a power 
outage or resets. 

Update Rate This is the rate at which the object expects an update from the BACnet 
network. When 'Fail Detect' is enabled, the controller will report an alarm if 5 
consecutive updates are not received. 
If binding is accomplished by polling the source device, then the poll rate is 
set to the configured 'Update rate'. If 5 successive polls fail, then the 
controller will report an alarm. 
Recommended default value is 60 sec. 
(Refer the ‘Poll/Push’ column in the Bacnet Link Manager view). 

 

Point Conversion of NetworkInput 
Table 30 shows the conversion of NetworkInput to other physical points.  

Table 30: Point Conversion of NetworkInput 

Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

Network Input Constant 1. Right-click the Network Input block 
and select Configure Properties.  

2. Select Constant from the Point 
Type list.  

3. A warning message appears. 
Click Yes to continue.  

4. Select a Point Category.  
5. Select Units to be used within 

logic 
6. Enter Value. 
7. Click OK.  

1. If the functional block slot 
to which the point was 
connected was of type 
Constant/ Connector, the 
slot is converted from 
Connector type to 
Constant and the link is 
retained.  

2. If the functional block slot 
to which the point was 
connected was of type 
Connector only, the link is 
broken.  
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Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

Network Input Network 
Setpoint 

1. Right-click the Network input block 
and select Configure Properties.  

2. Select Network Setpoint from the 
Point Type list.  

3. A warning message appears. 
Click Yes to continue.  

4. Select a Point Category. 
5. Select Units to be used within 

logic 
6. Enter Value. 
7. Click OK. 

1. If the point is connected to 
any functional block, the 
functional blocks slot type 
and links are retained.  

2. A new setpoint input is 
created and added to the 
Objects table in the NV 
Configuration View/ 
Object Configuration 
View 
Note: 
• Follow step 1 and 2 

for Lon and BACnet 
Spyder 

• For Lon Spyder, NCI 
are seen in NV 
Configuration View  

 F  BAC t S d  
    

 
  

Network Input Binary Input 1. Right-click the Network input block 
and select Configure Properties.  

2. Select Binary Input from the 
Point Type list.  

3. A warning message appears. 
Click Yes to continue.  

4. Select Input Type.  
5. Select Input State values (if 

required).  
6. Click OK.  

1. If the point is connected to 
any functional block, the 
functional block slot type 
and links are retained.  

2. The resulting physical IO 
object (Binary input in this 
case) gets any free IO pin 
available. If no pin is 
available, the resulting 
physical IO becomes an 
invalid IO (IO with no pin).  

Network Input Modulating 
Input 

1. Right-click the Network input block 
and select Configure Properties.  

2. Select Modulating Input from the 
Point Type list.  

3. A warning message appears. 
Click Yes to continue.  

4. Select Type.  
Note:  
• This field is enabled only 

when ‘Custom Sensor’ is 
selected 

• For pre-defined sensor, it is 
set to default date category. 

• For example, if Temperature 
sensor is selected then 
‘temperature’ is data category 

5. Select Data Category 
6. Select Data Type.  
7. Enter Input State values (if 

required) 
8. Click OK.  

1. If the point is connected to 
any functional block, the 
functional block slot type 
and links are retained.  

2. The resulting physical IO 
object (Modulating input in 
this case) gets any free IO 
pin available. If no pin is 
available, the resulting 
physical IO becomes an 
invalid IO (IO with no pin).  
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Network Setpoints 
A NetworkSetpoint is a non-physical input. 
NetworkSetpoint blocks can be configured and use 
them while creating application logic in BACnet Spyder. 
Refer Figure 121. 

 
Figure 121: Network Setpoint Function Block 

To add and configure a NetworkSetpoint block:  

1. Right click ControlProgram under Honeywell 
Spyder in the Nav tree and select Views > 
Wiresheet View to view the wiresheet.  

2. Drag the Network Setpoint block from the 
HoneywellSpyderTool palette on to the wire sheet.  

3. Type the desired name for the Network Setpoint 
block and click OK. Refer Figure 122. The block 
appears as a container on the wiresheet, similar to 
any function block. Refer Figure 121. 

 
Figure 122: Enter Name of NetworkSetpoint  

4. Right click the container and select Configure 
Properties. Refer Figure 123. The NetworkSetpoint 
dialog box appears. Refer Figure 124.  

 
Figure 123: Network Setpoint > Configure Properties 

Option  

 

 
Figure 124: Configure Properties Screen of Network Setpoint 
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Table 31 defines the fields shown in the Figure 124. 

Table 31: NetworkSetpoint Configure Properties Screen 

Name Description 

Point Name Type a name of the function block or use the default names given by the tool.  

Point Type NetworkSetpoint is the default selection. Other options for Point Type are  

• Constant 

• Network Input 

• Network Setpoint 

• Binary Input 

• Modulating Input 

To change the point type from BinaryInput to any other option during development, 
refer Table 34. 

Point Category Displays the unit of measurement for the Point Type.  

Unit Displays the engineering unit based on the Point Category. 

Sub-Category Display the enumeration type for the software points. The field Unit is renamed as 
Sub-Category if the point category selection is unitless. 

Advanced Display the BACnet object details. Object Name, Object Type and Object Instance 
are the fields provided.  

• Object Name is automatically provided by the tool and can be edited.  

• Object Instance number can also be edited.  

• Object Type is a read only field and cannot be edited. 

OK  Saves the entered information and closes the dialog box. 

Cancel  Close the dialog box. Any information entered is lost 

 

Table 32 defines the fields shown in the Advanced 
screen of a Network Setpoint when Lon Spyder 
controller is selected. 
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Figure 125: Advanced Screen of NetworkSetpoint for Lon 
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Table 32: Fields of Advanced Screen of Network Setpoint 

Name Description 

NV Name Displays the name of the NetworkInput point. The object name can be edited. 
Copy From Enables the selection of Standard NVs or User Defined NVs (NVs user has created 

and saved earlier). 
• Standard: If Standard is selected, select a list of available NVs from the Select 

list. Standard NVs are pre-defined NVs known as SNVTs. 
• Custom: If Custom is selected, select a list of available NVs from the Select list. 

NVs that are created. This is taken from UNVT Name field.  Following are two 
options to select Custom NVs from:  
• File: Enables the selection of a custom NV that was created and saved 

regardless of the Station or device. Click the File option and click the 
Browse button; navigate to and select the .bog file. From the Select Type 
list, select the custom NV within the .bog file (a single .bog file may contain 
multiple custom NVs).  

• Station: Enables the selection of a custom NV that was created and saved 
only within any device belonging to the same Station. Click the Station 
option and select the device where the custom NV was created and saved. 
From the Select Type list, select the required custom NV. 

Station 
Name/File Ord 

Indicates the path of the station/file as per the selection from where the NVs of other 
device are copied 

Field Properties Displays the following properties for each field:  
• Field Name  
• Data Category  
• Network Data Type  
• Internal Data Type 
• Value 

Field Name Displays the name of the backend object created for the input object. It is non-
editable. 

Data Category Select the data type for the NV fields. 

Network Data 
Type 

It is the engineering unit received by the Honeywell Spyder controller. Specify the 
Network Data Type. Based on data category selected, the drop-down list changes. 

UNVT Name Enter UNVT Name in case a new NVI is being created. 

Internal Data 
Type 

It is the unit(s) of the output of the Network Variable. Specify the Internal Data Type. 
Based on data category selected, the drop-down list changes. 

Object Type Display the object type as NetworkInput. This field is non-editable. 

Value Indicates the default value of the selected variable. This field can be editable. The 
units are based on the Internal Data Type selected. 

Configure Invalid Use this option to configure an invalid value. Consequently, the Value field is 
disabled and displays NaN 

 

To define own custom enumeration type for the software 
points, refer Define Enum section 

 
 

Note:  

A Network Setpoint with Point Type as Constant 
can be added to a macro is also possible. 
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Figure 126: Advanced Screen of NetworkSetpoint for BACnet 

Table 33 defines the fields shown in the Advanced screen for BACnet of a Network Setpoint point. 

Table 33: Advanced Screen of NetworkSetpoint for BACnet Spyder Controller 

Name Description 

Object Name Displays the name of the NetworkSetpoint point. The object name can be 
edited. 
Note: 

By default, it is AV. If selected point is of Binary Value then change AV to BV. 

Field Name Displays the name of the backend object created for the output point. It is non-
editable. 

Object Type Displays the object type as NetworkSetpoint. It is non-editable. 

Object Instance Indicates a unique number that is automatically assigned to the object. This 
field is editable and user can assign different the instance number. The two 
objects should not have the same instance number. 

Update Interval The rate at which the controller compares the last value propagated to the 
network against the current value to determine whether a change has 
occurred that warrants the new value to be propagated. Update Interval can 
be used to throttle back the information propagated to the network. 
Recommended default value is 0 sec. 

Type Set Type to either AV (Analog Value) or BV (Binary Value) as per 
requirement.  
Note: 

By default, it is AV. If selected point is of Binary Value, then select BV. 
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Point Conversion of NetworkSetpoint 
Table 34 shows the conversion of NetworkSetpoint to other physical points.  

Table 34: Point Conversion of NetworkSetpoint 

Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

Network 
Setpoint 

Constant 1. Right-click the 
NetworkSetpoint blocks and 
select Configure Properties.  

2. Select Constant from the 
Point Type list.  

3. A warning message appears. 
Click Yes to continue.  

4. Select a Point Category.  
5. Select units to be used 

within logic 
6. Select a Value. 
7. Click OK.  

1. If the functional block slot to 
which the point was 
connected was of type 
Constant/Connector, the slot 
is converted from Connector 
type to Constant but the link 
is retained.  

2. If the functional block slot to 
which the point was 
connected was of type 
Connector only, the link is 
broken.  

Network 
Setpoint 

Network Input 1. Right-click the Network 
setpoint blocks and selects 
Configure Properties.  

2. Select Network Input from 
the Point Type list. 

3. A warning message appears. 
Click Yes to continue. 

4. Select a Point Category.  

5. Select units to be used 
within logic 

6. Click OK. 

1. If the point is connected to 
any functional block, the 
functional block slots and 
links are retained.  

2. A new network input is 
created and added to the 
Objects table in the NV 
Configuration View/ Object 
Configuration View 

Note: 
• Follow step 1 and 2 for 

Lon and BACnet Spyder 
• For Lon Spyder, NCI 

are seen in NV 
Configuration View  

• For BACnet Spyder, 
NCI are seen in Object 
Configuration View 

Network 
Setpoint 

Binary Input 1. Right-click the Network 
setpoint blocks and selects 
Configure Properties.  

2. Select Binary Input from the 
Point Type list. 

3. A warning message appears. 
Click Yes to continue. 

4. Select Input Type. Select 
Input State values (if 
required). 

5. Click OK.  

1. If the point is connected to 
any functional block, the 
functional block slot type and 
links are retained.  

2. The resulting physical IO 
object (Binary input in this 
case) gets any free IO pin 
available. If no pin is avail-
able, the resulting physical 
IO becomes an invalid IO 
(IO with no pin).  

Network 
Setpoint 

Modulating Input 1. Right-click the Network 
setpoint blocks and selects 
Configure Properties.  

2. Select Modulating Input 

1. If the point is connected to 
any functional block, the 
functional block slot type and 
links are retained.  
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Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

from the Point Type list.  

3. A warning message appears. 
Click Yes to continue. 

4. Select Type.  

Note:  

• This field is enabled only 
when  ‘Custom Sensor’ 
is selected   

• For pre-defined sensor, it 
is set to default date 
category. 

• For example, if 
Temperature sensor is 
selected then 
‘temperature’ is data 
category 

5. Select Data Category 

6. Select Data Type.  

7. Click OK.  

2. The resulting physical IO 
object (Modulating input in 
this case) gets any free IO 
pin available. If no pin is 
available, the resulting 
physical IO becomes an 
invalid IO (IO with no pin).  

Network Outputs 
While in the midst of creating a 
ControlProgram/Program, if need to quickly add of a 
NetworkOutput, then use the Software Outputs item on 
the honeywellSpyderTool palette as shown in  
Figure 127 

A Network Output point cannot be added to a macro. 

 
Figure 127: Network Output Function Block 

To add and configure a NetworkOutput block:  

1. Right click ControlProgram under BACnetSpyder in 
the Nav tree and select Views > Wiresheet View to 
view the wiresheet. 

2. Drag the NetworkOutput block from the 
HoneywellSpyderTool palette onto the wire sheet. 
The name window will pop up.  

3. Type the desired name for the NetworkOutput block 
and click OK. Refer Figure 128. The block appears as 
a container on the wire sheet similar to any function 
block as shown in Figure 127  

 
Figure 128: Enter Name of Network Output 

4. Right click the container and select Configure 
Properties. The NetworkOutput dialog box appears. 
Refer Figure 129. 

 

 
Figure 129: Network Output > Configure Properties 

Option  
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Figure 130: Configure Properties Screen of NetworkOutput 

 

Table 35 shows details of Configure Properties screen of NetworkOutputs (Figure 130) 

Table 35: Fields of Configure Properties Screen of NetworkOutputs 

Name Description 

Point Name  Enter a name of the function block or use the default names given by the tool.  

Point Type NetworkOutput is the default selection. Other options for Point Type are  

• Network Output 

• Binary Output 

• Modulating Output 

To change the point type from BinaryInput to any other option during development, 
refer Table 16. 

Point Category Displays the unit of measurement for the Point Type.  

Unit Displays the engineering unit based on the Point Category. 

Sub-Category Displays the enumeration type for the software points. The field Unit is renamed as 
Sub-Category if the point category selection is unitless. 

Advanced Displays the BACnet object details. Object Name, Object Type and Object Instance 
are the fields provided.  

• Object Name is automatically provided by the tool and can be edited.  

• Object Instance number can also be edited.  

• Object Type is a read only field and cannot be edited. 

OK  Saves the entered information and exits the dialog box. 

Cancel  Exits the dialog box. Any information entered is lost. 
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Figure 131: Advanced Screen of NetworkOutput for Lon 

Table 36 defines the fields shown in the Figure 131 of a Network Output point. 

 

Table 36: Advanced Screen of NetworkOutputs for Lon Spyder Controller 

Name Description 

NV Name Display the name of the NetworkInput point. The object name can be edited. 
Output Refresh Set the Output Refresh of each NVO to either Polled or Unpolled.  

 
• Output Refresh is only valid when the Guaranteed Periodic Refresh is set to 

False.  
• If an Output Refresh is polled, then the value of the output network variable is 

never propagated as a result of its value changing. Instead, the value of the 
output network variable is sent only in response to a poll request from a reader 
node. 
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Name Description 

Guaranteed 
Periodic Refresh 

Set Guaranteed Periodic Refresh of each Network Variable Output to either True or 
False.  
• True indicates that the Honeywell Spyder controller periodically sends this 

variable to the LonWorks network at the GPU rate (nciSndHrtBt). Setting this to 
True also enables the Significant Event Notification also known as SEN Delta. 
The Network Variable is also sent on the LonWorks Network whenever any field 
exceeds the SEN Delta. SEN Delta of zero (0) disables the feature.  

• False indicates that the Honeywell Spyder controller does not send the value to 
the LonWorks network. The Network Variable Output must be polled to get its 
value. 

Message Service The Message Service type of each NVO is Unacknowledged, Acknowledged or 
Unacknowledged Repeated.  
• Unacknowledged means the update is sent once and no acknowledgement is 

expected.  
• Acknowledged means all receiver nodes must acknowledge receipt of the 

message to the sender node.  
• Unacknowledged Repeated means the update is sent multiple times and no 

acknowledgements are expected. 

Copy From Enables the selection of Standard NVs or User Defined NVs (NVs user has created 
and saved earlier). 
• Standard: If Standard is selected, select a list of available NVs from the Select 

list. Standard NVs are pre-defined NVs known as SNVTs. 
• Custom: If Custom is selected, select a list of available NVs from the Select list. 

NVs that are created. This is taken from UNVT Name field. Following are two 
options to select Custom NVs from:  
• File: Enables the selection of a custom NV that was created and saved 

regardless of the Station or device. Click the File option and click the 
Browse button; navigate to and select the .bog file. From the Select Type 
list, select the custom NV within the .bog file (a single .bog file may contain 
multiple custom NVs).  

• Station: Enables the selection of a custom NV that was created and saved 
only within any device belonging to the same Station. Click the Station 
option and select the device where the custom NV was created and saved. 
From the Select Type list, select the required custom NV. 

Station 
Device/File Ord 

Indicates the path of the station/file as per the selection from where the NVs of other 
device are copied 

Field Properties Displays the following properties for each field:  
• Field Name  
• Data Category  
• Network Data Type  
• Internal Data Type 

Field Name Displays the name of the backend object created for the input object. It is non-
editable. 

Data Category Select the data type for the NV fields. 
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Name Description 

Network Data 
Type 

It is the engineering unit received by the Honeywell Spyder controller. Specify the 
Network Data Type. Based on data category selected, the drop-down list changes. 

UNVT Name Enter UNVT Name in case user is creating a new NVI. 

Internal Data 
Type 

It is the unit(s) of the output of the Network Variable. Specify the Internal Data Type. 
Based on data category selected, the drop-down list changes. 

Object Type Display the object type as NetworkInput. This field is non-editable. 

Value Indicates the default value of the selected variable. This field can be editable. The 
units are based on the Internal Data Type selected. 

Configure Invalid Use this option to configure an invalid value. Consequently, the Value field is 
disabled and displays NaN 

Significant Event 
Notification 

Indicates the Sen delta value of the selected variable. This field can be editable. The 
units are based on the Network Data Type selected 

 

To define own custom enumeration type for the software 
points, refer Define Enum section.  

Table 36 defines the fields shown in the Figure 131 of a 
Network Output point. 

 

 

 
Figure 132: Advanced Screen of Network Output for BACnet 

 



HONEYWELL SPYDER USER GUIDE 

 107 31-00089—02 

 

Table 37: Advanced Screen of Network Output for BACnet Spyder Controller 

Name Description 

Object Name Displays the name of the NetworkOutput point. The object name can be edited. 
Note: 

By default, it is AV. If selected point is of Binary Value then change AV to BV. 

Field Name Displays the name of the backend object created for the input point. It is non-
editable. 

Object Type Displays the object type as NetworkOutput. It is non-editable. 

Object Instance Indicates a unique number that is automatically assigned to the object. This field is 
editable and user can assign different the instance number. The two objects should 
not have the same instance number. 

Update Interval The rate at which the controller compares the last value propagated to the network 
against the current value to determine whether significant change has occurred that 
warrants the new value to be propagated. Update Interval works with Sen Delta to 
throttle back the information propagated to the network. 

The recommended value is 60 sec. 

Type Sets Type to either AV (Analog Value) or BV (Binary Value) as per requirement.  
Note: 

By default, it is AV. If selected point is of Binary Value then select BV. 

Sen Delta The delta value for Significant Event Notification is also known as Sen Delta.  

The controller refreshes/updates the ‘present Value’ property of this object when 
the value changes by the configured Sen Delta. This can be used to tune the 
controller such that small changes of value are not propagated to the BACnet 
network.  

If this object is 'bound' to another controller, then the value is sent on the BACnet 
Network to the target controller whenever it changes by an amount exceeding the 
Sen Delta.  

A Sen Delta of zero means that any change of value is considered significant and 
is propagated to the network.  

Note: 

If the application logic is driving the output at multiple priority levels using the 
'PriorityOverride' function block, then the configured SenDelta and UpdateInterval 
values would apply to all the priority levels.  

Controller refreshes the present Value property of the object as per the configured 
SenDelta and UpdateInterval values and it is propagated to the network as per the 
SenDelta and GPU settings. 

GPU Sets the GPU (Guaranteed Periodic Update) to either True or False.  

• True means that the present Value of the NetworkOutput has to be sent 
periodically (at the configured 'Send Heart Beat' rate) to the target controller 
that is bound, regardless of whether a significant change, as defined by Sen 
Delta, has occurred. 

• False means the NetworkOutput is NOT to be sent periodically. The value will 
be sent to the target controller only based on the Sen Delta value configured.  
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Name Description 

Send Heart Beat The rate at which a Network object value is sent to the network regardless of 
whether its value has changed or not. The SendHeartBeat must be configured to 
be equal to or greater than the 'update rate' expected by the target controller. This 
value should be configured as multiples of 5 seconds only, else tool rounds it off to 
the nearest multiple of 5 during download. 

 

Point Conversion of NetworkOutput 
Table 38 shows the conversion of NetworkOutput to other physical points.  

Table 38: Point Conversion of NetworkOutput 

Source Point  Destination 
Point 

Step for conversion Effect of Conversion 

Network Output  Binary Output  1. Right-click the 
NetworkOutput block and 
select Configure Properties.  

2. Select BinaryOutput from 
the Point Type list.  

3. A warning message appears. 
Click Yes to continue.  

4. Click OK. 

1. If there are any free pins 
available, the resulting 
physical IO object gets an 
IO pin.  

If no pin is available, the 
resulting physical IO 
becomes an invalid IO (IO 
with no pin).  

2. If the point is connected to 
any functional block, the 
functional block slot type 
and links are retained.  

Network Output Modulating 
Output 

1. Right-click the 
NetworkOutput block and 
select Configure Properties.  

2. Select ModulatingOutput 
from the Point Type list.  

3. A warning message appears. 
Click Yes to continue.  

4. Select Type 

7. Select Analog Type. 
8. Select Output Values/PWM 

Configuration/ 
FloatingMotorConfiguration 

5. Click OK. 

1. If there are any free pins 
available, the resulting 
physical IO object gets an 
IO pin.  

If no pin is available, the 
resulting physical IO 
becomes an invalid IO (IO 
with no pin).  

2. If the point type is 
connected to any 
functional block, the 
function block slot type 
and links are retained.  
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EDITING SOFTWARE POINTS 
Editing software points in Lon Controller: 

1. Expand the LonNetwork > LonSpyder controller > 
ControlProgram.  

2. Right click ControlProgram and select Views > NV 
Configuration View. 

3. NV Configuration View will be open. Upper pane 
shows all available NVs in the program. Lower pane 
shows the NVs available on the controller wiresheet. 

4. Select required NV from NVs list (upper pane). Click 
Edit NV button to edit selected NV. Refer Figure 134 

 

 

 

 

5. Select the software point to edit from the bottom half 
of the NV Configuration View and click the Edit 
Point button. The Configure Properties dialog box 
appears. Window will pop up as shown in Figure 133 

 
Figure 133: Edit Software Points Screen of Lon 

Spyder 

 

 
Figure 134: Edit Network Variable Screen of Lon Spyder 

 

6. Click OK to save the changes or Cancel to close the 
screen without saving the changes. 
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Editing software points in BACnet Controller 

1. Expand the BacnetNetwork > BACnetSpyder > 
ControlProgram. 

2. Right click ControlProgram. Select Views > Object 
Configuration View. 

3. Object Configuration View will be open. Upper 
pane shows all available NVs in the program. Lower 
pane shows the NVs available on the controller 
wiresheet. 

4. Select required NV from NVs list (upper pane). Click 
Edit Object button to edit selected NV. Refer  
Figure 135 

5. Select the software point to edit from the bottom half 
of the Object Configuration View and click the Edit 
Point button. The Configure Properties dialog box 
appears. Window will pop up as shown in  
Figure 136. 

6. Click OK to save the changes or Cancel to close the 
screen box without saving the changes. 

 

 
Figure 135: Edit Network Variable Screen of BACnet Spyder 

 

 
Figure 136: Edit Software Points Screen BACnet Spyder 
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Network Input 
To edit NetworkInput, right click the NetworkInput 
block. Select Configuration Properties.  

Refer Figure 117. Configuration Properties window will 
pop up as shown in Figure 118. Table 27 shows details 
of NetworkInputs Configure Properties screen. 

 

Table 39, shows the fields of the Configuration 
Properties screen.  

 

Table 39: Details of Network Inputs Configure Properties Screen 

Name Definition 

Point Name Indicate the name of the software point. 

Point Type Default selection is Network Input. Constant, Network Input, Network 
Setpoint, Binary Input or Modulating Input can be selected. 

Point Category Select a unit of measurement for the Point Type. 

Unit to be used within Logic Select the engineering unit based on the Point Category. 

Sub-Category Select the enumeration type for the software points. The field Unit to be 
used within logic is renamed as Sub-Category if the Point Category 
selection is Unit less. 

Value This field is enabled when the Point Type is Network Setpoint or 
Constant. The field enables  to provide a setpoint or constant input value. 

Advanced • Object Name is automatically provided by the tool and can be edited.  

• Object Instance number can also be edited.  

• Object Type is a read only field and cannot be edited. 

Network Setpoint 
To edit NetworkSetpoint, right click the 
NetworkSetpoint block. Select Configuration 
Properties. Refer Figure 123. Configuration Properties 
window will pop up as shown in Figure 124. 
Table 31 shows details of NetworkSetpoint Configure 
Properties screen. 

 

 

 

 

Table 40: Details of Network Setpoints 

Name Definition 

Point Name Indicate the name of the software point. 

Point Type Default selection is Network Setpoint. Enable  to select Constant, 
Network Input, Network Setpoint, Binary Input or Modulating Input 
can be selected. 

Point Category Selects a unit of measurement for the Point Type. 

Unit to be used within Logic Selects the engineering unit based on the Point Category. 

Sub-Category Selects the enumeration type for the software points. The field Unit to be 
used within logic is renamed as Sub-Category if the Point Category 
selection is unitless. 

Value Enables to provide a setpoint input value. Check the Configure Invalid 
option to disable the Value field. 
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Name Definition 

Advanced • Object Name is automatically provided by the tool and can be edited. 

• Object Instance number can also be edited.  

• Object Type is a read only field and cannot be edited. 

Constant 
To edit Constant, right click the Constant block. Select 
Configuration Properties. Refer Figure 110.  

Configuration Properties window will pop up as shown 
in Figure 111. 

Table 25 shows details of Constant Configure 
Properties screen. 

 

 

 

 
 

Table 41: Details of Constants 

Name Definition 

Point Name  Indicate the name of the software point. 

Point Type Default selection is Constant. Enables to select Constant, Network 
Input, Network Setpoint, Binary Input or Modulating Input. 

Point Category Select a unit of measurement for the Point Type. 

Unit to be used within logic Select the engineering unit based on the Point Category. 

Sub-Category Select the enumeration type for the software points. The field Unit to be 
used within logic is renamed as Sub-Category if the Point Category 
selection is Unit less. 

Value Enable to provide a constant input value. 

Advanced • Object Name is automatically provided by the tool and can be edited.  

• Object Instance number can also be edited.  

• Object Type is a read only field and cannot be edited. 

Network Output 
To edit NetworkOutput, right click the NetworkOutput 
block. Select Configuration Properties. For 
NetworkOutput Configure Properties Option screen, 
refer Figure 129. NetworkOutput Configuration 
Properties window will pop up as shown in Figure 130. 
Table 35 shows details of NetworkOutputs Configure 
Properties screen. 

 

Table 39, shows the fields of the Configuration 
Properties screen.  

 

 

Table 42: Details of Network Outputs 

Name Definition 

Point Name  Indicate the name of the software point.  

Point Type Default selection is Network Output. Constant, Network Input, Network 
Setpoint, Binary Input or Modulating Input can be selected. 

Point Category Select a unit of measurement for the Point Type. 
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Name Definition 

Unit to be used within logic Select the engineering unit based on the Point Category. 

Sub-Category Select the enumeration type for the software points. The field Unit to be 
used within logic is renamed as Sub-Category if the Point Category 
selection is Unit less. 

Advanced • Object Name is automatically provided by the tool and can be edited.  

• Object Instance number can also be edited.  

• Object Type is a read only field and cannot be edited. 
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NETWORK VARIABLES 
A Network Variable (NV) is a Lon network point created 
for every network input, network output and network 
setpoint which is added in the application logic. 
LonMark® functional profiles define Standard Network 
Variable Types (SNVTs), but additional non-standard 
NVs are usually available, depending on the device to 
store additional non-standard data. 

There are three categories of NVs that the Honeywell 
Spyder supports. They are:  

• Mandatory: Mandatory NVs are the default NVs 
compulsorily present in a Lon Spyder device.  

• Fixed Droppable: Fixed Droppable NVs are not 
editable except Edit Selected Field > Value field. 

This field can be editable for NetworkSetpoints. To 
add these NVs onto the wiresheet: 

Expand LonSpyder > ControlProgram. Right click 
ControlProgram and select Views > NV 
Configuration View. Click Show on Wiresheet as 
Points button on NV Configuration View. After 
adding, these points can be utilized in the application 
logic if required. 

• Custom: Custom NVs can be added during logic 
development. These NVs can be added, deleted, 
edited. 

 

Table 43 shows a list of mandatory and fixed NVs 
supported by Spyder. 

Table 43: A List of Mandatory and Fixed NVs Supported by Spyder 

NvName Data Type NV Type 

nroPgmVer UNVT_pgmVer Mandatory 

nvoNodeStatus SNVT_obj_status Mandatory 

nviFileRequest SNVT_file_req Mandatory 

nvoFileStatus SNVT_file_status Mandatory 

nviFilePos SNVT_file_pos  Mandatory 

nviNodeRequest SNVT_obj_request Mandatory 

nvoConfigError UNVT_configError Mandatory 

nciApplVerNew UCPT_applVerNew Mandatory 

nviDebugIndex UNVT_debugIndex Mandatory 

nvoDebug1 UNVT_debug Mandatory 

nvoDebug2 UNVT_debug Mandatory 

nciDeviceName UCPT_devName Mandatory 

nviInUse UNVT_inUse Mandatory 

nvoAlarmH UNVT_alarm Mandatory 

nvoAlarmStatus UNVT_alarmStatus Mandatory 

nvoError UNVT_error Mandatory 

nciAlarmInhibit UCPT_alarmInhibit Mandatory 

nciSndHrtBt SCPTmaxSendTime Mandatory 

nciRcvHrtBt SCPTmaxRcvTime Mandatory 

nvoWMCommError UNVT_WMCommError Mandatory 

nciUICalOffset UCPT_uiCalOffset Fixed 

nviTimeSet SNVT_time_stamp Fixed 

nvoTime SNVT_time_stamp Fixed 

nvoIO1 UNVT_io1 Fixed 

nvoIO2 UNVT_io2 Fixed 
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NvName Data Type NV Type 

nvoIO3 UNVT_io3 Fixed 

nviManVal UNVT_manVal Fixed 

 

 
Note:  

Mandatory and Fixed NVs changes as per the 
Spyder controller model. If fixed or mandatory 
NV are exposed for a selected model and later 
model is changed with another model which 
does not support that fixed or mandatory point, 
then that point becomes invalid.  

The Spyder tool permits downloading or 
uploading network and internal data type 
information of all NV fields. 

 

The Lon Spyder controller has following four types of 
NVs which can be added and edited into NV 
Configuration View. User can drag these NVs form NV 
Configuration View onto the wiresheet to use them in 
the application logic. On the wiresheet, they can be 
connected to the required function blocks. 

• NVI: Network Variable Inputs  

• NVO: Network Variable Output  

• NCI: Network Configuration Input  

• Many to One NV: Many to One Network Variable.  

To do this change click Add NV button.   

Also, these NVs can be created through 
honeywellSpyderTool. These NVs are available in the 
‘SoftwarePoints’ folder. Drag them from the 
honeywellSpyderTool palette onto the wiresheet. Utilize 
them for the required application logic creation. They get 
automatically added on the NV Configuration View. 

Viewing the List of Network 
Variables 
1. For Lon Spyder, browse through to Station > Config 

> Drivers > LonNetwork > LonSpyder.  
Refer Figure 137. 

 
Figure 137: NV Configuration View Option of Lon 

Spyder 

 
2. For Lon Spyder, select ControlProgram > Views > 

NV Configuration View. For NV Configuration 
View, refer Figure 138. 
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Figure 138: NV Configuration View 

The summary page appears with a list of pre-
programmed Mandatory, Fixed, and Custom NVs in a 
tabular format. For NV configuration View, refer  
Figure 138. 
The table has the following columns:  
• NV Name: Indicates the name of the network 

variable. 

• Type: Indicates if the NV is of type NVI, NVO, NCI or 
Many to One NV.  

• Category: Indicates if the NV is Mandatory, Fixed, 
Fixed Droppable, or Custom.  

• NV Container: Indicates where the NV is used. 

3. The bottom half of the NV Configuration View 
displays the software points available on the 

wiresheet in a tabular format. The table has the 
following columns:  

• Point Name: The name of the software point 
(Network Input/Network Setpoint/Network Output) 
as it appears on the wiresheet. 

• Field Names: Indicates if the NV is of type NVI, 
NVO, NCI or Many to One NV.  

• Point Container: Indicates where the software 
point is used. All software points that are used in a 
Program within an application are also listed. 
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Note:  

1. Mandatory NVs cannot be used in the 
application logic.  

2. Mandatory NVs cannot be edited or 
deleted. 

3. In Fixed Droppable NVs, any ‘Value’ for 
NetworkSetpoint can be edited. 

4. Custom NV is the user defined NV. A 
Custom NV can be edited or deleted.  

5. Fixed NVs marked as Fixed_Dropable can 
be exposed on the wiresheet. Other fixed 
NVs cannot be exposed as points. 

6. For each point that is copied and pasted on 
the wiresheet, a new NV of SNVT type 
nearest to the selected data type is created 
automatically.  

7. When a user change the device model, if the 
name of a custom NV clash with a fixed NV 
name in the target model, Honeywell Spyder 
generates a new unique name for the 
custom NV and creates the new fixed NV. 

 

Group NVs 
Multiple points spread across NVs can be grouped into a 
single new NV or add it to an existing one. The points 
must be available on the wiresheet to make such a 
grouping possible. Multiple points of an NV of the type 
NVI and NCI can be grouped together to create a new 
NV. The new NV created can be saved as an NVI or 
NCI, when one or more NVs are grouped. 

Also, invalid points can be grouped with fields of another 
NV to create a new NV. 

A single point belonging to an NV can be grouped. In this 
case, a new NV is created. 

 

 
Note:  

The Group as NV option is not available for 
software points of type:  

• Network Output (NVO points)  

• Many To One NV 

• Network Input/Network Setpoint 

• Software points of a ManyToOneNV, if at 
least one or whose network data type of the 
corresponding field is configured as bit field 
is selected 

• Fixed NV fields exposed as points  

 

To group fields as NVs:  

1. On the NV Configuration View, select the required 
field to group from the Software points available on 
wiresheet list.  

 
Note:  

Use the CTRL key of keyboard to select the 
different required fields to group. 

 

2. Click the Group as NV button. The Confirmation 
dialog box appears, if trying to group fields belonging 
to NVI or NCI. Also, the fields will be deleted from the 
NVs from which they are being selected. If a field was 
the only field in an NV, and it was selected to be 
grouped as an NV, the NV from which it is being 
selected is deleted. Refer Figure 139. 

 
Figure 139: Confirmation Box 

 
Note:  

For grouping of NVOs, the application do not 
show Confirmation dialog box. 
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3. Click OK. The Group as NV dialog box appears.  

 

 
Figure 140: Group as NV Screen 

 

4. Fill the necessary information in the fields of  
Figure 140 as explained in the Table 44. 

 

Table 44: Details of Group NV’s 

Name Definition 

Group as New NV If this option is selected, a new NV will be 
created in the ‘NVs (upper half screen of the NV 
Configuration View) and all other NV points 
will be added to that NV. 

Note:  

The new NV is created on the same folder on 
which the Group as NV option is invoked.  

Example: If a ControlProgram is available, 
which has an Application2 residing in 
Application1 and the points are grouped on the 
NV Configuration View of Application2, then 
the new NV is created in the Application2 folder. 
However, if NVs are grouped on the NV 
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Name Definition 

Configuration View of the Application1, then the 
new NV is created in the Application1 folder. 

Add to Existing NV If this option is selected then NVs available on 
the wiresheet can be grouped to existing NV.  

Either existing NCI or NVI point can be selected 
for grouping. On the ‘NV Name’ drop down 
menu, all existing NVIs or NCIs (as per the NV 
Type Selection) are available. Select the NVI 
or NCI as per the requirement.  

On selecting this option, the fields of the NV to 
which the new points will be added are listed in 
the Fields Properties table. 

Note:  

In the case where the selected NVI was of a 
SNVT type, the NV is converted to a UNVT 
after grouping of points is done. 

NV Name If ‘Group as a New NV’ option is selected then 
‘NV Name option is enabled. Give the desired 
name to the NV as per the preference. 

NV Type Two NV Type options are available, 

• NVI 

• NCI 

Select the type of NV for the grouped NV as 
NVI or NCI as per the requirement. For 
example, if NV = Group as New NV and NV 
Type is NVI, then the new NV created will be 
NVI. 

Fields Properties 

 

Displays the following properties for each field: 

• Field Name  

• Data Category  

• Network Data Type  

• Internal Data Type  

Up Arrow 

 
 

Use this button to reorder a field. 

Down Arrow 

 

Use this button to reorder a field. 

Field Name User defined field name. 

Data Category Select the data type for the NV fields.  
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Name Definition 

Network Data Type It is the engineering unit received by the 
Honeywell Spyder controller. Specify the 
Network Data Type. Based on the data 
category selected, the drop-down list changes. 

Internal Data Type It is the unit(s) of the output of the Network 
Variable. Specify the Internal Data Type. Based 
on the data category selected, the drop-down 
list changes. 

Value This option can be edited for an NCI. 

UNVT Name Enter UNVT Name in case of creating a new 
NVI. 

 
5. Click OK. The new NV is created. It appears in the 

NVs list in the NV Configuration View. If Add to an 
existing NV is selected, then the fields are added to 
the existing NV and can be seen in the NVs list.  

Table 45 summarizes how to group a point(s) of an NV. 

Table 45: How to Group Point(s) of an NV 

     

NVI NCI NVO 

Valid 
Software 

Input 
Point 

Invalid 
Software 

Input 
Point 

Constant 
Point 

Valid 
Network 
Output 
Point 

Invalid 
Network 
Output 
point 

NVI Yes Yes No Yes Yes Yes No No 

NCI Yes Yes No Yes Yes Yes No No 

Valid 
Software 
Input Point 

Yes Yes No Yes Yes Yes No No 

Invalid 
Software 
Input Point 

Yes Yes No Yes Yes Yes No No 

Constant 
Point 

Yes Yes No Yes Yes Yes No No 

NVO No No Yes No No No Yes Yes 

 

Network Variable Input  
The Network Variable Input (NVI) converts a raw network 
variable input into a value(s) that can be used by other 
function blocks.  

 
Note:  

The maximum limit of the fields is based on the 
memory limitation of a selected controller model 
and NV size cannot exceed 31 bytes.  

Each field is converted from Network Data Type to 
Internal Data Type engineering units. Network Data Type 
is the engineering unit received by the Honeywell Spyder 
controller. Internal Data Type is the unit(s) of the output 
of the Network Variable.  

Example: Programming the Network Data Type to be 
SNVT_temp_p, and the Internal Data Type to be °F, 
converts network temperatures of type SNVT_temp_p 
into °F for use by the Function Blocks. 
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Adding an NVI 
An NVI can be added from:  

• NV Configuration View  

• honeywellSpyderTool palette  

Adding an NVI from the NV Configuration 
View 
To add a new Network Variable Input:  

1. Navigate to Station > Config > Drivers > 
LonNetwork > LonSpyder. 

2. Select ControlProgram > Views > NV 
Configuration View. The NV Configuration View 
will appear with a list of pre-programmed Mandatory, 
Fixed, and Custom NVs. For NV Con Figuration View, 
refer Figure 138 

NV Configuration View is divided into two parts. On 
the upper half pane of the view, all the NVs appear. In 
the NVs view, three types of NVs are there, 

1. Fixed_Dropable: These are fixed and cannot be 
edited. These can be exposed on the wiresheet 
for utilization in the application logic. 

2. Fixed and Mandatory NVs: These cannot be 
exposed on the wiresheet. 

3. Custom NVs: Custom NVs are the NVs which 
are created by the programmer. Programmer 
can add, delete, edit, and group these NVs as 
per the logic requirement. 

On the lower half pane, only those NVs will appear 
which are exposed to the controller’s wiresheet. To 
expose any custom created NV or fixed droppable 
NV, drag that NV from NVs (upper half pane) in the 
‘Software Points available on wiresheet’ (lower half 
pane). Edit as per the requirement. Utilize the NV 
exposed on the wiresheet as per the logic 
requirement. 

 

3. Click Add NV. The New NV dialog box appears. 
Select Network Variable Input. Refer Figure 141 

 
Figure 141: Add NV Screen 

4. Click OK. The Add NVI dialog box appears. For Add 
NVI screen, refer Figure 142. 
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Figure 142: Add NVI Screen 

5. Fill the necessary information in the fields and click 
OK to complete adding an NVI. The NVI is displayed 
in the NVs Table 46. 

 

 
Note:  

An NVI cannot be added to a macro. Only a 
Constant point can be added to a macro.  

A Software Output cannot be added to a macro. 
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Table 46: Edit NVI in NVs 

Name Definition 

NV Name Enter a name for the NV. 

Fail Detect Set the Fail Detect of each NVI to either True or False.  
• True: If the Network Variable Input is bound and it has not received an update 

from the Lon network source in the fail detect time, then an alarm is generated 
and the Network Variable Input is set to Invalid.  

• False: The Network Variable Input will retain what was written to it until a Lon 
network source change it or the Honeywell Spyder has a power outage or 
resets.  

Copy NV From Enables user to select Standard NVs or User Defined NVs (NVs that are created 
and saved earlier). 

Standard NV If Standard NV is selected, then a list of available NVs can be selected from the 
Select list. Standard NVs are pre-defined NVs known as SNVTs. 

Custom NV Two options are available to select Custom NVs from: 

• File: It enables the selection of a custom NV that was created and saved 
regardless of the Station or device. Click the File option and click the Browse 
button; navigate to and select the .bog file. From the Select Type list, select the 
custom NV within the .bog file (a single .bog file may contain multiple custom 
NVs). 

• Station: It enables the selection of a custom NV that was created and saved 
only within any device belonging to the same Station. Click the Station option 
and select the device where the custom NV was created and saved. From the 
Select Type list, select the required custom NV. 

Fields Properties Displays the following properties for each field:  

• Field Name  

• Data Category  

• Network Data Type  

• Internal Data Type  

Add Field Use this button to add a field. A maximum of 99 fields can be added. 

Delete Field Use this button to delete a field. 

Duplicate It duplicates the selected field. This can be used to duplicate the fields with same 
properties. Duplicating action saves time. 

Edit Selected Field Displays the following fields: 

• Field Name: Enter a name for the field. The default names of fields being 
Field_x, where x is from 1 to 99. 

• Data Category: Select the data type for the NV fields. 

• Network Data Type: It is the engineering unit received by the Honeywell 
Spyder controller. Specify the Network Data Type. Based on the data category 
selected, the drop-down list changes. 

• Internal Data Type: It is the unit(s) of the output of the Network Variable. 
Specify the Internal Data Type. Based on the data category selected, the drop-
down list changes. 
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Name Definition 

UNVT Name Enter UNVT Name in case of creating a new NVI. 

Export to File When creating custom UNVTs, use this option to save it to a .bog file so it can be 
reused. A single .bog file may contain multiple custom NVs. 

>> Click this button to view the facets Details Viewer for the network/internal data 
type. 

The following information is displayed: 

• Minimum: The minimum limit for selected unit  

• Maximum: The maximum limit for selected unit  

OR 

• Range: Indicates the possible enumeration with their ordinal for a selected unit.  

• Units: Indicates the unit symbol for the selected unit (If it shows null, it means 
the unit symbol is not applicable there)  

• Type: Indicates the data type size for selected units  

 F32: Float 4 Bytes  

 U16: Unsigned 2 bytes  

 S16: Signed 2 bytes  

 U8: Unsigned byte  

 S8: Signed byte  

 E8: Enumerated byte  

 UB: Unsigned bit  

• Resolution: Indicates scaling factor for the selected Unit. When a value is 
written to the controller, the value is divided by the value specified in the 
Resolution field and when it is read from the controller, it is multiplied by the 
Resolution value before it is displayed in Niagara.  

• Precision: Precision for the selected Unit  

 

 
Note:  

New NVs can be created even if the NV count, 
field count, or unit store count has been 
exceeded. Honeywell Spyder displays a 
message informing the same, but allows the 
creation of NVs. 

 

Exposing an NVI on controller’s 
wiresheet from the NV Configuration 
View 
To expose the NV fields on the controller wiresheet: 

1. Expand the NVI in the table to display the fields. 
Select the fields that need to be displayed on the 

wiresheet and click the Show on wiresheet as 
Points button. 

OR 

Drag and drop the fields that need to be displayed on 
the wiresheet on to Software Points available on 
wiresheet list at the bottom of NV Configuration 
View screen on the right side. The Add Points dialog 
box appears. For Add Points screen, refer  
Figure 143 
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Figure 143: Add Points Screen 

2. Click OK. Selected fields are appearing in the 
Software Points available on wiresheet list at the 
bottom half of the screen on the right side. The field 
name displays the NV Name, Field Name 
information. If point to be displayed on the wiresheet 
is not selected, then the NV is added but is not visible 
on the wiresheet. 

3. Click Cancel if it is not required to continue adding an 
NVI. 

Adding an NVI from the 
honeywellSpyderTool Palette 

 
Note:  

An NVI cannot be added to a macro. Only a 
Constant point can be added to a macro 

 

Another method to add NV on the wiresheet is to drag 
the required network point form honeywellSpyderTool 
(points are available under SoftwarePoints folder) onto 
the wiresheet. After adding these NVs on the wiresheet, 
right click the controller. Select Actions > Generate 
NVs. After generating NVs, these NVs will appear in the 
NV Configuration View. 

To add an NVI to a Controlprogram/Application:  

1. On the honeywellSpyderTool palette, expand the 
SoftwarePoints folder. If the honeywellSpyderTool 
palette is not visible on the left side of the screen, on 
the Menu bar, then click Windows > Sidebars > 
Palette to display the Palette.  

2. Drag a NetworkInput to the wiresheet of 
ControlProgram. The Name window will pop up. For 
name window of NetworkInput, refer Figure 144. 

 
Figure 144: Enter Name for NetworkInput 

3. Enter a name for the point and click OK. 

4. Right click the NetworkInput point which is just 
added and select Configure Properties. The 
Configure Properties dialog box appears. For 
NetworkInput Configuration Properties screen, 
refer Figure 145. 

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 126  

 
Figure 145: Configure Properties Screen of NetwokInput 

5. Enter/select the following: 

• Point Name: Enter a name for the point. 

• Point Category: Select a category. 

• Unit to be used within Logic: Select the unit for 
the Point Category chosen. 

• Value: This is disabled.  

6. Click OK to complete adding an NVI.  

 
Note:  

When NVs are created using the 
honeywellSpyderTool palette, the fields are 
automatically added on the NV Configuration 
window. The NVs selected on wiresheet appear 
automatically in Software Points available on 
wiresheet window. 

 

Connecting NVIs 
Once NVI is created on the wiresheet, select the output 
port of the NVI block and drag it to the input of any 
function block or physical/software output for wire 
connection. When connection is done, data transfers 
from NVI to selected block. 

Multiple points spread across NVs can be grouped into a 
single new NV or add it to an existing one. The points 
must be available on the wiresheet to make such a 
grouping possible. Multiple points of an NV of the type 
NVI and NCI can be grouped together to create a new 
NV. The new NV created can be saved as an NVI or 
NCI, when one or more NVs are grouped.  

Also, invalid points can be grouped with fields of another 
NV to create a new NV. 

Also, a single point belonging to an NV can be grouped. 
In this case, a new NV is created. 

 
Note:  

The Group as NV option is not available for 
software points of type:  

• Software Output (NVO points)  

• Many To One NV 

• Network Input/Network Setpoint 

• ManyToOneNV if at least one or whose 
network data type of the corresponding field 
is configured as bit field is selected 

• Fixed NV fields exposed as points  

 

Grouping Points of type NVI 
If two or more points of type NVI, NCI, valid software 
input point, invalid software input point, or software input 
point are grouped then these can be configured as 
constant to:  

• Create a new NVI  

• Add to an existing NVI 

• Create a new NCI  

• Add to an existing NCI 

When grouping to create a new NVI/NCI, the number of 
fields of the new NVI equals the number of software 
points selected for grouping. When points are grouped to 
add to an existing NVI/NCI, then the selected software 
output points are added to the existing fields of the 
selected target NVI/NCI. The new/edited NVI/NCI 
appears in the upper pane in the list of NVs in the NV 
Configuration View. The lower pane in the NV 
Configuration View displays the list of all NVs with 
which a particular software output has been grouped. 

The result of such a grouping is that the previous 
NVI/NCI is modified such that the corresponding field to 
this point is removed from the NV. The NV is deleted if 
the NV was a single field NV. This happens when points 
selected are already attached to an existing NV. 

Points to note: 

If invalid software input points (an invalid NVI point) are 
grouped to form an NVI/NCI, then the invalid NVI point is 
converted to a valid NVI/NCI point. 

When a software input point configured as a Constant is 
grouped to form an NVI or NCI, the software point is 
converted to a NVI/NCI point and any links from that 
point to functional block slots is broken. Such functional 
block slots are converted to Connector type of slots. The 
links are broken only when the target property type in the 
function blocks is CONSTANT_ONLY, else, target 
property type is converted to CONNECTOR and the link 
is retained. 
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The result of copying and pasting an invalid Network 
input/setpoint/output point in the wiresheet is the creation 
of an invalid Network input/setpoint/output point. 

When a folder contains some software points 
(NVI/NCI/NVO points) who’s NVs are present in other 
folders (other than its child folders), the points become 
invalid as the reference to the NV is lost. 

If points selected for grouping have a mixture of software 
input and output points, Group as NV option is not 
available. 

Table 47 summarizes how a point(s) of a source NV can 
be grouped to form a target NV. 

 

Table 47: Group a point(s) of a source NV to form a target NV 

Source NV 
Points 

Target NV    

NVI NCI NVO 

Valid 
Software 

Input 
Point 

Invalid 
Software 

Input 
Point 

Constant 
Point 

Valid 
Network 
Output 
Point 

Invalid 
Network 
Output 
point 

NVI Yes Yes No Yes Yes Yes No No 

NCI Yes Yes No Yes Yes Yes No No 

Valid 
Software 
Input Point 

Yes Yes No Yes Yes Yes No No 

Invalid 
Software 
Input Point 

Yes Yes No Yes Yes Yes No No 

Constant 
Point 

Yes Yes No Yes Yes Yes No No 

NVO No No Yes No No No Yes Yes 

 

To group points of NVIs:  

1. On the NV Configuration View, select the required 
NVIs from the lower half view (‘Software Points 
available on wiresheet’ view). 

 

2. Click the Group as NV button. The Confirmation 
dialog box appears. Refer Figure 146.The fields are 
deleted from the NVs from which they are being 
selected.  

 
Figure 146: Confirmation Box 

If a field is selected from an NV (for grouping), in 
which it was the only field, then the NV from which it 
is being selected is deleted. 

3. A message appears, gives warning that if the 
selected point is attached to an NV, grouping will 
delete that point from that NV. Click OK. The Group 
as NV dialog box appears. For Group as NV screen, 
refer Figure 147. 

 
Note:  

Use the CTRL key of a keyboard to select the 
different fields that need to be grouped.  
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4. Fill the necessary information in the fields of Group 
as NV screen (Figure 147) as explained in the  
Table 48. 

 

 

 
Figure 147: Group as NV Screen for NVI 

 

Table 48 shows details of Group as New NV screen 

Table 48: Details of Group as New NV Screen 

Name Definition 

Group as New NV Select this option to save the selected fields which are required to Group as a 
New NV. In this case, a new NV Name can be entered. 

Note: 

The new NV is created on the same folder in which the NV Configuration View is 
invoked.  

Example: If there are two programs i.e. Application1 and Application2 in 
ControlProgram, in which Application2 is residing in Application1 and if points 
are grouped on the NV Configuration View of Application2, then the new NV is 
created in the Application2 folder. However, if NVs are grouped on the NV 
Configuration View of the Application1, then the new NV is created in the 
Application1 folder. 
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Name Definition 

Add to Existing NV Select this option to group the points to an existing NV, if required. In this case, an 
existing custom NVI/NCI can be selected from the NV Name list. 

On selecting this option, the fields of the NV to which the new points will be added 
are listed in the Fields Properties table. 

Note: 

• In this case, the selected existing NV is edited to reflect the changes. 

• In the case where the selected NVI was of a SNVT type, the NV is converted 
to a UNVT after grouping of points is done 

NV Name Indicate the name that can be configured for this NV with. 

NV Type Select this option to save the selected fields NVI or NCI. 

Fields Properties Displays the following properties for each field: 

• Field Name  

• Data Category 

• Network Data Type 

• Internal Data Type 

Up Arrow Use this button to reorder a field and move it up in the list. 

Down Arrow Use this button to reorder a field and move it down in the list. 

Point Name Indicate the name of the point.  

Field Name User defined field name. 

Data Category Select the data type for the NV fields. 

Network Data Type It is the engineering unit received by the Honeywell Spyder controller. Specify the 
Network Data Type. Based on the data category selected, the drop-down list 
changes. 

Internal Data Type It is the unit(s) of the output of the Network Variable. Specify the Internal Data 
Type. Based on the data category selected, the drop-down list changes. 

UNVT Name Enter UNVT Name in case of creating a new NV. This is not mandatory. 

 

5. Click OK. The new NV is created. It appears in the 
NVs list in the NV Configuration View. If Add to an 
existing NV is selected, then the fields are added to 
the existing NV and can be seen in the NVs list. 

Network Configuration Input 
NCI is a Network Configuration Input. 

Adding an NCI 
NCI can be added from:  

• NV Configuration View  

• honeywellSpyderTool palette  

Adding an NCI from the NV Configuration 
View 
To add a new Network Configuration Input:  

1. Navigate to Station > Config > Drivers > 
LonNetwork > LonSpyder. 

2. Select ControlProgram > Views > NV 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom NVs. For NV Configuration View, refer 
Figure 138. 
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Note:  

If adding an NCI to an Application, browse 
through to the appropriate Application on the Nav 
tree. 

 

3. Click Add NV. The New NV dialog box appears. 
Select Network Configuration Input. To add new 
NV, refer Figure 148. 

 
 

Figure 148: Add NV Screen 

4. Click OK. The Add NCI dialog box appears. To add 
NCI, refer Figure 149. 

 

 
Figure 149: Add NCI Screen 
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5. Fill the necessary information in the fields and click 
OK to complete adding of an NCI. The NCI is 
displayed in the NVs table. 

 
Note:  

An NCI cannot be added to a macro. Only a 
Constant point can be added to a macro.  

New NVs are created even if the NV count, field 
count, or unit store count has been exceeded. 
Honeywell Spyder displays a message informing 
the same, but allows the creation of NVs. 

Exposing an NCI from the NV 
Configuration View 
To expose the NV fields those are added as follows: 

1. Expand the NCI in the table to display the fields. 
Select the fields that need to be displayed on the 
wiresheet and click the Show on wiresheet as 
Points button 

OR 

Drag and drop the fields that need to be displayed on 
the wiresheet in to Software Points available on 
wiresheet list at the bottom of the screen on the right 
side. The Add Points dialog box appears as shown 
in Figure 150. 

 
Figure 150: Add NCI Point Screen 

 

2. Click OK. The fields that are selected appear on the 
Software Points available on wiresheet list at the 
bottom of the screen on the right side. The field name 
displays the combination of NV Name and Field 
Name information (Click Edit Point button and then 
the Advanced button for more information). If point to 
be displayed on the wiresheet is not selected, then 
the NV is added but is not visible on the wiresheet. 

3. Click Cancel if do not wish to continue adding an 
NCI. 

Table 49 shows details of Add NCI screen (Figure 149). 

 

Table 49: Edit NCI in NVs 

Name Definition 

NV Name Indicate the name that can be configured for this NVI. 

Copy From Enables the selection of Standard NVs or User Defined NVs (NVs user has 
created and saved earlier). 
• Standard: If Standard is selected, select a list of available NVs from the 

Select list. Standard NVs are pre-defined NVs known as SNVTs. 
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Name Definition 

• Custom: If Custom is selected, select a list of available NVs from the Select 
list. NVs that are created. This is taken from UNVT Name field.  Following are 
two options to select Custom NVs from:  
• File: Enables the selection of a custom NV that was created and saved 

regardless of the Station or device. Click the File option and click the 
Browse button; navigate to and select the .bog file. From the Select Type 
list, select the custom NV within the .bog file (a single .bog file may 
contain multiple custom NVs).  

• Station: Enables the selection of a custom NV that was created and 
saved only within any device belonging to the same Station. Click the 
Station option and select the device where the custom NV was created 
and saved. From the Select Type list, select the required custom NV. 

Station Device/File 
Ord 

Indicates the path of the station/file as per the selection from where the NVs of 
other device are copied 

Field Properties Displays the following properties for each field:  

• Field Name  

• Data Category  

• Network Data Type  

• Internal Data Type  

• Value 

Add Field Button Use this button to add a field. A maximum of 16 fields can be added. 

Delete Field Button Use this button to delete a field. 

Duplicate Button Use this button to duplicates a field 

Up Arrow Use this button to reorder a field and move it up in the list. 

Down Arrow Use this button to reorder a field and move it down in the list. 

Edit Selected Field Use this button to edit a selected field. 

Field Name User defined field name. 

Data Category Select the data type for the NV fields. 

Network Data Type It is the engineering unit received by the Honeywell Spyder controller. Specify the 
Network Data Type. Based on the data category selected, the drop-down list 
changes. 

Internal Data Type It is the unit(s) of the output of the Network Variable. Specify the Internal Data 
Type. Based on the data category selected, the drop-down list changes.  

Value Indicates the default value of the selected variable. This field is editable. The units 
are based on the Internal Data Type selected. 

Configure Invalid Use this option to configure an invalid value. Consequently, the Value field is 
disabled and displays NaN. 

UNVT Name Enter UNVT Name if required while creating a new NCI. 

Export to File When creating custom UNVTs, use this option to save it to a .bog file, so it can be 
reused. A single .bog file may contain multiple custom NVs. 
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Name Definition 

>> Click this button to view the network/internal data type details. 

Click this button to view the Facets Details Viewer for the network/internal data 
type. 

The following information is displayed: 

• Minimum: The minimum limit for selected unit  

Maximum: The maximum limit for selected unit  

OR 

Range: Indicates the possible enumeration with their ordinal for a selected 
unit.  

• Units: Indicates the unit symbol for the selected units (If it shows null, it means 
the unit symbol is not applicable there)  

• Type: Indicates the data type size for selected unit  

 F32: Float 4 Bytes  

 U16: Unsigned 2 bytes  

 S16: Signed 2 bytes  

 U8: Unsigned byte  

 S8: Signed byte  

 E8: Enumerated byte  

 UB: Unsigned bit  

• Resolution: Scaling factor for the selected Unit. When a value is written to the 
controller, the value is divided by the value specified in the Resolution field 
and when it is read from the controller, it is multiplied by the Resolution value 
before it is displayed in Niagara.  

• Precision: Precision for the selected Unit 

• Network Unit: Indicates Network Data Type 

• Network Value: Indicates current value 

 

Adding NCI from honeywellSpyderTool 
While in the midst of creating a 
ControlProgram/Application, if an NCI is required to 
add quickly, then use the Software Inputs item on the 
honeywellSpyderTool palette.  

 
Note:  

An NCI cannot be added to a macro. Only a 
Software Input can be added with Point Type as 
Constant to a macro.  

A Software Output can be added to a macro. 

 

To add an NCI to ControlProgram/Application:  

1. On the honeywellSpyderTool palette, expand the 
SoftwarePoints folder.  

 
Note:  

If the Spyder Palette is not visible on the left side 
of screen, on the Menu bar, click Windows > 
Sidebars > Palette to display the Spyder Palette. 

 

2. Drag and drop a NetworkSetpoint to the wiresheet of 
ControlProgram/Application. The Name dialog box 
appears. For NetworkSetpoint name window, refer 
Figure 122. 

3. Enter a name for the point and click OK. 

4. Right click the NetworkSetpoint that are just added 
and select Configure Properties. The Configure 
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Properties dialog box appears. For 
NetworkSetpoint Configure Properties screen 
Refer Figure 124. 

5. Enter/select the following: 

• Point Name: Enter a name for the point. 

• Unit to be used within Logic: Select the unit for 
the Point Category chosen. 

• Value: Enter a value based on the Point 
Category and Units to be used within Logic 
fields are selected. 

6. Click OK to complete adding an NCI.  

 
Note:  

When NVs are created using the 
honeywellSpyderTool palette, the fields are 
automatically added on the NV Configuration 
window. The NVs selected on wiresheet appear 
automatically in Software Points available on 
wiresheet window. 

Connecting NCIs 
Once an NCI is created, a point of an NCI can be 
connected to an NVO/Function Block/Physical point by 
left-clicking on the output of a point of an NCI and 
dragging the mouse to the input of an NVO/Function 
Block/Physical point. 

Multiple points spread across NVs can be grouped into a 
single new NV or add it to an existing one. The points 
must be available on the wiresheet to make such a 
grouping possible. Multiple points of an NV of the type 
NVI and NCI can be grouped together to create a new 
NV. The new NV created can be saved as an NVI or NCI 
when one or more NVs are grouped.  

Also, invalid points can be grouped with fields of another 
NV to create a new NV. 

Also, a single point belonging to an NV can be grouped. 
In this case, a new NV is created. 

 
Note:  

The Group as NV option is not available for 
software points of type:  

• Software Output (NVO points)  
• Many to one NV 
• Network Input/Network Setpoint  
• ManyToOneNV if at least one or whose 

network data type of the corresponding field 
is configured as bit field is selected 

• Fixed NV fields exposed as points  

Grouping Points of type NVI/NCI 
Two or more points of type NVI, NCI, Valid Network 
Input/Setpoint, Invalid Network Input/Setpoint, or 
Constant point are grouped to:  

• Create a new NCI  

• Add to an existing NCI 

• Create a new NVI  

• Add to an existing NVI 

When grouping to create a new NVI/NCI, the number of 
fields of the new NV equals the number of software input 
points selected for grouping. When points are grouped to 
add to an existing NVI/NCI, then the selected software 
input points are added to the existing fields of the 
selected target NVI/NCI. The new/edited NVI/NCI 
appears in the upper pane in the list of NVs in the NV 
Configuration View. The lower pane in the NV 
Configuration View displays the list of all NVs with 
which a particular software input has been grouped. 

The result of such a grouping is that the previous 
NVI/NCI is modified such that the corresponding field to 
this point is removed from the NV. The NV is deleted if 
the NV was a single field NV. This happens when points 
selected are already attached to an existing NV. 

Points to note: 

If invalid software input points (an invalid NCI point) are 
grouped to form an NVI/NCI, then the invalid NCI point is 
converted to a valid NVI/NCI point. 

1 When software input point configured as a Constant 
is grouped to form an NVI or NCI, then the software 
point is converted to a NVI/NCI point and any links 
from that point to functional block slots is broken. 
Such functional block slots (Property/Input Type) are 
converted to Connector type of slots. The links are 
broken only when the target property type in the 
function blocks is CONSTANT_ONLY, else, target 
property type is converted to CONNECTOR and the 
link is retained. 

2 The result of copying and pasting an invalid Network 
Input/Setpoint/Output point in the wiresheet is the 
creation of an invalid Network Input/Setpoint/Output 
point. 

3 When a folder contains some software points 
(NVI/NCI/NVO points) who’s NVs are present in other 
folders (other than its child folders), the points 
become invalid as the reference to the NV is lost. 

4 If points selected for grouping have a mixture of 
software input and output points, Group as NV option 
is not available. 

 

 Table 50 summarizes how a point(s) of a source NV can 
be grouped to form a target NV.  
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Table 50: Grouping of a Source NV to Target NV 

Source NV Points 

Target NV 

NVI NCI NVO 
Valid 

Software 
Input Point 

Valid 
Network 

Output Point 

NVI Yes Yes No Yes No 

NCI Yes Yes No Yes No 

Valid Software Input Point Yes Yes No Yes No 

Invalid Software Input 
Point 

Yes Yes No Yes No 

Constant Point Yes Yes No Yes No 

NVO No No Yes No Yes 

 

To group points of NCIs:  

1. On the NV Configuration View, select the fields 
need to be grouped from the Software points 
available on wiresheet list. 

 

 
Note:  

Use the CTRL key on keyboard to select the 
different fields that need to be grouped. 

 

2. Click the Group as NV button. The Confirmation 
dialog box appears. Refer Figure 151.The fields are 
deleted from the NVs from which they are being 
selected.  

 
Figure 151: Confirmation Box 

If a field is selected from an NV (for grouping), in 
which it was the only field, then the NV from which it 
is being selected is deleted. 

3. A message appears gives warning that if the selected 
point is attached to an NV, then grouping will delete 
that point from that NV. Click OK. The Group as NV 
dialog box appears as shown in Figure 152. 

4. Fill the necessary information in the fields of Group 
as NV screen (Figure 152) is explained in Table 51. 
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Figure 152: Group as NV Dialog Box for NCI 

 

Table 51 shows details of Group as NV screen. 

 

Table 51: Details of Group as NV Dialog Box 

Name Definition 

Group as New NV Select this option to save the selected fields which are required to Group as a 
New NV. In this case, a new NV Name can be entered. 

Note: 

The new NV is created on the same folder in which the NV Configuration View is 
invoked.  

Example: If there are two programs i.e. Application1 and Application2 in 
ControlProgram, in which Application2 is residing in Application1 and if points are 
grouped on the NV Configuration View of Application2, then the new NV is created 
in the Application2 folder. However, if NVs are grouped on the NV Configuration 
View of the Application1, then the new NV is created in the Application1 folder. 
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Name Definition 

Add to Existing NV Select this option if the points that need to be added to group to an existing NV. In 
this case, an existing custom NVI/NCI can be selected from the NV Name list. 

On selecting this option, the fields of the NV to which the new points will be added 
are listed in the Fields Properties table. 

Note: 

• In this case, the selected existing NV is edited to reflect the changes. 

• In the case where the selected NVI was of a SNVT type, the NV is converted 
to a UNVT after grouping of points is done 

NV Name Indicates the name that can be configured for this NV. 

NV Type Select this option to save the selected fields NVI or NCI. 

Fields Properties Displays the following properties for each field: 

• Field Name  

• Data Category 

• Network Data Type 

• Internal Data Type 

Up Arrow Use this button to reorder a field and move it up in the list. 

Down Arrow Use this button to reorder a field and move it down in the list. 

Point Name Indicate the name of the point.  

Field Name User defined field name. 

Data Category Selects the data type for the NV fields. 

Network Data Type It is the engineering unit received by the Honeywell Spyder controller. Specify the 
Network Data Type. Based on the data category selected, the drop-down list 
changes. 

Internal Data Type It is the unit(s) of the output of the Network Variable. Specify the Internal Data 
Type. Based on data category selected, the drop-down list changes. 

UNVT Name Enter UNVT Name in case of creating a new NV. This is not mandatory. 

>> Click this button to view the network/internal data type details. 

 

5. Click OK. The new NV is created. It appears in the 
NVs list in the NV Configuration View. If Add to an 
existing NV is selected, then the fields are added to 
the existing NV and can be seen in the NVs list. 

Many to One NV 
Use this built-in function to bind an output from 2 to 8 
other network NVOs to a single network variable input on 
Honeywell Spyder. The value from each controller is 
placed on an output of the Many to One. For example, 
the minimum, maximum, average or other function blocks 
can be used to combine them as per the application. 

The many to one network variable has a single input NV 
field. The field can be 1, 2, or 4 bytes long. It cannot be 
configured for SNVT types. 

The input engineering units and the output engineering 
units can be configured. All outputs have the same 
engineering unit. 

From 2 to 8 outputs can be configured. Each output is 
the value of the NVO of the corresponding source 
controller. As each output source is received on the 
input, it is assigned an output slot. Honeywell Spyder 
keeps track of the domain/subnet/node of all NVs bound 
so that it can put new values into the proper output slot. 
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The outputs are assigned on a first-come-first-served 
basis. Data is not saved over a power outage. This 
means it is possible the order may be different after each 
power outage. The Many-to-One input is not Fail 
Detect. However a fail detect timer is kept for each input 
source. nciRcvHrtBt is used for the timer. If the Timer 
expires the corresponding output is set to INVALID. 

If less source NVs are bound than are configured then 
the ones not received are set to Invalid. 

If more source NVs are bound than are configured, then 
any sources received after the slots are filled are 
ignored. 

The Many-to-One outputs are set to Invalid on power 
up/reset. As NV updates are received, the corresponding 
output slot is set to the received value. 

To add a new Many To One Network Variable:  

1. Navigate to Station > Config > Drivers > 
LonNetwork > LonSpyder. 

2. Select ControlProgram > Views > NV 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom NVs. For NV Configuration View, refer 
Figure 138. 

3. Click New NV. The Select dialog box appears. For 
new NV, refer Figure 141. 

 
Figure 153: Add New NV Screen 

4. Select Many To One NV. Refer Figure 153 

5. Click OK. The Add Many-To-One NVI dialog box 
appears as shown in Figure 154. 

 
Figure 154: Add Many-To-One NVI Screen 

6. Fill the necessary information in the fields and click 
OK to complete adding a Many To One NV. Table 52 
shows details of Add Many-To-One screen (Figure 
154)  

Table 52: Fields of Add Many to One NV screen 

Name Definition 

NV Name Indicate the name that can be 
configured this Many-To-One 
NVI with. 

Name Definition 

Number of 
Bound 
Input NVs 

The minimum and maximum 
limits are 2 and 8. 

Field Name This is non-editable. 

Data 
Category 

Select the data type for the NV 
fields.  
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Name Definition 

Network 
Data Type 

It is the engineering unit 
received by the Honeywell 
Spyder controller. 

Internal 
Data Type 

It is the unit(s) of the output of 
the Network Variable.  

 

 

 
Note:  

New NVs can be created even if the NV count, 
field count, or unit store count has been 
exceeded. Honeywell Spyder displays a 
message informing the same, but allows the 
creation of NVs. 

 

Exposing a Many-To-One NVI from the 
NV Configuration View 
To expose the NV fields those are added as follows: 

1. Expand the Many-To-One NVI in the table to display 
the fields. Select the fields that need to be displayed 
on the wiresheet and click the Show on wiresheet 
as Points button. 

OR 

Drag and drop the fields that need to be displayed on 
the wiresheet on to Software Points available on 
wiresheet list at the bottom of screen on the right 
side. The Add Points dialog box appears as shown 
in Figure 155. 

 
Figure 155: Add Many-To-One NV 

 

2. Click OK. The fields that are selected appear on the 
Software Points available on wiresheet list at the 
bottom of the screen on the right side. The field name 
displays the combination of NV Name and Field 
Name information (Click Edit Point button, then 
Advanced button for more information). If point to be 
displayed on the wiresheet is not selected, then the 
NV is added but is not visible on the wiresheet. 

3. Click Cancel if do not wish to continue adding a 
Many-To-One NVI. 

Connecting Many To One NVs 
Once a Many To One NV is created, a point of a Many 
To One NV can be connected to an NVO by left-clicking 

on the output of a point of a Many To One NV and 
dragging the mouse to the input of an NVO. 

Grouping as NV 
The Group as NV option is not available for software 
points of the type Many to One NV.  

Network Variable Output 
The Network Variable Output (NVO) converts input 
value(s) [Public Variable(s)] into a raw network variable 
output that is published onto the LONWORKS® network. 
Each NVO can be defined with up to 16 fields. 
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Note:  

The maximum limit of the fields is based on the 
memory limitation of a selected controller model 
and NV size cannot exceed 31 bytes. 

 

Each field is converted from Internal Data Type to 
Network Data Type engineering units. Internal data type 
is the units of the input of the Network Variable. Network 
Data Type is the engineering unit sent by the Honeywell 
Spyder controller onto the LONWORKS® network. For 
example, programming the Network Data Type to be 
SNVT_temp_p, and the Internal Data Type to be °F 
converts network temperatures of type SNVT_temp_p 
into °F for use by the Function Blocks. 

Adding an NVO 
An NVO can be added from:  

• NV Configuration View  

• honeywellSpyderTool Palette  

Adding an NVO from the NV 
Configuration View 
To add a new Network Variable Output:  

1. Navigate to Station > Config > Drivers > 
LonNetwork > LonSpyder. 

2. Select ControlProgram > Views > NV 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom NVs. For NV Configuration View, refer 
Figure 138. 

 

 
Note:  

If adding an NVO to a Program, browse through 
to the appropriate Application on the Nav tree. 

 

3. Click Add NV. The New NV dialog box appears as 
shown in Figure 156. 

 
Figure 156: Add New NVO Screen 

4. Select Network Variable Output.  

5. Click OK. The Add NVO dialog box appears as 
shown in Figure 157. 
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Figure 157: Add NVO Screen 

6. Fill the necessary information in the fields and click 
OK to complete adding an NVO. The NVO is 
displayed in the NVs table.

 

 
Note:  

An NVO cannot be added to a macro. Only a 
Constant point can be added to a macro.  

A Software Output cannot be added to a macro. 

 

 

Table 53: Fields of Add an NVO Dialog Box 

Name Definition 

NV Name Indicates the name that can be configured for this NVO. 

Output Refresh Set the Output Refresh of each NVO to either Polled or Unpolled.  

• Output Refresh is only valid when the Guaranteed Periodic Refresh is set 
to False.  

• If an Output Refresh is Polled, then the value of the output network variable 
is never propagated as a result of its value changing. Instead the value of 
the output network variable is sent only in response to a poll request from a 
reader node.  
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Name Definition 

Guaranteed Periodic 
Refresh 

Set Guaranteed Periodic Refresh of each Network Variable Output to either 
True or False.  

• True indicates that the Honeywell Spyder controller periodically sends this 
variable to the LONWORKS® network at the GPU rate (nciSndHrtBt). 
Setting this to True also enables the Significant Event Notification also 
known as SEN Delta. The Network Variable is also sent on the 
LONWORKS® Network whenever any field exceeds the SEN Delta. SEN 
Delta of zero (0) disables the feature.  

• False indicates that the Honeywell Spyder controller does not send the 
value to the LONWORKS® network. The Network Variable Output must be 
polled to get its value.  

Message Service The Message Service type of each NVO is Unacknowledged, 
Acknowledged or Unacknowledged Repeated.  

• Unacknowledged means the update is sent once and no 
acknowledgement is expected.  

• Acknowledged means all receiver nodes must acknowledge receipt of the 
message to the sender node.  

• Unacknowledged Repeated means the update is sent multiple times and 
no acknowledgements are expected.  

Copy From Enables the selection of Standard NVs or User Defined NVs (NVs user has 
created and saved earlier). 
• Standard: If Standard is selected, select a list of available NVs from the 

Select list. Standard NVs are pre-defined NVs known as SNVTs. 
• Custom: If Custom is selected, select a list of available NVs from the 

Select list. NVs that are created. This is taken from UNVT Name field.  
Following are two options to select Custom NVs from:  
• File: Enables the selection of a custom NV that was created and 

saved regardless of the Station or device. Click the File option and 
click the Browse button; navigate to and select the .bog file. From the 
Select Type list, select the custom NV within the .bog file (a single 
.bog file may contain multiple custom NVs).  

• Station: Enables the selection of a custom NV that was created and 
saved only within any device belonging to the same Station. Click the 
Station option and select the device where the custom NV was 
created and saved. From the Select Type list, select the required 
custom NV. 

Station Device/File Ord Indicates the path of the station/file as per the selection from where the NVs of 
other device are copied 

Fields Properties Displays the following properties for each field: 

• Field Name  

• Data Category  

• Internal Data Type  

• Network Data Type  

• Significant Event Notification  

Add Field Use this button to add a field. A maximum of 16 fields can be defined. 
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Name Definition 

Delete Field Use this button to delete a field. 

Duplicate Button Use this button to duplicates a field 

Up Arrow Use this button to reorder a field and move it up in the list. 

Down Arrow Use this button to reorder a field and move it down in the list. 

Field Name User defined field name. 

Internal Data Type It is the unit(s) of the output of the Network Variable. Specify the Internal Data 
Type. Based on the data category selected, the drop-down list changes. 

Network Data Type It is the engineering unit received by the Honeywell Spyder controller. Specify 
the Network Data Type. Based on the data category selected, the drop-down 
list changes. 

Significant Event 
Notification 

Indicates the SEN delta value of the selected variable. This field is editable. 
The units are based on the Network Data Type selected. 

UNVT Name Enter UNVT Name in case of creating a new NVO. 

Export to File When creating custom UNVTs, use this option to save it to a .bog file so it can 
be reused. A single .bog file may contain multiple custom NVs. 

>> 1. Click this button to view the network/internal data type details. 

2. Click this button to view the Facets Details Viewer for the network/internal 
data type. 

3. The following information is displayed: 

• Minimum – The minimum limit for selected unit  
• Maximum– The maximum limit for selected unit  

OR 
• Range: Indicates the possible enumeration with their ordinal for a 

selected unit.  
• Units: Indicates the unit symbol for the selected units (If it shows null, it 

means the unit symbol is not applicable there)  
• Type: Indicates the data type size for selected unit  
 F32: Float 4 Bytes  
 U16: Unsigned 2 bytes  
 S16: Signed 2 bytes  
 U8: Unsigned byte  
 S8: Signed byte  
 E8: Enumerated byte UB – Unsigned bit  

• Resolution: Indicates a scaling factor for the selected Unit. When a 
value is written to the controller, the value is divided by the value 
specified in the Resolution field and when it is read from the controller, it 
is multiplied by the Resolution value before it is displayed in Niagara.  

• Precision: Precision for the selected Unit  

• Network Unit: Indicates Network Data Type 

• Network Value: Indicates current value 

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 144  

 
Note:  

New NVs can be created even if the NV count, 
field count, or unit store count has been 
exceeded. Honeywell Spyder displays a 
message informing the same, but allows the 
creation of NVs. 

 

Exposing an NVO from the NV 
Configuration View 

To expose the NV fields those are added as follows: 

1. Expand the NVO in the table to display the fields. 
Select the fields that need to be displayed on the 
wiresheet and click the Show on wiresheet as 
Points button 

OR 

Drag and drop the fields that need to be displayed on 
the wiresheet on to Software Points available on 
wiresheet list at the bottom of the screen on the right 
side. The Add Points dialog box appears as shown 
in Figure 158. 

 
Figure 158: Add Points Screen of NVO 

 

2. Click OK. The fields that are selected appear on the 
Software Points available on wiresheet list at the 
bottom of screen on the right side. The field name 
displays the combination of NV Name and Field 
Name information (Click Edit Point button, then the 
Advanced button for more information). If the point to 
be displayed on the wiresheet is not selected, then 
the NV is added but is not visible on the wiresheet. 

3. Click Cancel if do not wish to continue adding an 
NVO. 

Adding an NVO from the 
honeywellSpyderTool Palette 
While in the midst of creating a Control 
Program/Application, if an NVO is required to add 
quickly, then use the Software Outputs item on the 
Spyder Palette.  

 
Note:  

An NVO or a Software Output point cannot be 
added to a macro. 

 

To add an NVO to a ControlProgram/Application:  

1. On the honeywellSpyderTool palette, expand the 
SoftwarePoints folder.  

 
Note:  

If the Spyder Palette is not visible on the left side 
of screen, on the Menu bar, click Windows > 
Sidebars > Palette to display the Palette.  

 

2. Drag and drop a NetwokOutput to the wiresheet of a 
ControlProgram/Application. The Name dialog box 
appears. For NetwokOutput name window, refer 
Figure 128. 

3. Enter a name for the point and click OK. 

4. Right click the Software Output point that is just 
added and select Configure Properties. The 
Configure Properties dialog box appears. For 
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NetwokOutput Configure Properties screen, refer 
Figure 130. 

5. Enter/select the following: 

• Point Name: Enter a name for the point. 

• Point Type: By default, Software Output is 
selected. This is the only available option. 

• Point Category: Select a category. 

• Unit to be used within Logic: Select the unit for 
the Point Category chosen. 

6. Click OK to complete adding an NVO.  

 
Note:  

When an NV is created using the Spyder Palette 
on the wiresheet, by default, then the fields are 
exposed. Also, do not have to manually expose 
the fields of the NVO on the wiresheet. 

 

Connecting NVOs 
Once an NVO is created, an NVO can be connected to 
an NVI/Function Block or Physical point by left-clicking 
on the output of an NVI/Function Block/Physical point 
and dragging the mouse to the input of an NVO. 

Grouping as NVOs 
Two or more NVO points can be grouped (shared) or 
valid/invalid software output points to:  

• Create a new NVO  

• Add to an existing NVO 

When grouping to create a new NVO, the number of 
fields of the new NVO equals the number of software 
output points selected for grouping. When points are 
grouped to add to an existing NVO, the selected software 
output points are added to the existing fields of the 
selected target NVO. In either case, the structure of the 
source NVOs to which the points originally belong are 

not affected. The new/edited NV appears in the upper 
pane in the list of NVOs in the NV Configuration View. 
The lower pane in the NV Configuration View displays 
the list of all NVOs to which a particular software output 
has been grouped into. 

Points to note: 

1. The new NVO is created by grouping of software 
output points is created at the same Application folder 
level as the one where the Group as NV operation 
screen is invoked.  

2. A shared NVO point cannot be edited from the NV 
Configuration View screen. To edit a shared NVO, 
right-click the NVO on the wiresheet and select 
Configure Properties. If software point details of an 
NVO are edited, whose points are grouped, then all 
newly created NVOs in which the point is grouped are 
modified. Only edit field names of the points selected 
to be grouped can be edited as NVO. This is true 
even if the points are added to an existing NVO. 
However, no information of the existing NVO fields is 
editable. Only the field names of the newly selected 
points are editable. 

3. Deleting a software output point from the wiresheet 
modifies all the NVOs in which the point is grouped. 
The field corresponding to the point is deleted in the 
NVOs and if this happens to be the last field, the NVO 
itself is deleted. 

4. If invalid software output points are grouped to NVOs, 
the invalid software points are converted to valid 
software points.  

5. The result of copying and pasting an invalid Network 
Input/Setpoint/Output point in the wiresheet is the 
creation of an invalid Network Input/Setpoint/Output 
point. 

6. When a folder contains some software points 
(NVI/NCI/NVO points) who’s NVs are present in other 
folders (other than its child folders), the points 
become invalid as the reference to the NV is lost. 

7. Table 54 summarizes how a point(s) of a source NV 
can be grouped to form a target NV. 

 
Table 54: Group a point(s) of a source NV to form a target NV 

Source NV 
Points 

Target NV    

NVI NCI NVO 

Valid 
Software 

Input 
Point 

Invalid 
Software 

Input 
Point 

Constant 
Point 

Valid 
Network 
Output 
Point 

Invalid 
Network 
Output 
point 

NVI Yes Yes No Yes Yes Yes No No 

NCI Yes Yes No Yes Yes Yes No No 

Valid Software 
Input Point Yes Yes No Yes Yes Yes No No 
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Source NV 
Points 

Target NV    

NVI NCI NVO 

Valid 
Software 

Input 
Point 

Invalid 
Software 

Input 
Point 

Constant 
Point 

Valid 
Network 
Output 
Point 

Invalid 
Network 
Output 
point 

Invalid Software 
Input Point Yes Yes No Yes Yes Yes No No 

Constant Point Yes Yes No Yes Yes Yes No No 

NVO No No Yes No No No Yes Yes 

 

To group points of NVOs:  
1. On the NV Configuration View, select the points of 

one or more NVOs that that need to be grouped from 
the Software points available on wiresheet list. 
 

 
Note:  

Use the CTRL key on keyboard to select the 
different points that need to be grouped 

 
2. Click the Group as NV button. The confirmation box 

appears. The Group as NV dialog box appears. 
Refer Figure 159. 

 

 

 

Figure 159: Group as NV Screen of NVO
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3. Fill the necessary information in the fields as 
explained in the Table 55. 

 

Table 55: Fields of Group as NV Dialog Box 

Name Definition 

Group as New NV 

Select this option to save the selected fields which are required to Group as a 
New NV. In this case, a new NV Name can be entered. 

Note: 

The new NV is created on the same folder in which the NV Configuration View is 
invoked.  

Example: If there are two programs i.e. Application1 and Application2 in 
ControlProgram, in which Application2 is residing in Application1 and if points 
are grouped on the NV Configuration View of Application2, then the new NV is 
created in the Application2 folder. However, if NVs are grouped on the NV 
Configuration View of the Application1, then the new NV is created in the 
Application1 folder. 

Add to Existing NV 

Select this option if need to be add the points that need to be added to group to 
an existing NVO. In this case, an existing custom NVO can be selected from the 
NV Name list. 
On selecting this option, the original fields of the NVO to which the new points 
will be added are listed in the Fields Properties table. 
Note: 

In the case where the selected NVO was of a SNVT type, the NV is converted to 
a UNVT after grouping of points is done. 

NV Name Indicates the name that can be configured for this NV. 
 NV Type Select this option to save the selected fields NVO 

Fields Properties 

Displays the following properties for each field: 
• Field Name  

• Data Category 

• Network Data Type 

• Internal Data Type 

Up Arrow Use this button to reorder a field and move it up in the list. 

Down Arrow Use this button to reorder a field and move it down in the list. 

Point Name Indicates the name of the point. It is in the format NVName_PointName.  

Field Name User defined field name. 

Data Category Select the data type for the NV fields. 

Network Data Type It is the engineering unit received by the Honeywell Spyder controller. This is 
non-editable. 

Internal Data Type It is the unit(s) of the output of the Network Variable. This is non-editable. 

UNVT Name Enter UNVT Name in case of creating a new NV. This is not mandatory 

 

4. Click OK. The new NVO is created. It appears in the 
NVs list in the NV Configuration View. If Add is 
selected to an existing NV, the fields are added to the 
existing NVO and can be seen in the NVs list. 
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Edit Network Variables 
Fixed Droppable NVs can be partially modified and 
totally modify Custom NVs. However, Mandatory and 
Fixed NVs cannot be modified. 

 
Note:  

If a point of an NV is deleted and if this point is 
the only point in that NV, then the NV itself is 
deleted. 

 

Table 56 summarizes what can be or cannot be do with 
NVs in the Wiresheet and the NV Configuration Views.  

 

Table 56: Actions with NVs 

Type 
Show NV 

on 
Wiresheet 

 Add  Edit  Delete  

 Wiresheet NV 
Config 
View 

Wiresheet NV 
Config 
View 

Wiresheet NV 
Config 
View 

Wiresheet NV 
Config 
View 

NVI 

NCI 

NVO 

Yes. 
Any NV 
added to 
the 
wiresheet 
is 
automatical
ly 
displayed 
on the 
wiresheet 

Yes.  
Need to 
be 
added 
an NV 
and 
select 
the 
points 
that 
needs 
to be 
displaye
d on the 
wireshe
et by 
clicking 
the 
Display 
on 
Wiresh
eet 
button. 

Yes. 
Only an 
NV can be 
added 
with a 
single 
point. 

Yes. 
An NV 
can be 
added 
with 
multiple 
points. 

Yes. 
Only an 
NV can be 
edited with 
a single 
point at a 
time. 

Yes. 
An NV 
can be 
edited 
with 
multiple 
points at 
a time. 

Yes. 
Only an NV 
can be 
deleted 
with a 
single point 
at a time. 
• NVs of 

Fixed 
Droppab
le type 
and NVs 
with Bit 
Configur
ation are 
not 
deleted, 
but only 
hidden 
from the 
wireshe
et. They 
are still 
availabl
e in the 
NVs list. 

Yes. 
An NV 
can be 
deleted 
with 
multiple 
points at 
a time. 
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Type 
Show NV 

on 
Wiresheet 

 Add  Edit  Delete  

Many 
to 
One 

Yes. 
Any NV 
added to 
the 
wiresheet 
is 
automatical
ly 
displayed 
on the 
wiresheet 

Yes.  
An NV 
need to 
be 
added 
and 
select 
the 
points 
that 
needs 
to be 
displaye
d on the 
wireshe
et by 
clicking 
the 
Display 
on 
Wiresh
eet 
button. 

No. Yes. 
An NV 
can be 
added 
with 
multiple 
points. 

No. Yes. 
An NV 
can be 
edited 
with 
multiple 
points at 
a time. 

Yes. 
Only an NV 
can be 
deleted 
with a 
single point 
at a time. 

Yes. 
An NV 
can be 
deleted 
with 
multiple 
points at 
a time. 

 

To edit an NV:  
1. Browse to Station > Config > Drivers > 

LonNetwork > LonSpyder.  
2. Select ControlProgram > Views > NV 

Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom NVs and Software points. For NV 
Configuration View, refer Figure 138. 

3. Select the Fixed/Custom NV that needs to be edited 
and click the Edit NV button. 

4. The Edit NV: NV Name dialog box appears. If the 
selected NV is a Fixed Droppable NV type, then only 
the Internal Data Type can be changed and click OK 
to save the changes. Refer Figure 160. 
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Figure 160: Edit NV: NV Name Screen 

5. If the NV is a Custom type, by default, the settings 
are such that can be changed: 

• Internal Data Type 

• Fail Detect 

• SNVT Select 

• Standard/User Defined NV 

6. Click OK to save the changes. However, for a 
Custom NV, the Copy NV From check box can be 
unchecked. Refer Figure 161.Change all parameters 
as described in Adding an NVI/NCI/NVO, and Many 
to one NV sections of this document. 
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Figure 161: Unchecked “Copy NV From” check box 

 

Example: The nciSetPoints is an NV used in the 
Temperature Set Point Calculator. 

Only it’s Internal Data Type and the Value can be 
changed. Refer Figure 162 

 
Figure 162: nciSetPoints is an NV 
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Table 57 summarizes editing network variables from the 
Wiresheet and NV Configuration Views. 

 

Table 57: Editing network variables from the Wiresheet and NV Configuration Views 

NV Type Action From Procedure 

NVI/NCI/NVO Remove points from 
wiresheet 

Wiresheet A point can be removed (hide) 
from the wiresheet. 

 Remove points from 
wiresheet 

NV Configuration View 1. Select the exposed fields from 
the Software Points available 
on wiresheet list. 

2. Click, Remove Points from 
wiresheet. 

3. Click OK to confirm. 

 Edit NV Wiresheet Individual points of an NV can be 
edited at a time.  

1. Right click the individual point of 
an NV and select Configure 
Properties. 

2. Edit the available fields and 
click OK to save the changes. 

 Edit NV NV Configuration View Multiple points of an NV can be 
edited at a time. 

1. Select the NV from the NVs list 
on the right side of the screen 
on top. 

2. Click Edit NV and edit one or 
multiple points of the NV at 
once.  

3. Click OK to save the changes 
made. 

 Delete NV Wiresheet Only individual points of an NV can 
be deleted at a time. 

 Delete NV NV Configuration View An NV with multiple points can be 
deleted at a time.  

To delete an NV with multiple 
points: 

1. Select the NV from the NVs list 
on the right side of the screen 
on top. 

2. Click Delete NV. 
3. Click OK to save the changes 

made. 
Also, individual points can be 
deleted in an NV 
1. Select the NV from the NVs list 

on the right side of the screen 
on top. 
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NV Type Action From Procedure 

2. Click Delete NV.  
3. Click OK to save the changes 

made. 

Many to One NV Remove points from 
wiresheet 

Wiresheet A point can be removed (hide) 
from the wiresheet. 

1. Select the point of a Many to 
One NV that needs to be hide 
and press Delete button on the 
keyboard. The point is removed 
from the wiresheet.  

This point is however available in 
the NVs list in the NV 
configuration View.  

 Remove points from 
wiresheet 

NV Configuration View 1. Select the exposed fields from 
the Software Points available 
on wiresheet list and click 
Remove Points from 
wiresheet. 

2. Click OK to confirm. 

 Edit NV Wiresheet Only individual points of an NV can 
be edited at a time.  

1. Right click the individual point of 
an NV and select Configure 
Properties. 

2. Edit the available fields and 
click OK to save the changes. 

 Edit NV NV Configuration View Multiple points of an NV can be 
edited at a time. 

1. Select the NV from the NVs list 
on the right side of the screen 
on top. 

2. Click Edit NV and edit one or 
multiple points of the NV at 
once.  

3. Click OK to save the changes 
made. 

 Delete NV Wiresheet Points of a Many to One NV 
cannot be deleted from the 
wiresheet. 

 Delete NV NV Configuration View An NV with multiple points can be 
deleted at a time. To delete an NV 
with multiple points: 
1. Select the NV from the NVs list 

on the right side of the screen 
on top. 
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NV Type Action From Procedure 

2. Click Delete NV.  
3. Click OK to save the changes 

made. 
Individual points can also be 
deleted in an NV 
1. Select the NV from the NVs list 

on the right side of the screen 
on top. 

2. Click Delete NV.  
3. Click OK to save the changes 

made. 

 

Points to note: 

1. For special NVs used in function blocks, only the 
Internal Data Type and the Value can be changed. All 
other fields are unusable. Also, the name 
nciSetPoints cannot be used to name any other item 
as it is a reserved name. 

2. If software point details of an NVO are edited, whose 
points are grouped (shared), all newly created/shared 
NVOs in which the point is grouped (shared) are 
modified. Only the field names of the selected points 
can be edited to be grouped as NVO. This is true 
even if the points are added to an existing NVO. 
However, no information of the existing NVO fields is 
editable. Only the field names of the newly selected 
points are editable. 

3. When an NVO is edited such that the details of the 
field whose exposed point is grouped across multiple 
NVs are modified, the association of the point with the 
NV is lost. The point is no longer shared with this 
NVO. The lower pane in the NV Configuration View 
does not list this NVO in the list of NVOs to which that 
point belongs. The modified field becomes local to the 
NVO and should be explicitly expose it on the 
wiresheet to use it in the logic 

Deleting NVs 
To delete an NV:  

1. Browse Station > Config > Drivers > LonNetwork > 
LonSpyder 

2. Select ControlProgram > Views > NV 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom NVs and Software points. Refer Figure 138. 

3. Select the Custom NV that is required to delete. 

4. Click the Delete NV button. A Delete Confirmation 
dialog box appears. Refer Figure 163 

 
Figure 163: Deleted Custom NV Screen 

5. Select: 

• Retain Points to delete the NV and make its 
exposed points (if any) as invalid points. 

• Delete Points to delete the NV and its exposed 
points (if any). 

• Cancel Delete to cancel the deletion 

 

 
Note:  

While deleting an NV, if Retain Points option is 
selected, points of the NV are converted to 
invalid points. The option to retain exposed 
points of deleted NVs is available only from the 
NV Configuration View. The invalid points are 
displayed in the lower pane of the NV 
Configuration View. 

Deleting Software Points From Wiresheet 
If a software point is deleted from the wiresheet, then the 
NV to which the point belonged to is modified such that 
the corresponding field is deleted. The NV itself is 
deleted if the field happens to be the last field. 
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Note:  

In the following cases, deleting a point from the 
wiresheet puts the point back in the NV.  

• If the point is attached to Many to One NVI 
or Fixed NV. 

• If the point is configured as Bit Field. 

• If the point is attached to nciTempSetpoints. 

 

Invalid Points 
An NV can be deleted without deleting its exposed 
points. Points of such NVs are converted as invalid 
points. This option is available only from the NV 
Configuration view. 

NVs can be copied and pasted from a source controller 
to a target controller. When an application folder 
containing point, but the NV to which it belongs is 
present in the parent folder of the folder in which the 
points are present, is copied/cut and pasted to the target 
controller, the points become invalid. 

When an application folder containing NVs whose points 
are exposed in its parent folder, is cut/copied and pasted 
to a target controller, the corresponding field (to which 
the exposed point belonged) is removed from the NV. 
The NV is deleted if the point happens to be the last field 
in the controller. 

When an application folder containing NVs (containing bit 
field configuration) whose points are exposed in its 
parent folder, is cut/copied and pasted to a target 
controller, the corresponding field (to which the exposed 
point belonged) is removed from the NV. However, an 
additional field is added to the NV to make the NV valid. 
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BACNET OBJECTS 
An Object is a data item such as a temperature, a switch 
value or actuator state. Objects can be thought of as 
point parameters. 

There are two categories of Objects that the BACnet 
Spyder supports. They are:  

• Fixed_Droppable: Fixed_Dropable Objects can be 
used while creating an application logic and only 
Internal Data Type can be edited. Fixed Droppable 
Objects can also be displayed on the wiresheet.  

• Custom: Custom Objects are the objects that are 
created while creating application logic. They can be 
created, edited, and deleted based on the 
requirements.  

The Table 58 shows a list of fixed objects supported by 
Spyder. 

Table 58: List of fixed objects supported by Spyder 

Object Name Object Type 

DebugIndex0 Analog-value 

DebugIndex1 Analog-value 

DebugIndex2 Analog-value 

DebugIndex3 Analog-value 

DebugIndex4 Analog-value 

DebugIndex5 Analog-value 

DebugIndex6 Analog-value 

DebugIndex7 Analog-value 

DebugIndex8 Analog-value 

DebugIndex9 Analog-value 

DebugIndex10 Analog-value 

DebugIndex11 Analog-value 

DebugIndex12 Analog-value 

DebugIndex13 Analog-value 

Debug0 Analog-value 

Debug1 Analog-value 

Debug2 Analog-value 

Debug3 Analog-value 

Debug4 Analog-value 

Object Name Object Type 

Debug5 Analog-value 

Debug6 Analog-value 

Debug7 Analog-value 

Debug8 Analog-value 

Debug9 Analog-value 

Debug10 Analog-value 

Debug11 Analog-value 

Debug12 Analog-value 

Debug13 Analog-value 

 

Table 59 shows the list of mandatory objects supported 
by Spyder 

Table 59: List of mandatory objects supported by 
Spyder 

Object Name Object Type Object 
Instance 

HardwareID Analog-value 0 

BrandModel Analog-value 1 

VersionReflash Analog-value 2 

VersionMajor Analog-value 3 

VersionMinor Analog-value 4 

InUse Analog-value 5 

Error0 Analog-value 6 

Error1 Analog-value 7 

Error2 Analog-value 8 

Error3 Analog-value 9 

Error4 Analog-value 10 

Error5 Analog-value 11 

Error6 Analog-value 12 

Error7 Analog-value 13 

Error8 Analog-value 14 

Error9 Analog-value 15 

Error10 Analog-value 16 



HONEYWELL SPYDER USER GUIDE 

 157 31-00089—02 

Object Name Object Type Object 
Instance 

Error11 Analog-value 17 

Error12 Analog-value 18 

Error13 Analog-value 19 

Error14 Analog-value 20 

Error15 Analog-value 21 

AlrmStatus Analog-value 22 

AlarmH Analog-value 23 

ConfigErrorID Analog-value 24 

ConfigErrorNature Analog-value 25 

ConfigErrorRecord Analog-value 26 

WMCommErrorDe
viceAddr 

Analog-value 27 

WMCommErrorFile
ID 

Analog-value 28 

UniqueID0 Analog-value 29 

UniqueID1 Analog-value 30 

UniqueID2 Analog-value 31 

UniqueID3 Analog-value 32 

UniqueID4 Analog-value 33 

UniqueID5 Analog-value 34 

 

 
Note:  

The BACnet Spyder supports the following object 
types.  

• AVI: Analog Value Input  

• AVO: Analog Value Output  

• AV Setpoint: Analog Value Setpoint  

• BVI: Binary Value Input  

• BVO: Binary Value Output  

• BV Setpoint: Binary Value Setpoint  

• MVI: Multi-state Value Input  

• MVO: Multi-state Value Output  

• MV Setpoint: Multi-state Value Setpoint 

The configured objects are mapped to the Function Block 
memory space to be used by any Function Block. Each 
Object is configured with a name. 

Viewing the List of BACnet 
Objects 
1. Browse Station > Config > Drivers > 

BacnetNetwork > BACnetSpyder 

2. Select ControlProgram> Views > Object 
Configuration View. Refer Figure 164. The 
Summary page appears with a list of pre-
programmed Fixed_Droppable and Custom Objects 
in a tabular format. Refer Figure 165. 

 
 

Figure 164: Views > Object Configuration View for 
BACnet 
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Figure 165: Object Configuration View 

 

The table has the following columns:  

• Name: Indicates the name of the Object.  

• Type: Indicates if the object is of type AVI, AVO, AV 
Setpoint, BVI, BVO, BV Setpoint, MVI, MVO, or MV 
Setpoint.  

• Category: Indicates if the Object is Fixed_Droppable 
or Custom.  

• Object Container: Indicates where the Object is 
used.  

• Object Instance: A unique number that is 
automatically assigned to the object.  

• Update Rate: The polling rate to update the object 
value of Object components.  

• Send Heartbeat: The rate at which a Network object 
value is sent to the network regardless of whether its 
value is changed or not. The timeout value is equal to 

the value entered in this field multiplied by 5. This 
value should be configured as multiples of 5 only, 
else tool rounds it off to the nearest multiple of 5 
during download.  

• The bottom half of the Object Configuration View 
displays the physical and software points available on 
the wiresheet in a tabular format.  

3. Duration view displays the physical and software 
points available on the wiresheet in a tabular format. 
The table has the following columns:  

• Point Name: The name of the physical /software 
point as it appears on the wiresheet.  

• Field Names: Indicates the Object type.  

• Point Container: Indicates where the physical 
/software point is used. All physical /software 
points that are used in a Program within an 
application are also listed.  
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Note:  

• In a Fixed Droppable Object, only Internal 
Data Type can be modified. 

• Custom Object is the user defined Object. A 
Custom Object can be edited or deleted. 

• Fixed Objects marked as Fixed_Dropable 
can be exposed on the wiresheet. Other 
fixed objects cannot be exposed as points. 

• When a user changes the device model, if 
the name of a custom object clashes with a 
fixed object name in the target model, 
Honeywell Spyder generates a new unique 
name for the custom object and creates the 
new fixed object. 

 

Object Input 
The Object Inputs (Analog Value Input, Binary Value 
Input, and Multi-state Value Input) convert a raw object 
input into a value(s) that can be used by other function 
blocks.  

When an Object Input is added to the wiresheet, the 
object appears in the Object Configuration View.  

Adding an Object Input 
An Object Input can be added from:  

• Object Configuration View  

• honeywellSpyderTool palette  

Adding an Object Input from the Object 
Configuration View 
To add a new Object Input:  

1. Browse Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder 

2. Select ControlProgram > Views > Object 
Configuration View. Refer Figure 165. The summary 
page appears with a list of pre-programmed 
Mandatory, Fixed, and Custom Objects.  

 
Note:  

If adding an Object Input to an application, 
browse through to the appropriate application on 
the Nav tree. 

 

3. Click Add Object. The New Object dialog box 
appears. Select an Object Type (Analog Value, 
Binary Value, Multi-state Value). Refer Figure 166. 

 
 

Figure 166: New object Screen 

 
Note:  

The Input option is selected by default under 
Select Point Type.  

 

4. Click OK. The Advanced (Network Input) dialog box 
appears. Refer Figure 167. 
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Figure 167: Advanced Screen of Network Input 

 

5. Fill the necessary information in the fields and click 
OK to complete adding an Object Input. The Object 
Input is displayed in the Objects table.  

 
Note:  

An Object Input cannot be added to a macro. 
Only a Software point can be added with Point 
Type as Constant to a macro. A Network Output 
cannot be added to a macro. 

Exposing an Object Input from the Object 
Configuration View 
To expose the Object Inputs those are added:  

1. Select the object that needs to be displayed on the 
wiresheet from the object table and click the Show 
on wiresheet as Points button.  
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Figure 168: Add points Screen 

OR 
Drag the object user wants to display on the 
wiresheet on to the Software Points available on 
wiresheet list at the bottom of the Object 
Configuration View. The Add Points dialog box 
appears.  

2. Click OK. The object that is selected appears on the 
Software Points available on wiresheet list at the 
bottom of the view. The field name displays the 

combination of NV Name and Field Name 
information (Click Edit Point button, then Advanced 
button for more information). If point is not selected to 
be displayed on the wiresheet, then the Object is 
added but is not visible on the wiresheet.  

3. Click Cancel if do not wish to continue adding an 
Object Input.  

Table 60 shows screen details as shown in Figure 169 

 
Figure 169: Edit NV Name Screen 
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Table 60: Fields of Expose the Object Inputs 

Name Definition 

Object Name It indicates the name of the Object Input. This field is editable. 

Object Type It indicates if the object input is of type AV, BV or MSV. This field is non-editable. 

Object 
Instance 

Indicate a unique number that is automatically assigned to the object. This field is editable. 
If it is required replace the instance value with a value of choice, then the replacement is 
successful only if the value of choice is not in use by any other object. 

Update 
Interval 

The rate at which the controller compares the last value propagated to the network against 
the current value to determine whether significant change has occurred that warrants the 
new value to be propagated. Since 'NetoworkInput' objects are never propagated back to 
the network, it is recommended that this value should be let at the default value of 15 
seconds. 

Object 
Category 

Displays the unit of measurement for the object input. 

Unit Displays the engineering unit based on the object category. 

Sub-
Category 

Display the enumeration type for the object inputs. The field Unit is renamed as  
Sub-Category if the object category selection is unitless. 

Fail Detect 
Enabled 

Set the Fail Detect Enabled to either True or False.  

• True means if the object is bound and has not received an update from the BACnet 
network source in the fail detects time, then an alarm is generated and the 
presentValue is set to Invalid. Note that fail detect time depends on the update rate 
configured. 

• False means the object retains the last value that was written to it until a BACnet 
network source change it or the Honeywell Spyder has a power outage or resets.  

Update Rate This is the rate at which the object expects an update from the BACnet network. When 
'Fail Detect' is enabled, the controller will report an alarm if 5 consecutive updates are not 
received. 

If binding is accomplished by polling the source device, then the poll rate is set to the 
configured 'Update rate'. If 5 successive polls fail, then the controller will report an alarm. 

(Refer the 'Poll/Push' column in the 'Bacnet Link Manager View'). 

 

Adding an Object Input From 
honeywellSpyderTool Palette 
While in the midst of creating a 
ControlProgram/Application, if an Object Input is 
required to add quickly, use the NetworkInput item on 
the honeywellSpyderTool palette.  

 
Note:  

An Object Input cannot be added to a macro. 
Only a Software point can be added with Point 
Type as Constant to a macro.  

To add an Object Input to a 
ControlProgram/Application:  

1. On the honeywellSpyderTool palette, expand the 
SoftwarePoints folder. If the Spyder Palette is not 
visible on the left side of the screen, then on the 
Menu bar, click Windows > Sidebars > Palette to 
display the Palette.  

2. Drag a NetworkInput to the wiresheet of a 
ControlProgram/Application. The Name dialog box 
appears. Refer Figure 170.  
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Figure 170: Enter Name for NetworkInput 

3. Type a name for the point and click OK.  

4. Right-click the Network Input point that is just added 
and select Configure Properties. The Configure 
Properties dialog box appears. Refer Figure 171. 

 
Figure 171: Configure properties Screen 

5. Select NetworkInput, ModulatingInput, or 
BinaryInput from the Point Type field.  

6. Type or select the following:  

• Point Name: Types a name for the point.  

• Point Category: Select a category.  

• Unit: Select the unit for the Point Category 
chosen.  

• Sub-Category: Select the enumeration type.  

• Value: This is disabled.  

7. Click the Advanced button. The Advanced (Network 
Input) dialog box appears.  

8. Fill the necessary information in the fields and click 
OK to return to the configure properties dialog box.  

9. Click OK to complete adding an Object Input.  

Connecting Object Inputs 
Once an Object Input is created, an Object Input can be 
connected to an Object Output/Function Block or 
Physical point by left-clicking on the output of an Object 
Input and dragging the mouse to the input of an Object 
Output/Function Block or Physical point. 

Object Setpoint 
The Object Setpoints are Analog Value Setpoint, Binary 
Value Setpoint and Multi-State Value Setpoint. 

Adding an Object Setpoint 
An NCI can be added from:  

1. Object Configuration View  

2. honeywellSpyderTool palette  

Adding an Object Setpoint from the 
Object Configuration View 
To add a new Object Setpoint:  

1. Browse to Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder.  

2. Select ControlProgram > Views > Object 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom Objects. Refer Figure 171. 

 
Note:  

If adding an Object Setpoint to an Application, 
browse through to the appropriate Application on 
the Nav palette. 

3. Click Add Object. The New Object dialog box 
appears. Select an Object Type (Analog Value, 
Binary Value, Multi-state Value). Refer Figure 172. 

 
Figure 172: Add Object Screen of BACnet Object 

4. Select the Select Point Type as Setpoint.  
5. Click OK. The Advanced (NetworkInput) dialog box 

appears. Refer Figure 173. 
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Figure 173: Advanced Screen Network Setpoint 

6. Fill the necessary information in the fields and click 
OK to complete adding an Object Setpoint. The 
Object Setpoint is displayed in the Objects table.  

 
Note:  

An Object Setpoint cannot be added to a macro. 
Only an Object Input can be added with Point 
Type as Constant to a macro. 

 

Exposing an Object Setpoint from the 
Object Configuration View 
To expose the Object Setpoints those are added:  

1. Select the object that needs to be displayed on the 
wiresheet from the object table and click the Show on 
wiresheet as Points button. 

OR 
Drag the object that needs to be displayed on the 
wiresheet on to the Software Points available on 
wiresheet list at the bottom of the Object 
Configuration View. The Add Points dialog box 
appears. Refer Figure 174. 

 
Figure 174: Add Points Screen 

2. Click OK. The selected object appears on the 
Software Points available on wiresheet list at the 
bottom of the view. The field name displays the 
combination of NV Name and Field Name 
information (Click Edit Point button, then the 
Advanced button for more information). If select point 
is not selected to be displayed on the wiresheet, the 
Object is added but is not visible on the wiresheet.  

3. Click Cancel if it is not required to continue adding an 
Object Setpoint. Refer Figure 175 
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Figure 175: Configure Properties Screen 

 

 

 

 

 

 

 

 

 

 

 

 

 
Table 61: Fields of Expose the Object Setpoints 

Name Definition 

Point Name Indicate the name of the Object Setpoint. This field is editable. 

Point Type Indicate if the object input is of type AV, BV or MSV. This field is non-editable. 

Point Instance Indicate a unique number that is automatically assigned to the object. This field 
is editable. When trying to replace the instance value with a value of choice, 
then the replacement is successful only if the value of choice is not in use by 
any other object. 

Update Interval The rate at which the controller compares the last value propagated to the 
network against the current value to determine whether significant change has 
occurred that warrants the new value to be propagated. 

If the NetworkSetpoint object is accessible for editing via the S-Bus wall 
module, then it is recommended that update interval be configured as 0 
second (which is the default value), else it is recommended to be configured as 
15 seconds. 

Point Category Displays the unit of measurement for the object setpoint. 

Unit Displays the engineering unit based on the object category. 

Sub-Category Display the enumeration type for the object inputs. The field Unit is renamed 
as Sub-Category if the object category selection is unitless. 

 

Adding an Object Setpoint from the 
honeywellSpyderTool Palette 
While in the midst of creating a 
ControlProgram/Application, if an Object Setpoint is 
required to add quickly, then use the NetworkSetpoint 
item on the Spyder Palette. 

 

 
Note:  

An Object Setpoint cannot be added to a macro. 
Only a Software point can be added with Point 
Type as Constant to a macro. An Object Output 
cannot be added to a macro. 

To add an Object Input to a 
ControlProgram/Application:  

1. On the honeywellSpyderTool palette, expand the 
SoftwarePoints folder.  
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Note:  

If the Spyder Palette is not visible on the left side 
of the screen, on the Menu bar, click Windows > 
Sidebars > Palette to display the Spyder Palette. 

 

2. Drag a NetworkSetpoint to the wiresheet of a 
ControlProgram/Application. The Name window will 
pop up. Refer Figure 176. 

 
Figure 176: Enter Name for Network Setpoint 

3. Type a name for the point and click OK.  

4. Right-click the Network Setpoint point that is just 
added and selects Configure Properties. The 
Configure Properties dialog box appears. Refer 
Figure 177. 

 
Figure 177: Configure Properties Screen 

5. By default, NetworkSetpoint is the Point Type. If it is 
not, select Network Point from the Point Type field.  

6. Type or select the following:  

• Point Name: Enter a name for the point. 

• Point Category: Select a category.  

• Unit: Select the unit for the Point Category 
chosen.  

• Sub-Category: Select the enumeration type. 

• Value: Enter a value based on the Point 
Category and Units fields chosen. 

7. Click OK to complete adding an Object Setpoint. 

Connecting Object Setpoints 
Once an Object Setpoint is created, user can connect a 
point of an Object Setpoint to an Object Output/Function 
Block or Physical point by left-clicking on the output of an 
Object Setpoint and dragging the mouse to the input of 
an Object Output/Function Block or Physical point. 

Object Output 
The Object Outputs (AVO, BVO, and MVO) convert input 
value(s) (Public Variable(s)) into a raw network variable 
output that is published onto the BACnet network. 

Adding an Object Output 
An Object Output can be added from:  

• Object Configuration View  

• honeywellSpyderTool palette  

Adding an Object Output from the Object 
Configuration View 
To add a new Object Output:  

1. Browse to Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder.  

2. Select ControlProgram > Views > Object 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom Objects. Refer Figure 165. 

 
Note:  

If adding an Object Output to an Application, 
browse through to the appropriate Application on 
the Nav tree. 

 

3. Click Add Object. The New Object dialog box 
appears. Refer Figure 178. 
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Figure 178: New Object Screen 

4. Select an Object Type (Analog Value, Binary Value, 
Multi-state Value).  

5. Select the Select Point Type as Output.  

6. Click OK. The Advanced (NetworkOutput) dialog 
box appears. Refer Figure 173. 

 
Figure 179: Advanced Screen of Network Output 

7. Fill the necessary information in the fields and click 
OK to complete adding an Object Output. The 
Object Output is displayed in the Objects table.  

Table 62 shows details as shown in Figure 179 

 
Note:  

An Object Output cannot be added to a macro. 

 

Table 62: Fields of Advanced (Network Output) Dialog Box 

Name Definition 

Object Name Indicate the name of the Object Output. This field is editable. 

Object type Indicate if the object input is of type AV, BV or MSV. This field is non-editable. 

Object Instance Indicate a unique number that is automatically assigned to the object. This field is 
editable. When trying to replace the instance value with a value of choice, the 
replacement is successful only if the value of the choice is not in use by any other 
object. 

Update Interval The rate at which the controller compares the last value propagated to the network 
against the current value to determine whether significant change has occurred that 
warrants the new value to be propagated. Update Interval works with SEN Delta to 
throttle back the information propagated to the network. 

The recommended value is 0 second. 
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Name Definition 

Sen Delta The delta value for Significant Event Notification is also known as SEN Delta.  

The controller refreshed/updated the ‘presentValue’ property of this object when the 
value changes by the configured SEN Delta. This can be used to tune the controller 
such that small changes of value are not propagated to the BACnet network.  

If this object is 'bound' to another controller, then the value is sent on the BACnet 
Network to the target controller whenever it changes by an amount exceeding the 
SEN Delta.  

A SEN Delta of zero means that any change of value is considered significant and is 
propagated to the network. 

Object Category It displays the unit of measurement for the object output. 

Unit It displays the engineering unit based on the object category. 

Sub-Category It displays the enumeration type for the object inputs. The field Unit is renamed as 
Sub-Category if the object category selection is unitless. 

GPU Set the GPU (guaranteed periodic update) to either True or False.  

• True means that the presentValue of the object has to be sent periodically (at the 
configured 'Send Heartbeat' rate) to the target controller that is bound, regardless 
of whether a significant change, as defined by SEN Delta, has occurred. 

• False means the presentValue is NOT to be sent periodically. The value will be 
sent to the target controller only based on the Sen Delta value configured.  

Send Heart Beat The rate at which a Network object value is sent to the network regardless of whether 
its value has changed or not. The send heart beat must be configured to be equal to 
or greater than the 'update rate' expected by the target controller. This value should 
be configured as multiples of 5 seconds only, else tool rounds it off to the nearest 
multiple of 5 during download. 

 

Exposing an Object Output from the 
Object Configuration View 
To expose the Object Output that is added:  

1. Select the object that needs to be displayed on the 
wiresheet from the object table and click the Show 
on wiresheet as Points button. 

OR 

Drag the object that needs to be displayed on the 
wiresheet on to the Software Points available on 
wiresheet list at the bottom of the Object 
Configuration View. The Add Points dialog box 
appears. Refer Figure 180. 
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Figure 180: Add Points Screen of Network Output 

 

2. Click OK. The object that is selected appears on the 
Software Points available on wiresheet list at the 
bottom of the view. The field name displays the 
combination of NV Name and Field Name 
information (Click Edit Point button, then the 
Advanced button for more information). If point is not 
selected to be displayed on the wiresheet, the Object 
is added but is not visible on the wiresheet. Refer 
Figure 181. 

 
Figure 181: Configure Properties Screen of Network 

Output 

3. Click Cancel to stop adding an Object Output.  

Adding an Object Output from the 
honeywellSpyderTool Palette 
While in the midst of creating a 
ControlProgram/Application, if an Object Output is 
required to add quickly, then use the Network Outputs 
item on the Spyder Palette. 

 
Note:  

An Object Output cannot be added to a macro. 

 

To add an Object Output to a 
ControlProgram/Application:  

1. On the honeywellSpyderTool palette, expand the 
SoftwarePoints folder. If the Spyder Palette is not 
visible on the left side of the screen, on the Menu bar, 
click Windows > Sidebars > Palette to display the 
Palette.  

2. Drag a NetworkOutput to the wiresheet of a 
ControlProgram/Application. The Name dialog box 
appears. Refer Figure 182. 

 
Figure 182: Enter Name for Network Output 

3. Type a name for the point and click OK.  

4. Right-click the Network Output point that is just added 
and select Configure Properties. The Configure 
Properties dialog box appears. Refer Figure 183 

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 170  

 
Figure 183: Configure Properties Screen of Network 

Output 

5. Select Network Output, Modulating Output, or 
Binary Output from the Point Type field.  

6. Type or select the following:  

• Point Name: Enter name for the point.  

• Point Category: Select a category. 

• Unit: Select the unit for the Point Category 
chosen.  

• Sub-Category: Select the enumeration type.  

7. Click OK to complete adding an Object Output 

Once an Object Output is created, an Object Output can 
be connected to an Object Input/Function Block or 
Physical point by left-clicking on the output of an Object 
Input/Function Block/Physical point and dragging the 
mouse to the input of an Object Output. 

Edit Objects 
Fixed Droppable Objects can be partially modified and 
totally modify Custom Objects. However, Mandatory and 
Fixed Objects cannot be modified. 

 
Note:  

If the only point in an object is deleted, then the 
Object itself gets deleted. 

 

Table 63 summarizes what can be or cannot be done 
with Objects in the Wiresheet and the Object 
Configuration View. Refer Figure 165.  

 

Table 63: Actions with Objects in the Wiresheet and Object Configuration View 

Type Show 
Object on 
wiresheet 

 Create  Edit  Delete  

 Wiresheet Object 
Config 
View 

Wiresheet Object 
Config 
View 

Wiresheet Object 
Config 
View 

Wiresheet Object 
Config 
View 

Object 
Input 

Object 
Setpoint 

Object 
Output 

Yes. 

Any Object 
added 
directly to 
the 
wiresheet is 
automatically 
displayed on 
the 
wiresheet 

Yes.  

An Object 
need to 
be added 
and 
select the 
points 
that 
needs to 
be 
displayed 
on the 
wiresheet 
by 
clicking 
the 
Display 
on 
Wiresheet 
button. 

Yes. 

User can 
add an 
object 
can be 
added 
with a 
single 
point. 

Yes. 

An 
object 
can 
be 
added 
with 
single 
point. 

Yes. 

An Object 
can be 
edited 
with a 
single 
point at a 
time. 

Yes. 

An 
Object 
can 
be 
edited 
with a 
single 
point 
at a 
time. 

Yes. 

An Object 
can be 
deleted with 
a single point 
at a time. 

Objects of 
Fixed 
Droppable 
type and 
Objects with 
Bit 
Configuration 
are not 
deleted, but 
only hidden 
from the 
wiresheet. 
They are still 
available in 
the Objects 
list. 

Yes. 

An 
Object 
can be 
deleted 
with a 
single 
point at 
a time. 
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To edit an Object:  

1. Browse Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder.  

2. Select ControlProgram > Views > Object 
Configuration View. The summary page appears 
with a list of pre-programmed Mandatory, Fixed, and 
Custom Objects and Software points.  
Refer Figure 165. 

3. Select the Fixed or Custom Object that needs to be 
edited and click the Edit Object button.  

4. The Edit Object Name dialog box appears. If the 
selected BACnet object is a Fixed Droppable Object 
type, user can only change the Internal Data Type 
and click OK to save the changes. Refer Figure 184 

 
Figure 184: Edit Object Name Screen 

If the object is Custom type, by default, the settings are 
such that Object Name, Object Type, Object Instance 
and Update Interval can be changed.  

5. Click OK to save the changes.  

Table 64 summarizes editing BACnet objects from the 
Wiresheet and Object Configuration View. Refer 
Figure 165. 

 

Table 64: Editing BACnet objects from the Wiresheet and Object Configuration View 

Object Type Action From Procedure 

Object Input/ 
ObjectSetpoint/ 
ObjectOutput 

Remove points from 
wiresheet 

Wiresheet A point cannot be removed 
(hide) from the wiresheet. 

 Remove points from 
wiresheet 

Object Configuration 
View 

1. Select the exposed fields 
from the Points available 
on wiresheet list.  

2. Click, Remove Points 
from wiresheet.  

3. Click OK to confirm.  
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Object Type Action From Procedure 

 Edit Object Wiresheet 1. Individual points of an 
object can be edited at a 
time.  

2. Right-click the individual 
point of an object and 
select Configure 
Properties.  

3. Edit the available fields 
and click OK to save the 
changes.  

 Edit Object Object Configuration 
View 

1. Individual points of an 
object can be edited at a 
time. 

2. Select the object from the 
Objects list on the right 
side of the screen on top.  

3. Click Edit Object and 
edit the point of the 
object.  

4. Click OK to save the 
changes made. 

 Delete Object Wiresheet 1. Individual points of an 
object can be deleted at a 
time. 

 Delete Object Object Configuration 
View 

1. An object with individual 
points can be deleted at a 
time. To delete an object 
with individual points: 

2. Select the object from the 
Objects list on the right 
side of the screen on top.  

3. Click Delete Object.  

4. Click OK to save the 
changes made. 

 

Deleting Objects 
To delete an Object:  

1. Browse to Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder.  

2. Select ControlProgram > Views > Object 
Configuration View. Refer Figure 165. The summary 
page appears with a list of pre-programmed 
Mandatory, Fixed, and Custom objects and Software 
points. 

3. Select the Custom object that needs to be deleted.  

4. Click the Delete Object button. A Delete 
Confirmation dialog box appears. Refer Figure 185 

 
Figure 185: Confirmation Box of Object 

5. Select: 

• Retain Point(s): To delete the object and make its 
exposed points (if any) as invalid points. 
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• Delete Point(s): To delete the objects and 
exposed points (if any). 

• Cancel to cancel the deletion.  

 
Note:  

While deleting an object, if Retain Point(s) option 
is selected, point of the object is converted to 
invalid point. The option to retain exposed points 
of deleted objects is available only from the 
Object Configuration View. The invalid points are 
displayed in the lower pane of the Object 
Configuration View. 

 

Deleting Points from Wiresheet 
If a software point is deleted from the wiresheet, then the 
object to which the point belonged to is modified such 
that the corresponding field is deleted. The object along 
with its point is deleted. 

Invalid Points 
An Object can be deleted without deleting its exposed 
points. Points of such Objects are converted to invalid 
points. This option is available only from the Object 
Configuration View. 

Objects can be copied and pasted from a source 
controller to a target controller. When an application 
folder containing point, but the object to which it belongs 
is present in the parent folder of the folder in which the 
points are present, is copied or cut and pasted to the 
target controller, the points become invalid. 

When an application folder containing objects whose 
points are exposed in its parent folder, is cut or copied 
and pasted to a target controller, the corresponding field 
(to which the exposed point belonged) is removed from 
the object. The object is deleted if the point happens to 
be the last field in the controller. 

However, an additional field is added to the object to 
make the object valid. 

 
Note:  

When an invalid object input, setpoint, or an 
output point is copied and pasted, the resulting 
points are also invalid. 
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BINDINGS OR DATA 
SHARING 
A binding refers to a configured association between 
LONWORKS® network variables (NVs) either within a 
device, or between separate devices on a Lon network. 

Data Sharing is the terminology that is used for Bindings 
in case of BACnet devices. 

 
Note:  

The terms network object and BACnet object are 
used interchangeably. 

 

Binding Lon Devices 
To bind two Lon Devices in honeywellSpyderTool:  

1. Right click Lon Network in the Nav tree and select 
Views > Wire sheet. Refer Figure 186. All devices on 
the Lon Network are displayed as containers on the 
wire sheet. 

 
 

Figure 186: Views > Wire Sheet Option 

2. Right click the source device container and select 
Link Mark. Refer Figure 187. 

 
 

Figure 187: Link Mark Option of Source 

3. Right click the target device container and select Link 
From source device name. Refer Figure 188.The 
Add Binding dialog box appears. Refer Figure 189. 

 
 

Figure 188: Link From Option of Source 

 
 

Figure 189: Add Binding Screen of Lon 

4. Click the NV of the source controller that needs to be 
linked. The pane showing the target NVs highlights 
NVs with which the source NV can be bound.  

5. Select the NV from the target device pane which are 
required to link the source NV. 

6. Click OK. A link appears on the wire sheet between 
the source and target controllers. 

7. Right click Lon Network in the Nav tree and select 
Views > Lon Link Manager. Refer Figure 190. A row 
providing the link details appear.  
Refer Figure 191. 

 
Figure 190: Views > Lon Link Manager Option 
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8. Select the row and click Selective Bind to complete 
binding NVs between a source and target controller. 
Figure 192 shows bound objects. 

Also, Bind option can be used for binding all the links 
in one go. 

 
 

 
Figure 191: Link Status_New Link 
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Figure 192: Bounded Objects 

When the operations are performed such as, 
add/delete/modify NVs in ControlProgram, the changes 
are not reflected to NVs under Lon Spyder device until a 
download operation is performed or click Generate NVs.  

Generate NVs option recreates the NVs under the 
device as per the NVs in the ControlProgram of that 
device. It is not necessary to be online for the Spyder 
device to use this option for the Spyder device, online 
status is not essential. Lon bindings can be set up offline 
involving Spyder devices and bind the devices when the 
Spyder devices are online. This feature is useful for 
offline engineering. 

Binding BACnet Devices 
To bind two BACnet devices in HoneywellSpyderTool:  

1. Right click Bacnet Network in the Nav tree and 
select Views > Wiresheet. Refer Figure 193.All 
devices on the Bacnet Network are displayed as 
containers on the wiresheet. Refer Figure 194. 

 
Figure 193: Views > Wire Sheet Option 
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2. Right click the source device container and select 
Link Mark. Refer Figure 194. 

 
Figure 194: Link Mark Option of Source 

3. Right click the destination device container and select 
Link To. Refer Figure 195. The Add Binding dialog 
box appears. Refer Figure 196. 

 

Figure 195: ‘Link To’ Option for Destination Device 

 
Figure 196: Add Binding Screen of BACnet 

4. Click the Object of the source controller that needs to 
be linked. The pane showing the destination objects 

highlights the objects with which can be bound the 
source object.  

5. Select the Object from the destination device pane to 
which needs to be linked to the source object.  

 
Note:  

The Object Properties of the source device 
shows PresentValue. This implies that the 
present values of the object input or object 
output is taken as input to the control logic. 

The Object Properties of the destination device 
shows Present Value for all objects except AO 
and BO. When an AO or BO object is selected 
as a destination object, Object Properties 
displays the priority array index from 1 to 16. The 
priority can be set value for the destination 
object.  

If an AO and BO object is set as the source 
objects, then their present value is taken as input 
to drive the logic.  

AO and BO object types can act as both source 
and target. 

 

6. Click OK. A link appears on the wiresheet between 
the source and destination controllers.  

7. Right click Bacnet Network in the Nav tree and 
select Views > Bacnet Link Manager. Refer Figure 
197. A row providing the link details appear.  

 
Figure 197: Views > Link Manager Option 

8. Select the row and click Bind to complete binding 
Objects between a source and destination controller.  

 
Note:  

Binding cannot be done if both source and 
destination devices are third party BACnet 
devices. At least one of them must be a Spyder 
device.  

1. AI, BI, AV/BV/MSV (setup as 
NetworkOutput) can act as source objects to 
the device. 

2. AV/BV/MSV (setup as NetworkInput) can act 
as destination objects to the device. 

3. Only the custom BACnet objects are 
displayed in the Add Binding dialog box for 
binding devices. The mandatory and fixed 
objects are not available for binding. 
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Unlike Lon, the objects will not be present under the 
device level until Generate Network Objects is clicked 
on the BACnet Spyder device. This option creates a 
BACnetObjectReferences for network objects in the 
ControlProgram. 
When a new network object is added, perform Generate 
Network Objects so that the corresponding 
BACnetObjectReference is added at the BACnet 
Spyder device level. 
When operations are performed such as delete/modify 
Network Objects in the ControlProgram, 
BACnetObjectReferences are automatically updated. 
Generate Network Objects option recreates the 
BACnetObjectReferences under the device as per the 
BACnet Objects under ControlProgram of that device. 
Users do not have to be online for the Spyder device to 
use this option. Offline BACnet data sharing links can be 
set up involving Spyder devices and bind the devices 
when the Spyder devices are online. This feature is 
useful for offline engineering. 

About BACnet Link Manager 
Using Bacnet Link Manager view, the binding of Spyder 
devices can be managed. The view also provides the link 
details of the BACnet devices. 
The following link details are displayed in the Bacnet Link 
Manager view.  
• Link Status: Displays the current status of each link 

as NewLink, Bound, or Obsolete. For more details, 
refer “Types of Link Status”.  

• Device Status: Displays the status of the device as 
Downloaded, To be downloaded, or Offline. If the 
device status is Downloaded, it indicates that the 
bindings are downloaded to the controller. To be 
downloaded indicates that the download is pending. 
If the device status is Offline, it indicates that the 
device is not downloaded to the controller.  

• Source Device: Displays the name of the source 
BACnet device whose output is linked or bound to the 
target BACnet device.  

• Source Object: Displays the name of the BACnet 
object in the source device.  

• Source Property: Displays the object property of the 
source object.  

• Target Device: Displays the name of the target 
BACnet device.  

• Target Object: Displays the name of the BACnet 
object in the target device. 

• Target Property: Displays the object property of the 
target object. The object property of the target device 
shows PresentValue for all objects, except AO and 
BO. When an AO or BO object is selected as a target 
object, target property displays the priority selected.  

• Poll or Push: Spyder BACnet devices use a 
poll/push mechanism to share data on the network. 
Every Spyder BACnet device has 1 poll table and 1 
push table, the size of each being 256. The tool 
automatically decides the poll/push mechanism when 
a link is added. The push table on the source Spyder 
is filled first and when there are no spare entries in 
the push table, the poll table on the destination device 
is used.  

When there is binding between a Spyder and a third 
party device, the push/pull table will be in the Spyder 
device. Its use depends on whether it is a source or a 
target device. The status Poll implies that the target 
device would poll the value periodically from the 
source device used in binding. The interval for polling 
is the Update Rate configured on the destination 
object. The status Push implies that the source 
device would push the value periodically to the target 
device. The interval for pushing the data is the GPU 
interval configured on the source object. The 
mechanism cannot be selected to be used for 
binding.  

Opening BACnet Link Manager View 
To access the Bacnet Link Manager view:  

• Right click Bacnet Network in the Nav tree and 
select View > Bacnet Link Manager.  
Refer Figure 197. 

BACnet Link Manager Commands 
The following commands are available in the BACnet 
Link Manager view- 

1. Add 
Click Add, to bind two Spyder BACnet devices, or 
bind a Spyder BACnet device and a third party 
BACnet device. It will bind objects. Refer Figure 198. 
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Figure 198: Add Two Devices 

 
Figure 199: Link Status_New Link  
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Figure 200: Bounded Objects 

2. Delete 
Click Delete, to delete the links from the database. 
The link status changes to Obsolete after the 
deletion, to indicate that the link is deleted only in the 
database. Click Bind, to remove the binding 
information from the controller. 

3. Refresh 
Click Refresh, to refresh the status of the bindings 
between the devices. The link status is displayed as 
NewLink, Bound, or Obsolete, depending on 
whether the link is downloaded to the device or is yet 
to be downloaded.  

4. Bind 
Click Bind, to download the binding information to the 
devices. The link status is updated, after the Bind 
option is invoked.  

5. Selective Bind 
Click Selective Bind, to download the binding 
information selectively to one or more devices. 

6. Learn Link(s) 
Click Learn Link(s), to learn the binding information 
from the devices. The link status is updated, after the 
binding information is retrieved from the device. On 
clicking Learn Link(s), all obsolete links are marked 
as Bound. The NewLinks that are not yet 
downloaded to the controller are retained. 

 

 
Note:  

At any point, for Learn Link(s) to restore the link 
status from a Spyder BACnet device, the device 
has to be in downloaded state, that is, the 
application in ControlProgram of the source 
device in Niagara should match that in the online 
device. Otherwise, Learn Links(s) does not learn 
links from that device. 

The application in the target device involved in 
data sharing in Niagara does not have to match 
that in the online device. 

 

7. Clear Bindings 

Click Clear Bindings, to clear all the links from the 
device. The links that are in Bound and Obsolete 
states are marked as NewLink.  

Types of Link Status 
Each link or binding in the Bacnet Link Manager view 
appear with a status in the LinkStatus column. The links 
show one of the following statuses assuming there is no 
error.  
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• NewLink: If links are created between two or more 
devices and are not downloaded to the device, shows 
NewLink type.  

• Bound: If links are created between, two or more 
devices and also are downloaded to the device. On 
clicking the Bind button on the Bacnet Link Manager 
view, all the links with a status as NewLink are 
converted to Bind.  

• Obsolete: If links that are downloaded to the device 
are deleted shows Obsolete type. All links with a 
status as Bound are changed to Obsolete when the 
Delete button is clicked on the Bacnet Link Manager 
view. On clicking the Bind button on the Bacnet Link 
Manager view; all links with a status as Obsolete are 
deleted. 

Error Conditions 
Errors and warnings may occur while attempting to 
change or modify data when the devices are bound. The 
following are some of the error conditions.  

• After the devices are bound, a break in 
communication between the devices causes a 
Network Communication alarm, which is displayed 
in the Error View.  

• If the GPU rate of the source or target device is 
changed after the links are downloaded to the device, 
then a warning message appears suggesting that 
download the links once again to the device. In the 
Bacnet Link Manager view, the links with the status 
as Bound are changed to NewLink.  

• If the GPU rate on the source is greater than the 
update rate on the target, a warning message 
appears.  

• When changing a point type results in the change of 
the BACnet object type, a warning message appears 
to delete the links. It may not be possible to bind the 
new object type with the existing objects.  

• When editing BACnet objects from the Object 
Configuration View, the links with status as Bound 
is changed to NewLink.  

• If the source and target devices are third party 
devices, an error message appears. 

Add Bindings 
Add Bindings allows binding of two devices wherein at 
least one device is a Spyder device. Two devices can be 
bound in any one of the following ways.  

1. A Spyder source device with a Spyder target device  

2. A Spyder source device with a third party target  

3. A third party source device with a Spyder target 
device  

The Spyder device can be selected under the Source 
Details or the Target Details section. 

1. Perform the following to bind two Spyder devices.  

a. Select a Spyder BACnet source device from the 
Device list.  

b. Select the source object from the Object list. 

 
Note:  

Click  icon (Refer Figure 198) to select 
an object from the most recently used objects for 
data sharing. 

c. Select presentValue from the Property list.  

d. Select a Spyder BACnet destination device from 
the Device list.  

e. Select the destination object from the Object list.  

f. Select presentValue from the Property list when 
the destination object type is AV, BV, and MSV. 

OR 

Select the priority value from the Property list when the 
destination object type is AO or BO. A priority value from 
1 to 16 can be set for the destination object.  

 
Note:  

The priority index selected for binding in case of 
a destination device should be different from the 
priority index being driven by the 
ControlProgram logic. 

g. Click OK to bind the two devices.  

2. Perform the following to bind a Spyder source device 
with a third party destination device.  

a. Select a Spyder source device from the Device 
list.  

b. Select the source object from the Object list.  

c. Select presentValue from the Property list.  

d. Select a third party destination device from the 
Device list.  

e. Select the destination Object Type from the list.  

f. Type the object instance number in the Object ID 
text box. A default Object Name is provided for 
the destination object.  

 
Note:  

The Object Name can be edited 
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g. Select presentValue from the Property list when 
the destination object type is AV, BV, and MSV. 

OR 

Select the priority value from the Property list 
when the destination object type is AO or BO. A 
priority value from 1 to 16 can be set for the 
destination object.  

h. Click OK to bind the two devices.  

3. Perform the following to bind a third party source 
device with a Spyder destination device.  

a. Select a third party source device from the 
Device list.  

b. Select an Object Type from the list.  

c. Type the object instance number in the Object ID 
text box. A default Object Name is provided for 
the destination object.  

 
Note:  

The Object Name can be edited.  

 

d. Select presentValue from the Property list. The 
present value of the source object is taken by 
default.  

e. Select a Spyder BACnet destination device from 
the Device list.  

f. Select the destination object from the Object list.  

g. Select presentValue from the Property list when 
the destination object type is AV, BV, and MSV. 

OR 

Select the priority value from the Property list 
when the destination object type is AO or BO. A 
priority value from 1 to 16 can be set for the 
destination object.  

 
Note:  

The priority index selected for binding in case of 
a destination device should be different from the 
priority index being driven by the 
ControlProgram logic. 

h. Click OK to bind the two devices.  

 
Note:  

Binding cannot be done if both source and 
destination devices are third party BACnet 
devices. An error message "Cannot create the 
link. Both are non-bondable devices." appears, if 
binding of two third party devices are tried. 

Binding JACE and Spyder 
A JACE can behave as a BACnet device. Points from 
Spyder and JACE can be bound to reduce the number of 
polls needed to read or write values to the point on the 
MSTP network. 

Configuring BACnet Device 
The Local Device in the BACnet network is being added 
to the network.  

1. Expand Config > BacnetNetwork > Bacnet Comm 
> Network in the Nav side bar. 

2. Right-click MstpPort and select Actions > Enable. 
Double click the MstpPort. The Property Sheet on 
the right pane displays the details of the Mstp port. 
The details include Network Number and Mstp 
Address. 

3. Drag a BACnet device from the BACnet palette onto 
the Nav side bar. For details, refer "Adding a 
Controller" under “Getting Started”. 

4. Type a name for the device that is added and click 
OK. 

5. Right-click the newly added BACnet device in the 
Nav tree and select Views > Property Sheet. 

6. Type the Network Number as specified in the 
BACnet Local Device > Mstp Port into the Network 
Number text box of the Address property.  

7. Type the MAC Address as specified in the Bacnet 
Local Device > Mstp Port > Mstp Address in the 
MAC Address text box of the Address property. 

8. Set, MAC Address Style as MSTP/Other. 

9. Now, the JACE is configured to work as BACnet 
device. To enable binding between Spyder and 
JACE, refer “Binding BACnet Devices”. 

 

For details, refer the “About BACnet server access” 
section on the Niagara Help set for more details on 
monitoring points by binding JACE and Spyder controller. 

By default, the BACnet driver provides read access to all 
exposed objects from third party BACnet devices. 

To enable write access to exposed objects from third 
party BACnet devices, it should be ensured to have the 
necessary permissions to those objects. To allow write 
access, the Super User option must be enabled in the 
Property Sheet of the user service. 

For details, refer "About BACnet server access" on the 
Niagara Help set for more details on allowing write 
access from BACnet. 
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FLOW CALIBRATION 
The flow balancing view is used to balance a Spyder 
controller that is programmed with a standard VAV 
application. Based on the version of the VAV application 
and its features, the following operations can be 
performed on the view. 

• Flow pressure zero calibration  

• Two point calibration 

• K factor calibration  

• Heating coil water flow calibration 

 
Note:  

Flow balancing is supported via the browser. 
Flow Balancing can be performed from the 
browser even if embedded work bench admin 
license is not available. 

 

Pre-requisites  
1. The Spyder controller must be online. 

2. The Spyder controller must be in a commissioned 
state. 

3. VAV Zone Terminal Single Duct must be selected 
as the Application Type and Air Balance 
Supported must be selected. 

 

 
Note:  

The selections must be done before downloading 
the program to the Spyder controller. 

 

4. The option to calibrate the reheat valve is available 
when Reheat Valve Override Supported is selected.  

5. The option to calibrate the peripheral heat valve is 
available when Peripheral Heat Valve Override 
Supported is selected.

 
Figure 201: Flow Calibration Window 
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Procedure  
1. On the Nav tree, browse Station > Config > Drivers 

> LonNetwork > LonSpyder. 

OR 

Browse Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder 

2. Right click LonSpyder and select Views > Flow 
Balancing View. The Flow Balancing View appears 
on the right pane. 

 

Figure 202: Views > Flow balancing View Option 

 

Table 65: Fields of Flow Balancing View 

Name Description 

Actuator Travel Time The actuator travel time is the time required by the actuator to travel from 0% to 
100% open or 100% to 0% open. This time interval depends on the actuator type 
and can vary from 0 - 500 sec. 

K Factor The value of K factor varies the air velocity. This field allows changing the K 
factor value manually. 

Inlet Area Display the area of the duct. Either a standard diameter can be selected or a 
custom area can be entered in this field. 

Measured Flow Display the actual air flow when measured by the balancer using an accurate 
device. This field is editable. 

Maximum Flow 
Setpoint 

This field allows setting the flow setpoint for maximum flow calibration and K 
factor calibration. The controller seeks stable flow and when it is reached, it 
allows user to set the calibration source value. 

Minimum Flow 
Setpoint 

This field allows setting the flow setpoint value which must be less than the 
maximum value to obtain minimum flow calibration. The controller seeks stable 
flow and when it is reached, it allows setting the calibration source value. 

Re-heat Valve 
Override 

This allows overriding the value of the reheat valve in an application built for the 
reheat valve. This field is visible when the Reheat Valve Override Supported 
feature is selected in the Details View of the ControlProgram. 

Peripheral Heat Valve 
Override 

This allows overriding the value of the peripheral heat valve in an application built 
for the peripheral heat valve. This field is visible when the Peripheral Heat Valve 
Override Supported feature is selected in the Details View of the 
ControlProgram. 

Device Mode Display the current device mode. This is a non-editable field. 

Damper Position Display the current damper position. This is a non-editable field. 

Sensed Flow Display the actual air flow that is measured by a pressure sensor. This field is 
non-editable. 

Flow Pressure Display the current flow pressure. This field is non-editable. 

 

The values can be typed into the following field. 

Flow pressure zero calibration 
To start zero balancing calibration method: 

• Click on Start Zero Balancing. 

The damper is completely closed. If any flow pressure is 
detected the value is considered to be a flow pressure 
offset. After the completion of zero balancing, the device 
mode is set to automatic operation. 
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Two point calibration 
The device can be set to either maximum or minimum 
balancing in any order. The tool does not enforce any 
rules on the order of balancing. 

Maximum calibration 

To start maximum calibration method: 

• Click Start Maximum Balancing. 

The device adjusts the damper to try and attain the 
maximum flow setpoint. After the setpoint is attained, the 
Measured Flow field is enabled and the actual 
measured flow value can be entered. The device 
remains in manual mode (Open Maximum) after 
maximum balancing is complete. 

Minimum calibration 

To start minimum calibration mode calibration method: 

• Click Start Minimum Balancing. 

The device adjusts the damper to try and attain the 
minimum flow setpoint. After the set point is attained, the 
Measured Flow field is enabled and the actual 
measured flow value can be entered. The device 
remains in manual mode (Open Minimum) after minimum 
balancing is complete. 

K Factor calibration 
To start K factor calibration method: 

• Click Start K Factor Balancing. 

After a warning message, the two point calibration data is 
returned to factory defaults. 

The device adjusts the damper to try and attain the 
maximum flow setpoint. After the setpoint is attained the 
Measured Flow field is enabled and the actual measured 
flow value can be entered. 

After the measured flow is entered, the K factor value is 
calculated by the tool and displayed. The tool prompts 
the writing of this value to the device. To calculate the K 
factor can be selected without using the tool and set the 
calculated value in the K factor field. The device remains 
in manual mode (Open Maximum) after K factor 
balancing has completed. 

Heating coil water flow calibration 
To override the reheat valve position: 

• Type the reheat value in percentage and click the 
Override button next to Reheat Valve Override field. 

To override the peripheral heat valve position: 

• Type the peripheral heat value in percentage and 
click the Override button next to Peripheral Heat 
Valve Override field. 

 
Note:  

Click the Auto button to set the reheat and 
peripheral heat valve into automatic operation. 
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FUNCTION BLOCKS 
Function blocks are the library of the objects used to 
implement any custom application logic for wide variety 
of HVAC applications. A Function blocks has inputs and 
outputs. Function block receives inputs from physical 
inputs, network inputs or from output of another block. 
They processes received input data and produces 
output. Processing depends upon the Function block 
type. 

All Function blocks are available in 
HoneywellSpyderTool palette. 

Function Blocks are classified into six categories. They 
are:  

• Analog Function Blocks  

• Logic Function Blocks  

• Math Function Blocks  

• Control Function Blocks  

• Zone Arbitration  

• Data Function Blocks 

• BuiltIn 

• Utility 

 

Refer Figure 203 for available Function blocks and 
objects of the honeywellSpyderTool. 

 
Figure 203: Function Blocks 

 

Procedure to add Lon or BACnet 
controller 
To add BACnet controller: 

1. Select the BACnetSpyder form the 
HoneywellSpyderTool and drag it on to 
BacnetNetwork. 

2. Name window will appear. Name the controller and 
click OK. The Spyder controller will appear on the 
BACnet trunk. 

To add Lon controller: 

1. Select the LonSpyder form the 
HoneywellSpyderTool and drag it on to 
LonNetwork. 

2. Name window will appear. Name the controller and 
click OK. The Spyder controller will appear on the 
Lon trunk. 

Add Function Block 
To add a function block:  

1. Display the Spyder palette (If honeywellSpyderTool 
is not visible in the palette on the left pane. On the 
Menu bar, select Window > Side Bars > Palette). 
The Spyder palette is displayed with the following 
items:  

• Physical Points: Modulating and Binary 
Inputs/Outputs 

• SoftwarePoints: Constant/Network 
Input/Setpoint/Output. Use this to create NVI, NCI, 
NVO, or constants. 

• Analog: Analog function blocks 

• Logic: Logic function blocks 

• Math: Math function blocks 

• Control: Control function blocks 

• DataFunction: Data Function blocks 

• ZoneArbitration: Zone Arbitration function blocks 

• BuiltIn: BuiltIn function blocks 

• Utility: Utility function blocks 

− Macro: A Macro is a group of functional 
blocks grouped together that define a specific 
functionality. Commonly used programs 
elements can be defined as macros so that 
they could be reused across applications. 

− Application: This includes macros and logic 
that can be defined and use in applications. 

2. Expand the LonSpyder or BACnetSpyder device in 
the Nav tree and select the ControlProgram folder.  
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3. Drag and drop the desired function block on to the 
wiresheet.  

4. Enter the name of the function block and click OK. 
The function block is added and it appears on the 
wire sheet. 

 
Note:  

A total of 100 function blocks are supported in 
the Lon Spyder I, Spyder II, and BACnet Spyder 
models. Spyder Lon Micro and Spyder BACnet 
Micro models support 200 Function blocks. 

• Lon Spyder I models are: PVL6436A, 
PVL6438N, and PUL6438 

• Lon Spyder II models are: PVL 6436AS, 
PVL 6438NS, and PUL 6438S 

• Lon Spyder Micro models are: PVL4024NS, 
PVL4022AS, PUL4024S, PUL1012S, and 
PVL0000AS 

• BACnet Spyder Micro models are: 
PVB4024NS, PVB4022AS, PUB4024S, 
PUB1012S, and PVB0000AS 

• BACnet Spyder models are: PVLB6436AS, 
PVB 6438NS, and PULB6438S 

Configure Function Block 
Complete the following procedure to configure a function 
block:  

1. Add the desired function block to the wiresheet of an 
Application Logic, Program or Macro. Refer Adding a 
Device and Adding a Function Block for more details.  

2. Right-click the function blocks on the wiresheet and 
select Configure Properties. A dialog box with the 
configuration details appears.  

3. Enter information in the available fields. 

Click Apply to save the changes  

OR 

Click OK to save the changes and close the dialog 
box.  

4. Click Cancel to revert to the last saved settings and 
close the dialog box.  

Delete Function Block 
To delete a function block: 

1. On the wiresheet, select the function block that needs 
to be deleted. 

2. Click the Delete button on user’s keyboard or right-
click the function block and select Delete. The 
function block is deleted along with bindings to it, if 
any. 

Removing non-required Pin Slots 
Every function block has inputs and outputs. Many times 
all these inputs and outputs are not required in the logic. 
In such situations, user can remove unwanted pins of the 
function block. 

Procedure to remove unwanted pin slots from the 
function block: 

1. Right click on the function block and select Pin Slots. 
Pin slots window will open. 

2. Click on the pins which are not required and click 
OK. Block will appear on the wiresheet without those 
pins. 

Example: As shown in Figure 204, AND function block 
with only in1 and in2 inputs are connected. From in3 to 
FalseDelay inputs are not utilized.

 

 
Figure 204: AND function block with all inputs
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After removing the pin slots, the logic appears as shown 
in the Figure 205. 

.

 
Figure 205: AND function block with required inputs
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ANALOG FUNCTION BLOCKS 
The honeywellSpyderTool provides the following 
Analog function blocks that can be configured and use to 
build the application logic: 

• Analog Latch 

• Average 

• Compare 

• Encode 

• Hysteretic Relay 

• Maximum 

• Minimum 

• Priority Select 

• Select 

• Switch 

Analog Latch 
This function latches the Y output to the value on the X 
input when the latch input transitions from FALSE to 
TRUE. The output is held at this value until the next 
FALSE to TRUE transition. At each FALSE to TRUE 
transition the Y output is latched to the current X input.  

 

 

Logic Diagram Function Block 

Figure 206: Analog Latch 

Logic Inputs 
Table 66: Logic Inputs of Analog Latch 

Input 
Name 

Input 
value 

Logic 
Value 

Description 

latch unconnected 0 Output remains 
at zero as there 
is nothing to 
cause a latch. 

 VAL != 0.0 1 Latch the input 
X to the output 
on FALSE to 
TRUE 
transitions (no 
negation) 

 invalid 0 Output remains 
as it was. 
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Analog Inputs 
Table 67: Analog Inputs of Analog Latch 

 Range   

Input Name Low High Input Value Description 

x >= –infinity < +infinity unconnected X = invalid 

   invalid X = invalid 

 

Output 
Table 68: Output of Analog Latch 

Output Name Range Description 

Y Any floating point value The value from X when the latch input goes 
from FALSE to TRUE 

 

 
Note:  

If both the X and latch inputs are unconnected, 
the output will be zero.  

If the input is invalid, the output will transition to 
invalid when the latch input goes from FALSE to 
TRUE.  

The latch input can be negated to cause a TRUE 
to FALSE transition to latch X to Y.  

From iteration to iteration of the Analog Latch 
keeps track of the last state of the latch input so 
that it knows when a FALSE to TRUE transition 
occurs.  

On power up/reset the last latch value is set to 
FALSE, regardless of the negation configuration. 

Example: An illustration to explain the behavior 
of the Analog Latch 

Example: 

Figure 207 illustrates the operation of Latch function 
block. 
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Figure 207: Behavior of the Analog Latch

Average 
This function block calculates average of 8 inputs. Inputs 
to this block could be from physical inputs, network 
inputs or outputs of their function blocks. Output is set to 
the average value of inputs. 

 

 

 

 
 

Logic Diagram Function Block 

 

Figure 208: Average Function
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Note:  

The Output returns an invalid value if no inputs 
are connected or if all inputs are invalid. 

 

Ignore invalid inputs: If this option is selected, function 
block will consider only valid inputs while determining the 
average of the inputs. If this option is not selected, and 
any input become invalid then, output also becomes 
invalid.  

 
Note:  

This option is not supported in the Lon models 
PVL6436A, PVL6438N, or PUL6438 and 
therefore this configuration cannot be 
downloaded to those models. 

 

Inputs 
Table 69: Inputs of Average Function 

 Range   

Input Name Low High Input Value Description 

in1-8 >= –infinity < +infinity unconnected Not used in calculation 
if all inputs unconnected then 
output = invalid  

in1-8 >= –infinity < +infinity invalid If any input is invalid then  
output = invalid 

 

Outputs 
Table 70: Outputs of Average Function 

Output 
Name Range Description 

OUTPUT Any floating point 
number 

Average of 
the inputs 

 

 

 

 

Compare 
This function compares two inputs to each other. 

 
 

Logic Diagram Function Block 

Figure 209: Compare Function 
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Note:  

It is possible to create invalid numbers by 
combining large values of input 2 and on and off 
hysteresis. The behavior is dependent on the 
operation selected, value of input 1, and the 
compiler. (That is, the simulator may have a 
behavior different from the product). 

 

The following comparison calculations can be made 
using the Compare function block:  

• Input1 less than input2 

• Input1 greater than input2 

• Input1 equal to input2 

Additionally, ON and OFF hysteresis analog inputs are 
provided which can be used to make compare 
calculations. 

 
Note:  

The Output returns an invalid value if no inputs 
are connected or if all inputs are invalid. 

 

Inputs 
Table 71: Inputs of Compare Function 

 Range   

Input Name Low High Input Value Description 

input1-2 >= – infinity < +infinity unconnected out = 0 

   invalid out = 0 

onHyst 0 < +infinity unconnected val = 0 

   invalid val = 0 

offHyst 0 < +infinity unconnected val = 0 

   invalid val = 0 

 

Setpoints 
Table 72: Setpoints of Compare Function 

Name Range Value Description 

Operation Equals • The output is set to TRUE if (Input 2 – On Hyst) <= input 1 <=  
(Input 2 + Off Hyst) 

 Less Than • The output is set to TRUE if Input 1 < (input 2 – on Hyst) 

• The output does not change if (Input 2 – on Hyst) <= input1 less 
than (Input 2 +off Hyst)  

• The output is set to FALSE if Input1 >= (Input 2 + off Hyst) 

 Greater Than • The output is set to TRUE if Input 1 > (input 2 + on Hyst) 

• The output does not change if (Input 2 – off Hyst) <  input1 <= (Input 
2 + on Hyst) 

• The output is set to FALSE if Input1 <= (Input 2 - off Hyst) 
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Outputs 
Table 73: Outputs of Compare Function 

Output Name Range Description 

OUTPUT FALSE (0) or 
TRUE (1) 

• Comparison of inputs 

  • If Property Negate is selected, the output is negated after performing 
the logic. The sense of the hysteresis settings does not change. 

• When negation is selected, the old output (from the previous cycle) 
is determined by negating the current value of the output. 

Encode 
This function translates enumerations of a digital value 
into different enumeration numbers, allowing standard 
and custom enumerations to be combined and used 
together. 

 

 

If the value of ‘InENum’ input is not matching with any of 
the in1 to in9 values, then Output value is equal to the 
value of InEnum input and FIRE output is equal to 
FALSE. If Disable input is TRUE, then the Output value 
is equal to InEnum input.

 

 

Logic Diagram Function Block 

 

Figure 210: Encode Function 
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Analog Inputs 
Table 74: Analog Inputs of Encode Function 

 Range   

Input Name Low High Input Value Description 

inEnum  0  255 unconnected  Val = 0 

invalid  Val = 0 

Val matches an 
input value 

Output = matching input’s 
output value 

Val matches two or 
more input values 

Output = matching input’s first 
output value 

Disable 0 255 Unconnected val = 0 

invalid val = 0 

VAL != 0 All mappings disable, pass 
input to output  

Val=0 Enable mappings 

In 1, 2, 3 0 All mappings 
disable, pass 
input to output 
Val=0 Enable 
mappings 

0xAABBCC  Refer Note Input 1 value 0xAA 
maps to output 1 values; Input 
2 value 0xBB maps to output 
2 Input 3 value 0xCC maps to 
output 3  

In 4,5, 6 0 16777215.0  0xDDEEFF Refer Note Input 4 value 
0xDD maps to output 4 
values; Input 5 value 0xEE 
maps to output 5 Input 6 value 
0xFF maps to output 6 

In 7, 8, 9 0 16777215.0 0xGGHHII Refer Note Input 7 value 
0xGG maps to output 7 
values; Input 8 value 0xHH 
maps to output 8 Input 9 value 
0xII maps to output 9 

Out 1, 2, 3 0 16777215.0  0xaabbcc Refer Note Input 1 value 0xaa 
maps to output 1 values; Input 
2 value 0xbb maps to output 2 
Input 3 value 0xcc maps to 
output 3 

Out 4,5, 6 0 16777215.0  0xddeeff Refer Note Input 4 value 0xdd 
maps to output 4 values; 

Input 5 value 0xee maps to 
output 5 Input 6 value 0xff 
maps to output 6 

Out 7 0  255  0xgg  Input 7 value 0xgg maps to 
output 7 values;  
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 Range   

Input Name Low High Input Value Description 

Out 8  0 255  0xhh  Input 8 value 0xhh maps to 
output 8 values; 

Out 9  0  255  0xii  Input 9 value 0xii maps to 
output 9 values; 

 

 
Note:  

In123,In456, In789, Out 123,and Out456 are 
created by taking each individual input value (0-
255) and convert to a hex byte (0x00 – 0xFF) 
and putting first value in Most Significant Byte, 
2nd value in middle and 3rd value in Least 
Significant Byte.  

The end result gives an integer value that must 
be stored as a float. So if In1 is 1, In2 is 2 and 
In3 is 3 then the integer would be 
0x010203=66051, and the float value stored as a 
parameter would be 66051.0.  

The tool will prompt user for individual in1 out9 
values and do the conversion both to and from 
the packed structure for the user. 

 

 

 

 

 

 

 

 

 

Analog Outputs 
 

Table 75: Analog Outputs of Encode Function 

  Range   

Input 
Name 

Cfg Low High Input Value Description 

Out  OUT_DIG  0  255 Refer description If an input matches a block 
mapping and Disable is 
FALSE, then output = block 
mapping.  

If input does not mach a 
block mapping or if Disable 
is TRUE, the output = input. 

fire OUT_ DIG 0  1 Refer description  If Disable is FALSE and 
input matches a block 
mapping, then fire output is 
TRUE.  

If Disable is TRUE, then fire 
is TRUE 
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For example, to map a standard HVAC enumeration into 
a custom enumeration, the standard HVAC enumeration 
and desired mapping is as shown in Table 76:

 

 

Table 76: Standard HVAC enumeration and desired mapping 

In Parameter Input Enumeration 
Configurations  Out Parameter 

# 
Output 

Enumerations  

in 1 HVAC _AUT O  0 out1  COOL_MODE  0 

in 2 HVAC _HEAT  1 out2  HEAT_MODE  2 

in 3 HVAC _MORNING_WARM_UP 2 out3  HEAT_MODE  2 

in 4 HVAC _COO L  3 out4  COOL_MODE  0 

in 5 HVAC _NIGHT_PURGE  4 out5  NIGHT_MODE  7 

in 6 HVAC _PRECOOL  5 out6  COOL_MODE  0 

in 7 HVAC _OFF  6 out7  OFF_MODE  255 

in 8 HVAC _TEST  7 out8  OFF_MODE  255 

in 9 HVAC _EMERGENCY_HEAT 8 out9  EMERG_HEAT  3 

Block 2 passed 
through  

HVAC _FAN_ ONLY  9 Block2 not used Pass through 
(output =9) (Does 
not require mapping 
because the output 
is the same as the 
input.) 

 

Block 2 In 1  HVAC _NUL  255 Block2Out1 REHEAT_MODE  1 

 

The first encode function block parameters are:  

• In 1,2,3 : 0,1,2 = 0x000102 = 258 

• In 4,5,6: 3,4,5 = 0x030405 = 197637 

• In 7,8,9: 6,7,8 = 0x060708 = 395016 

• Out 1,2,3: 0,2,2 = 0x000202 = 514 

• Out 4,5,6: 0,7,0 = 0x000700 = 1792 

• Out 7: 255 

• Out 8: 255 

• Out 9: 3 

 

 

 

And the Second block:  

• In 1,2,3: 255,0,0 = 0xFF0000 = 16711680 

• In 4,5,6: 0,0,0 = 0x000000 = 0 

• In 7,8,9: 0,0,0 = 0 

• Out 1,2,3: 1,0,0 = 0x010000 = 65535 

• Out 4,5,6: 0,0,0 = 0 

• Out 7: 0 

• Out 8: 0 

• Out 9: 0 

Connect as shown Figure 211. 
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Figure 211: Encode Function Block Parameters 

Hysteretic Relay 
This function set the output TRUE (1) if input value is 
greater than onVal and FALSE when input value is less 
than offVal. 

MinOn Input: When output transit from TRUE (1) to 
FALSE (0), it will remain TRUE (1) for time period 
specified by the minOn input. This input can be a 
constant or can take value from other function blocks or 
physical/network inputs. 

MinOff Input: When output transit from FALSE (0) to 
TRUE (1), it will remain in FALSE (0) condition for time 
period specified by the minOff input.

From iteration to iteration, the Function Block keeps track 
of the current minimum on or off time. On power up/reset 
this timer is cleared. 

 

 

 

Logic Diagram Function Block 

Figure 212: Hysteretic Relay Function 
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Inputs 
Table 77: Inputs of Hysteretic Relay Function 

 Range   

Input Name Low High Input Value Description 

in >=– infinity <+ infinity unconnected val = invalid Output = FALSE  

   invalid val = invalid Output = FALSE 

onVal >=– infinity <+ infinity unconnected val = invalid Output = FALSE  

   invalid val = invalid Output = FALSE 

offVal >=– infinity <+ infinity unconnected val = FALSE Output = invalid 

   invalid val = invalid Output = FALSE 

minOn 0 65535 unconnected val = 0 

(sec)   invalid val = 0 

minOff 0 65535 unconnected val = 0 

(sec)   invalid val = 0 

 

Outputs 
Table 78: Outputs of Hysteretic Relay Function 

Output Name 
Range Description 

OUTPUT Any floating 
point value  

The output is set 
TRUE at OnVal and 
FALSE at OffVal 
while honoring min 
on and off times. 

 

Maximum 
This function calculates the maximum of 8 inputs 
(connected inputs or inputs set as constant).  
The output is set to the largest input. 

 

 

  

Logic Diagram Function Block 

Figure 213: Maximum Function 
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Note:  

If one or more inputs are selected as constant, 
any previous connection from the outputs of 
other functional blocks to this block is removed 
automatically and the maximum of the selected 
constant values is set as the output. 

 

Ignore invalid inputs: If this option is selected, function 
block will consider only valid inputs while determining the 
maximum of the inputs. If this option is not selected, and 
any input become invalid then output also becomes 
invalid.  
This option is not supported in the PVL6436A, 
PVL6438N, or PUL6438 models and therefore this 
configuration cannot be downloaded to those models. 

Inputs 
Table 79: Inputs of Maximum Function 

 Range   

Input Name Low High Input Value Description 

In 1-8 >=– infinity  <+ infinity  unconnected  
Not used in the calculation. If all 
inputs are unconnected, output is 
invalid. 

in1-8  >=– infinity  <+ infinity  invalid  If any input is invalid, then output 
is invalid  

in1-8  >=– infinity  <+ infinity  valid Calculates the maximum of 8 
inputs or those set as constant.  

 

Outputs 
Table 80: Outputs of Maximum Function 

Output Name 
Range Description 

OUTPUT Any floating 
point value  

Maximum of the 
inputs 

Minimum 
This function calculates the minimum of 8 inputs or those 
set as constant. The output is set to the smallest input. 
Unused/invalid inputs are ignored. 

 

 

 

  

Logic Diagram Function Block 

Figure 214: Minimum Function 
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Ignore invalid inputs: If this option is selected, function 
block will consider only valid inputs while determining the 
minimum of the inputs. If this option is not selected, and 
any input become invalid then output also `becomes 
invalid. 

This option is not supported in the PVL6436A, 
PVL6438N, or PUL6438 models and therefore this 
configuration cannot be downloaded to those models. 

Inputs 
Table 81: Inputs of Minimum Function 

 Range    

Input Name Low High Input Value Invalid Flag Description 

In 1-8 >=– infinity  <+ infinity  unconnected  

 Not used in the calculation. 
If all inputs are 
unconnected, output is 
invalid.  

in1-8  >=–- infinity  <+ infinity  invalid  
0 Not used in the calculation. 

If all inputs are invalid, then 
output is invalid  

in1-8  >=-– infinity  <+ infinity   1  If any input is invalid, then 
output is invalid 

 

Outputs 
Table 82: Outputs of Minimum Outputs 

Output Name 
Range Description 

OUTPUT Any 
floating 
point 
value  

Minimum of the 
inputs 

Priority Select 
This function allows one to four inputs in any combination 
to be individually enabled to override the default. The 
output is the input with its highest priority enabled TRUE 

 

 

  

Logic Diagram Function Block 

Figure 215: Priority Select Function 
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Login Inputs 
Table 83: Login Inputs of Priority Select Function 

Input 
Name  

Input Value  Logic 
Value  

Description 

enable
1 -4  

VAL != 0.0 0 1   

 0 0  

 unconnected  0  

 invalid 0  

 

 
 
 
 
 
 
 
 
 

Analog Inputs 
Table 84: Analog Inputs of Priority Select Function 

 Range   

Input Name Low High Input Value Description 

in1-4  >=– infinity  <+ infinity  unconnected  val = invalid 

   invalid val = invalid 

   Valid Val = value of in1-4 

Setpoint 
Table 85: Setpoint of Priority Select Function 

Name Range/Value Description 

In1 As Default  Yes Output is set to Input 1 even if all Enable Inputs 1-4 are invalid  

 No Output is set to Invalid if all Enable Inputs 1-4 are disabled 

Output 
Table 86: Outputs of Priority Select Function 

Output 
Name Range Description 

OUTPUT Any floating point value The output is set to the input that is enabled.  

• If all inputs are unconnected, output is invalid  
• If all Enable inputs are disabled, and all inputs are invalid, 

the output is invalid  
• If SetIn1asDefault is enabled, output is Input1, even if all 

Enable inputs are disabled. 
• When SetIn1asDefault is disabled/Enabled and if at least 

one Enable input is enabled, output is the input with its 
highest priority enabled TRUE. The priority order among 
Enable inputs is:  
1. Enable1  
2. Enable2  
3. Enable3  
4. Enable4 
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Based on the In1asDefault option and the Enable 
options selected, the output is set as Input as shown in 
Table 87: 

 

 

Table 87: Output based on In1asDefault 

In1asDefault Enable Inputs 1–4 Output 

Enabled Disabled Output is set to Input1 

 Enabled Output is set to highest enabled input. 

Disabled Disabled The output is invalid 

 One or more inputs 
is Enabled 

Output is set to one of the Inputs 1-4 based on the priority order: 

1. Enable1  

2. Enable2  

3. Enable3  

4. Enable4 

Note: 

Enable 1 has the highest priority and if it is enabled, output is taken 
as Input1. 

If Enable 1 is disabled, Enable 2 has the next highest priority and if 
Enable 2 is enabled, output is taken as Input 2. 

Enable 3 has the third highest priority and if Enable 1 and Enable 2 
are disabled, the output is taken as Input 3. 

Enable 4 has the least priority and output is set to Input 4 only if 
Enable 1-3 is disabled. 
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Select 
The Select function block selects one of the 6 input 
values to be transferred to the output. The input selected 
depends on the value of X. 

The default input allows multiple Select function blocks to 
be tied together by chaining the outpu00t of one block to 
the default input of the next. 

When Select function blocks are chained, all chained 
blocks receive the same input, but different offsets, so 
they examine different ranges of the input value.  

When (X) selects one of the 6 inputs, the output equals 
the value on the input (X-offset). Otherwise, the output 
equals the value on the default input. 

 
 

Logic Diagram Function Block 

Figure 216: Select Function 

Analog Inputs 
Table 88: Analog Inputs of Select Function 

 Range   

Input Name Low High Input Value Description 

x >=– infinity  <+ infinity  unconnected  val = invalid 

   invalid val = invalid 

   valid Val = valid 

default >=– infinity  <+ infinity  unconnected  val = invalid 

   invalid val = invalid 

   valid Val = valid 

Input0 to 6 >=– infinity  <+ infinity  unconnected  val = invalid 

   invalid val = invalid 

   valid Val = valid 
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Output 
Table 89: Outputs of Select Function 

Output 
Name 

Range Description  

Output Any floating 
point value 

Output = input (x-
offset) 

 

 

 

 

Setpoint 
Table 90: Setpoints of Select Function 

Name Range Description 

Offset 0 - 255 

Output value depends upon the input value x and offset. Output value 
will be the value equal to the input (any one of the input0-6) selected 
by the niputx-offset. Following is the example for illustration; 
Input0: 1 
Input1: 2 
Input2: 3 
Input3: 4 
Input4: 5 
Input5: 6 
 
Offset: 2 
 
If input x is 4, then (x-offset=4-2)=2  
Output will be the value of input 2 . From the input values, output=3 

 

 

 
Note:  

If any input is invalid, the output is invalid. 

 

Output = Position determined by the value  
(X - Offset).  

• If the value of (X – Offset) is greater than 6, the 
default value is taken as the Output.  

• If the value (X - Offset) is a floating point number 
between 0 and 6, the position is determined thus:  

 0.10 – 0.99, 0 is returned and Input 0 is taken as 
Output 

 

 1.10 – 1.99, 1 is returned and Input 1 is taken as 
Output  

 2.10 – 2.99, 1 is returned and Input 2 is taken as 
Output 

 3.10 – 3.99, 1 is returned and Input 3 is taken as 
Output 

 4.10 – 4.99, 1 is returned and Input 4 is taken as 
Output 

 5.10 – 5.99, 1 is returned and Input 5 is taken as 
Output 

Example 1: 

X = 100, Offset = 97, default = 10 

Output = 100 – 97 = 3, and hence Input 3 is taken as the 
output. 

Example 2: 

X = 100.6, Offset = 95.2, default = 10 

Output = 100.6 – 95.2 = 5.4, and hence Input 5 is taken 
as the output. 

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 206  

Example 3: 

X = 100, Offset = 5.2, default = 10 

Output = 100 – 5.2 = 94.4, and hence default value 10, is 
taken as the output. 

Switch 

This function takes an enumerated typed input and 
subtracts a user defined offset to determine which output 
to set TRUE, holding all others FALSE.  

The valid range of the input minus the offset is 0 through 
7. The output X (0 through 7) is TRUE if input – offset = 
X, else, it is FALSE. 

 

 
 

Logic Diagram Function Block 

Figure 217: Switch Function 

Analog Inputs 
Table 91: Analog Inputs of Switch Function 

 Range   

Input Name Low High Input Value Description 

     

input  0  255  unconnected  val = invalid, all outputs off.  

   invalid val = invalid, all outputs off. 

   in – offset > 7  All outputs off. 

   in – offset < 0 All outputs off 
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Output 
Table 92: Output of Switch Function 

Output 
Name Range Description 

OUTPUT 

0-7 

Any floating 
point value 

The output 0 
through 7 is 
TRUE if (input – 
offset) = X, 
otherwise it is 
FALSE If an 
output is 
negated, then it 
is also negated 
from the value 
determined by 
the function 
block logic 

Setpoint 
Table 93: Setpoint of Switch Function 

Output 
Name Range Description 

offset  0 - 255 Used to 
determine which 
Output is set to 
TRUE based on 
the expression 
(input - offset) = 
Output 

 

Output = Output position determined by the value (input 
– Offset).  

 If the value of (input – Offset) is greater than 7, all 
outputs are taken as FALSE. 

 If the value (input – Offset) is a floating point number 
between 0 and 8, the position is determined thus:  

 

 0.10 – 0.99, 0 is returned, Output 0 is TRUE and 
all other outputs are FALSE 

 1.10 – 1.99, 1 is returned, Output 1 is TRUE and 
all other outputs are FALSE 

 2.10 – 2.99, 2 is returned, Output 2 is TRUE and 
all other outputs are FALSE 

 3.10 – 3.99, 3 is returned, Output 3 is TRUE and 
all other outputs are FALSE 

 4.10 – 4.99, 4 is returned, Output 4 is TRUE and 
all other outputs are FALSE 

 5.10 – 5.99, 5 is returned, Output 5 is TRUE and 
all other outputs are FALSE 

 6.10 – 6.99, 6 is returned, Output 6 is TRUE and 
all other outputs are FALSE 

 7.10 – 7.99, 7 is returned, Output 7 is TRUE and 
all other outputs are FALSE 

 

Example 1: 

Input = 100, Offset = 97 

Output = 100 – 97 = 3, and hence Output 3 is made 
TRUE and all other outputs are made FALSE.  

Example 2: 

X = 100.6, Offset = 95.2 

Output = 100.6 – 95.2 = 5.4, and hence Output 5 made 
TRUE and all other outputs are made FALSE. 

Example 3: 

X = 100, Offset = 5.2 

Output = 100 – 5.2 = 94.4, and hence all Outputs are 
made FALSE. 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 208  

BUILT IN FUNCTION BLOCKS 
The honeywellSpyderTool provides the following Built 
In function blocks that can be configured and used to 
build the required application logic: 

• Schedule 

• Conventional wall module 

• S-Bus wall module 

Schedule 
The Schedule function block configures schedule and 
schedule assignment for the controller.  
The scheduler to determine the scheduled Occupancy 
uses the day and date. An external device via LON 
communications may update the time of day and date. 
This function calculates:  

1. Current State 

2. Next State and  

3. Time Until Next Change of State (TUNCOS) based 
on the date and time. 

 

 

 

Logic Diagram Function Block 

Figure 218: Schedule Function Block 

Inputs 
Date and Time from the operating system or spyder 
controller are the inputs to the Scheduler. 

Outputs 
CURRENT_STATE: This output produces current state 
of the scheduler as per the settings done inside the 
scheduler. Following are the available states; 

• Occupied: Occupied set points are used. 

• Unoccupied: Unoccupied set point are used. 

• Standby: Standby set point are used. 

Schedule Next State: It is the occupancy state the 
controller will go to after the current state is complete.  

• Occupied:  The next state is occupied. 

• Unoccupied: the next state is unoccupied. 

• Standby: The next state is standby. 

• OCCNUL: The next state is unknown. 

`Schedule TUNCOS is the time (in minutes) until the next 
change of state. The Honeywell Spyder controller uses 
this to perform setpoint recovery. 

Configure Schedules 
To configure schedule right click the Schedule function 
block and select Configure properties. The Schedule 
dialog box appears.  

 
Figure 219: Select > Configure Properties Option 

An occupancy schedules can configured for eight days of 
the week: Monday through Sunday, and a holiday. There 
are four events per day with one state/time per event. 
There are four states:  

• Occupied 

• Standby 



HONEYWELL SPYDER USER GUIDE 

 209 31-00089—02 

• Unoccupied 

• Unconfigured 

The event time range is 0 - 1439 mins. The event time 
resolution is 1 min. Zero is the first minute of the day at 
12:00 a.m. 1439 is the last minute of the day at  
11:59 p.m. Event times greater than 1439 mins are illegal 
and the event is treated as if the state were null.  

The scheduled events execute in the order based on 
time of day. It is not necessary for the events to be in 
time sequential order. If the events are entered non-
sequentially, the event which is the earliest is executed 
and the next earliest and so on. If an event state is not 
programmed (Unconfigured), the event time can be 
anything and will not be used.  

 

 
Figure 220: Schedule Tab > Schedule Screen 

To configure a schedule: 

1. On the Scheduling tab, click the day of the week to 
select the day needs to be configured user wants to 
configure the schedule. 

2. Select a maximum of four events, Occ1, Occ2, 
Unocc1, Unocc2, for the selected day. Use the drop 
down list to specify the occupancy status for the 
event. Notice that the cell turns green if the occupied 
mode is selected. White for an unoccupied mode, 
yellow for a standby mode and windows default 
background color for the unconfigured option. 

3. Click the hours, minutes, and/or AM/PM and use the 
up/down arrow buttons to set the time. 

4. Click Apply Event. 

5. Repeat the steps 1 through 5 for the remaining days 
of the week and the Holiday. 

To Unconfigure a day schedule/event: 

1. Select the row/cell of the day whose schedule needs 
to be unconfigured. 

2. Right-click the row/cell and select Delete. The 
schedule for that row/cell is unconfigured. 

To copy the schedule from one day/event to another:  

1. Select the day/event by right-clicking the time line 
row. 

2. Select Copy. 

3. Right click the destination row and select Paste. 
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Configure Holiday Schedules 
A maximum of 10 holidays can be scheduled. Each 
scheduled holiday has a valid start month, day, and 
duration. After the start month/date is calculated, the 
duration is added to find the end date. If it is a one day 
holiday, then the duration is one day. The end date is set 
to the start date. If the current date is within the start and 
end dates, inclusive, then it is a holiday. 

Holidays can be specified in any order in the list. 
Holidays do not have to be in date consecutive order. 
The Scheduler is called once per second. Also ensures 
that the clock time of the day is valid. It computes the 
occupancy by examining the programmed schedule. 

 

It looks at the current date/time and compares it to the 
entered schedule and holidays to determine the current 
state, next state and TUNCOS. 

A holiday is configured by a start date and duration. The 
start date can be a specific date or a relative day in a 
month. A holiday is not specific to a particular year; each 
holiday configuration is applicable for every year. 

A holiday can be configured by either specifying a date 
or by specifying a day in a month. To configure a Holiday 
schedule: 

1. Click the Holidays tab. Options are available to 
select holidays based on weekday/month every year 
or on a specific date every year. 

 

 
 

Figure 221: Holidays Tab > Schedule screen 

2. To specify a weekday/month for every year as a 
holiday, select the Weekday/Month for every year 
option to configure a holiday by selecting a weekday 
in a month. Select the month from the Select Holiday 
Start Month list and the day from the Select Holiday 
Start Day list to specify the holiday start month and 
start day. The days are the relative days, such as, 
First Sunday, Fourth Monday, and so on. 

3. To specify a specific date(s) every year as a holiday, 
select the Specific Date for every year option to 
configure a holiday by selecting a specific date for 
every year. Select the month from the Select Holiday 
Start Month list and the date from the Select 

Holiday Start Date list to specify the holiday start 
month and start date. 

4. Select the month, start date, and duration of the 
holiday from the Select Holiday Start Month, Select 
Holiday Start Date, and Duration fields respectively. 
The duration can be configured from 1 to 255 days. 

5. Select one of the options provided and click Add to 
add to the Holiday list. 

6. To remove a holiday from the Holiday List, select the 
holiday and click Remove. 
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Load U.S. Holidays 
To select the list of US holidays to required holiday list, 
click the Load US Holidays button. The following pre-
configured US holidays are loaded to the holiday list:  

• January 1 

• Memorial Day 

• July 4 

• Labor Day 

• Thanksgiving and Day After 

• Christmas Eve and Day After 

If there are more than four holidays already configured, 
the Load US holidays option will not load all the six 
holidays, since they would exceed the maximum holiday 
count. The first few US holidays are loaded until the total 
count has reached the maximum of 10 holidays. No 
duplicate holidays are allowed. 

Save Schedule 
• Click Apply to save the changes that are made to the 

schedule. 

• Click OK to save the changes and close the Schedule 
dialog box. 

• Click Cancel to close the Schedule dialog box 
without saving the changes. 

Conventional Wall Module 
The Spyder tool supports configuring the conventional 
wall module (7-wire) in addition to the S-Bus wall module 
(2-wire wall module). A maximum of one conventional 
wall module can be available per ControlProgram.  

 

 
Note:  

If more than one conventional wall module is added 
to an application, a message appears stating: 

 “You have more than 1 ConventionalWallModule 
function block in the Control Program. Since only 1 
‘ConventionalWallModule’ function block can be 
downloaded to the controller, user will have to 
delete the extra ConventionalWallModule function 
block(s) from the ControlProgram before 
downloading.” 

 

 
Figure 222: Conventional Wall Module Function 

Block 

However, if deleting the additional wall module is failed 
and Validate button is clicked on the toolbar, then an 
error message appears. 

Click OK to close the message window and delete the 
additional wall module before downloading the 
application logic. 

To configure the conventional wall module:  

1. Expand the BuiltIn folder in the 
honeywellSpyderTool palette.  

2. Drag the ConventionalWallModule onto the 
wiresheet or onto the ControlProgram. The 
conventional wall module block appears on the 
wiresheet.  

 
Note:  

The Spyder tool supports only one wall module 
block for each type (S-Bus and Conventional). 

 

3. Right click the ConventionalWallModule block and 
select Configure Properties. The Wall Module 
Configuration Wizard appears. General Settings 
can be configured for the conventional wall module. 

 

 
Figure 223: Conventional Wall Module > Configure 

Properties option 
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Figure 224: Conventional Wall Module Settings Screen 

Procedure 
1. Click the General Settings button on the left pane to 

open the General Settings page.  

2. Enter information into the available fields.  

3. Click Finish to save the settings or Cancel to revert to 
the last saved settings.  

 
FIELDS 

Table 94: Fields of Conventional Wall Module Screen 

Name Definition 

Block Name  Enter a name for the wall module block. 

Block Type  Display the type of wall module.  

Wall Module Model Selection 

Wall Module Type  Display the wall module type selected.  
Note:  
For a Conventional wall module having links on the wiresheet, if the Wall module type 
is changed to that of an S-Bus wall module, a warning box will appear stating that links 
of the conventional wall module will be deleted. 
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Name Definition 

 

Select Model Use these options only if the wall module needs to be changed to an S-Bus wall 
module. If either option is checked, then a message appears informing that ‘The 
model selection has been changed and that all settings of the conventional wall 
module will be lost’. Confirmed it to proceed. Also, with this confirmation, the 
changeover to an S-Bus wall module type is decided. To proceed further, refer the 
Conventional Wall Module section. 

Override Type  

 

One of three options can be selected:  
• NORMAL_OVERRIDE: If this option is selected, user can override the system in 

Unoccupied and Bypass Mode using Override button. If analog output is 
connected to the LED input of the wall module, it will give feedback of the 
overridden state.  
To override the system in Unoccupied Mode, press the Override button till LED 
starts blinking. To remove overridden state, press the Override button till LED 
turns off. 
To override the System in Bypass Mode, press the override button till LED turns 
ON. To remove overridden state, wait till bypass time (refer Bypass Time in same 
table) expires or press the Override button and wait till LED turns OFF. 

• BYAPSS_ONLY_OVERRIDE: If this option is selected, user can override the 
system in only Bypass Mode.  
To override the System in Bypass Mode, press the override button till LED turns 
ON. To remove overridden state, wait till bypass time (refer Bypass Time in same 
table) expires or press the override button and wait till LED turns OFF. 

• OVERRIDE_DISABLE: User cannot override the system in any mode. Override 
button has no any effect. 

Bypass Time Source Select one of the following options:  
• Fixed Parameter: Enter the required bypass time in Minutes inside the 

ConvetionalWallModule function block.  
• Variable Input: Bypass time is determined externally and connected to the 

bypassTime input of the wall module. The input can be a physical/network output 
or output of another function block. 

Finish Saves the configuration changes that are made. 

Cancel Exits the wizard without saving the configuration changes 
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S Bus Wall Module 
The Spyder tool supports configuring the S-Bus (Sensor-
Bus) WallModule (2-wire wall module) in addition to the 
conventional wall module for the Lon Spyder II and 
Spyder Micro models. A maximum of  
1 S-Bus wall module can be available in a control 
program for TR70 model and a maximum of 4 S-Bus wall 
modules for TR71/TR75 models. 

 
Figure 225: S-Bus Wall Module Function Block 

 

 
Note:  

If more than 4 S-BusWallModule are added to an 
application, a message appears stating that user 
has more than 4 S-BusWallModule function 
blocks in the Control Program. Since only  
4 S-BusWallModule function blocks can be 
downloaded to the controller, user will have to 
delete the extra S-BusWallModule function 
block(s) from the control program before 
downloading. 

 

However, additional wall module is not deleted and click 
the Validate button on the toolbar, an error message 
appears stating that the number of blocks of  
S-Bus wall module has exceeded the allowed limit.  

Click OK to close the message window and delete the 
additional wall module before downloading the 
application logic. 

Different parameters of the  
S-Bus wall modules can be configured in two ways.  

• The configuration wizard of the  
S-Bus wall module function block can be invoked and 
use the wizard screens to configure the wall module. 
Use the Preview screen to preview the configuration 
that have made. Download the configuration changes 
made to the controller to view the configuration 
changes on the wall module.  

• Using the display screen of the wall module mounted 
on the wall can be configured locally. This can be 
done only in the Contractor mode.  

After completing the configuration, link the slots on the  
S-Bus wall module function block as required. The input 
and output slots of the wall module can be connected to 
other function blocks, Physical/software points, and 
NVs/BACnet objects, to develop the application logic. 

 
Note:  

Only NC, NV, or BACnet Objects can be 
connected to the type Network setpoint 
parameters 

 

Later on, the configuration can be downloaded to the 
controller. This configuration is then automatically 
downloaded to the S-Bus wall module by the Spyder 
controller. 

 

 
Note:  

On the wiresheet, the S-BusWallModule displays 
the parameters on the container as follows: 
input, OUTPUT, Input. Ex- input: categ1.param1 
(all small case), OUTPUT: categ1.PARAM1 (all 
in capital), Input: categ1.Param1 (first letter in 
capital, followed by all the others in small case). 
Category names appear as given by the user 
and the category name must be unique. 

 

The default S-Bus wall module would have only 
ROOMTEMP (for the Temperature from WallModule) 
sensor and occupancy_status (to show the occupancy 
status). 

If the changes are made to the configuration locally on 
the wall module, the same gets uploaded to the 
controller.  

Note that, the changes made in the wall module 
configuration are not get uploaded in the controller 
application developed in the WEBStation-N4. To upload 
wall module configuration, use either learn Logic or 
Sync from the Field device to wiresheet functions. 

 

If one of the following is changed and performed a quick 
download, then only the changed configuration is 
downloaded to the controller.  

• Toggling the Viewable by Tenant check box, 

• Changing the default home screen only, 

• Changing the default value of Value from wall 
module, 

• Changing the default value of Sensor or Offset 
parameters 

For all other changes, the whole configuration is needed 
to be download (full download) to the controller.  

These applications can be saved to the Spyder library for 
later use. Applications that are stored can be imported 
from the library and used to rapidly build application 
logic.  

 

 

 



HONEYWELL SPYDER USER GUIDE 

 215 31-00089—02 

An already configured S-Bus wall module function block 
can be deleted if necessary.  

Initial Setup and Configuration  
Once the wall module is wired to the controller, the wall 
module is configured using the Spyder tool user 
configures the wall module using the Spyder tool.  

CONFIRM BUS ADDRESS SETTING  

Ensure that the bus address dial (located on the back of 
the module) of the Wall Module is set to any address that 
matches with the default setting of the configuration tool.  

 
Note:  

Only one TR70 wall module must be placed 
under one Spyder controller and the address of 
TR70 wall module must be 1. If more than one 
TR70 wall module is placed under one Spyder 
controller, Validate/ Compile/ Download process 
will fail. A maximum 4 modules can be placed 
with a combination of TR70, TR71 and TR75 wall 
modules. 

Configuring S-Bus Wall Module 
To configure the S-Bus wall module using the 
configuration wizard:  

1. Expand the BuiltIn folder in the 
honeywellSpyderTool palette.  

2. Drag and drop the S-BusWallModule onto the 
wiresheet or on to the ControlProgram in the Nav 
tree. The Name dialog box is displayed. 

 
Figure 226: Enter Name of S-Bus Wall Module 

3. Enter the name of the module and click OK.  
The S-BusWallModule block appears on the 
wiresheet. This block shows only the slots relevant to 
the configuration that are made. This block shows 
only the slots relevant to the configuration that user 
has made. By default, slots configured in standard 
applications will be shown as part of the wall module 
block.  

4. Right-click the S-Bus wall module block and select 
Configure Properties. The Wall Module Configuration 
Wizard appears.  

 
Figure 227: S-Bus Wall Module > Configure Properties 

Option 
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Figure 228: S-Bus Wall Module Configuration Settings Screen 

Table 95 the settings can be configured which are 
displayed on the left pane of the wizard:  

Table 95: Icons used for S-Bus Wall Module Settings  

Settings Icon 

General Settings 
 

Categories and Parameters  
 

Home Screen Options  
 

Occupancy and Override  
 

Fan Command 
 

System Status and Command  
 

Settings Icon 

Schedule/Time  
 

Password 
 

Preview  
 

 

Point to note:  

1. When the S-BusWallModule is dragged onto the 
wiresheet, right click it, and select Configure 
Properties, the General Settings properties are 
displayed in the Wizard window. 

2. The Schedule/Time and Password setting depends 
on the wall module model selection in General 
Settings. 

• If the TR70 wall module model is selected, the 
password protection option in Password setting is 
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disabled and the controller time can be 
viewed/edited only in the Schedule/Time setting. 

• If the TR71 wall module model is selected, the 
password protection option in Password setting is 
enabled and the controller time can be 
viewed/edited only in the Schedule/Time setting. 

• If the TR75 wall module model is selected, If user 
selects the TR75 wall module model, the 
password protection option in Password setting is 
enabled and controller time can be viewed/edited 
only in the Schedule/Time setting. 

3. In the screen labels, the Top Alpha Numeric Alert 
Labels, Middle Alpha Numeric Alert Labels and 
Schedule Labels can be customized. 

For renaming the Top AlphaNumeric Alert Labels: Use 
Lexicon Editor 

The label value should not be more than eight 
characters. Special characters are not allowed except 
slash and hyphen. If special character is entered, then it 
will be considered as "blank space" on Zio wall module 
screen. 

Table 96: Lexicon Editor for Top AlphaNumeric Alert 
Labels 

Lexicon Key Default Value 

Please  PLEASE  

TestMode  TESTMODE  

Download  DOWNLOAD  

Upload  UPLOAD  

Locked  LOCKED  

Password  PASSWORD  

SysMode  SYS MODE  

Saving  SAVING  

Unavail  UNAVAIL  

Address  ADDRESS 

 

For renaming the Middle AlphaNumeric Alert Labels: Use 
Lexicon Editor  

The label value should not be more than four characters. 
Special characters are not allowed except slash and 
hyphen. If special character is entered, then it will be 
considered as "blank space" on Zio wall module screen.  

 

 

Table 97: Lexicon Editor for AlphaNumeric Alert 
Labels 

Lexicon Key Default Value 

Load  Load  

Yes  YES  

No  NO  

Hold  Hold  

Schd  SCHD  

 

For renaming the Schedule Labels: Use Lexicon Editor  

The label value should not be more than eight (8) 
characters in general where the Schedule Event label 
values are special cases and that should not be more 
than seven (7) characters. The Tool will suffix numbers to 
event label value to indicate different events.  

E.g.: Configuring Monday Event (Lexicon key is 'MonE'): 
If the user configures the value as "MonEven"(7 chars 
max supported) then it will generate labels as 
"MonEven1". "MonEven4".  

If any special character is entered, then it will be 
considered as "blank space" on Zio wall module screen. 

Table 98: Lexicon Editor for Schedules 

Lexicon Key Default Value 

Sunday  SUNDAY  

Monday  MONDAY  

Tuesday  TUESDAY  

Wednesday  WEDNESDY  

Thursday  THURSDAY  

Friday  FRIDAY  

Saturday SATURDAY  

Holiday  HOLIDAY  

MonFri  MON--FRI  

SatSun  SAT--SUN  

Schedule Events 

MonE  MON E  

ThesE  TUE E  

WedE  WED E  
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Lexicon Key Default Value 

ThrE  THU E  

FriE  FRI E  

SatE  SAT E  

SunE  SUN E  

HolE  HOL E  

MonFriE  MO-FR E  

SatSunE  SA-SU E 

 

HOW TO USE LEXICON EDITOR  

Navigate to Lexicon Editor from Workbench (Tools > 
Lexicon Editor)  

 
 

Figure 229: Tools > Lexicon Tool Option  

For Soft JACE 
1. Change the respective lexicon values in  

en lexicon only for HoneywellSpyderTool in Lexicon 
Editor as per the above recommendations  

2. The Default value will be used if a user fails to follow 
any recommendations. E.g.:- Default value will be 
used if the user enters more than 8 characters for 
Top Alphanumeric labels  

3. Save the lexicon file after modification.  

4. Restart the workbench and station.  

5. If device already in download state, then modify some 
configuration to ensure tool will again compile the 
configurations on wiresheet and download it.  

6. Then the user can see the alert changes in Zio.  
This is for local host (Soft JACE).  

For Hard JACE 
1. Use "Lexicon installer" and transfer the en lexicon to 

JACE.  

2. Follow Soft JACE steps 4 to 6. 

General Settings 
Use this page to configure the general settings of the  
S-Bus wall module. 

PROCEDURE 
1. Click the General Settings button on the left pane to 

open the General Settings page.  

2. Enter information into the available fields.  

3. Click Finish to save the settings or Cancel to revert 
to the last saved settings.  
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Figure 230: S-Bus Wall Module General Settings Screen 

 

 
Note:  

Click Next to go to the succeeding settings page. 

 
 
 

FIELDS 
Table 99: Fields of Lexicon Editor Screen 

Name Definition 

Block Name  Enter a name for the wall module block.  

Block Type  Display the type of wall module.  

Wall module model 

Wall Module Type  List all wall module models supported by Spyder. The following options are 
available: 

• Temperature Only 

• Temperature, Humidity  

Depending on the wall module type selected, the available models are 
displayed in the Select Model list. The selected wall module type 
determines the function block type. If selected model is of 
Conventionalwallmodule type, then the function block becomes a 
Conventional wall module. Similarly, if the module type selected is an S-Bus 
wall module, the function block becomes an S-Bus wall module. 

Note:  
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Name Definition 

For a Conventional wall module having linkages on the wiresheet, if the wall 
module type is changed to that of an S-BusWallModule, a warning box will 
appear stating that links of the conventional wall module will be deleted. 

 

Model Options One of the following option can be selected:  

• LCD Display  

• Wire Sensor Bus Communication  

For the current Spyder version, the available models have both LCD display 
and 2-wire Sensor Bus Communication options and therefore selecting any, 
one option automatically selects the other.  

Note:  

Based on the Wall Module Type and the Model Option selected, the Model 
Selection list displays the available models.  

Changing conventional wall module to S-Bus and vice-versa:  The wall 
module can be suitably changed that is dropped onto the wiresheet by 
checking the Model Options checkboxes. If a conventional wall module is 
dropped on the wiresheet and check any of the Model Options 
checkboxes, the wall module changes to an  
S-BusWallModule and all the wizard buttons are displayed on the left 
pane. Similarly, if S-BusWallModule is dropped on the wiresheet and 
uncheck the Model Options checkbox, the wall module changes to that of a 
conventional type and all wizard buttons except for the General Settings 
disappear from the left pane. 

Select Model The options available in this list are based on the Wall Module Type and 
Model Option selected.  

Example: If Temperature Only is selected as the Wall Module Type and 
LCD Display as the Model option, the Select Model list, lists Temp (LCD, 2 
Wire) as the selectable option 

Wall Module Address This field is hidden for any wall modules that are not on 2 wire bus or have 
an LCD display (all LCD wall modules are 2 wire). Select an address that 
indicates the address for the selected wall module on the 2 wire bus 
(corresponding to dip switch selections). The default selection is 1. The 
address of the TR71/TR75 wall modules ranges from 1 to 10. The address 
of the TR70 wall module ranges from 1 to 5. 

Time Display Format Specify whether time is shown in 12 hour or 24 hour units. 

Memory Usage Details Show current memory usage for the wall module. Memory updates are 
made every time when a change is made to the configuration. Every click in 
the S-Bus wall module calculates the memory at the background.  
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Name Definition 

Note:  

Memory usage must be less than or equal to 100% in order to download the 
configuration to the programmable controller.  

If the memory usage exceeds the maximum limit, a message appears 
indicating that the configuration must be modified in order to reduce the 
memory usage before downloading the configuration. Click the memory 
usage details button to view the distribution of memory for each configured 
component graphically and in a tabular format 

Selected Model Preview Previews the wall module selected, which includes a model preview image 
of the actual wall module, and configuration that are selected. This appears 
in the preview area at the bottom of the wizard screen.  

Next Move to the next settings wizard. 

Finish Exit the wizard after saving the configuration changes. 

Cancel The wizard prompts to save the changes.  

• Click Save to save the changes. 

• Click No to ignore the changes. 

• Click Cancel to close the dialog box.  

Help Acknowledge the user about functionality of the field. 

Preview Display the option to select either the Tenant View or Contractor View. 

Save to Library Save the wall module configuration to the Spyder library.  

Note:  

For details, refer Saving Library Items for information about how to save this 
configuration to the library. 
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Categories and Parameters 
Use this page to configure the categories and 
parameters of the S-Bus wall module. All available 
categories and parameters are displayed in a 
hierarchical tree structure. User can expand and collapse 
the tree levels. Selecting a level shows the preview 
associated with the selected level (whether category or 
parameter) at the bottom of the screen in the Category 
Preview area. The first category is highlighted by default 
and the preview is shown. 
 
The context menu (right-click menu) can be used to cut, 
copy, paste, delete, parameters across the context menu 
(right-click menu) can be used to cut, copy, paste, delete, 
parameters across categories.  

 
The parameters can be dragged and dropped across 
categories. When a parameter is dragged and dropped 
under a category, a slot is added to the function block. If 
a parameter is moved to a different category (cut and 
paste), the slot name in the function block changes to 
reflect the new category but any links to the application 
logic remain. The parameters can be dragged and 
dropped between categories. This results in a copy of the 
parameter being added. 

PROCEDURE 
1 Click the Categories and Parameters button on the 

left pane to open the Categories and Parameters 
page.  

2 Enter the information into the available fields.  

3 Click Finish to save the settings or Cancel to revert 
to the last saved settings.  

 

 
 

Figure 231: Categories and Parameters Screen 
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FIELDS 

Table 100: Fields of Categories and Parameters Screen 

Name Definition 

Up/Down arrow reorder buttons Reorder the sequence of categories and parameters in the wall 
module. The buttons are disabled only for the first and last items of 
the list. This button is disabled for schedule and time parameters.  

Add Category Adds a new category at the bottom of the tree with the default name 
is CATEG##, where ## is determined by the number of categories in 
the tree (starting at 1). 

Add Parameter Adds a new parameter below the selected category at the bottom of 
the tree with the default name PARAM##, where ## is determined by 
the number of parameters in the tree (starting at 1). The Parameter 
details screen appears. 

Edit Navigates the corresponding detail screen to edit configuration 
details of the selected category/parameter 

Remove Remove the selected category/parameter from the tree. The 
parameters cannot be removed that are linked to other parameter in 
TR71/TR75 wall modules. Only the categories/parameters cannot be 
removed that are not referenced in any home screen / linked 
parameter. 

If still removing of such parameters/categories are required, then the 
references to the parameter/category has to be removed in the home 
screen before it can be done so. Only after all references are 
removed then removing of the he category/parameter is possible. If a 
parameter/category is removed which is not used in one or more 
home screens, then there is no scope to undo this change. 

Category details - These fields are available only for adding/editing of a category.  

Category Name Display the name of either the newly created category (CATEG1) or 
the selected category (SENSORS). The name can be edited. The 
category name has a limit of 8 characters and cannot begin with a 
numeric or special character. Examples of invalid category names 
are: 2category or .categ2. Examples of valid category names: Categ1 
or categ123  

Description Display the brief description of the category. The description has a 
limit of 255 characters. 

Number of Parameters Indicate a read-only field that displays the number of parameters 
under the selected category. For newly created categories, the 
number of parameters would be 0. 

Save Save the configuration changes after displaying a message asking a 
confirmation of saved changes that are made. After confirmation, the 
preview screen appears. It is disabled until a configuration change is 
made.  

Cancel Cancels the configuration changes made and ignores any changes 
made. On clicking Cancel, a message appears indicating that the 
changes made will be lost. On confirmation, the Preview screen of 
the selected category (or parameter) appears. 

Parameter details - These fields are available only for adding/editing of a category. 
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Parameter Name Display the name of either the newly created parameter (PARAM1) or 
the selected parameter (CO2). The name can be edited. The 
parameter name must be unique within a category.  

If trying to save a parameter with an existing parameter name, a 
message appears indicating that a parameter with the name already 
exists. For a parameter of the category OFFSET, default names 
appear. The default names are as follows:  

• Temperature: TEMPOFST  

• Humidity: RH OFST  

• CO2: CO2 OFST  

The parameter name has a limit of 8 characters and cannot begin 
with a numeric or special character.  

Viewable by Tenant Check this option for parameters that needs to be displayed to the 
tenant.  

Editable by Tenant Applies to the following Parameter Types:  

• Value from wall module  

• Dynamic value  

• Sensor offset value  

Description Display the brief description of the parameter. The description has a 
limit of 255 characters. For a parameter of the category OFFSET, this 
field, by default displays the parameter name. 

Parameter Type One of the following parameter types can be selected:  

• Controller Value: These are also called as "IN" parameters. Only 
inputs can be connected to these parameters. When values 
change in the controller, they are reflected in the S-Bus wall 
module. There can be a maximum of 30 IN parameters. This 
includes the "IN" type parameters configured from Parameters 
and Categories screen, Occupancy status configured from 
Occupancy/Override screen and System Status configured from 
System Status and Command screen.  

Note:  

The parameter configuration automatically changes when the 
parameter type is changed. For TR71(H) and TR75(H) models, 
controller value is 250.  

• Value from wall module: These are also called as "OUT" 
parameters. These parameters can be connected to input slots of 
function blocks. There can be a maximum of 19 OUT parameters. 
This includes the OUT type parameters configured from 
Categories and Parameters screen.  

Note:  

The parameter configuration automatically changes when the 
parameter type is changed. For TR71(H) and TR75(H) models, there 
can be n numbers of value from wall module. As long as if free 
memory is available in configuration, then this parameter can be 
added. There is no restriction in no. of the count.  

• Network Setpoint: Network Setpoint parameters are both inputs 
and outputs and are also called "IN-OUT" parameters. These 
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parameters can be viewed and changed and are both an input 
and output to the S-Bus wall module function block. Spyder sends 
these values to S-Bus wall module to be displayed. These can be 
modified from the wall module. Only NC's and NV's can be 
connected to these parameters. These parameter types can be 
created in the S-Bus wall module configuration and linked to NCI 
slots in the application. There can be a maximum of 10 IN-OUT 
(TR70 only) parameters. This includes the "IN-OUT" type 
parameters configured from Parameters and Categories screen.  

Note:  

The parameter configuration automatically changes when the 
parameter type is changed. For TR71(H) and TR75(H) models, 
network set point value is 125.  

• Temperature from wall module (depends on model): For  
S-Bus wall modules supporting temperature sensor, this 
parameter gives the temperature sensor output which can be 
used in the application.  

• CO2 from wall module (depends on model): For S-Bus wall 
modules supporting CO2 sensor, this parameter gives the CO2 
sensor output which can be used in the application.  

• Humidity from wall module (depends on model): For S-Bus 
wall modules supporting humidity sensor, this parameter gives the 
humidity sensor output which can be used in the application.  

• Sensor offset value: Depending on the S-Bus wall module type, 
this parameter defines offset values for the sensor parameter 
type.  

• Time: Consists of the following time components:  
 Time of Day: This value is derived from the controller.  
 Hours (Dynamic value): This can be set by the user or 

derived from the controller.  
 Minutes (Dynamic value): This can be set by the user or 

derived from the controller.  
 Days (Dynamic value): This can be set by the user or derived 

from the controller.  
 Month (Dynamic value): This can be set by the user or 

derived from the controller.  
 Year (Dynamic value): This can be set by the user or derived 

from the controller.  

Enumerated Use this option to get the exact listing of parameters. Select the 
parameter type as Controller Value, Value from Wall Module or 
Network Setpoint to enable the Enumerated option. Ensure that the 
module type is TR 71 and TR 75. 

Define Enum Range This option allows  defining of the enum range. 
To define enum range  
4. Click the Define Enum Range button. The Zio Enum Library 

dialog box is displayed.  
5. Select the available Enum names from the drop down list and 

click Select.  
A new Enum range also can be created. 
To create a new Enum range  
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1. Click the Define Enum Range button. The Zio Enum Library 
dialog box is displayed.  

2. Type the Ordinal value and Display tag, and click Add.  

3. Type the Default Value and the Default Display to be displayed 
for the controller value.  

4. Type the Enum Name, and click Save.  

Note:  

The Ordinal value and the Display tag must be unique. 

An entry in the Zio Enum Library can be modified/removed.  

To modify an entry  

1. Select the entry.  

2. Modify the Ordinal value and Display tag, and click Modify.  

To remove an entry  

1. Select the entry, and click Remove.  

An enum also can be removed from the library  

To remove an enum from the library  

1. Select the enum name from the drop down list and click Remove.  

Note:  

A total of maximum 255 entries are available in a Zio enum library. 

Select Sensor Displays the list of sensors that needs to be configured an 
offset for. All available sensors are listed, but the selection is based 
on the selected model. The default selection is Temperature. This 
field is displayed only for a parameter of the category OFFSET.  

Number of Decimals Apply to all parameter types except Time. For This value affects 
Increment/Decrement options.  

Default Sensor Offset Value The default value for the following parameter types:  

• Temperature from wall module  

• Humidity from wall module 

• CO2 from wall module  

The default value has a limit of 5 characters.  

Note:  

For the Parameter Types Temperature/Humidity/CO2 from wall 
module, if this value is edited and the changes are saved, the Default 
Value of the Sensor Offset Value of the corresponding sensor also 
changes to the edited value. 

Default value Indicate the value that will be initially downloaded to the wall module. 
This value must be between the Low and High limits. This field is 
displayed for the following parameter types:  

• Value from wall module  

• Sensor offset value. By default, it is set to 0.  
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Show Temperature Units as Provide options to select the temperature units to display on the wall 
module when the Parameter Type selected is Temperature from 
wall module. Fahrenheit and Centigrade are the available options. 
By default Fahrenheit is selected. 

Increment/Decrement Depend on the Number of decimal places selected. If the number of 
decimal places = 0, then increment/decrement = 1, 5, 10, 100. If the 
number of decimal places = 1, then increment/decrement = 0.1, 0.5, 
1, 5, 10, 100. If number of decimal places = 2, then 
increment/decrement = 0.01, 0.1, 0.5, 1, 5, 10, 100.  

Note:  

The increment of 5 and 0.5 are only available for the Value from Wall 
Module, Network Setpoint and Sensor Offset Value (Internal) 
parameters in TR71/TR75 model wall modules. 

Low limit Define the low limit for the adjustable value. This limit is used at the 
wall module. Once the limit is reached, additional button presses 
have no effect. The number of decimal places determines the value. 
For example, if the number of decimals = 1, then the low limit is 
shown as XXX.X (0.0 for default).  

The Low Limit must not be greater than the High Limit.  

The low limit can be changed by linking to the other parameter.  

To link the low limit to another parameter  

1. Click the Browse button. The Select Parameter dialog box is 
displayed. It displays the parameters available in the wall module.  

2. Click the expand button and select the parameter.  

3. Click OK. The low limit will be set with respect to the selected 
parameter.  

For example, suppose Zone Temperature Setpoint is added as a 
parameter and low limit is set to 55 OF, user can lower the setpoint up 
to 55 OF down key on the wall module. 

Note:  

The Browse button is only available for the TR71/TR75 model wall 
modules. 

High Limit Define the high limit for the adjustable value. This limit it used at the 
wall module. Once the limit is reached, additional button presses 
have no effect. The number of decimal places, determines the value. 
For example, if the number of decimals = 1, then the high limit is 
shown as XXX.X (999.9 would be the default). The High Limit must 
not be lesser than the Low Limit.  

The high limit can be changed by linking to the other parameter.  

To link the high limit to another parameter  

1. Click the Browse button. The Select Parameter dialog box is 
displayed. It displays the parameters available in the wall module.  

2. Click the expand button and select the parameter.  

3. Click OK. The high limit will be set with respect to the selected 
parameter.  

For example, suppose Zone Temperature Setpoint is added as a 
parameter and High limit is set to 85 °F; user can increase the 
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setpoint up to 85 °F using up key on the wall module. 

Note:  

The Browse button is only available for the TR71/TR75 model wall 
modules. 

Allow null values Indicate whether null values can be set for the adjustable value. If 
enabled, when the LCD user reaches a low/high limit, an additional 
button press will send the null value. 

Time Component Indicates the time and the time format that needs to be configured. 
This field is available only if the Parameter Type selected is Time. 
The following options are available. 

• Time of Day (From controller, Read Only)  

• Hours (Dynamic value)  

• Minutes (Dynamic value)  

• Day (Dynamic value)  

• Month (Dynamic value)  

• Year (Dynamic value)  

If Time of Day option is selected, Editable by Tenant is disabled 
(because TOD is read only). However, Viewable by the tenant and 
Editable by tenant is enabled for other Time Component option. 

Category (Sensors) Preview Gives a preview of the wall module selected along with the model 
preview image and configuration that is selected in the model preview 
area at the bottom of the wizard screen. 

Back Move to the General Settings wizard window.  

Next Move to the Home Screen Options wizard window. 

Finish Exit the wizard after saving the configuration changes. 

Cancel The wizard prompts to save the changes.  

• Click Save to save the changes. 

• Click No to ignore the changes. 

Click Cancel to close the dialog box. 

 

 
Note:  

If a parameter is edited that is used in a home 
screen and the configuration is saved, then the 
change (any customization already done in home 
screen is changed) is also reflected in the home 
screen. 

 

If the change applies to the parameter name, type, 
number of decimals, limits, increment/decrement, default 
value, a message appears indicating that the parameter 

is used in one or more home screens and options are 
provided to save this change or discard it.   
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Click the labels in the preview area (in the Contractor 
mode) to enable/disable the labels which need to be 
made visible to the tenants on the wall module screens 
for the selected parameter. Changes made to parameter 
labels do not affect home screens.  

If a parameter is edited and the parameter type is 
changed, any links to the parameter slot in the 
ControlProgram will be lost. 

 

 
DEFAULTS 

Table 101: Default Parameter Settings 

Parameter Type Default values 

Value from controller • Viewable = Not selected  

• Number of decimals = 0  

Value from wall module • Viewable = not selected  

• Default value = 0 • Number of Decimals = 0 

• Increment/decrement = 1  

• Low limit = 0  

• High limit = 9999  

• Allow null = not selected  

Dynamic value (Last one wins) • Viewable = not selected  

• Number of Decimals = 0  

• Increment/decrement = 1 • Low limit = 0  

• High limit = 999  

• Allow null = not selected  

Temperature from wall module • Viewable = not selected  

• Number of Decimals = 0  

• Default sensor offset value = 0  

• Show temperature units as = °F 

CO2 from wall module • Viewable = not selected 

• Number of Decimals = 0  

• Default sensor offset value = 0  

Humidity from wall module • Viewable = not selected  

• Number of Decimals = 0  

• Default sensor offset value = 0  

Time PT • Viewable = not selected  

• Time component = Time of day (From controller, read only)  
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Sensor Offset value • Viewable = not selected  

• Default value = from sensor parameter (0 unless user changes 
it) 

Default values for Sensor OFFSET 

Field Temperature Humidity CO2 

• No Decimals  1 0 0 

• Increment/Decrement 1 1 1 

• Low limit  –5 –5 –100 

• High limit  5 5 100 
 

 

Home Screen Options 
Use this page to see the available home screen options 
that are configured in the wall module. All available home 
screen options are displayed in a list view. Selecting a 
home screen shows the preview associated with the 
selected home screen option at the bottom of the screen 
in the Home Screen Option preview Area. The Next 
(soft key on the extreme right) and Previous (soft key on 
the extreme left) soft keys can be used in the preview 
area to preview the other home screen options in the list. 
The first home screen option is highlighted by default and 
its preview is shown. 

PROCEDURE 
1. Click the Home Screen Options button on the left 

pane to open the Home Screen Options page.  

2. Enter information into the available fields.  

3. Click Finish to save the settings or Cancel to revert 
to the last saved settings.  
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Figure 232: Home Screen Options Screen 

FIELDS 

Table 102: Fields of Home Screen Options Screen 

Name Definition 

Set as Default Set a selected home screen option as the default home screen. The 
default home screen can be changed by selecting another home screen 
from the list and then clicking this button. Default appears in 
parentheses along with the home screen name.  

Add Add a new home screen option at the bottom of the tree. The Home 
Screen details screen appears. Two home screens cannot have the 
same name. A unique name should be provided to home screens.  

Edit Navigates the corresponding detail screen to edit configuration details 
of the selected home screen.  

Remove Remove the selected home screen from the list. A message appears 
indicating that this action cannot be undone and a confirmation is 
sought. On confirmation, the home screen is removed.  

Up/Down Arrow reorder buttons Reorder the sequence of home screens in the wall module. To re-order 
the sequence of home screens, click the home screen name and use 
the up/down arrow to move it up/down in the list. The buttons are 
disabled only for the first and last items of the list. 
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New Home Details 

Option Name Display the name of the newly created home screen. Enter a unique 
home screen name for each option that is created. If a typed named 
that is already exists, then a message appears asking user to change 
the name as such a name already exists. The option name has a limit 
of 32 characters.  

Set as Default A check mark for this option indicates that this is the default home 
screen option. As only one home screen option can be set as the 
default screen, the last home screen to be selected as default becomes 
the default home screen. This option is not checked by default for every 
new home screen that is added. However, the exception is that if there 
are no other home screens in the list (this is the first), the set as default 
button is checked automatically.  

Description Display the brief description of the home screen. This description is 
shown on mouse over of a home screen option in the preview area. The 
description has a limit of 255 characters.  

Option Type Display the two home screen option types available. Based on this 
selection, the options are provided to select parameters and labels 
which can be viewed in the preview area.  

Multiple parameters: Select up to three parameters and any labels 
(fixed segments) Single parameter: Select one parameter and provide a 
unique 8 character label. Any labels (fixed segments) can be selected 
to show. 

Home Screen Option (RM) 
Preview 

Display the configured home screen options.  

Save Saves the configuration changes that are made. It is enabled once any 
change is made on the screen.  

Cancel Cancels the configuration changes made and ignores any changes 
made.  

Back Move to the Categories and Parameters wizard window.  

Next Move to the Occupancy and Override wizard window.  

Finish Exit the wizard after saving the configuration changes. 

Memory Usage Details Show current memory usage for the wall module. Memory updates are 
made every time when a change is made to the configuration. Every 
click in the S-Bus wall module calculates the memory at the 
background.  

Note:  

Memory usage must be less than or equal to 100% in order to 
download the configuration to the programmable controller.  

If the memory usage exceeds the maximum limit, a message appears 
indicating that the configuration must be modified in order to reduce the 
memory usage before downloading the configuration. Click the memory 
usage details button to view the distribution of memory for each 
configured component graphically and in a tabular format. 

Help Acknowledge the user about functionality of the field. 

Preview Display the option to select either the Tenant View or Contractor View. 
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Save to Library Save the wall module configuration to the Spyder library.  

Note:  

For details, refer Saving Library Items for information about how to save 
this configuration to the library. 

 

Occupancy and Override 
Use this page to view Occupancy settings and enable 
Occupancy Override. The Preview Area at the bottom of 
the screen displays the occupancy and override options 
that are selected for the wall module. 

PROCEDURE 
1 Click the Occupancy and Override button on the left 

pane to open the Occupancy and Override page.  

2 Enter the information into the available fields.  

3 Click Finish to save the settings or Cancel to revert 
to the last saved settings.  

 
 

Figure 233: Occupancy and Override Screen 
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FIELDS 

Table 103: Fields of Occupancy and Override Screen 

Name Definition 

Show Advanced Settings Displays the following advanced override occupancy settings:  

• Unoccupied  

• Standby  

• Occupancy Values  

Hide Advanced Setting Hide the Advanced Settings.  

Enable Occupancy Override Enables occupancy override and shows the current override state 
configuration in parentheses.  

Following are the options:  

• Occupied: This option is displayed once the Enable Occupancy 
Override option is enabled. 

• Unoccupied: This option is displayed only if the Show Advanced 
Settings button is clicked.  

• Standby: This option is displayed only if the Show Advanced 
Settings button is clicked.  

If the Occupancy Override Type (refer next row in the table for more 
details) is set to  

• Continuous: The status is shown as Continuous.  

• Timed (Days/Hours): The status is shown as Min and Max 
hours/days selected.  

Checking the Enable Occupancy Override option also automatically 
checks the Occupancy check box. If this option is checked but there 
is no valid states checked,  a message appears prompting to 
configure at least one override state or disable the occupancy 
override feature. 

Settings Displays the Override to (Override Type selected) Settings window 
that lets setting the Override Type. The following are the options: 

• Continuous Override: The default setting, this setting disables 
the time override type options.  

• Timed Override in Hours: This option enables the Time Setting 
Details, wherein the Minimum Time and Maximum Time can be 
set in Hours and Minutes. The default setting is Min = Max = 3 
hours. Make sure that the Maximum Time is greater than the 
Minimum time or that the Minimum Time is lesser than Maximum 
Time. If either case is not TRUE, an error message appears 
informing that the min value is greater than max value. The 
range is from 0 - 24 hrs.  

• Timed Override in Days: This option enables the Time Setting 
Details, wherein the Minimum Time and Maximum Time can be 
set in Days. In this case, the Hours and Minutes options are 
disabled. The default setting is Min = Max = 1 day. The range is 
from 1 to 99 days.  
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Note:  

If the range is exceeded, an error message appears to inform about 
the same.  

Use Network Bypass Time Only: If this option is selected, then all 
other override details are disabled. The timed override details will 
be determined by the Spyder application.  

Note:  

The Use Network Bypass Time Only option only applies to 
Occupied override type settings. This option is not available for 
Unoccupied and Standby override type settings. 

Occupancy Status Display Options Provides options to select how override status is required to be 
displayed in the LCD. The options are:  

• Show effective occupancy status: LCD shows the actual 
occupancy status taking into account the Spyder application.  

• Show occupancy override status: LCD shows the occupancy 
override status initiated from the LCD, independent of the 
Spyder application.  

• Do not show occupancy or override status: LCD does not show 
occupancy or override, regardless of what the user initiates and 
the Spyder application. 

Occupancy and Override Preview Display the configured options. All valid occupancy states are 
shown in the preview with the active one black and other states 
grayed out.  

Back Move to the Home Screen Options wizard window.  

Next Move to the Fan Command wizard window.  

Finish Exit the wizard after saving the configuration changes. 

Cancel The wizard prompts to save the changes.  

• Click Save to save the changes. 

• Click No to ignore the changes. 

• Click Cancel to close the dialog box.  

Memory Usage Details Show current memory usage for the wall module. Memory updates 
are made every time when a change is made to the configuration. 
Every click in the S-Bus wall module calculates the memory at the 
background.  

Note:  

Memory usage must be less than or equal to 100% in order to 
download the configuration to the programmable controller.  

If the memory usage exceeds the maximum limit, a message 
appears indicating that the configuration must be modified in order 
to reduce the memory usage before downloading the configuration. 
Click the memory usage details button to view the distribution of 
memory for each configured component graphically and in a tabular 
format 

Help Acknowledge the user about functionality of the field. 
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Preview Display the option to select either the Tenant View or Contractor 
View. 

Save to Library Save the wall module configuration to the Spyder library.  

Note:  

For details, refer Saving Library Items for information about how to 
save this configuration to the library. 

 

Fan Command 
Use this page to view Fan command settings. The 
Preview Area at the bottom of the screen displays the 
LCD fan command options that are selected for the wall 
module. 

PROCEDURE 
1 Click the Fan Command button on the left pane to 

open the Fan Command page.  

2 Enter the information into the available fields.  

3 Click Finish to save the settings or Cancel to revert 
to the last saved settings.  

 
Figure 234: Fan Command Screen 
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FIELDS 

Table 104: Fields of Fan Command Screen 

Name Definition 

Show Advanced Settings Display the Fan Status values. Defaults will follow the LonMark 
standards. Valid fan status values are shown as enabled. Invalid 
status values are disabled (depending on the fan status options 
selected).  

Hide Advanced Settings Hide the Fan Status values.  

Enable Fan Command Enable the fan command. Only if this option is checked will the Valid 
Fan States options be enabled. Select one from the three valid fan 
states:  

• 2 State  
• 3 State  
• 5 State  
Default Fan State: The following are fan state options: 

• 2 State: Auto/On. The default option is On.  

• 3 State: Auto/On/Off. The default option is On.  

• 5 State: Auto/Off/Low/Medium/High. The default option is Auto.  
Set as Network setpoint: Select this option to connect the System 
command block with the Network input/set point and the Network 
output point. If the option is not selected, then the System command 
block can be connected with the Network output point, but not with 
the Network input/set point.  

Note:  

Set as Network Setpoint option is available only for the TR71/TR75 
model wall modules. 

Fan Command Preview Display the configured fan state options. All valid fan states appear 
grayed out (unless configured) in the preview area, by default. Note 
that the configuration that is made, is reflected in the preview area.  

Example: If the Enable Fan Command option is selected and 
select Default Fan State as On, the preview area shows a fan icon 
with On highlighted. Auto the other Default Fan State is also 
displayed but is grayed out indicated that it is not the selected 
option.  

Back Move to the Occupancy and Override wizard window.  

Next Move to the System Status and Command wizard window. 

Finish Exit the wizard after saving the configuration changes.  

Cancel The wizard prompts to save the changes.  
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Memory Usage Details Show current memory usage for the wall module. Memory updates 
are made every time when a change is made to the configuration. 
Every click in the S-Bus wall module calculates the memory at the 
background.  

Note:  

Memory usage must be less than or equal to 100% in order to 
download the configuration to the programmable controller.  

If the memory usage exceeds the maximum limit, a message 
appears indicating that the configuration must be modified in order 
to reduce the memory usage before downloading the configuration. 
Click the memory usage details button to view the distribution of 
memory for each configured component graphically and in a tabular 
format 

Help Acknowledge the user about functionality of the field. 
Preview Display the option to select either the Tenant View or Contractor 

View. 

Save to Library Save the wall module configuration to the Spyder library.  

Note:  

For details, refer save items to library on page 331 for more 
information about how to save this configuration to the library. 
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System Status and Command 
Use this page to view System Status and Command 
settings. The Preview Area at the bottom of the screen 
displays the LCD fan command options that are selected 
for the wall module. 

PROCEDURE 
1 Click the System Status and Command button on 

the left pane to open the System Status and 
Command page.  

2 Enter the information into the available fields.  

3 Click Finish to save the settings or Cancel to revert 
to the last saved settings.  

 
 

Figure 235: System Status and Command Screen 

FIELDS 

Table 105: Fields of System Status and Command Screen 

Name Definition 

Show Advanced Settings Display the System Status Values and System Command Values. 
System status values are enabled when Show system status 
checkbox is enabled. System command values are enabled only 
when enable system command checkbox is enabled and depending 
on the valid system commands selected, the respective values are 
enabled. Invalid values are disabled (depending on the system 
configuration options selected). Defaults will follow the LonMark 
standards. 

Hide Advanced Settings Hide the System Status Values and System Command Values. 
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Show System Status Indicate an option to enable/disable displaying the system status.  

Enable System Command Indicate an option to enable/disable tenant commanding the system.  

Following are the five valid system command options:  

• Off / Heat  

• Off / Cool  

• Off / Heat / Cool  

• Off / Auto / Heat / Cool  

• Off / Auto / Heat / Cool / Emergency Heat  

Default System Command: Set the default value for the system 
command options:  

• Off / Heat: Heat  

• Off / Cool: Cool  

• Off / Heat / Cool: Heat  

• Off / Auto / Heat / Cool: Auto  

• Off / Auto / Heat / Cool / Emergency Heat: Auto  

Set as Network setpoint: Select this option to connect the System 
command block with the Network input/set point and the Network 
output point. If the option is not selected, the System command 
block can be connected with the Network output point, but not with 
the Network input/ set point.  

Note:  

Set as Network Setpoint option is available only for the 
TR71/TR75 model wall modules. 

System Status and Command 
Preview Area 

Display a preview of the LCD system status and command options. 
If the Enable System Command option is checked, the SYSTEM 
soft key label is shown in the preview area and the soft key button 
(the soft key button on the extreme right) is activated. Press the soft 
key button to cycle through the available system command options.  

Back Move to the Fan Command wizard window.  

Next Move to the Preview wizard window. 

Finish Exit the wizard after saving the configuration changes. 

Cancel The wizard prompts to save the changes.  

• Click Save to save the changes. 

• Click No to ignore the changes. 

• Click Cancel to close the dialog box.  

Memory Usage Details Show current memory usage for the wall module. Memory updates 
are made every time when a change is made to the configuration. 
Every click in the S-Bus wall module calculates the memory at the 
background.  

Note:  

Memory usage must be less than or equal to 100% in order to 
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download the configuration to the programmable controller.  

If the memory usage exceeds the maximum limit, a message 
appears indicating that the configuration must be modified in order 
to reduce the memory usage before downloading the configuration. 
Click the memory usage details button to view the distribution of 
memory for each configured component graphically and in a tabular 
format 

Help Acknowledge the user about functionality of the field. 

Preview Display the option to select either the Tenant View or Contractor 
View. 

Save to Library Save the wall module configuration to the Spyder library.  

Note:  

For details, refer save Saving Library Items for information about 
how to save this configuration to the library. 
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Schedule/Time 
Use this page to configure the schedule from the Zio wall 
module of the controller. 

PROCEDURE 
1 Click the Schedule/Time button on the left pane to 

open the Schedule/Time page.  

2 Enter the information into the available fields. 

3 Click Finish to save the settings or Cancel to revert 
to the last saved settings.  

 

 
 

Figure 236: Schedule/Time Screen 

FIELDS 

Table 106: Fields of Schedule/Time Screen 

Name Definition 

Do you want Zio wall module to 
view/modify the controller time 

This field helps the user to view and modify the controller time. 
Select Yes to view and modify controller time. Select No to disable 
the controller time settings 

Do you want the Tenant to be able 
to view the controller time 

This field helps the tenant to view the controller time. Select Yes to 
view the controller time. Select No to disable the controller time 
settings.  

Do you want the Tenant to be able 
to edit the controller time 

This field helps the tenant to edit the controller time. Select Yes to 
edit the controller time. Select No to disable the controller time 
settings. 
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Do you want to change the schedule 
from the Zio 

This field helps the user to view and edit the schedule in contractor 
mode.  

On the Schedule page, select Yes to view and edit the schedule. 
Select No to disable the schedule settings.  

Do you want the tenant to be able to 
view the schedule 

This field helps the user to view the schedule in tenant mode.  

Select Yes to view the schedule.  

Select No to disable the schedule viewing in tenant mode.  

Do you want the tenant to be able to 
edit the schedule 

This field helps the user to edit the schedule in tenant mode.  

Select Yes to edit the schedule in tenant mode.  

Select No to disable the schedule editing in tenant mode. 

Do you want Zio to display the 
Schedule as 

This field helps user to set the schedule.  

• 8 day schedule (Monday, Tuesday, Wednesday, Thursday, 
Friday, Saturday, Sunday and Holiday) - This action allows to 
set the four events for each day. 

• 7 day schedule (Monday, Tuesday, Wednesday, Thursday, 
Friday, Saturday and Sunday) - This action allows to set four 
events for each day of the week except for holidays.  

• 5-2-1 schedule (Monday-Friday, Saturday-Sunday and 
Holiday) - This action allows the event settings in groups. This 
feature can be used to apply the event settings of a day to one 
or more days. For example: If the four events are set for 
Monday, the same event settings can be applied till Friday. 
Similarly, if a different set of events is available for Saturday, 
then the same settings can be applied to Sunday as well. For the 
holidays, different events have to be set.  

• 5-2 schedule (Monday-Friday and Saturday-Sunday) - This 
action allows event settings in the batch except for holidays. 

Memory Usage Details Show current memory usage for the wall module. Memory updates 
are made every time when a change is made to the configuration. 
Every click in the S-Bus wall module calculates the memory at the 
background.  

Note:  

Memory usage must be less than or equal to 100% in order to 
download the configuration to the programmable controller.  

If the memory usage exceeds the maximum limit, a message 
appears indicating that the configuration must be modified in order 
to reduce the memory usage before downloading the configuration. 
Click the memory usage details button to view the distribution of 
memory for each configured component graphically and in a tabular 
format 

Help Acknowledge the user about functionality of the field. 

Preview Display the option to select either the Tenant View or Contractor 
View. 

Save to Library Save the wall module configuration to the Spyder library.  
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Note:  

For details, refer Saving Library Items for information about how to 
save this configuration to the library. 

Back Moves to the System Status and Command wizard window.  

Next Move to the Password wizard window. 

Finish Exit the wizard after saving the configuration changes. 

Cancel The wizard prompts to save the changes.  

• Click Save to save the changes. 

• Click No to ignore the changes. 

• Click Cancel to close the dialog box.  

 

Password 
Use this page to set the password from Zio wall module. 

PROCEDURE 
1 Click the Password button on the left pane to open 

the Password page.  

2 Enter the information into the available fields. 

3 Click Finish to save the settings or Cancel to revert 
to the last saved settings.  

 
Figure 237: Password Screen 
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Table 107: Fields of Password Screen 

Name Definition 

Enable Password Protection This option enables the user for password protection.  

Password Label This option enables the user to add password label information.  

Password Displays the password required to change the mode from Tenant to 
Contractor. By default, the Zio wall module is in Tenant mode. 

Password Protection Preview In this section, the password protection can be previewed. Use this 
section to view the password settings 

Memory Usage Details Shows current memory usage for the wall module. Memory updates 
are made every time when a change is made to the configuration. 
Every click in the S-Bus wall module calculates the memory at the 
background.  

Note:  

Memory usage must be less than or equal to 100% in order to 
download the configuration to the programmable controller.  

If the memory usage exceeds the maximum limit, a message 
appears indicating that the configuration must be modified in order 
to reduce the memory usage before downloading the configuration. 
Click the memory usage details button to view the distribution of 
memory for each configured component graphically and in a tabular 
format 

Help Acknowledges the user about functionality of the field. 

Preview Displays the option to select either the Tenant View or Contractor 
View. 

Save to Library Save the wall module configuration to the Spyder library.  

Note:  

For details, refer Saving Library Items for information about how to 
save this configuration to the library. 

Back Moves to the Schedule wizard window.  

Next Moves to the Preview wizard. 

Finish Exits the wizard after saving the configuration changes. 

Cancel The wizard prompts to save the changes.  

• Click Save to save the changes. 

• Click No to ignore the changes. 

• Click Cancel to close the dialog box.  

 

Preview 
Use this page to preview the wall module configuration 
settings. 

PROCEDURE 
1 Click the Preview button on the left pane to open the 

Preview page.  

2 Select the view that needs to be display.  

3 Click Finish to save the settings or Cancel to revert 
to the last saved settings.  
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4 Click Back to display the System Status and 
Command page. 

 

 
Figure 238: Preview Screen 

FIELDS 

Table 108: Fields of Preview Screen 

Name Definition 

Select View Displays the wall module configuration preview with options to view 
the following:  

• Tenant view: Displays wall module settings for tenant (normal 
user)  

• Contractor view: Displays wall module settings for contractors 
(A unique button press sequence is used as a method of 
identifying a user as a Contractor. This button press sequence is 
made available only to Contractors.)  

Use the soft key buttons to preview the configuration mode. All valid 
settings are shown based on the configuration at the point the 
Preview button is pressed (including any defaults). For segments 
that are not enabled, based on the configuration, the soft key button 
(located directly beneath the segment) is not enabled.  

Click Close to close the Preview window. 
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CONTROL FUNCTION 
BLOCKS 
The HoneywellSpyderTool provides the following 
Control function blocks that can be configured and use to 
build the required application logic: 

• AIA 
• Cycler 
• Flow Control 
• PID 

• Rate Limit 
• Stager 
• Stage Driver 

AIA 
This function is an Adaptive Integral Action controller 
(AIA). It can be used in place of the PID. This control 
works better than PID when delays in the process being 
controlled cause integral windup resulting in undershoot 
or overshoot that leads to instability. 

 
 

Logic Diagram Function Block 

Figure 239: AIA Function  

Err = Sensor – Set Point. 

If Direct/Reverse is set to reverse, then Err term is set to 
–Err. 

Tr (throttling range): It is Error value that results in an 
Output change of the maximum value (MaxAOchange) 
from one step to the next. MaxAOchange is the 
maximum amount (%) that Output will change for a single 
cycle of the control (1 second). This is typically set to 100 
%/( Actuator speed (second/full stroke)).  

Deadband: Deadband is the absolute value that Error 
must be greater than before the output will change. 

EffErr = Err – deadband 

If Err > 0, ErrSign = 1 else ErrSign = –1 

If |Err| < dead band, then AbsErr = 0. 

Otherwise (|Err| > deadband), AbsErr = |Err| – deadband 

Output = Output + ErrSign * [(maxAOchng – minAO) * 
(AbsErr / (ThrottlingRange – Deadband)) * 3 + MinAO)]. 

From iteration to iteration, the Function Block keeps track 
of the old proportional error. On power up/reset this is 
cleared. 

Logic Inputs 
Table 109: Logic Inputs of AIA Function 

Input 
Name Input Value Logic 

Value Description 

disable unconnected 0  AIA function 
runs. 

 VAL != 0.0  1  Disable AIA 
function. 
Output is 
set to 0. 

 0.  0  AIA function 
runs 

 invalid  0  AIA function 
runs. 
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Analog Input 
Table 110: Analog Input of AIA Function 

 Range   

Input Name Low High Input Value Description 

sensor  >= –infinity < +infinity unconnected AIA functions disabled. Output 
is set to 0. 

   invalid AIA functions disabled. Output 
is set to 0. 

setPt >= –infinity < +infinity unconnected AIA functions disabled. Output 
is set to 0. 

   invalid  AIA functions disabled. Output 
is set to 0. 

tr  0  < +infinity unconnected AIA functions disabled. Output 
is set to 0. 

   invalid AIA functions disabled. Output 
is set to 0. 

   VAL <= 0 AIA functions disabled. Output 
is set to 0. 

maxAOChange 0< 100 unconnected MaxAOChange = 1.1 %/ sec 

(%/sec)   invalid MaxAOChange = 1.1 %/ sec 

   0 MaxAOChange = 1.1 %/ sec 

   VAL < low MaxAOChange = 1.1 %/ sec 

   VAL > high MaxAOChange = 1.1 %/ sec 

deadband 0 < tr unconnected Disable Dead Band action  

   invalid Disable Dead Band action 

   

VAL < low 

OR 

VAL >+ tr 

DB = 0 

   0 disable Dead Band action 

derivGain  0 <+ unconnected val = 0 

   invalid val = 0 

minAO Change 0< <= maxAOchange unconnected MinAOchange = 0 

   invalid MinAOchange = 0 

   VAL < 0 MinAOchange = 0 

   VAL>=MaxA 
Ochange 

MinAOchange = 0 
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Output 
Table 111: Output of AIA Function 

Output Name Range Description 

OUTPUT 0 to +100 % Output = Output + ErrSign * NonLin (AbsErr, ThrottlingRange, 
 MaxAOchange, MinAOchange) 

 

Setpoint 
Table 112: Setpoint of AIA Function 

Name Range/Value Description 

revAct 0 =  Direct 
 acting  

1 =  Reverse 
 acting. 

User specified 
revAct value 

Cycler 
This function is a generic stage driver or a Thermostat 
Stage Cycler dependant on the value of the CPH 
parameter (cph=0 means stager functionality, and 
cph=1-60 gives thermostat cycler functionality). 

 

 

 

  

Logic Diagram Function Block 

Figure 240: Cycler Function 

 

Logic Inputs 
Table 113: Logic Inputs of Cycler Function 

Input Name Input Value Logic Value Description 

disable unconnected 0 Normal operation 

 VAL != 0.0 1 Disable block, output = 0 

 0 0 Normal operation 

 invalid 0 Normal operation 
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Input Name Input Value Logic Value Description 

override Off  unconnected 0 Normal operation 

 VAL != 0.0 1 Turns off stages as min on time allows 

 0 0 Normal operation 

 invalid 0 Normal operation 

Analog Inputs
Table 114: Analog Inputs of Cycler Function 

 Range   

Input Name Low High Input Value Description 

in 0 100 unconnected stgsAct = 0 

(%)   invalid in = 0% 

maxStgs 1 255 unconnected stgsAct = 0 

   invalid maxStgs = 1 

minOn 0 65535 unconnected stgsAct = 0 

(sec)   invalid stgsAct = 0 

minOff 0 65535 unconnected stgsAct = 0 

(sec)   invalid stgsAct = 0 

intstgOn 0 65535 unconnected stgsAct = 0 

(sec)   invalid stgsAct = 0 

intstgOff 0 65535 unconnected stgsAct = 0 

(sec)   invalid stgsAct = 0 

Output 
Table 115: Output of Cycler Function 

Output Name Range Description 

STAGES_ ACTIVE 0 to +100 % The number of stages active (on) 

 

Setpoints 
Table 116: Setpoints of Cycler Function 

Name Range/Value Description 

anticipatorAuthority  0 to 200% User specified value Typical value 100% 

cph 0 to 60 User specified value. 

hyst 0 to 100 User specified value. 
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Configuration  
1. Specify CPH from 0 to 60. 

2. Specify Anticipator Authority from 0 to 200%. Typical 
value is 100%. 

3. Specify hysteresis from 0 to 100. 

Cycler Functionality 
The Cycler function is the traditional anticipator cycling 
algorithm used in Honeywell thermostats. Input is either 
P or PI space temperature error in % (0-100). 

 
Standard (recommended) settings are cph = 3 for 
cooling, cph = 6 for heating, anticAuth = 100%,  
hyst = 100%/maxstages/2. Also note that for multiple 
stage cyclers the PID block feeding this block should 
have an appropriately large throttling range to achieve 
smooth behavior. 

 

100 % /MaxStgs

Stages

CmdPercent

Stage 3 locked on

AnticAuth/MaxStgs

Cycler 
Behavior

Stage 2 locked on

Stage 1 locked on

- Hyst
0 %

Hyst

 
 

Figure 241: Cycler Functionality 

Stager Functionality 
The Stager Function takes a 0-100 percent (typically PID 
error) input and determines how many stages to turn on. 
The 0-100 percent input range is divided evenly between 
how many stages are configured in MaxStages. The first 
stage is turned on at CmdPercent > 0 and off at 
CmdPercent < – Hyst. As shown in following illustration 
the general criterion for turning on stage N is:  

CmdPercent > (N –1) * 100% / MaxStages.  

For turning off stage N the criterion is: 

CmdPercent < (N –1) * 100% / MaxStages – Hyst 

From iteration to iteration, the Function Block keeps track 
of the on timer, off timer, anticipator, and CPH multiplier. 
On power up/reset, the off timer and anticipator are 
cleared, the on timer is set equal to the inter-stage on 
time and the CPH multiplier is recalculated. 

 

100 %/MaxStgs

Stages

CmdPercent

Stage 3 on

Stager 
Behavior

Stage 2 on

Stage 1 on

0 %

Hyst

 
Figure 242: Stager Functionality 

 

When overrides is TRUE, active stages are shed (turned 
off) based on min on and inter stage timers regardless of 
the CmdPercent input. Output is the number of stages 
active (0-MaxStages) which can be sent to the 
StageDriver function block. Configuration parameters 
include: 
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• MaxStages is the maximum stages available to turn 
on.  

• CPH (non-zero) is max cycle rate in Cycles Per Hour 
when input is halfway between stages available, and 
AnticAuth is at default value (100%). CPH = 0 means 
the Stager logic is performed and has no other effect. 

• Hyst is the switching differential around the switch 
points in % error.  
(Range: 0 < Hyst < 100 / Maxstgs) 

• AnticAuth (cycler only (CPH!= 0)) is the anticipator 
authority, which allows adjustment of the cycling 
behavior. It represents the max amount of “fake” error 
in % that is input into the switching logic when 
MaxStages are turned on. (Range 0 < AnticAuth < 
200.) 

• MinOnTime is the minimum time a stage must be on 
once it is turned on. 

• MinOffTime is the minimum time a stage must be off 
once it is turned off. 

• InterstageOn is the minimum time before the next 
stage can be turned on after the previous one is 
turned on. 

• InterstageOff is the minimum time before the next 
stage can be turned off after the previous one is 
turned off. 

Flow Control 
This function is a Variable Air Volume (VAV) Damper 
Flow Controller. Traditionally, this is the second half of a 
pressure independent VAV box cascade control strategy. 
Typically, the input would come from the output of a PID 
block controlling space temperature. 

 

  

Logic Diagram Function Block 

Figure 243: Flow Control Function 

Analog Inputs 
Table 117: Analog Inputs of Flow Control Function 

 Range   

Input Name Low High Input Value Description 

cmdFlowPercent (%) 0 <+ infinity 
unconnected cmdFlowPercent= 0 

invalid Same as unconnected 

sensedFlowVol  >=– infinity <+ infinity 
unconnected damperPos = cmdFlowPercent 

invalid damperPos = cmdFlowPercent 

minFlowSetPt  >=– infinity <+ infinity unconnected 

Switch to Pressure dependant 
mode.  
• minFlowSetPt = 20  
• maxFlowSetPt = 100  
• effFlowSetPt = invalid 
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 Range   

Input Name Low High Input Value Description 

invalid  Same as unconnected 

maxFlowSetPt  >=– infinity <+ infinity 
unconnected 

Switch to Pressure dependant 
mode.  
• minFlowSetPt = 20  
• maxFlowSetPt = 100  
• effFlowSetPt = invalid 

invalid Same as unconnected 

manFlowOverride  >=– infinity <+ infinity 
unconnected Normal operation 

invalid  Same as unconnected 

manFlowValue   0 <+ infinity 
unconnected value = invalid 

invalid  Same as unconnected 

ductArea  >0 <+ infinity 

invalid 
effFlowSetPt = invalid & damperPos 
  = (100* minFlowSetPt/ 
  maxFlowSetPt) 

unconnected Same as invalid 

VAL <= 0 Same as invalid 

Output 
Table 118: Outputs of Flow Control Function 

Output Name Range Description 

EFF_FLOW_SETPT  Any floating point value Effective Flow setpoint 

DAMPER_POS Any floating point value Damper position 

Setpoints 
Table 119: Setpoints of Flow Control Function 

Name Range/Value Description 

units  

0 to 2 

• 0 = flow (cfm), area (ft2)  

• 1 = flow (Lps), area (m2)  

• 2 = flow (cmh), area (m2).  

• Default is zero (0). 

motorSpeed 1 to 255 Seconds per 90° Default is 90 

Configuration  
• Specify the units from 0 to 2. 

 0 = flow (cfm), area(ft2) 

 1 = flow (Lps), area (m2) 

 2 = flow (cmh), area (m2).  

• Specify the motor speed from 1 - 255 sec per 90 °. 
Default is 90. 

 

The Flow Controller function calculates an effective flow 
control set point (effFlowSetPt) and outputs a  
0 % - 100 % command to drive a VAV box damper. The 
commanded flow set point (in percent) from a 
temperature control signal is mapped into the effective 
flow set point such that 0 % maps to the min flow set 
point and 100 % maps to the max flow set point. The 
sensedFlowVol input is the volumetric flow into the box, if 
it is invalid (sensor fails) the damper is driven in a 
pressure dependant mode where: 
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Output = 100% * (minSP/maxSP) +  
 (1 − minSP/maxSP) * cmdPercent. 

If either flow MinSP, MaxSP is invalid, the  
Output = 20% + .8 * cmdPercent 

The Units parameter sets the units being used for the 
flow sensor, set points, and the duct area where  
0 = cfm (flow) and ft2 (area), 1 = L/s (flow) and  
m2 (area), 2 = m3/hr (flow) and m2 (area).  
The cmdFlowPercent input is the input in percent from 
the temperature control logic. DuctArea is the duct area 
in units per the Units parameter selection. DuctArea is 
required for the control algorithm. 

The control loop is implemented in air velocity in order to 
simplify loop tuning. The motorSpeed parameter is the 
time the actuator being used takes to travel a full 90° 
stroke in seconds (this is used to automatically adjust the 
control gains). 

The manFlowOverride input allows the flow set point to 
be selectively overridden based on the following codes: 
(taken from snvt_hvac_overid) 

• 0 and all others not listed = no override (normal 
operation) 

• 2 = effFlowSetPt is set to the ManFlowValue input 
• 6 = effFlowSetPt is set to the minFlowSetPt input 
• 7 = effFlowSetPt is set to the maxFlowSetPt input 
Manual flow override is particularly useful when trying to 
make the box easy to be balanced. 

 

 
Figure 244: EffectiveFlowSetPt Calculation 

PID 
The PID controller compares a measured value from a 
process with a reference setpoint value. The difference 
(or error signal) is then used to calculate a new value for 
a manipulatable input to the process that brings the 
process measured value back to its desired setpoint. 
Unlike simpler control algorithms, the PID controller can 
adjust the process outputs based on the history and rate 
of change of the error signal, which gives more accurate 
and stable control. 

 
 

Logic Diagram Function Block 

Figure 245: PID Function Block 

In a PID loop, correction is calculated from the error in 
three ways:  

• Cancel out the current error directly (Proportional) 

• The amount of time the error has continued 
uncorrected (Integral) 

• Anticipate the future error from the rate of change of 
the error over time (Derivative) 
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 Err = Sensor – Set Point 

 Kp = 100/Proportional Band 

 Ti = Integral Time (seconds) 

 Td = Derivative Time (second) 

 Bias = proportional offset (%)  

• Output (%) =Bias +Kp * Err + Kp/Ti  + 
Kp* Td*dErr/dt 

 

Logic Inputs 
Table 120: Logic Inputs of PID 

Input Name Input Value Logic Value Description 

disable unconnected 0.  PID function runs. 

 VAL != 0.0 1 PID function is disabled. Output set to zero 

 0 0 PID function runs. 

 invalid 0 PID function runs. 

 

Analog Inputs 
Table 121: Analog Inputs of PID 

 Range   

Input Name Low High Input Value Description 

sensor >=− infinity <+ infinity unconnected PID function disabled. Output is set to 0. 

   invalid  

setPt >=− infinity <+ infinity unconnected PID function disabled. Output is set to 0 

   invalid Same as unconnected 

tr 0< <+ infinity unconnected PID function disabled. Output is set to 0. 

   invalid Same as unconnected 

   0 PID function disabled. Output is set to 0 

   VAL < low val = low 

intgTime 0 <+ infinity unconnected PID function disabled. Output is set to 0. 

(sec).    invalid Disable Integral Action. 

   0 Disable Integral Action. 

   VAL < low IT = low 

dervTime 0 <+ infinity unconnected Disable Derivative action. 

(sec)   invalid Disable Derivative action 

   0 Disable Derivative action. 

   VAL < low DT = low 

deadBand  0 < tr unconnected Same as 0 input 

   invalid Same as 0 input 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 256  

 Range   

Input Name Low High Input Value Description 

   VAL < low or 
VAL >= tr 

DB = 0 

   0 Disable deadband action 

dbDelay 0 65565  Deadband delay 

(sec)    unconnected Same as 0 input 

   invalid Same as 0 input 

   0 Deadband action enabled without delay 

   VAL < low Dead band delay = low 

Output 
Table 122: Output of PID  

Output Name Range Description 

OUTPUT  −200 to +200 % Output (%) =Bias +Kp * Err + Kp/Ti  + Kp* Td*dErr/dt 

Setpoints 
Table 123: Setpoints of PID 

Name Range/Value Description 

Action  • 0 = Direct acting 
• 1 = Reverse acting  
For Spyder Relay model only:  
• 2 = sign of tr.  
• Under this setting:  
• If throttling range < 0, reverse 

action  
• If throttling range >= 0, direct 

action 

User specified inputs 

bias 0 to 100% User specified inputs 

Configuration 
1 Specify Action 

• 0 = Direct acting  

• 1 = Reverse acting 

2 Specify the bias: 0 to 100%. 

When Disable/Initialize input is TRUE, the Output and 
the integral are set to 0 and the block stops running.  

If Direct/Reverse is set to reverse, then Err term is set to 
–Err. 

When Err < Deadband, Err is set to zero until Deadband 
Delay time has elapsed and Err is still in the dead band. 

To prevent integral wind up, the integral portion of the 
total error output is limited to 100%.  

From iteration to iteration, the Function Block keeps track 
of the old proportional error, integral error, and deadband 
timer. On power up/reset these are cleared. 

Rate Limit 
This function creates an output that follows the input, but 
prevents the output from changing faster that the 
specified rates depending on direction. 
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Logic Diagram Function Block 

Figure 246: Rate Limit Function 

Logic Inputs 
Table 124: Logic Inputs of Rate Limit Function 

Input Name Input Value Logic Value Description 

disable unconnected 0.  Function runs. 

 VAL != 0.0 1 The function is disabled.  

 0 0 The function runs. 

 invalid 0 The function runs. 

 

Analog Inputs 
Table 125: Analog Inputs of Rate Limit Function 

 Range   

Input Name Low High Input Value Description 

in  >=- infinity <+ infinity unconnected In= 0.0 

   invalid In = Invalid 

   Valid In = value 

     

startInterval  0 65535 unconnected Startinterval = 0 

(sec)    invalid Start interval = 0 

   0<val<max float Limit Start interval value 0 to 65535.0 
sec. 
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 Range   

Input Name Low High Input Value Description 

   <0 StartInterval = 0 

startVal.  >=- infinity <+ infinity  Output assumes the start value when 
the function is disabled 

   unconnected If disable=1, then Out=in 

   invalid If disable=1, then Out=in 

     

upRate  0< <+ infinity unconnected No limit on up rate 

(chg/sec)   invalid No limit on up rate 

   0  No limit on up rate 

   <0 upRate = 0 (no limit on up rate) 

down  0< <+ infinity unconnected Rate no limit on down rate 

(chg/sec)   invalid no limit on down rate  

   0 no limit on down rate 

   <0 downRate=0 (no limit on up rate) 

 

Output 
Table 126: Output of Rate Limit Function 

Output Name Range Description 

OUTPUT  Any floating point value  Rate limit 

 

Operation 
The value StartInterval (Sec) limits the output after the 
rate limit function is enabled (disable input set to 0) and 
the StartInterval time is still in process. Ratelimit uses 
the startVal input as the default output during disable. 

• If the rate limit function is disabled (disable input set 
to 1) the output will be set to StartVal. 

• After rateLimit is enabled (disable set to 0) the 
StartInterval timer will count down from the 
StartInterval number of seconds and during this time 
the output will be rate limited. 

• When the timer expires (and ratelimit is enabled) the 
out value will be exactly what the input (in) is set to 
and there will no longer be rate limiting. 

• If the StartInterval second is set to 0 (and ratelimit 
is enabled), then the output will be Ratelimited. 

• During Ratelimit the output will move at a maximum 
allowed rate toward the new input value each 
second. 

• UpRate controls the rate in a more positive direction, 
and DownRate controls the rate in a more negative 
direction. UpRate set to zero means the uprate limit 
is not enforced. DownRate set to zero means the 
downrate limit is not enforced. 

• Out is set to StartVal before rate limiting is enabled 
(disable set to 0). 

• From iteration to iteration, the Function Block keeps 
track of the start timer. On power/up/reset, this is set 
to the StartInterval. 

Stager 
This function is a generic stage driver or a Thermostat 
Stage Cycler dependant on the value of the CPH 
parameter. 
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Where cph = 0 means stager functionality, and  cph = 1-60 gives thermostat cycler functionality.  

  

Logic Diagram Function Block 

Figure 247: Stager Function Block 

Logic Inputs 
Table 127: Logic Inputs of Stager Function 

Input Name Input Value Logic Value Description 

disable unconnected 0 Normal operation 

 VAL != 0.0 1 Disable block, output = 0 

 0 0 Normal operation 

 invalid 0 Normal operation 

override Off unconnected 0 Normal operation 

 VAL != 0.0 1 Turns off stages as min on time allows 

 0 0 Normal operation 

 invalid 0 Normal operation 

 

Analog Inputs 
Table 128: Analog Inputs of Stager Function 

 Range   

Input Name Low High Input Value Description 

in  0 100 unconnected stgsAct = 0 

%   invalid in = 0% 

maxStgs 1 255 unconnected stgsAct = 0 

   Invalid masStgs = 0 
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 Range   

Input Name Low High Input Value Description 

minOn  0 65535 unconnected stgsAct = 0 

(sec)    invalid stgsAct = 0 

minOff  0 65535 unconnected stgsAct = 0 

(sec)   invalid stgsAct = 0 

intstgOn 0 65535 unconnected stgsAct = 0 

(sec)   invalid stgsAct = 0 

intstgOff 0 65535 unconnected stgsAct = 0 

 (sec)  invalid stgsAct = 0 

 

Output 
Table 129: Output of Stager Function 

Output Name Range Description 

STAGES_ ACTIVE   0 to +100 % The number of stages active (on) 

 

Setpoints 
Table 130: Setpoint of Stager Function 

Name Range/ Value Description 

hyst  0 to 100 User specified value. 

 

Configuration 
Specify hysteresis from 0 to 100. 

Cycler Functionality 
The Cycler function is the traditional anticipator cycling 
algorithm used in Honeywell thermostats. Input is either 
P or PI space temperature error in 
% (0-100). 

Standard (recommended) settings are cph = 3 for 
cooling, cph = 6 for heating, anticAuth = 100%,  
hyst = 100%/maxstages/2.Also note that for multiple 
stage cyclers the PID block feeding this block should 
have an appropriately large throttling range to achieve 
smooth behavior. 
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Figure 248: Cycler Behavior

Stager Functionality 
The Stager Function takes a 0-100 percent (typically PID 
error) input and determines how many stages to turn on. 
The 0-100 percent input range is divided evenly between 
how many stages are configured in MaxStages. The first 
stage is turned on at CmdPercent > 0 and off at 
CmdPercent < – Hyst. As shown in following illustration 
the general criterion for turning on stage N is: 

• CmdPercent > (N - 1) * 100% / MaxStages  

• For turning off stage N the criterion is: 

• CmdPercent < (N - 1) * 100% / MaxStages – Hyst 

From iteration to iteration, the Function Block keeps track 
of the on timer, off timer, anticipator, and CPH multiplier. 
On power up/reset, the off timer and anticipator are 
cleared, the on timer is set equal to the inter-stage on 
time and the CPH multiplier is recalculated. 

100 % /MaxStgs

Stages

CmdPercent

Stage 3 locked on

AnticAuth/MaxStgs

Cycler 
Behavior

Stage 2 locked on

Stage 1 locked on

- Hyst
0 %

Hyst

 
Figure 249: Stager Behavior 

When override is TRUE, active stages are shed (turned 
off) based on min on and interstage timers regardless of 
the CmdPercent input. Output is the number of stages 
active (0-MaxStages) which can be sent to the 
StageDriver function block. Configuration parameters 
include: 

• MaxStages is the maximum stages available to turn 
on.  

• CPH (non-zero) is max cycle rate in Cycles Per Hour 
when input is halfway between stages available, and 
AnticAuth is at the default value (100%). CPH = 0 
means the Stager logic is performed and has no other 
effect. 

• Hyst is the switching differential around the switch 
points in % error.  
(Range: 0 < Hyst < 100 / Maxstgs) 
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• AnticAuth (cycler only (CPH!= 0)) is the anticipator 
authority, which allows adjustment of the cycling 
behavior. It represents the max amount of “fake” error 
in % that is input into the switching logic when 
MaxStages are turned on. (Range 0 < AnticAuth < 
200.) 

• MinOnTime is the minimum time a stage must be on 
once it is turned on. 

• MinOffTime is the minimum time a stage must be off 
once it is turned off. 

• InterstageOn is the minimum time before the next 
stage can be turned on after the previous one is 
turned on. 

• InterstageOff is the minimum time before the next 
stage can be turned off after the previous one is 
turned off. 

Stage Driver 
The StageDriverMaster function takes an input number 
of stages active and determines which stages to 
energize or de energize based on the lead/lag strategy 
chosen while doing Stage driver control block 
configuration. Stage Driver works with StageDriverAdd to 

distribute additional stages above those provided in 
Stage Driver. Stage Driver also maintains nonvolatile 
runtime total and digital stage status information for each 
stage.  

The configuration tool will set a runtime and 
stgStatusOut, offset in a single offsets variable. The 
offsets variable is not used as a Public Variable ID. The 
lower byte will store the offset in digital memory to 
reference the starting stage status memory index, and 
the upper byte will store the offset in nonvolatile memory 
to reference the starting runtime memory index. 
stgStatusOut is the offset to digital stage status that is 
used by connected StageDriverAdd blocks. 

As more stages are set up during design, the 
configuration tool will calculate the starting address for 
both stage status and runtime, and allocate the memory 
and calculate the offset from the base index that is the 
starting address for the runtime area and the stage 
status area in their respective memories. 

The stage status information is accessible to drive 
additional stages. The StageDriverAdd function blocks 
are used to drive the stages above those provided in 
Stage Driver up to 255 stages. 

 

 

 

Logic Diagram Function Block 

Figure 250: Stage Driver Function 
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Analog Inputs 
Table 131: Analog Inputs of Stage Driver Function 

 Range   

Input Name Low High Input Value Description 

nStagesActive  0 255 unconnected Stages all off 

   invalid Stages all off  

runtimeReset 0 255 Unconnected No action to reset; runtime can accumulate 

   Invalid No action; runtime can accumulate 

   Value=0 No action; runtime can accumulate 

   1<=VAL<=255 Stage runtime for stage VAL is reset to 0; 
runtime for this stage will not accumulate— 
should be reset VAL to 0 to allow accumulation 
of runtime. 

Outputs 
Table 132: Outputs of Stage Driver Function 

 Range  

Output Name Low High Description 

Stage1 0  1 Stage 1 output 

Stage2 0 1 Stage 2 output 

Stage3 0  1 Stage 3 output 

Stage4  0 1 Stage 4 output 

Stage5 0 1 Stage 5 output 

stgStatusOut    Output values to connect to StageDriverAdd block. The floating 
number must be converted to an integer and then converted to a 2 
byte value. The upper byte (value right shifted 8 bits) is the 
maxStgs info and the lower byte (value AND 0xFF) is the 
stageStatus offset to reference the starting location in digital 
memory for the stageStatus bytes. 

offset    Float value has two components – after conversion to a two byte 
unsigned integer value, the upper byte is offset of a number of 
nonvolatile entries to get to the start of the stage runtime storage 
(used only for leadLag=LL-RUNEQ) and the lower byte is the offset 
of number of digital memory locations to the start 

 

Configuration 
Specify the maximum number of stages (maxStgs) from 
1 to 255. 

Specify the lead lag 

• LL_FOLO = 0  first on last off 

• LL_FOFO = 1  first on first off 

• LL_RUNEQ = 2  runtime equalization for lowest 
runtime 

If the leadlag is outside of the range of 0 - 2 then stages 
are initialized to off and not commanded. 

Inputs 
nStagesActive is the input number of stages to be 
distributed to on/off values to individual stages. 
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runtimeReset is the stage number, runtime to be reset to 
0 if the lead-lag parameter is set to LL RUNTIME. 0 or 
unconnected results in no reset occurring. This value 
must be returned to 0 to allow the reset stage number to 
resume counting. It is only valid, if leadLag is set to LL 
RUNTIME. The stage runtime values are only allocated 
and updated if the leadLag config is set to LL RUNTIME. 
The runtime for each stage is stored as a floating point 
number in intervals of 1 min.  

The stages are sampled once a minute and if the stage 
is on, then the stage runtime accumulator number for 
that stage is incremented by one minute. The range of 
values for an integer number stored as a float, is from –
16,777,216 to 16,777,216. If the runtime is stored in 
minutes starting at 0 to 16,777,216, then the range of 
runtime is from 0 to 31.92 years of run time. 

Outputs 
Stage1, stage2, stage3, stage4, and stage5 are 
individual outputs that represent on or off values. These 
are outputs that are turned on in a different order 
depending on the leadLag strategy. 

stgStatusOut is connected from StageDriver to the 
StageDriverAdd block and gives a floating point number 
combined to hold two pieces of information, offset in the 
Common Memory to the  

StageBitStatus values and maximum number of stages 
are available. This information is used by the 
StageDriverAdd to find the correct offset to command 
which stages to turn on or off.  
The floating value can be converted to an integer and 
ANDed with 0xFF. It will give the value of the 
stageStatus Offset. The floating value stgStatusOut 
converted to an integer and right shifted 8 bits will give 
the byte value of the maxStages. These values are 
needed to allow the StageDriverAdd to work properly.  

The values in stgStatusOut are created by the 
StageDriver stage and no tool calculation is required. 

Offsets store the public Variable ID to a float a value 
created by the tool to allocate storage memory and 
reference for stage status in digital memory and stage 
runtime in nonvolatile memory. There are two offsets 
stored inside the float value, one for runtime, and one for 
stage status. The offset, float value right shifted 8 bits 
gives the number of nonvolatile float values from the 
beginning nonvolatile index (offset) where the runtime 
values are stored (one runtime value offset for each 
stage configured), and the offset ANDED with 0xff gives 
the number of digital values from the base where the 
stagestatus is stored (one byte per up to 8 stages 
configured). Each digital memory location takes up 1 
byte storage in calculating the offset. 

Example 

If three nonvolatile were already assigned and four digital 
outputs were already assigned before adding a 
stagedriver stage of nine stages with runtime 
accumulation, then the offset float value would be 256 (3) 
+ 4 = 772.0.  

That means the tool would have 8 nonvolatile runtime 
locations starting at offset 3 from the base of nonvolatile 
memory. The tool would allocate digital memory of two 
bytes for the stage status starting at offset of 4 from the 
base of digital memory. The tool sets this float value for 
offsets and allocates the memory, and then stagedriver 
uses this information to know where to look for 
stagestatus and stage runtime information.  

The Float value that stores Offsets is composed of two 
values 

• offsetStageRuntimer (byte)  

The float value converted to an integer and shifted 8 
bits specifies the variable quantity offset to be applied 
to the beginning of nonvolatile memory variable 
numbers that indicates the starting variable number 
used to store the individual stage runtime values. This 
number is calculated by the configuration tool and is 
not changeable.  

• offsetStageStatus (byte)  
The float value converted to an integer and ANDed 
with 0xFF specifies the variable number offset to be 
applied to the beginning of the digital memory area 
that indicates the starting variable number used to 
store the individual stage on/off values. This number 
is calculated by the configuration tool and is not 
changeable. This value is exported to other stages 
through the stageBitStatus output. 

Parameters 
leadLag (Byte param:UBYTE) specifies whether the 
staging strategy should be: 

• First on, last off (LL STD = 0 - standard) 

• First on, first off (LL FOFO = 1 - Rotating) 

• Run time accumulation where next ON has lowest 
runtime and next OFF has highest runtime (LL 
RUNTEQ = 2 - Runtime Accumulation) 

Runtime Accumulation selection requires the tool to 
allocate Nonvolatile memory and Set the Offsets value.  

 

Example 
LL STD: Consider that a Stage Driver function block is 
configured with 3 stages and with LL STD settings for a 
boiler application. Then if, 

1. nStageActiveinput value=1, Stage 1 will be turned 
ON 

2. If nStageActiveinput value=2, Stage 1 and stage 2 
will be turned on 

3. If nStageActiveinput value becomes 3, or greater 
than 3, then all 3 stages will turn on. 

Now suppose nStageActiveinput was 3 and it becomes 
2, then stage 3 will be turned OFF first and stage 1 and 2 
will remain ON. Stage 3 will be turned OFF because it 
was last stage. Stage 1 always comes on first and is 
always the last stage to turn off. 



HONEYWELL SPYDER USER GUIDE 

 265 31-00089—02 

LL FIFO: If the stage driver is configured as LL_FIFO, 
then stage driver operates the stages on a basis of First 
On First Off. 

Number of Active stages = value of nStagesActive input 

If stage driver with three stages and with LL_FIFO is 
configured and if, 

1. nStageActive input becomes 1, then stage 
driver will turn on first stage. 

2. nStageActive input becomes 2 then stage driver 
will turn on second stage. 

3. nStageActive input becomes 1, then Stage 1 
will be turned OFF. 

4. nStageActive input again become 2, then Stage 
3 will be turned ON. 

5. nStageActive input  become 1, then Stage 2 will 
be turned OFF as it was the first stage 

 

 
RUNTEQ:  If stage driver is configured with 
LL_RUNTEQ, it will accumulates the run time of every 
active stage. When staging down is required, it will turn 
OFF the stage which has largest runtime. 

Number of active stages=value of nStageActive input.  

If stage driver is configured with 3 stages and with 
LL_RUNTEQ. Setting, then 

1. If nActiveStages input value is 0, then all stages 
are turned OFF. If it is considered as an initial 
condition then accumulated active time for every 
stage is 0 minutes. 

2. If nActiveStages value becomes 1, then first 
stage will be turned ON. If stager remains in this 
condition for 2 minutes, then runtime of first 
stage will be 2 minute. 

3. If nActiveStages value becomes 2, then second 
stage will be turned ON. If stager remains in this 
condition for 2 minutes, then runtime of first 
stage will be 4 minute. And runtime of the 
second stage is 2 minutes. 

4. If nActiveStages value becomes 1, then first 
stage will be turned OFF. And second stage will 
remain ON as second stage has least time. 

5. If nActiveStages value becomes 2, then third 
stage will be turned ON as third stage has 0 
runtime as compared to first stage 

During staging up, the least runtime stage will be turned 
ON and during staging down, the stage with highest run 
time will be turned OFF. The aim is to equal runtime of 
every stage to avoid wear and tear.

maxStages (Byte param:UBYTE) specifies how many 
total stages nStagesActive can reach. MaxStages can 
go up to a total of 255 stages. 

 

 
Note:  

Due to limitations of Niagara, only 95 stages can 
be seen on the wiresheet. To see, say stage 
number 200, do one of the following: 

• Select the stages (in this case, stage 200) 
that needs to be seen by right-clicking them 
in the Block Configuration table under 
Show Stages and select Show. 

• Invoke the link editor on the wire sheet. 
Select the Source and the Target (in this 
case, stage 200). 
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DATA FUNCTION BLOCKS 
The honeywellSpyderTool provides the following Data 
Function blocks that can be configured and use to build 
the required application logic:  

• Alarm 

• Counter 

• Override 

• Run Time Accumulate 

• Priority Override 

Alarm 
This function creates an alarm based on the value of the 
input compared to the high and low limits. Up to 32 alarm 
function blocks can be created that map to nvoError. 
From iteration to iteration, the function block keeps track 
of the alarm status and delay timer. On power up/reset, 
these are cleared. 

It is NOT necessary to connect the output of this 
Function Block to the input of another for this function 
block to work. (This is said because as a general rule, if 
a Function Block’s output is not connected, it has no 
value.) The Alarm Function Block is different because it 
also sets/resets a bit in nvoError. 

 
 

Logic Diagram Function Block 

Figure 251: Alarm Function 

Logic Inputs 
Table 133: Logic Inputs of Alarm Function 

Input Name Input Value Logic Value Description 

disable unconnected 0 Set Disable = False 
 invalid 0 Set Disable = False 

 0 0 The disable is False 
 VAL != 0.0 1 The disable is True 

Analog Inputs 
Table 134: Analog Inputs of Alarm Function 

 Range   
Input Name Low High Input Value Description 

Value  >=- infinity <+ infinity unconnected Value = invalid 

   invalid Value = invalid 

High Limit  >=- infinity <+ infinity unconnected High Limit = invalid 

   invalid High Limit = invalid 

Low Limit  >=- infinity <+ infinity unconnected Low Limit = invalid 



HONEYWELL SPYDER USER GUIDE 

 267 31-00089—02 

 Range   
Input Name Low High Input Value Description 

   invalid Low Limit = invalid 

Preset Time  0 3276 7 unconnected Preset Time = 0 

(sec)   invalid Preset Time = 0 

Post Time 0 3276 7 unconnected Post Time = 0 

(sec)   invalid Post Time = 0 

Output 
Table 135: Output of Alarm Function 

Output Name  Range Description 

ALARM_STATUS False (0) / True (1) Alarm status 

Operation 
If the Value is greater than the High Limit or less than the 
Low Limit continuously for the Preset Time, the Alarm 
Status is TRUE. Once the alarm is set TRUE, it remains 
TRUE for at least the Post Time. If at the end of the Post 
Time the Value is still outside of the limits, the alarm will 
remain. If the Value is within the limits and the post time 
expires, the Alarm Status is set to FALSE. 

If the Value is Invalid (open, short, or not connected) or 
the Disable input is TRUE, the Alarm Status and timers 
are cleared.  

 
Note:  

If a universal input is open or shorted, it 
generates an alarm ID configured to do so. (By 
adjusting the UI limits, it can be selected when a 
UI is open or shorted.) 

Alarms on Digital Values 
The Alarm function block can be used to alarm on digital 
values by setting the high and low limits to zero (0.0). 
When Value equals FALSE (0), Alarm status will be 
FALSE. When Value is any other value, the Preset Time 
will start. 

The Preset and Post Time values are limited to  
0 - 32767 sec (9.1 hrs). 

When the Alarm Status is TRUE, the configured bit in 
nvoError is set. When the Alarm Status is FALSE, the 
configured bit in nvoError is reset. 

 
Figure 252: Alarm Status 
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Table 136: Effects of Alarm States 

Alarm 
State  Value  Timer  Action  Comment 

False Outside limits < Preset Time Increment Timer. Insure alarm is valid for the preset 
time before issuing the alarm. 

False  Outside limits >= Preset Time Set Alarm Status = 
TRUE; Clear Timer 

The preset time has been met, 
post alarm and clear the timer so it 
can count the post time. 

False  Inside limits Don’t care Clear Timer 

Value is inside the limits and there 
is no prior alarm, so clear the timer 
so it’s ready to count the preset 
time when the value goes 
outside[again] 

True Outside limits < Post Time Increment Timer 
Insure that we post the alarm for at 
least Post Time seconds 
regardless of what the value does 
with respect to the limits. 

True Outside limits >= Post Time Stop Timer 

The alarm has been issued for at 
least the Post Time. The alarm is 
now allowed to return to normal as 
soon as the value goes back within 
the limits. 

True Inside limits < Post Time Increment Timer 
The value has gone back inside 
the limits after posting the alarm. 
Wait until the timer expires before 
issuing the return to normal. 

True Inside limits >= Post Time Clear Alarm Status; 
Clear Timer 

The alarm has been issued for at 
least the Post Time. Clear the 
alarm because the conditions are 
no longer present. 

 

View Alarms 
To view the alarms, that are generated, right click 
LonHoneywell in the Nav tree and select Views > Error 
View. 

 
Figure 253: Views > Error View Option 

The Error View is displayed.  

There are 4 categories of alarms: 

• Sensor Alarms: These alarms are generated for all 
the Sensors configured in the logic. All input blocks 
assigned to pins UI0 to UI7 will be listed in this 
category. 

• Invalid Configuration Alarms: This alarm will occur 
if there is an error in the configuration that was 
downloaded. 

• Network Communication Alarms: These alarms will 
occur ONLY for Network variable inputs (NVIs) 
configured as fail detect. The network variable names 
will be listed in this category. 

• Control Alarms: All the alarm blocks configured in the 
logic will be listed in this category. If an alarm block 
does not have any incoming link, then the status will 
always be NORMAL 

Counter 
This function counts leading edge transitions of the input. 
If enable is True and the input transitions from False to 
True, then the count is incremented or decremented by 
the count value. Positive values on count value 
increment the count. Negative values decrement the 
count. If the preset is True, the count is set to the Preset 
Value. From iteration to iteration, the Function Block 
keeps track of the previous state of the input so that it 
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can detect a transition. On power up/reset, this is cleared. 

 

 

Logic Diagram Function Block 

Figure 254: Counter Function 

 

Logic Inputs 
Table 137: Logic Inputs of Counter Function 

Input Name Input Value Logic Value Description 

Input  unconnected 0 Set Input = False 

 invalid 0 Set Input = False 

 0 0 Input is False 
 VAL != 0.0 1 Input is True 

Enable unconnected 1 Set Enable = True 

 invalid 1 Set Enable = True 

 0 0 Set Enable = False 

 VAL != 0.0 1 Set Enable = True 

Preset unconnected 0 Set Preset = False 

 invalid 0 Set Preset = False 

 0 0 Set Preset = False 

 VAL != 0.0 1 Set Preset = False 

StopAt Zero unconnected 0 Set Stop At Zero = False. The default value is False. 

 invalid 0 Set Stop At Zero = False. 
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Input Name Input Value Logic Value Description 

 0 0 Stop At Zero is False. The count is unaffected by a zero 
value. 

 VAL != 0.0 1 
Stop At Zero is True. Stops counting at zero if counting 
down from a positive count or up from a negative count.  

 

 

 

 

 

 

 

Analog Inputs 
Table 138: Analog Inputs of Counter Function 

 Range   

Input Name Low High Input Value Description 

Count Value  >=- infinity <+ infinity unconnected Set Count Value = 1.0. The default value = 1.0 

   Invalid Set Count Value = 1.0 

   VAL < low Set Count Value = 1.0 

   VAL > high Set Count Value = 1.0 

Preset Value  >=- infinity <+ infinity unconnected Set Preset Value = 0.0 

   Invalid Set Preset Value = 0.0 

   VAL < low Set Preset Value = 0.0 

   VAL> high Set Preset Value = 0.0 

 

Output 
Table 139: Output of Counter Function 

Output Name Range Description 

COUNT  Any floating point number Counter value 

 



HONEYWELL SPYDER USER GUIDE 

 271 31-00089—02 

Transition versus time with positive and negative count values 

 
Figure 255: Transition versus Time with Positive and Negative Count Values 

 

Override 
This function sets the output to the highest priority input 
that is not invalid. The Priority1 value has the highest 
priority and cntrlInput the lowest priority. This function 
block checks if the Inputs are not invalid in the following 
order:  

1. Priority 1 Value 

2. Priority 2 Value 

3. Priority 3 Value 

4. Priority 4 Value 

5. Priority 5 Value 

6. Priority 6 Value 

7. Ctrl Input 

 

The first value that is not invalid in the order of priority is 
set as the output. If all inputs are invalid or unconnected, 
the output is set to the defaultValue. 

This function block corresponds to the BACnet priority 
array implementation with the replacement of the BACnet 
NULL state with invalid.
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Logic Diagram Function Block 

Figure 256: Override Function 

Analog Inputs 
Table 140: Analog Inputs of Override Function 

 Range   

Input Name Low High Input Value Description 

priority1Value 
through 
priority6Value  

>=- infinity <+ infinity Unconnected 
or invalid 

Output = highest priority input (priority1 
Val is top priority and cntrlInput is lowest 
priority) that is not invalid or unconnected. 
If no inputs are valid, then use 
defaultValue 

cntrlInput  >=- infinity <+ infinity Unconnected 
or invalid 

Output = highest priority input (priority1 
Val is top priority and cntrlInput is lowest 
priority) that is not invalid or unconnected. 
If no inputs are valid, then use 
defaultValue 

defaultValue  >=- infinity <+ infinity unconnected DefaultValue = invalid 

   invalid  DefaultValue = invalid 

Output 
Table 141: Output of Override Function 

Output Name Range Description 

EFF_OUTPUT  >=- infinity <+ infinity effOutput = highest priority input that is not invalid. 
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Example 

Set the Inputs to the following:  

• Priority 1 Value = Invalid 

• Priority 2 Value = Invalid 

• Priority 3 Value = 50 

• Priority 4 Value = 60 

• Priority 5 Value = –20 

• Priority 6 Value = 80 

• Ctrl Input = 30 

 

The output is set as 50. Priority 1 and Priority 2 values 
are invalid. The next highest priority value (Priority 3 
value = 50) is set as the output. 

An invalid input to this function block could arise when 
the output of the Minimum function block can be 
connected whose input is invalid.  

Priority Override 
The PriorityOverride block supports driving the outputs 
based on the priority of the connected application 
components. There can be different ControlProgram 
logic components driving the outputs at different priority 
levels. This block decides the priority level at which the 
output must be driven. This block supports up to 16 
priority levels that can be connected to different 
application components.  

 
 

Logic Diagram Function Block 

Figure 257: Priority Override Function Block 

The Priority1 value has the highest priority and Priority 
16 the lowest priority. The block provides an output 
called PriorityOut. The value of the highest priority is set 
as the output PriorityOut. The PriorityOut slot of the 
PriorityOverride block can be linked only to a 
modulating/binary output.  

The block can be used in both Lon and BACnet 
applications. This block provides the PriorityArray 

mechanism in case of BACnet objects. This block detail 
does not get downloaded to the controller in case of 
BACnet. In case of Lon, the PriorityArray mechanism is 
internally achieved using Override blocks. The 
information about the override blocks gets downloaded to 
the Lon controller. Hence there would be a difference in 
function block count between BACnet and Lon 
application when this block is used. 
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During upload the PriorityOverride block is depicted as 
part of the ControlProgram, depending on the number 
of application components driving the outputs. If there is 
an only one application component driving the output, the 
ControlProgram wiresheet would show a direct link from 

that application component to the output. If there are 
more than one application component driving the output, 
the PriorityOverride block would be depicted in the logic 
with outputs being driven at different priority levels. 

 

Analog Inputs 
Table 142: Analog Inputs of Priority Override Function 

 Range   

Input Name Low High Input Value Description 

priority1Value 
through priority16 

>=- infinity <+ infinity Unconnected 
or invalid 

Output = value of the highest 
priority input (priority1 is top 
priority and priority16 is lowest 
priority). If no inputs are valid, 
then the output is also invalid. 

Output 
Table 143: Output of Priority Override Function 

 Range  

Output Name Low High Description 

PriorityOut >=- infinity <+ infinity PriorityOut = value of the highest priority input. 

 

Example 

Set the Inputs to the following:  

1. Priority 1  = Unconnected  

2. Priority 2  = Invalid  

3. Priority 3  = 50  

4. Priority 4  = 60  

5. Priority 5  = -20  

6. Priority 6  = 80  

7. Priority 7 = 30  

8. Priority 8 =Unconnected  

9. Priority 9 =Unconnected  

10. Priority 10 =Unconnected  

11. Priority 11 =Unconnected  

12. Priority 12 =Unconnected  

13. Priority 13 =Unconnected  

14. Priority 14 =Invalid  

15. Priority 15 =40  

16. Priority 16 =10  

The output is set as invalid as Priority 2 is invalid. The 
highest priority value is set as the output. 

The properties of the Priority Override function block are 
listed in the Table 144. 

 

Table 144: Properties of the Priority Override function 

Sr. No. Description LON BACnet 

1 The input to the priority slot of the Priority Override function block 
can be a physical point, a software point, or function blocks but 
cannot be a constant.  

Applicable Applicable 

2 The PriorityOut slot can be connected to only one physical point 
which can be modulating output or binary output.  

Applicable Applicable 

3 The memory increment depends on the type of input block. Applicable Applicable 
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Sr. No. Description LON BACnet 

4 The FB count in the Resource Usage View is only incremented 
when the Priority Override block contains a Valid Link and a Valid 
Knob. 

Applicable Not Applicable 

5 If there are valid links from priority levels 1 to 8, FB count is 
incremented by 1. 

Applicable Not Applicable 

6 If there are valid links from priority levels 9 to 15, FB count is 
incremented by 2. 

Applicable Not Applicable 

7 If there are valid links greater than priority level 15, FB count is 
incremented by 3. 

Applicable Not Applicable 

8 The FB count in the Resource Usage View is not incremented. Not Applicable Applicable 

 

Runtime Accumulate 
This function accumulates runtime whenever the input is 
True (non zero) and enable is True. If Preset is True, 
runtime is set equal to the Preset Value. Runtime is 
provided in four outputs of seconds, minutes, hours, and 
days. From iteration to iteration, the Function Block 
keeps track of the run time seconds. On power up/reset, 
this is cleared. 

 

 
Note:  

On power up/reset, only the Runtime Sec output 
is set to zero. The other three outputs, Runtime 
Min, Runtime Hrs, and Runtime Days are stored 
and not lost. 

 

 
 

Logic Diagram Function Block 

Figure 258: Runtime Accumulate Function 

Logic Inputs 
Table 145: Logic Inputs of Runtime Accumulate Function 

Input Name Input Value Logic Value Description 

Input  unconnected 0 Set Input = False 
 invalid 0 Set Input = False 

 0 0 Input is False 
 VAL != 0.0 1 Input is True 
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Input Name Input Value Logic Value Description 

Enable unconnected 1 Set Enable = True 

 invalid 1 Set Enable = True 

 0 0 Enable is False 

 VAL != 0.0 1 Enable is True 

Preset unconnected 0 Set Preset = False 

 invalid 0 Set Preset = False 

 0 0 Preset is False 

 VAL != 0.0 1 Preset is True 

Analog Inputs 
Table 146: Analog Inputs of Runtime Accumulate Function 

 Range   
Input Name Low High Input Value Description 

Preset Value 0 <+8 unconnected Set Preset Value = 0.0 (in minutes) 

   invalid Set Preset Value = 0.0 

   VAL < low Set Preset Value = 0.0 

   VAL > high Set Preset Value = 0.0 

Output 
Table 147: Outputs of Runtime Accumulate Function 

Output Name  Range Description 

RUNTIME_MIN Any floating point number >= 0 Runtime Min 

RUNTIME_SEC Any floating point number >= 0 Runtime Sec 

RUNTIME_HRS Any floating point number >= 0 Runtime Hrs 

RUNTIME_DAYS Any floating point number >= 0 Runtime Day 
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Operation 

 
Figure 259: Run Time Function Block 

 

Run time is always accumulated internally in minutes. It 
is reported in 4 different units of seconds, minutes, hours 
and days. Run time Min is saved over a power outage 
and reset. If a power outage or reset occurs, the 
controller could lose up to one minute of runtime. 
Runtime Sec, Runtime Hrs, and Runtime Days are 
calculated every iteration from the Runtime Min.  

Runtime Hrs and days outputs are fractional units to the 
nearest minute. Runtime Sec is runtime Min multiplied by 
60. The preset input should be used to set the runtime to 
an initial value in minutes.  

Runtime Accumulate is run every second. The state of 
the input, enable, and the preset are examined by the 
Function Block when it is run. Momentary transitions of 
the inputs between invocations of the Function Block will 
not be detected. If the runtime reaches 16,277,216 mins, 
it will stop. 

Runtime Min is effectively limited to 16, 277,216 mins (31 
years). 

Example 

Connect an output from another block to the Input. 
Connect a digital input to Preset. Set the Preset Value to 
123. Set the Preset Value to 255 (TRUE).  

The four outputs are as follows:  

• Runtime Min = 123 

• Runtime Sec = 7380 

• Runtime Hrs = 2.05 

• Runtime Days = 0.085416 
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LOGIC FUNCTION BLOCKS 
The HoneywellSpyderTool provides the following Logic 
function blocks that can be configured and use to build 
the required application logic:  

• AND 

• One Shot 

• OR 

• XOR 

Inputs to Logic Function Block may come from either 
Digital or Floating point variables.  

For digital inputs  

• 0 = FALSE 

• 1-255 = TRUE 

For floating point variables  

• 0.0 = FALSE 

• Any nonzero number = TRUE 

An output sent to a Digital variable will be 0 or 1. 
Similarly, an output sent to a float point variable will be 
0.0 or 1.0. 

AND 
AND output becomes TRUE if all inputs are TRUE. This 
function is a six-input AND Function Block. Each input 
may be individually inverted (NOT). 

Table 148 shows basic operation of AND function block. 

Table 148: Basic Operation of AND 

Input Output 

(X NAND Y = XY) (X) (Y) 

0 (FALSE) 0 (FALSE) 0 (FALSE) 

0 (FALSE) 1 (TRUE) 0 (FALSE) 

1 (TRUE) 0 (FALSE) 0 (FALSE) 

1 (TRUE) 1 (TRUE) 1 (TRUE) 

 

Table 148 shows basic operation of NAND function 
block. 

Table 149: Basic Operation of NAND 

Input Output 

(X NAND Y = XY ) (X) (Y) 

0 (FALSE) 0 (FALSE) 1 (TRUE) 

0 (FALSE) 1 (TRUE) 1 (TRUE) 

1 (TRUE) 0 (FALSE) 1 (TRUE) 

1 (TRUE) 1(TRUE) 0 (FALSE) 

 

Unconnected or invalid inputs default to TRUE, without 
negation, so as to have no effect on the result. 

From iteration to iteration, the function block keeps track 
of the last computed output value and the current true or 
false delay time. These values are cleared on power 
up/reset. 

 
 

Logic Diagram Function Block 

Figure 260: AND Function 
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Logic Inputs 
Table 150: Logic Inputs of AND Function 

Input Name Input Value Logic Value Description 

in1-6 VAL != 0.0 1  

 0  0  

 unconnected 1  Inputs with a "not" interpreted as logic 1 when 
disconnected. 

 invalid 1 Negin does not affect the invalid logic value. 

 

Analog Inputs 
Table 151: Analog Inputs of AND Function 

 Range   

Input Name Low High Input Value Description 

trueDelay 0 3276 7 unconnected val = 0 
It is the minimum time the computed output 
must stay True before the output actually 
changes from False to True. 

(sec)   invalid val = 0 

falseDelay  0 3276 7 unconnected val = 0  
It is the minimum time the computed output 
must stay False before the output actually 
changes from True to False. 

(sec)   invalid val = 0 

 

Output 
Table 152: Outputs of AND Function 

Input Name Low Description 

OUTPUT Any floating point value Output = AND/NAND (inputs).  
Negating the Output makes AND function block behave like 
a NAND function block. 

 

Example  

1. Set In1- In6 = 1, and True delay = 2, and False delay 
= 6.  

In this case, the output is set to 1 after a time delay of 
2 seconds as specified by the True delay.  

2. Set In1 = 0, In2 - In6 = 1, and True delay = 2, and 
False delay = 6.  

In this case, the output is set to 0 after a time delay of 
6 seconds as specified by the False delay. 

Oneshot 
In the Oneshot function block, when x transitions from 
False to True, y is set to True for OnTime seconds. 

OnTime is limited to the range 0 - 65535 sec. An 
OnTime of zero keeps the output OFF no matter what 
changes occur at the x input. 

Both the x input and y outputs have an option to be 
negated. From iteration to iteration, the Function Block 
keeps track of the last input and the on time. On power 
up/reset, these are cleared. 
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Logic Diagram Function Block 

Figure 261: Oneshot Function 

Logic Inputs 
 

Table 153: Logic Inputs of Oneshot Function 

Input Name Input Value Logic Value Description 

x unconnected N/A For an invalid input make the output be OFF (ON if 
output is negated). Clear the timer 

    

 VAL != 0.0 1  

 0 0  

 invalid N/A Must go from FALSE to TRUE (or TRUE to FALSE 
(Negated)) 

Analog Inputs 
Table 154: Analog Inputs of Oneshot Function 

 Range   

Input Name Low High Input Value Description 

onTime(sec) 0 65535 unconnected onTime =0 

   invalid onTime =0 

   < 0 0  

   >65535 65535 

 

Output 
Table 155: Output of Oneshot Function 

Input Name Low Description 

Y Any floating point value When x transitions from FALSE to TRUE, y will be set to 
TRUE (1) for onTime seconds 
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Example 
The Input is a square wave of 2 sec amplitude. The time 
transition diagram of the Output for different ontimes of 1 
and 5 seconds is illustrated. 

 

 

 
 

Figure 262: Time Transition Diagram of 1 sec and 5 Sec 
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OR 
The OR output becomes TRUE if at least one input is 
TRUE. This function is a six input OR. Each input may be 
individually inverted (NOT).  

Table 156 shows basic operation of OR function block. 

Table 156: Basic Operation of OR 

Input Output 

(X OR Y = X + Y) (X) (Y) 

0 (FALSE) 0 (FALSE) 0 (FALSE) 

0 (FALSE) 1 (TRUE) 1 (TRUE) 

1 (TRUE) 0 (FALSE) 1 (TRUE) 

1 (TRUE) 1 (TRUE) 1 (TRUE) 

 

Table 157 shows basic operation of NOR function block. 

Table 157: Basic Operation of OR 

Input Output 

(X NOR Y = Y  X + ) (X) (Y) 

0 (FALSE) 0 (FALSE) 1 (TRUE) 

0 (FALSE) 1 (TRUE) 0 (FALSE) 

1 (TRUE) 0 (FALSE) 0 (FALSE) 

1 (TRUE) 1(TRUE) 0 (FALSE) 

 

Unconnected or invalid inputs default to True, without 
negation, so as to have no effect on the result.  

From iteration to iteration, the function block keeps track 
of the last computed output value and the current true or 
false delay time. These values are cleared on power 
up/reset. 

  

Logic Diagram Function Block 

Figure 263: OR Function 

Logic Inputs 
Table 158: Logic Inputs of OR Function 

Input Name Input Value Logic Value Description 

in1-6 VAL != 0.0 N/A For an invalid input make output be OFF (ON if 
output is negated). Clear the timer 

 0 0  

 unconnected 0 Inputs with a not interpreted as logic 0 when 
disconnected. 

 0 0 Negin does not affect the invalid logic value 
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Analog Inputs 
Table 159: Analog Inputs of OR Function 

 Range   

Input Name Low High Input Value Description 

onTime 0 65535 unconnected onTime =0 

(sec)   invalid onTime =0 

   < 0 0  

   >65535 65535 

 

Output 
Table 160: Output of OR Function 

Input Name Low Description 

OUTPUT Any floating point value Output = OR/NOR (inputs). Negating the Output makes the 
OR function block behave like a NOR function block. 

 

XOR 
The XOR output becomes TRUE if exactly one input is 
TRUE. This function is a six input XOR. Each input may 
be individually inverted (NOT). 
Table 161 shows basic operation of XOR function block. 

Table 161: Basic Operation of XOR 

Input Output 

(X OR Y = YXXY + ) (X) (Y) 

0 (FALSE) 0 (FALSE) 0 (FALSE) 

0 (FALSE) 1 (TRUE) 1 (TRUE) 

1 (TRUE) 0 (FALSE) 1 (TRUE) 

1 (TRUE) 1 (TRUE) 0 (FALSE) 

 

 
 
Table 162 shows basic operation of XNOR function 
block. 

Table 162: Basic Operation of XNOR 

Input Output 

(X NOR Y = XYXY + ) (X) (Y) 

0 (FALSE) 0 (FALSE) 1 (TRUE) 

0 (FALSE) 1 (TRUE) 0 (FALSE) 

1 (TRUE) 0 (FALSE) 0 (FALSE) 

1 (TRUE) 1(TRUE) 1 (TRUE) 

 

Unconnected or invalid inputs default to True, without 
negation, so as to have no effect on the result. 
From iteration to iteration, the function block keeps track 
of the last computed output value and the current true or 
false delay time. These values are cleared on power 
up/reset. 
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Logic Diagram Function Block 

Figure 264: XOR Function 

Logic Inputs 
Table 163 Logic Inputs of XOR Function 

Input Name Input Value Logic Value Description 

in1-6    VAL! = 0. 0 1  

 0 0  

 unconnected 0 Inputs with a not interpreted as logic 0 when 
disconnected. 

 invalid 0 Negin does not affect the invalid logic value 

 

Analog Inputs 
Table 164: Analog Inputs of XOR Function 

 Range   

Input Name Low High Input Value Description 

trueDelay 0 32767 unconnected val = 0 

(sec)   invalid val = 0 

falseDelay 0 32767 unconnected val = 0 

(sec)   invalid val = 0 

 

Output 
Table 165: Output of XOR Function 

Input Name Low Description 

OUTPUT Any floating point 
value 

Output = XOR/XNOR (inputs). Negating the Output makes the 
XOR function block behave like an XNOR function block. 
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MATH FUNCTION BLOCKS 
The HoneywellSpyderTool provides the following Math 
function blocks that can be configured and use to build 
the required application logic:  

• Add 

• Digital Filter 

• Divide 

• Enthalpy 

• Exponential 

• Flow Velocity 

• Limit 

• Logarithm 

• Multiply  

• Ratio 

• Reset  

• Square Root 

• Subtract 

Add 
Math functions operate on and produce single precision 
floating point numbers. In the absence of any other 
restrictions, if the result overflows the range of a single 
precision floating point number (approx minus 3.4e38 to 
plus 3.4e38) the result returned is invalid. 

 

 
Note:  

Both Analog and Digital inputs can be connected 
as inputs to this function block. 

 

TailOperation: The output value is based on one of four 
specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) 
value of the result is returned. Example: If the output 
is -3, the result will be 3. 

• Integer: The integer value of the result is returned. 
Example: If the output is 3.25, the result will be 3. 

• Fractional: The fractional value of the result is 
returned. Example: If the output is 3.25, the result will 
be .25. 

Ignore invalid inputs:  

If this option is selected, Function block will consider only 
valid inputs while determining the addition of the inputs. If 
this option is not selected, and any input becomes invalid 
then the output becomes invalid too. 
This option is not supported in the PVL6436A, 
PVL6438N, or PUL6438 models and therefore this 
configuration cannot be downloaded to those models. 

 

  

Logic Diagram Function Block 

Figure 265: Add Function 
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Inputs 
Table 166: Inputs of Add Function 

 Range   

Input Name Low High Input Value Description 

x1-x8  >=- infinity <+ infinity Unconnected Not used in the calculation  

If all inputs are unconnected, the output 
is zero. 

   Invalid If any input is invalid, the output is 
invalid 

 

Output 
Table 167: Output of Add Function 

Input Name Low Description 

Y  Any floating point value Output is the sum of inputs x1 through x8. 

 

Digital Filter 
This function digitally filters the input.  

Ynew = Yold +(X –Yold) * (1 – exp(–t/Tau)).  

 

τ

t
eoldYXoldYnewY
−

−−−= 







 

Where, t = 1 sec and Tau is in the range 0 - 65535 sec. 

The output can be initialized to zero (zeroInit=TRUE) or 
the first valid input value (zeroInit=FALSE). 

From iteration to iteration, the Function Block keeps track 
of the tau multiplier (1 – exp (–t/Tau)). On power up/reset, 
this is recalculated 

 

 

 

Logic Diagram Function Block 

Figure 266: Digital Filter Function 
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Inputs 
Table 168: Inputs of Digital Filter Function 

 Range   

Input Name Low High Input Value Description 

x >=- infinity <+ infinity Unconnected The output is invalid. 

   Invalid Output is set to invalid and filter 
reinitializes when the input returns to 
valid. 

 

Output 
Table 169: Output of Digital Filter Function 

Input Name Low Description 

Y Any floating point value Ynew = Yold +(X –Yold) * (1 – exp (–t/Tau)). 

Setpoint 
Table 170: Setpoint of Digital Filter Function 

Input Name Low Description 

Y Any floating point value Ynew = Yold +(X –Yold) * (1 – exp (–t/Tau)). 

 

 
Note:  

Both Analog and Digital inputs can be connected 
as inputs to this function block. 

 

Example 1:  

Set In1 (X) = 4, tau = 2.0, Set ZeroInit = 1 (initializes filter 
to 0.0) 

Ynew = Yold + (X – Yold) * (1 – exp (–t / Tau)) 

In the first iteration,  

Yold = 0; Ynew = Yold + (X – Yold) *  

 (1 – exp (–t/Tau)) 
Ynew = 0 + (4 - 0) * (1 – 2.718 (–1 / 2)) 

          = 0 + 4 * (0.393)  
          = 1.572 
In the second iteration, 

Yold = 1.572; X = 4; Ynew = 1.57 +  

 (4 – 1.57) * (0.393) 
Ynew = 2.52 

In the third iteration, 

Ynew = 2.52 + (4 – 2.52) * (0.393) 

          = 3.107 
The iterations continue until the input is reached. 

Example 2:  

Set In1 (X) = 4, tau = 2.0, Set ZeroInit = 0 (initializes filter 
to first valid value) 

Ynew = Yold + (X – Yold) * (1 – exp (–t / Tau)) 

In the first iteration, 

Ynew = X 

          = 4 
In the second iteration, if X = 6 

Ynew = Yold + (X – Yold) * (1 – exp (–t / Tau)) 

          = 4 + (6 – 4) * (0.393) 
          = 4 + 0.786 
          = 4.786 
In the third iteration, if X = 6 

Ynew = Yold + (X – Yold) * (1 – exp (–t / Tau)) 

          = 4.786 + (6 – 4.786) * (0.393) 
          = 5.263. 
The iterations continue until the input is reached. 
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Divide 
This function divides one input by the other.  
Y = x1 / x2. Division by 0 results in an invalid output. If 
the result overflows the range of a single precision 
floating point number (approximately minus 3.4e38 to plus 
3.4e38) the result returned is invalid. 

divOperation: The result of the division is based on one 
of two specified property values. For Modulo, the output 
is the remainder of the division; for Divide, the output is 
the quotient. 

TailOperation: The output value is based on one of four 
specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) 
value of the result is returned. Example: If the output 
is -3, the result will be 3. 

• Integer: The integer value of the result is returned. 
Example: If the output is 3.25, the result will be 3. 

• Fractional: The fractional value of the result is 
returned. Example: If the output is 3.25, the result will 
be .25. 

 
Note:  

Both Analog and Digital inputs can be connected 
as inputs to this function block. 

 

 

 

 
 

Logic Diagram Function Block 

Figure 267: Divide Function 

Analog Inputs 
Table 171: Analog Inputs of Divide Function 

 Range   

Input Name Low High Input Value Description 

x1 >=- infinity <+ infinity unconnected x1=0 

   invalid Output is set to invalid 

x2 >=- infinity <+ infinity unconnected Output is set to invalid 0 output set to 
invalid 

   invalid Output is set to invalid 

 

Output 
Table 172: Output of Divide Function 

Input Name Low Description 

Y Any floating point value Y= x1 / x2 
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Enthalpy 
This function computes the enthalpy (BTU/LB) based on 
the temperature (°F) and relative humidity (%) inputs. 
Relative humidity (rh) is limited to 0 % to 100 %. 
Temperature is limited to 0 °F - 120 °F. 

  

Logic Diagram Function Block 

Figure 268: Enthalpy Function 

Analog Inputs 
Table 173: Analog Inputs of Enthalpy Function 

 

 Range   

Input Name Low High Input Value Description 

t  0 °F 120 °F unconnected output = invalid 

(F)   invalid output = invalid 

   VAL < low T = low 

   VAL > high T = high 

rh (%) 0 100 unconnected output = invalid 

   invalid output = invalid 

   VAL < low RH = low 

   VAL > high RH = high 

Output 
Table 174: Output of Enthalpy Function 

Input Name Low Description 

Y Any floating point value Output = Enthalpy (t, rh) 
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Exponential 
This function raises y to the power of x. x and y are 
floating point numbers. The application designer is 
limited to two function blocks (these types) per device. 
Unconnected inputs are treated as 0. Invalid inputs result 
in an invalid output. The negInvalid input determines 
whether the operation should proceed with a negative 
base and non-integer exponent, operating on the 
absolute value of the base, or return invalid. The 
negInvalid input does not affect an unconnected or 
invalid input. If both the x and y inputs are disconnected, 
then the output z, is 1.

TailOperation: The output value is based on one of four 
specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) 
value of the result is returned. Example: If the output 
is -3, the result will be 3. 

• Integer: The integer value of the result is returned. 
Example: If the output is 3.25, the result will be 3. 

• Fractional: The fractional value of the result is 
returned. Example: If the output is 3.25, the result will 
be .25 

 

 

 

Logic Diagram Function Block 

Figure 269: Exponential Function 

Analog Inputs 
Table 175: Analog Inputs of Exponential Function 

 Range   

Input Name Low High Input Value Description 

onTime 0 65535 unconnected onTime = 0 

(sec)   invalid onTime = 0 

   < 0 0  

   >65535 65535 

 

Output 
Table 176: Output of Exponential Function 

Input Name Low Description 

Y Any floating point value When x transitions from FALSE to TRUE, y will be 
set to TRUE (1) for onTime seconds 
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Flow Velocity 
This function computes the flow and velocity based on 
the measured pressure and the K factor. 

Error! Bookmark not 

defined. offsetΔPKflow −=  

And  

Vel = flow/area  

Where:  

• K=Flow coefficient (K-Factor) representing the actual 
flow in ft^3/min corresponding to a velocity pressure 
sensor output of 1 w.g. 

 

• DeltaP = flow sensor output pressure in inches  

• Water gauge (inw). 

• Offset = a correction pressure (inw) to adjust for zero. 

• Flow = airflow in ft3/min (CFM) 

• vel = flow velocity in ft/min 

• Area = duct area in ft2. 

 

  

Logic Diagram Function Block 

Figure 270: Flow Velocity Function 

Analog Inputs 
Table 177: Analog Inputs of Flow Velocity Function 

 Range   
Input Name Low High Input Value Description 

press  >= – infinity < + infinity unconnected Output is set to invalid 
   invalid Output is set to invalid 
   > –0.002425 and  

< 0.002425 inw 
Flow and vel = 0 

autoSetOffset >= – infinity < + infinity Unconnected no effect on output 
   Invalid No effect on output 
   ! = 0 Set offset = incoming press 
clearOffset   >= – infinity < + infinity unconnected or invalid No effect on output 
   ! = 0 Set offset = 0 
area  >= – infinity < + infinity Invalid or < = 0; value in ft2 Velocity is set to invalid 
kFactor  >= – infinity < + infinity unconnected Output is set to invalid 
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 Range   
Input Name Low High Input Value Description 

   invalid Output is set to invalid 
   < = 0 kFactor = 1015 

 

Output 
Table 178: Output of Flow Velocity Function 

 Range  
Input Name Low High Description 

FLOW > = – infinity <+ infinity Flow value (ft3/min)  
OFFSET > = – infinity <+ infinity Input press, offset correction (inches water column). Not 

used for hardware connection. Stores Flow offset amount. 
VEL > = – infinity <+ infinity Flow velocity (ft/min) 

Limit 
This function limits the input to the low and high limits. 

If the value of input (x) is:  

• Lower than the lowLimit, value of output is set to 
lowLimit 

 

• Higher than the hiLimit, output is set to hiLimit 
• Between the lowLimit and hiLimits, output is set to 

input 

 
 

Logic Diagram Function Block 

Figure 271: Limit Function 

Analog Inputs 
Table 179: Analog Inputs of Limit Function 

 Range   

Input 
Name Low High Input Value Description 

x >=– infinity <+ infinity unconnected Output is set to invalid  
   invalid Output is set to invalid 
   x< lowLimit Output is set to lowLimit  
   lowLimit >  hiLimit Limits not enforced (“not enforced” means 

Y is always set to X.) 
   lowLimit < x < hiLimit Output set to x x>hiLimit Output set to 
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 Range   

Input 
Name Low High Input Value Description 

hiLimit 
hiLimit >=– infinity <+ infinity unconnected hiLimit not enforced  
   invalid hiLimit not enforced 
lowLimit >=–infinity <+ infinity unconnected lowLimit not enforced 
   invalid lowLimit not enforced 

Output 
Table 180: Output of Limit Function 

Input Name Range Description 

Y Any floating point value Y = Limit (x, lowLimit, hiLimit) 

 

Multiply 
This function multiplies one input with the other.  
y = x1 multiplied by x2. If the result overflows the range 
of a single precision floating point number (approximately 
minus 3.4e38 to plus 3.4e38), the result returned is invalid. 

 
Note:  

Both Analog and Digital inputs can be connected 
as inputs to this function block. 

 

TailOperation: The output value is based on one of four 
specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) 
value of the result is returned. Example: If the output 
is -3, the result will be 3. 

 

• Integer: The integer value of the result is returned. 
Example: If the output is 3.25, the result will be 3. 

• Fractional: The fractional value of the result is 
returned. Example: If the output is 3.25, the result will 
be .25. 

Ignore invalid inputs: If this option is selected, Function 
block will consider only valid inputs while determining the 
multiplication of the inputs. If this option is not selected, 
and any input becomes invalid, then output also 
becomes invalid. This option is not supported in the 
PVL6436A, PVL6438N, or PUL6438 models and 
therefore this configuration cannot be downloaded to 
those models. 

 

 
 

Logic Diagram Function Block 

Figure 272: Multiply Function 
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Analog Inputs 
Table 181: Analog Inputs of Multiply Function 

 Range   

Input 
Name Low High Input Value Description 

x1, x2 > = –infinity < + infinity unconnected Unconnected inputs are set to 0 If all inputs 
unconnected, output is set to zero  

   invalid If any input is invalid, then output is invalid 

 

Output 
Table 182: Output of Multiply Function 

Input Name Range Description 

Y Any floating point value Y= x1 * x2 

 

Ratio 
This function converts the input X to the output Y based 
on the line defined by x1, y1, x2, and y2. 

Output (Y) = y1 + (((x – x1) * (y2 – y1)) / (x2 – x1)) 

 

 

 

Logic Diagram Function Block 

Figure 273: Ratio Function 

Analog Inputs 
Table 183: Analog Inputs of Ratio Function 

 Range   

Input Name Low High Input Value Description 

x >=– infinity <+ infinity unconnected Output is set to invalid  

   invalid Output is set to invalid 
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 Range   

Input Name Low High Input Value Description 

x1-2 >=–infinity <+ infinity unconnected Output is set to invalid  

   invalid Output is set to invalid 

   x1 = x2 Output is set to y1 

y1-2 >=–infinity <+ infinity unconnected Output is set to invalid  

   invalid Output is set to invalid 

 

Output 
Table 184: Output of Ratio Function 

Input Name Range Description 

OUTPUT Any floating point value Out Ratio(X, X1,Y1, X2,Y2) 

 

Setpoints 
Table 185: Setpoints of Ratio Function 

Input Name Range/Value Description 

operation Unlimited 
Vav_Flow_Balance 
Endpoint_Limited 

 

 

Unlimited 
The Output is based on the line defined by x1, x2, y1, y2. 
The behavior of the function block is as illustrated. 

Y = y1 + (((x – x1) * (y2 – y1)) / (x2 – x1)) 

 
Figure 274: Unlimited 

VAV Flow Balance 
The Output is based on the line defined by x1, x2, y1, y2. 
The slope of the line is as shown in the illustration below. 

• When x1 = 0,  

OUTPUT = 0 

• When x >= x1, 

OUTPUT = y1 + (((x - x1) * (y2 - y1)) / (x2 - x1)) 

• When x < x1, 

OUTPUT = ((x * y2) / x2) 
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Figure 275: VAV Flow Balance 

Endpoint Limited 
The Output is based on the line defined by x1, x2, y1, y2. 
The slope of the line is as shown in the illustration below. 
Beyond points x1 and x2, the output is limited to the point 
y1 and y2 respectively. The Output is held between the 
point y1 and y2. 

 
Figure 276: Endpoint Limited 

 

• When x1 < x2 and x <= x1 OUTPUT = Y1 

• When x1 < x2 and x >= x2 OUTPUT = Y 

• When x1 > x2 and x <= x2 OUTPUT = Y2 

• When x1 > x2 and x >= x1 OUTPUT = Y1 

Reset 
This function computes the reset value based on the 
relation of the input to the reset parameters. 

 

 

 

 

Logic Diagram Function Block 

Figure 277: Reset Function 
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Analog Inputs  
Table 186: Analog Inputs of Reset Function 

 Range   

Input Name Low High Input Value Description 

input >=– infinity <+ infinity unconnected Output is set to invalid  

   invalid Output is set to invalid 

sensor >=– infinity <+ infinity unconnected Output is set to invalid 

   invalid Output = input 

zeroPctResetVal >=– infinity <+ infinity unconnected Output is set to invalid 

   invalid Output = input 

   0%RV = 100%RV Output is set to invalid 

hundredPctResetVal >=– infinity <+ infinity unconnected Output is set to invalid 

   invalid Output = input 

   0%RV = 100%RV Output is set to input 

resetAmount >=– infinity <+ infinity unconnected Output is set to invalid 

   invalid Output = input 
 
Output 

Table 187: Output of Reset Function 

Input Name Range Description 

OUTPUT Any floating point value Y = Reset (input, sensor, 0%, 100%, reset amount) 

 

Working

 
  

Figure 278: Working of Reset 
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Table 188: Input and Output of Reset Function 

If Input Condition is  Output 

• Input is unconnected  
• Input is invalid 
• Sensor is unconnected  
• zeroPctResetVal is unconnected  
• hundredPctResetVal is unconnected  
• resetAmount is unconnected 

Output = invalid  

• Sensor is invalid  
• Sensor < zeroPctResetVal  
• zeroPctResetVal is invalid  
• hundredPctResetVal is invalid  
• resetAmount is invalid  
• hundredPctResetVal = zeroPctResetVal 

Output = input 

Sensor > hundredPctResetVal  Output = input + resetAmount 

If none of the above conditions are satisfied Output =  input + ((sensor – zeroPctResetVal) / 
 hundredPctResetVal – zeroPctResetVal)) * 
 resetAmount 

 

Square Root 
This function takes the square root of the input. The 
Output Y is the Sqrt (x), where x is the input. The 
behavior of a negative x input is controlled by the 
parameter negInvalid. 

 

 
Note:  

Negative values are treated as absolute values. 
Example: Square root of -9801 is given as 99, 
taking the absolute value of –9801 as 9801. 

 

TailOperation: The output value is based on one of four 
specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) 
value of the result is returned. Example: If the output 
is -3, the result will be 3. 

• Integer: The integer value of the result is returned. 
Example: If the output is 3.25, the result will be 3. 

• Fractional: The fractional value of the result is 
returned. Example: If the output is 3.25, the result will 
be .25. 

 
 

Logic Diagram Function Block 

Figure 279: Square Root Function 
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Analog Inputs 
Table 189: Analog Inputs of Square Root Function 

 Range   

Input Name Low High Input Value Description 

x >=– infinity <+ infinity unconnected Y= 0  
   invalid Output is set to invalid 

   x1 < 0 Refer negInvalid description 

negInvalid 0 1 0 Use the square root of the absolute value. 

1 If the input is negative, the output is invalid. 
The default value is 0.  

   unconnected Y = sqrt(X), output is invalid for neg x1 
   invalid Y = sqrt(X), output is invalid for neg x1 

 

Output 
Table 190: Output of Square Root Function 

Input Name Range Description 

Y  Any floating point value Y= Sqrt (X) 

 

Subtract 
This function subtracts one input from the other.  
Y = x1 – x2. If the result overflows the range of a single 
precision floating point number, (approximately minus 
3.4e38 to plus 3.4e38) the result returned is invalid. 
 

 
Note:  

Both Analog and Digital inputs can be connected 
as inputs to this function block. 

 

Ignore invalid inputs:  

If this option is selected, function block will consider only 
valid inputs while determining the subtraction of the 
inputs. If this option is not selected, and any input 
become invalid then output also becomes invalid 

This option is not supported in the PVL6436A, 
PVL6438N, or PUL6438 models and therefore this 
configuration cannot be downloaded to those models. 
TailOperation: The output value is based on one of four 
specified property values: 
• No Change: The actual result is returned. 
• Absolute: The absolute (modulus or non-negative) 

value of the result is returned. Example: If the output 
is -3, the result will be 3 

• Integer: The integer value of the result is returned. 
Example: If the output is 3.25, the result will be 3. 

• Fractional: The fractional value of the result is 
returned. Example: If the output is 3.25, the result will 
be .25. 

 

  
Logic Diagram Function Block 

Figure 280: Subtract Function 
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Analog Inputs 
Table 191: Analog Inputs of Subtract Function 

 Range   

Input Name Low High Input Value Description 

x1, x2 >=– infinity <+ infinity unconnected Unconnected inputs are set to 0 if all 
inputs unconnected, y is set to 0  

   invalid If any input is invalid, y is invalid 

 

Output 
Table 192: Output of Subtract Function 

Input Name Range Description 

Y  Any floating point value Y= x1 - x2 

Logarithm 
This function takes either the natural logarithm  
(loge(x) = ln(x)) or logarithm base 10 (log10(x)) of the 
input, depending on the configuration setting eOR10.  
Y = loge(X) or Y = log10(X).  

eOR10: The Log operation depends on the selection of 
this configuration property. In this property, we can select 
a natural or base10 log. 

• Natural: Natural logarithm (loge(x) = ln(x)) of the input 

• Base10: logarithm base 10 (log10(x)) of the input 

 

TailOperation: The output value is based on one of four 
specified property values: 

• No Change: The actual result is returned. 

• Absolute: The absolute (modulus or non-negative) 
value of the result is returned. Example: If the output 
is −3, the result will be 3. 

• Integer: The integer value of the result is returned. 
Example: If the output is 3.25, the result will be 3. 

• Fractional: The fractional value of the result is 
returned. Example: If the output is 3.25, the result will 
be .25.  

 

 

Logic Diagram Function Block 

Figure 281: Logarithm Function 
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Analog Inputs 
Table 193: Analog Inputs of Subtract Function 

 Range   

Input Name Low High Input Value Description 

x > 0 + infinity unconnected Output is set to invalid  

   invalid Output is set to invalid 

   x<=0 Output is set to invalid 

 

Output 
Table 194: Output of Subtract Function 

Input Name Range Description 

Y  Any floating point value Y= Log (x) 
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ZONE ARBITRATION 
FUNCTION BLOCKS 
The HoneywellSpyderTool provides the following Zone 
Arbitration function blocks that can be configured and 
use to build the required application logic: 

• General Set Point Calculator 

• Occupancy Arbitrator 

• Set Temperature Mode 

• Temperature Set Point Calculator 

General Set Point Calculator 
This function does a generic setpoint calculation, 
including reset. It uses the three configuration 
parameters i.e. effective occupancy, current state, and 
reset input to calculate the effective setpoint. 

 

  

Logic Diagram Function Block 

Figure 282: General Set Point Calculator Function 

Analog Inputs 
Table 195: Analog Inputs of General Set Point Calculator Function 

 Range   

Input Name Low High Input Value Description 

effOccuCurrentState 0 3 unconnected Eff Occ Current state = 0 (OCC)  

   invalid Eff Occ Current state = 0 (OCC) 

   VAL < low Eff Occ Current state = 0 (OCC) 

   VAL > high Eff Occ Current state = 0 (OCC) 

ResetInput >=– infinity <+ infinity unconnected Reset Input = Invalid  

   invalid Reset Input = Invalid 

   VAL < low Reset Input = Invalid 

   VAL > high Reset Input = Invalid 

Reset0Pct >=– infinity <+ infinity unconnected Reset 0Pct = Invalid  

   invalid Reset 0Pct = Invalid 

   Val < low Reset 0Pct = Invalid 
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 Range   

Input Name Low High Input Value Description 

   Val > high Reset 0Pct = Invalid 

Reset100Pct >=– infinity <+ infinity  unconnected Reset 100Pct = Invalid  

   invalid Reset 100Pct = Invalid 

   Val < low Reset 100Pct = Invalid 

   Val > high Reset 100Pct = Invalid 

ResetAmount >=– infinity <+ infinity unconnected Reset Amount = Invalid Reset  

   invalid Amount = Invalid 

   Val < low Reset Amount = Invalid 

   Val > high Reset Amount = Invalid 

OccupiedSetpoint >=– infinity <+ infinity unconnected Occupied Setpoint = Invalid  

   invalid Occupied Setpoint = Invalid 

   Val < low Occupied Setpoint = Invalid 

   Val > high Occupied Setpoint = Invalid 

StandbySetpoint >=– infinity <+ infinity unconnected Standby Setpoint = Invalid  

   invalid Standby Setpoint = Invalid 

   Val < low Standby Setpoint = Invalid 

   Val > high Standby Setpoint = Invalid 

UnoccupiedSetpoint >=– infinity <+ infinity unconnected Unoccupied Setpoint = Invalid  

   invalid Unoccupied Setpoint = Invalid 

   Val < low Unoccupied Setpoint = Invalid 

   Val > high Unoccupied Setpoint = Invalid 

 

State value:  

• Occ = 0 

• Unocc=1 

• Bypass =2 

• Standby = 3 

• Null = 255 

 

Output 
Table 196: Output of General Set Point Calculator Function 

Input Name Range Description 

EFF_SETPT Any floating point number Effective Setpoint 
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Figure 283: General Set Point Calculator 

Reset Input 
Reset allows to change the Effective Setpoint either in 
the direction of increased energy savings or in the 
direction of increased comfort. The Reset Amount (+/-) is 
positive or negative to accommodate energy savings 
versus comfort. The reset value varies between zero and 
the reset amount and is proportional to the Reset Input 
with respect to the Reset 0% and Reset 100% 
parameters.  

 
Note:  

Insure that the Reset 0% and Reset 100% 
parameters are in the same engineering unit as 
the Reset Input. The Reset Amount should be in 
the same units as the configured setpoints.  

 

Positive reset values are added to the setpoint and 
negative resets are subtracted. Reset only applies in the 
occupied mode. Reset 0% can be any relation to Reset 
100%. The following illustration shows Reset 0% less 
than Reset 100% with a positive reset amount. If the any 
of the Reset Input, Reset 0%, Reset 100% or Reset 
Amount parameters is invalid, the reset value is set to  
zero (0). 

 
Figure 284: Reset Calculation: Positive Amount  

0% < 100% 

 
Figure 285: Reset Calculation: Positive Amount  

100% < 0% 
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Eff Occ Current State 

The effective Occupancy Current State comes from a 
scheduler. The valid values are  

• Occupied 
• Unoccupied 
• Bypass 
• Standby 
• Null 

 

The General Setpoint Calculator uses the three 
configured setpoints: effective occupancy, current state, 
and reset input to determine the effective setpoint. If a 
setpoint is invalid, INVALID will be propagated to the 
output as appropriate. 

 

Table 197: Valid values of Effective Occupancy Current State 

Eff Occ Current State Eff Setpoint 

UNOCC Result = unoccupied setpoint 

STANDBY Result = standby setpoint 

OCC Result = occupied setpoint + reset 

BYPASS Result = occupied setpoint + reset 

NULL Result = occupied setpoint + reset 

Occupancy Arbitrator 
This function computes the present Effective Occupancy 
Current State and the Manual Override State. 

 

 
 

Logic Diagram Function Block 

Figure 286: Occupancy Arbitrator 

Inputs 
Table 198: Inputs of Occupancy Arbitrator 

 Range   

Input Name Low High Input Value Description 

scheduleCurrentState 0 1,3,255 unconnected Schedule Current State = 255 (OCCNUL)  

   invalid Schedule Current State = 255 (OCCNUL) 

   VAL < low Schedule Current State =0 (OCC) 

   VAL > high Schedule Current State = 255 (OCCNUL) 
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 Range   

Input Name Low High Input Value Description 

WMOverride 0 1-3,255 unconnected WM Override = 255 (OCCNUL) 

   invalid WM Override = 255 (OCCNUL) 

   VAL < low WM Override = 0 (OCC) 

   VAL > high WM Override = 255 (OCCNUL) 

NetworkManOcc 0 1-3,255 unconnected Network Man Occ = 255 (OCCNUL)  

   invalid Network Man Occ = 255 (OCCNUL) 

   VAL < low Network Man Occ = 0 (OCC) 

   VAL > high Network Man Occ = 255 (OCCNUL) 

OccSensorState 0 1, 255 unconnected Occ Sensor State = 255 (OCCNUL)  

   invalid Occ Sensor State = 255 (OCCNUL) 

   VAL < low Occ Sensor State = 0 (OCC) 

   VAL > high Occ Sensor State = 255 (OCCNUL) 

 

State values: 

• Occ = 0 

• Unocc=1 

• Bypass =2 

• Standby = 3 

• Null = 255 

 

 

 

 

 

 

Outputs 
Table 199: Outputs Occupancy Arbitrator 

Output Name Range Description 

EFF_OCC_CURRENT_STATE 0 to 3 (Occupied, Unoccupied, 
Bypass, Standby) 

Effective Occupancy Current state 

MANUAL_OVERRIDE_STATE 0 to 3, 255 (Occupied, 
Unoccupied, Bypass, Standby, 
Null) 

Manual Override State 

Configuration  
Specify Net wins (0) or Last in wins (1). Specify the 
occupancy sensor operation. 

 

There are 3 choices: Conference room (0), Unoccupied 
Cleaning Crew (1), and Unoccupied Tenant (2). 
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Operation 
 

 

 
Figure 287: Occupancy Arbitrator Function 

Manual Override Arbitration Mechanism 
Manual Override Arbitration mechanism determines the 
value of Manual Override State. This value is used as an 
input to the Occupancy Arbitrator. 

The Manual Override Arbitrator uses either a Net Wins or 
a Last in Wins scheme to evaluate the inputs. Net Wins 
means the network command always takes precedence 
over the wall module command.  

Refer truth Table 200. 

 

 

With Last in Wins, the last override source is used to 
determine the final state. If multiple sources change state 
in the same second, they are evaluated in order: Network 
Man Occ, WM Override. Each second the function block 
is called, the algorithm looks for a change of state to 
Network Man Occ or WM Override. If either of these 
changed state, then appropriate action is taken. 
Generally, a new command on any input, cancels prior 
action by another source. 
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Table 200: Truth Table of Net Wins and Last Wins 

Net Wins/ 

Last in 
Wins 

Network 
Man Occ 

(note2) 

WM 
Override 

(note 2) 

RESULT: 

Manual 
Override 

State 

Comment 

Last in Wins OCC Don’t Care OCC Result set to Network Man Occ. 

Last in Wins UNOCC Don’t Care UNOCC Result set to Network Man Occ. 

Last in Wins BYPASS  Don’t Care BYPASS Result set to Network Man Occ. 

Last in Wins STANDBY Don’t Care STANDBY Result set to Network Man Occ. 

Last in Wins OCCNUL Don’t Care OCCNUL Override canceled. 

Last in Wins Don’t Care OCC OCC Result set to the wall module override. 

Last in Wins Don’t Care STANDBY STANDBY Result set to the wall module override. 

Last in Wins Don’t Care BYPASS BYPASS Result set to the wall module override. 

Last in Wins Don’t Care UNOCC UNOCC Result set to the wall module override. 

Last in Wins Don’t Care OCCNUL OCCNUL Override canceled. 

 

 
Note:  

Any other input value not listed, is not a valid 
state. If received, it is treated as OCCNUL. 

For last in wins, the value in the Table 200 was 
just changed from another state and this is the 
current state. 

 

The manual override command is hold ON for the 
Bypass Timeperiod outside the function block when 
Manual Override command is triggered.. The function 
block does not have an ability to hold the Manual 
Override Command for the required Bypass time or don’t 
have any parameter for setting the bypass time. 
If manual Override Command is coming from 
ConvetionalWallModule, then it is hold On for the bypass 
time period by the wall module after triggering of the 
command. 
If network Manual Override Command is there, then 
additional logic in the control program (or other device  
from the Manual Override Command is received over a 
Lon network) is need to be implemented for the bypass 
time. It need to be implemented. 

From iteration to iteration of the Function Block, the 
Occupancy Arbitrator keeps track of the last state of the 
Network Man Occ and WM Override inputs so that it 
knows when a transition occurs. On power up/reset the 
last latch value is set to FALSE, regardless of the 
negation configuration. Override is canceled, after a 

power outage. The Network Man Occ and WM Override 
inputs must reset themselves after a power outage. 

Network Manual Occupancy Input 

Network Man Occ is a method to command the 
occupancy state from a network workstation or a node. 
The user may write logic to combine these if both are 
required for the application. Network Man Occ can 
command the state to be occupied, unoccupied, standby, 
bypass or null. It is required that the workstation 
(nviManOccCmd) or network node (nviBypass) performs 
any timing needed (i.e. bypass).  

WM Override Input 

WM Override is a method to command the occupancy 
state from a locally wired wall module. WM Override can 
command the state to be occupied, unoccupied, standby, 
bypass or null. It is required that the function block wired 
to this input, perform any timing needed (i.e. bypass).  

 
Note:  

The current T7770 wall module function doesn’t 
support occupied or standby override, but future 
wall modules might. 

 

Occupancy Arbitration Mechanism 

The Occupancy Arbitrator computes the effective 
occupancy status. The inputs of the Effective Occupancy 
Arbitrator include the Schedule Current State, Occ 
Sensor State, and Manual Override State. The Manual 
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Override State comes from Network Man Occ or WM 
override. 

The Effective Occupancy Arbitrator sets the Effective 
Occ Current State. Valid states of current state are:  

• OCC: The space is occupied. 

• UNOCC: The space is unoccupied. 

• BYPASS: The space is occupied, though it is not 
scheduled to be occupied. 

• STANDBY: The space is in a standby state, 
somewhere between occupied and unoccupied. 

OCCNUL is not a valid output. If all inputs are OCCNUL, 
the output will be set to occupied. 

 
Table 201: Truth Table of Valid States of Effective Occ Current State 

Manual 
Override 

State 

Schedule 
Current 

State 

Occ Sensor 
State 

Occ Sensor 
Operation 

RESULT: effOcc 
CurrentState Comments Follows 

LonMark SCC 

OCC Don’t Care Don’t Care Don’t Care OCC Result = Manual 
Override State 

Yes. 

STANDBY Don’t Care Don’t Care Don’t Care STANDBY Result = Manual 
Override State 

Yes 

UNOCC Don’t Care  Don’t Care  Don’t Care UNOCC Result = Manual 
Override State 

Yes 

BYPASS OCC Don’t Care  Don’t Care OCC The result stays at 
occupied because 
bypass isn’t 
effective when 
scheduled for 
occupied 

Yes 

BYPASS STANDBY Don’t Care Don’t Care BYPASS The result stays at 
bypass. 

Yes 

BYPASS UNOCC Don’t Care Don’t Care BYPASS Result = bypass Yes 

BYPASS OCCNUL OCC Don’t Care OCC The result follows 
occupancy sensor 

Yes 

BYPASS OCCNUL UNOCC Don’t Care BYPASS The result follows 
manual override 

Yes 

BYPASS OCCNUL OCCNUL Don’t Care OCC When occupancy 
sensor is null, 
default to occupied. 

Yes  

OCCNUL STANDBY Don’t Care Don’t Care STANDBY Result = scheduled 
state. 

Yes  

OCCNUL OCC OCC Don’t Care OCC All say we’re 
Occupied. 

Yes 

OCCNUL OCC UNOCC Don’t Care STANDBY We’re schedule to 
be occupied, but 
the room is actually 
unoccupied, so go 
to standby to save 
energy. 

Yes 

OCCNUL OCC OCCNUL Don’t Care OCC  Sensor not present 
so use schedule. 

Yes  

OCCNUL UNOCC UNOCC Don’t Care UNOCC All say we’re Yes 
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Manual 
Override 

State 

Schedule 
Current 

State 

Occ Sensor 
State 

Occ Sensor 
Operation 

RESULT: effOcc 
CurrentState Comments Follows 

LonMark SCC 

unoccupied. 

OCCNUL UNOCC OCCNUL Don’t Care UNOCC Sensor not present 
so use schedule 

Yes 

OCCNUL OCCNUL OCC Don’t Care OCC Result -= 
occupancy sensor 
state. 

Yes 

OCCNUL OCCNUL UNOCC Don’t Care UNOCC Result -= 
occupancy sensor 
state. 

Yes  

OCCNUL OCCNUL OCCNUL Don’t Care OCC Result = occupied 
because the 
LonMark SCC sets 
a null occupancy 
sensor to Occupied. 

Yes 

OCCNUL UNOCC OCC Conference 
Room 

UNOCC Stay unoccupied 
regardless of what 
the sensor says 
(i.e. save energy). 

Yes 

OCCNUL UNOCC OCC Cleaning 
Crew 

STANDBY We’re schedule to 
be unoccupied, but 
the room is actually 
occupied, so go to 
standby for the 
comfort of the 
cleaning crew. 

No 

OCCNUL UNOCC OCC Tenant OCC We’re schedule to 
be unoccupied, but 
the room is actually 
occupied, so, go to 
occupied for the 
comfort of the 
tenant. 

No 
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Set Temperature Mode 
This function automatically calculates the effective 
temperature control mode based on the control type, 
system switch setting, network mode command, 
temperature set points, supply temperature and space 
temperature. 

From iteration to iteration, the Function Block keeps track 
of the previous command mode and the effective 
temperature mode. On power up/reset, these are 
cleared.

 

effTempMode indicates the current Mode determined by 
input states and arbitrated by control logic. 
SetTempMode does not generate all the possible Modes 
available. The valid enumerated values have the 
following meanings as shown in Table 202.

 

 

Logic Diagram Function Block 

Figure 288: Set Temperature Mode Function 

 

Table 202: Meanings of Valid Enumerated Values 

effTempMode Meaning 

COOL_MODE = 0 Cool air is being supplied to the node via the central air supply and cooling 
energy is being supplied to the controlled space. 

REHEAT_MODE = 1 Cool air is being supplied to the node via the central air supply. The air is 
being reheated by a local Heat source. 

HEAT_MODE = 2 Heated air is being supplied to the node via the central air supply and 
heated air is being supplied to the controlled space 

EMERG_HEAT = 3 Emergency Heat is being supplied to the node via the central air supply.  

OFF_MODE = 255 The controller is commanded off. 
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Analog Input 
Table 203: Analog Inputs of Set Temperature Mode Function 

  Range   

Input Name Cfg Low High Input Value Description 

sysSwitch IN 0 255 unconnected SystemSwitch = SS_AUTO(0)  

    invalid SystemSwitch = SS_AUTO(0) 

    VAL < low SystemSwitch = SS_AUTO(0) 

    VAL > high SystemSwitch = SS_AUTO(0) 

cmdMode IN 0 255 unconnected val = CMD_AUTO_MODE(0)  

    invalid val = CMD_AUTO_MODE(0) 

    VAL < low val = CMD_AUTO_MODE(0) 

    VAL > high val = CMD_AUTO_MODE(0) 

supplyTemp IN 0 255 unconnected SupplyTemp = invalid  

    invalid SupplyTemp = invalid 

    Val < low SupplyTemp = low 

    Val > high SupplyTemp = high 

spaceTemp IN 0 255 unconnected SpaceTemp = invalid  

    invalid SpaceTemp = invalid 

    Val < low SpaceTemp = low 

    Val > high SpaceTemp = high 

effHeatSP IN >=- <+ unconnected EffHeatSp = 68 

    invalid EffHeatSp = 68 

effCoolSP IN >=- <+ unconnected EffCoolSp = 75  

    invalid EffCoolSp = 75 

allowAutoChange IN_PAR 0 1 unconnected allowAutoChange=1  

    invalid allowAutoChange=1 

    Val < low allowAutoChange=1 

    Val > high allowAutoChange=1 

 

Outputs 
Table 204: Output of Set Temperature Mode Function 

Output Name Range Description 

Y  Any floating point value When x transitions from FALSE to TRUE, y will be 
set to TRUE (1) for onTime seconds 
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Configuration 
Specify the control Type (controlType)  

• 0 – CVAHU 

• 1 – VAV 

Input Enumerations 
Table 205: Input Enumerations of Set Temperature 

Mode Function 

sysSwitch  

SS_AUTO = 0  

SS_COOL = 1 

SS_HEAT = 2 

SS_EMERG_HEAT = 3 

SS_OFF = 255 

cmdMode  

CMD_AUTO_MODE= 0 = 0  

CMD_ HEAT_MODE = 1 = 1 

CMD_COOL_MODE = 2 = 2 

CMD_OFF_MODE = 3 = 3 

sysSwitch  

SS_AUTO = 0  

CMD_ EMERG_HEAT_MODE = 4  = 4 

CMD_NUL_MODE = 255  = 255 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
The CVAHU arbitration logic for ControlType = 0 
(CVAHU) is summarized in the Table 206: 

 

 

Table 206: CVAHU Arbitration Logic for ControlType = 0 (CVAHU) 

Space 
Temp sysSwitch cmdMode effTempMode 

X X CMD_OFF(3) OFF_MODE(255)  
X X CMD_EMERG_HEAT_MODE(4) EMERG_HEAT(3) 

X X CMD_COOL_MODE(2) COOL_MODE(0) 

X X CMD_HEAT_MODE(1) HEAT_MODE(2) 

X X ENUMERATION (5) through 
ENUMERATION (254) 

HEAT_MODE(2)  

X SS_COOL (1) CMD_AUTO_MODE(0), 
CMD_NUL_MODE(255) 

COOL_MODE (0) 

X 

SS_HEAT (2) or 
ENUMERATION(4) 
through 
ENUMERATION 
(254) 

CMD_AUTO_MODE(0), 
CMD_NUL_MODE(255) 

HEAT_MODE(2)  

X SS_EMERGENCY
_HEAT(3) 

CMD_AUTO_MODE(0), 
CMD_NUL_MODE(255),  

EMERG_HEAT(3) 

X SS_OFF (255) CMD_AUTO_MODE(0), 
CMD_NUL_MODE(255) 

OFF_MODE(255) 
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Space 
Temp sysSwitch cmdMode effTempMode 

INVALID 

SS_AUTO (0), 
invalid, 
unconnected, or a 
non-listed 
enumeration. 

CMD_AUTO_MODE(0), 
CMD_NUL_MODE(255) 

HEAT_MODE(2)  

VALID 

SS_AUTO (0), 
invalid, 
unconnected, or a 
non-listed 
enumeration. 

CMD_AUTO_MODE(0), 
CMD_NUL_MODE(255), 

COOL_MODE(0) or 
HEAT_MODE(2) (refer following 
note) 

 

 
Note:  

• X means Don’t Care 

• If allowAutoChange = 1 then allow to switch 
between HEAT_MODE and COOL_MODE.  

• Must have valid effHeatSP and effCoolSP. If 
allowAutoChange = 1 and effHeatSp > 
effCoolSp, then effHeatSp will be internally 
set to effCoolSP. 

 

 
The VAV Mode arbitration logic for controlType = 1 the 
Table 207 below summarizes (VAV): 

Table 207: VAV Mode Arbitration Logic for controlType = 1 

Space 
Temp  sysSwitch Supply 

Temp cmdMode effTempMode 

X  X  X CMD_OFF_MODE(3) OFF_MODE(255)  
 

X  X  X CMD_EMERG_HEAT_M
ODE(4) 

HEAT_MODE(2) 

X  X  X ENUMERATION (5) 
through ENUMERATION 
(254) 

COOL_MODE(0) 

Valid X <70.0 CMD_AUTO_MODE (0), 
CMD_HEAT_MODE (1), 
CMD_NUL_MODE (255) 

COOL_MODE (0) or 
REHEAT_MODE (1)  
(Refer note 1) 

Valid X 70.0 To 75.0 CMD_AUTO_MODE (0), 
CMD_HEAT_MODE (1), 
CMD_COOL_MODE (2), 
CMD_NUL_MODE (255)  

COOL_MODE (0), 
REHEAT_MODE (1), 
HEAT_MODE (2)  
(Refer note 1 for transition 
between cool mode and 
reheat mode) 

Valid X >75 CMD_AUTO_MODE (0), 
CMD_HEAT_MODE (1), 
CMD_NUL_MODE (255)  

HEAT_MODE(2) 

Valid X Invalid or 
unconnected 

CMD_HEAT_MODE (1)  HEAT_MODE (2) 

Valid X Invalid or 
unconnected 

CMD_COOL_MODE (2)  COOL_MODE (0) 
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Space 
Temp  sysSwitch Supply 

Temp cmdMode effTempMode 

Valid SS_COOL(1) Invalid or 
unconnected 

CMD_AUTO_MODE (0), 
CMD_NUL_MODE (255)  

COOL_MODE(0) 

Valid SS_HEAT (2) Invalid or 
unconnected 

CMD_AUTO_MODE (0), 
CMD_NUL_MODE (255)  

HEAT_MODE(2) 

Valid SS_ EMERGENCY_
HEAT (3) 

Invalid or 
unconnected 

CMD_AUTO_MODE (0), 
CMD_NUL_MODE (255)  

HEAT_MODE(2) 

Valid  SS_OFF (255) Invalid or 
unconnected 

CMD_AUTO_MODE (0), 
CMD_NUL_MODE (255)  

OFF_MODE(255) 

Valid SS_AUTO (0), 
invalid, 
unconnected, or 
a non-listed 
enumeration. 

Invalid or 
unconnected 

CMD_AUTO_MODE (0), 
CMD_NUL_MODE (255),  

COOL_MODE(0) or 
REHEAT_MODE(1) (refer 
note 1) 

Invalid SS_AUTO (0), 
invalid, 
unconnected, or 
a non-listed 
enumeration. 

Invalid or 
unconnected 

CMD_AUTO_MODE (0), 
CMD_NUL_MODE (255),  

COOL_MODE(0) 

 

 
Note:  

• X MEANS Don’t care 

• If allowAutoChange = 1 then allow to switch 
between REHEAT_MODE and 
COOL_MODE. Must have valid effHeatSP 
and effCoolSP.  

• If in cool mode and spacetemp < 
effheatsetpt and space temp < effcoolsetpt – 
1.0 then go to reheat mode. If in reheat 
mode and spacetemp > effCoolSetpt and 
spacetemp > effHeatsetpt + 1.0 then go to 
cool mode. 
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Temperature Setpoint Calculator 
This function calculates the current Effective Heat 
setpoint and Effective Cool setpoint based on the current 
schedule information, occupancy override, and intelligent 
recovery information. 

 

 

 

 

 
 

Logic Diagram Function Block 

Figure 289: Temperature Set Point Calculator Function 
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Inputs 
Table 208: Inputs of Temperature Set Point Calculator Function 

 Range   

Input Name Low High Input Value Description 

EffOccCurrentState 0 3 unconnected Eff Occ Current State = 0 (OCC) 

   invalid Eff Occ Current State = 0 (OCC) 

   VAL < low Eff Occ Current State = 0 (OCC) 

   VAL > high Eff Occ Current State = 0 (OCC) 

ScheduleNextState 0 1, 3, 255 unconnected Schedule Next State = 255 
(OCCNUL) 

   invalid Schedule Next State = 255 
(OCCNUL) 

   VAL < low Schedule Next State = 255 
(OCCNUL) 

   VAL > high Schedule Next State = 255 
(OCCNUL) 

ScheduleTUNCOS 0 11520 unconnected Schedule TUNCOS = 11520 

(min)   invalid Schedule TUNCOS = 11520 

   VAL < low Schedule TUNCOS = 0 

   VAL > high Schedule TUNCOS = 11520 

Setpoint >=– <+ unconnected Setpoint = 0 

   invalid Setpoint = 0 

   VAL < low Setpoint = 0 

   VAL > high Setpoint = 0 

HeatRampRate 0 <+ unconnected Heat Ramp Rate = 0 

   invalid Heat Ramp Rate = 0 

   VAL < low Heat Ramp Rate = 0 

   VAL > high Heat Ramp Rate = 0 

CoolRampRate 0 <+ unconnected Cool Ramp Rate = 0 

   invalid Cool Ramp Rate = 0 

   VAL < low Cool Ramp Rate = 0 

   VAL > high Cool Ramp Rate = 0 

ManualOverrideState 0 3,255 unconnected Manual Override State = 255 
(OCCNUL) 

   invalid Manual Override State = 255 
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 Range   

Input Name Low High Input Value Description 

(OCCNUL) 

   VAL < low Manual Override State = 255 
(OCCNUL) 

   VAL > high Manual Override State = 255 
(OCCNUL) 

 

• Occ = 0 

• Unocc=1 

• Bypass =2 

• Standby = 3 

• Null = 255 

Outputs 
Table 209: Outputs of Temperature Set Point Calculator Function 

Output Name Range Description 

EFF_HEAT_SETPT Any floating point number Effective Heat Setpoint 

EFF_COOL_SETPT Any floating point number Effective Cool Setpoint 

Setpoint Type 
Table 210: Setpoint Type of Temperature Set Point Calculator Function 

Property Value Description 

Global For Lon devices, setpoints are taken from the nciTempSetpoints, which is created 
in NV configuration view during drag and drop action of the function block on the 
wiresheet. For BACnet devices, setpoints are taken from the six objects 
(AV_occupiedCool, AV_standbyCool, AV_unoccupiedCool, AV_occupiedHeat, 
AV_standbyHeat, AV_unoccupiedHeat) created in Object Configuration view 
during drag and drop action of the function block on the wiresheet 

Custom Applicable only to Spyder Relay models. Applies setpoints to that function block 
alone. In the Function block, the following six extra inputs appear that are available 
for connection: 

• occupiedCool  

• standbyCool  

• unoccupiedCool  

• occupiedHeat  

• standbyHeat  

• unoccupiedHeat 

Configuration 
• Specify the 6 setpoints. When the TempSPCalc 

Function Block is used, the Spyder Tool adds 
nciTempSetpoints (SNVT temp setpt). 
nciTempSetpoints is mapped by the Tool to the first 6 
Public variables under Control non-volatile. The order 
is: 

 Occupied Cool 

 Standby Cool 

 Unoccupied Cool 

 Occupied Heat 

 Standby Heat 

 Unoccupied Heat 
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More than one TempSPCalc Function Block, are 
available however, all blocks use the same nciSetpoints 
network variable and map to the same 6 public variables. 
Refer Figure 289 for more information. 

 

 

 
Figure 290: TempSPCalc Function Block 

The Temperature Setpoint Calculator uses the following 
6 programmed setpoints to determine the effective heat 
setpoint and effective cool setpoint: 

• Effective occupancy current state 

• Scheduled next state and TUNCOS 

• Center/offset setpoint 

• Manual override state 

• Recovery heat ramp rate 

• Recovery cool ramp rate 

The algorithm:  

• Verifies if inputs are within range 

• Computes the occupied and standby heat and cool 
setpoints based on the setpoint input and 
programmed setpoints. 

 If the effective occupancy current state is in 
unoccupied mode and not in manual override, then 
calculates the recovery ramps. 

 If the effective occupancy current state is in 
occupied or bypass mode, uses the occupied 
setpoints. 

 If the effective occupancy current state is in 
standby mode, uses the standby setpoints. 

Programmed Set Points 
The controller is programmed with six setpoints. There 
are three setpoints of occupied, standby and unoccupied 
for heating and the same for cooling. All six can be 
changed from the Network via nciSetpoints. The 
Temperature Setpoint calculator does not place any 
restrictions on relationships between the setpoints and 
other inputs and the resulting calculations. This function 
block depends on the Tools writing nciSetpoints to 
enforce the range and relationship. 

For reference, the LonMark Space Comfort Controller 
profile defines nciSetpoints as having a range of 10 °C to 
35 °C with the following relationship unoccupied heat = 
standby heat = occupied heat = occupied cool = standby 
cool = unoccupied cool. 

Setpoint Input 
This input allows the temperature setpoint for the 
occupied and standby mode to be changed via the wall 
module and/or network. This input can be either center or 
offset setpoint. If the input is less than 10, then it is 
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treated as offset setpoint. If the input is greater than or 
equal to 10, it is treated as center setpoint. It is the user’s 
responsibility to insure the results are within the desired 
range. That is, it is possible to combine the setpoint input 
and the programmed heat and cool setpoints and get an 
effective setpoint outside of the unoccupied setpoints.  

Offset Setpoint 
The setpoint acts in offset mode (that is, relative setpoint) 
when the value on the Setpoint input is less than 10. The 
setpoint input adjusts the programmed occupied and 
standby heating and cooling setpoints up and down by 
the amount on the input. The user must insure the input 
range is less than +10 for offset setpoint to be used. The 
setpoint input does not affect the unoccupied setpoints. 
During bypass, the occupied setpoints are adjusted. If 
the setpoint input is not connected or the sensor has 
failed, the offset is zero. Consistent units should be 
insured. That is, if the Setpoint input is in °F, the 
programmed setpoints should also be in °F. 

• Occupied cool setpoint = programmed occupied cool 
setpoint + Setpoint input. 

• Occupied heat setpoint = programmed occupied heat 
setpoint + Setpoint input. 

• Standby cool setpoint = programmed standby cool 
setpoint + Setpoint input. 

• Standby heat setpoint = programmed standby heat 
setpoint + Setpoint input. 

Center Setpoint 
If the value on the Setpoint input is greater than or equal 
to 10, it will be used as the center setpoint (that is, 
absolute setpoint). If an invalid setpoint is on the Setpoint 
input, then the programmed setpoints will be used. The 
individual heat/cool setpoints for occupied and standby 
mode then derive from the Setpoint input minus/plus half 
the zero energy bands calculated from the programmed 
setpoints. 

• Occupied cool setpoint = setpoint + 1/2 zeb occ 

• Occupied heat setpoint = setpoint – 1/2 zeb occ 

• Standby cool setpoint = setpoint + 1/2 zeb standby 

• Standby heat setpoint = setpoint – 1/2 zeb standby 

Where, 

• zeb occ = programmed occupied cool – programmed 
occupied heat 

• zeb standby = programmed standby cool – 
programmed standby heat. 

Manual Override State 
The Manual Override State is required to turn off 
recovery if in manual mode. If the Manual Override State 
is any value other than null, then the algorithm does not 

know the scheduled next state and setpoint recovery is 
NOT done. 

 
Note:  

Manual Override State does not affect the 
effective occupancy state. The OccArb function 
block already handles this. The effective 
setpoints never go to the state commanded by 
the Manual Override state input. Manual 
Override State just affects recovery as stated 
above. 

 

Effective Occupied State 
The algorithm to determine the setpoints for the current 
occupancy state uses this. When the Effective 
Occupancy Current state is occupied or bypass, use the 
occupied setpoints. When the Effective Occupancy 
Current state is standby, then use the standby setpoints. 
When the Effective Occupancy Current state is 
unoccupied, recover the setpoint to the next state of 
occupied or standby. No recovery is done if in manual 
mode. Refer Adaptive Intelligent Recovery section. 

Heating and Cooling Ramp rates 
To recover the heating and cooling setpoints from their 
unoccupied values the adaptive recovery algorithm uses 
these parameters. 

Schedule Next state and TUNCOS 
To recover the heating and cooling setpoints from their 
unoccupied values the adaptive recovery algorithm uses 
these parameters. 

Adaptive Intelligent Recovery 
Set point recovery applies to setpoint changes 
associated with the following schedule state changes:  

• Unoccupied to Standby 
• Unoccupied to Occupied 
Setpoint changes from occupied or standby to 
unoccupied state, changes from occupied to standby 
state, and changes from standby to occupied state use a 
step change in setpoint. 

The heating or cooling recovery ramp begins before the 
next state transition time. During the recovery ramps, the 
heating and cooling set points are ramped from the 
unoccupied setpoint to the next state setpoint. The 
setpoint ramps will be at the target setpoint 10 mins prior 
to the occupied/standby event time. 

This allows the HVAC equipment an extra 10 mins to get 
the space temperature to the target setpoint during 
recovery.  
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Note:  

Recovery is NOT done if manual occupancy is in effect. 

 

 

 

 

 

 
Figure 291: Temperature Setpoint Calculator Graph 

The heat and cool recovery ramp rates are provided to 
the Temperature Setpoint Calculator. These can be 
constants; values calculated using the Ratio function 
block using outdoor air temperature, or some other 
method. Heating and cooling recovery ramp rates can be 
any value greater than or equal to zero and have units of 
°/Hr. A ramp rate of 0 °/Hr means no recovery ramp for 
that mode. This means the setpoint steps from one 
setpoint to the other at the event time (that is, no extra  
10 mins). The user must insure consistent units. That is, 
the ramp rates should be in the same units as the 
setpoints. 

 

 

 

 

 

 
Note:  

If the user programs a rate of 1 °/Hr and has 
more than 192° spread between OCC and 
UNOCC set points, the algorithm will be in 
recovery immediately when going to UNOCC.  

This is because the maximum TUNCOS is  
11520 mins times  

1 °/Hr = 192 ° maximum delta. 
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TUNCOS Mesa 
The controller implements the TUNCOS Mesa feature. 
The TUNCOS Mesa was added to the algorithm to insure 
the HVAC equipment gets the space temperature up to 
setpoint by the occupied time. The recovery algorithm 
subtracts 10 mins from the TUNCOS and uses that to 
calculate the setpoint ramps. 

 
 

Figure 292: TUNCOS Mesa 

Effective Setpoint Limiting 
This algorithm does nothing to insure the effective 
cooling setpoint does not go above the unoccupied 
cooling setpoint and the effective heating setpoint does 
not go below the unoccupied heating setpoint. No check 
is made to insure the effective heat and cool setpoints 
stays a minimum distance apart. 
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PASS THRU 
This object is used to provide an input and output slot so 
to Application block so that inputs and outputs can be 
connected to that Application block. 

Example: A logic is created with Application block as 
shown in Figure 294. It averages two temperature inputs 
and transfer the average value to network outputs. As 
shown in Figure 294 right side section, the Application  

 

 

block don’t have slots. PassThru block helps creating 
these slots and then user can connect inputs and outputs 
to the slots created to the Application block. 

 
Figure 293: Pass Thru Function Block

 
Figure 294: Pass Thru Example  

 

 

Figure 295: Navigating to ‘Composite’ 

To create the slots, Right click on the Application block 
and select ‘Composite;

Composite window will open. At the right pane of the 
window all points of which slots can be created are 
appears. Create slots as shown on the Figure 296 and 
click OK button. 

Input and output slots will be created to the Application 
block. Then connect inputs to input slots and output to 
the output slots. In this way, data is passed to and from 
Application logic through pass through object. 

Input and output slots can be created to function blocks 
also. In the given example, Average function block is 
used. Its inputs and outputs can be exposed to 
Application block. 
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Figure 296: Composite Editor window 

 

 
Figure 297: Composite Editor Window 
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CALIBRATE SENSORS 

Pre-requisites 
• The application logic is opened in Niagara Workbench 

and the same is downloaded to the Controller. 

• The Controller should be online. 

Procedure 
The Sensor Calibration screen allows the user to 
calibrate the sensor. This option is available only for 
commissioned and downloaded controllers. 

1. Right click the controller name on the Nav tree. Select 
Calibrate Sensor. The Sensor Calibration dialog 
box opens.  

 
Figure 298: Controller Name > Calibrate Sensors 

2. Enter the value the sensor must detect in the Edit 
Value field. 

 
 

Figure 299: Sensor Calibration Screen 

3. Click Close to close the dialog box. 

 
Note:  

If no sensors are configured, a warning 
message, “No sensors configured” appears. If a 
Modulating input is configured as Counter/Pulse 
Meter it will not be shown up in this screen. 

 

Table 211: Fields of Sensor Calibration Screen 

Name Definition 

Name Shows all the Modulating Inputs configured in the ControlProgram.  

Sensor Type Show the actual sensor type configured for that modulating input. This field is non-
editable. 

Actual Value Show the actual value of the modulating input read by the controller. This field is non-
editable. 

Edit Value Enter the value that the sensor must detect. 

Offset Show the difference between the actual and the edit value. This field is non-editable. 

Calibrate Click Calibrate to calibrate the Modulating Input to the value entered by the user. 

Refresh Click Refresh to refresh the Modulating Input values. 

Close Click, Close to exit the dialog box. 
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DIAGNOSE OUTPUTS 
The output value of the Lon and BACnet controllers can 
be monitored and diagnosed. If the output is faulty, it can 
be identified by manually setting the values of the 
physical points.  

Pre requisites 
• The Controller should be online. 

• It should be in a downloaded state. 

The Diagnostic screen displays:  

• Outputs section where outputs can be commanded. 

• The current output value to observe effect of the 
outputs on various values. 

• The current mode of the device  

Diagnose Outputs for a Lon 
Device 
Using the Controller Diagnostics feature, can be 
monitored and diagnosed the outputs of a Lon device. By 
setting the mode from auto to manual, the values of the 
modulating and binary outputs can be edited to get the 
required output. 

 

 

Procedure 
1. Right click on the controller. Select Diagnose 

Outputs. Refer Figure 300. The Diagnostics dialog 
box appears. Refer Figure 301. 

2. Enter the value of the current output to be detected in 
the Edit Value field. Enter/select information as given 
in the Figure 301. 

 
Figure 300: Controller > Diagnose Outputs of Lon 

 

 
Figure 301: Diagnostics Screen of Lon 
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Table 212: Fields of Diagnose output screen 

Name Definition 

Modulating Output The number of Modulating Outputs depends on the outputs configured in the 
application logic.  

Actual Value: Displays the value of the modulating output read by the controller. 
This field is non-editable. 

Edit Value: Enter the value that the current output must be detecting. The range is 
0-100 percent. 

Binary Output The number of Binary Outputs depends on the outputs configured in the 
application logic.  

Actual Value: Displays the value of the modulating output read by the controller. 
This field is non-editable. 

Edit Value: Select True or False. 

Mode Display the current mode of the device. 

Set Click Set to set the controller to manual mode. It writes the configured values to the 
controller and automatically puts the modulating output in the manual mode. 

Refresh Click Refresh to refresh the values. 

Close Click Close to exit the dialog box. It prompts to set all inputs in the manual or auto 
mode. 

 

 
Note:  

When an output is set to manual mode, the tool 
writes to priority 8 of that output. 

If the output is already driven at a higher priority, 
there is no effect of setting an output in manual 
mode. In this case, manual mode takes into 
effect only when priorities 1 to 7 are relinquished. 

 

3. Click, Close to exit the dialog box. 

Diagnose Outputs for a BACnet 
Device 
Using the Diagnose Outputs feature, the outputs of a 
BACnet device can be monitored and diagnosed. By 
setting the mode from auto to manual, the values of the 
modulating and binary outputs can be edited to get the 
required output. 

Procedure 
1. Right click on the controller. Select Diagnose 

Outputs. The Diagnostics screen of TargetSpyder 
dialog box appears.  

 
Figure 302: Controller > Diagnose Outputs of BACnet 
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Figure 303: Diagnostic Screen of BACnet 

2. Type/select information as given in the following 
Table 213. 

Table 213: Fields of Diagnostics screen of TargetSpyder Screen 

Name Definition 

Modulating Output The number of Modulating Outputs is depending on the outputs configured in 
the application logic. 

Current Value: Displays the value of the modulating output read by the 
controller. This field is non-editable. 

Edit Value: Type the value that the current output must be detecting. The 
range is 0 %-100 %. This field is non-editable in the automatic mode. 

Enable Manual Mode: Check this check box to enable manual mode. The 
Edit Value field is editable and the value can be entered that the current 
output must be detecting. The range is 0-100 percent. 

Note: 

If the value entered in the field is above or below the range, an error message 
appears. 

Binary Output The number of Binary Outputs is depending on the outputs configured in the 
application logic. 

Current Value: Displays the value of the binary output read by the controller. 
This field is non-editable. 

Edit Value: Select True or False. This field is non-editable in the automatic 
mode. 

Enable Manual Mode: Check this check box to enable manual mode. The 
Edit Value field is editable and it can be selected True or False from the list. 

Note: 

If the value entered in the field is invalid, an error message appears. 

Set Click Set to set the changes made to the values of the controller in manual 
mode. It writes the configured values to the controller when the modulating 
output or binary output is in manual mode. 

Refresh Click Refresh to refresh the values. 

Close Click Close to close the dialog box. It prompts user to set all outputs into 
manual or auto mode. 

 

3. Click, Close to exit the dialog box.  
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MACROS 
A Macro is a group of functional blocks grouped together 
that define a specific functionality. Commonly used 
programs elements can be defined as macros so that 
they could be reused across applications. Macros offer a 
way of transporting logic between different devices. They 
help in segmenting a huge program into smaller logical 
blocks. 

 
Figure 304: Pass Thru Function Block 

Functional blocks can be grouped as macros and macros 
can be included under macros. Macros can be re-used in 
other applications.  

Inputs/outputs of the blocks can be selected that are 
used in a macro need to be exposed in a particular 
setup. However, this does not limit the user from using 
the same macro elsewhere and choosing a different set 
of inputs/outputs to expose. 

When a macro is created and saved, it can be dragged 
and dropped onto the wiresheet view and used in 
creating application logic. The fields of the function 
blocks that make up a macro become available as fields 
of the macro itself. Macros are displayed as any other 
function blocks in a container view. 

Macros: 

• Can contain only functional blocks 

• Cannot contain I/O’s 

• Cannot contain network variables 

• Can have a macro within a macro 

 

SPYDER LIBRARY 
A Spyder library can be used to store devices, 
ControlPrograms, applications, and/or macros. A 
default library is automatically created at the location 
<Drive>:/Honeywell\WEBStation-N4-x.x.xx.x\lib. This 
library is available when Spyder Library is opened for the 
first time. This default library cannot be closed.  

However, own library can be created to create and store 
macros, applications, and/or devices. Each library comes 
with three default folders: Device(s), Application(s) and 
SBus_WM_Config(s). All the S-Bus wall modules that 
are added and saved are stored in the 
SBus_WM_Config(s) folder of a library. 

All the devices that are added and saved are stored in 
the Device(s) folder of a library. All macros and 
applications that are created and saved are stored in the 
Application(s) folder of a library.  

Display Spyder Library Palette 
To display the Spyder Library palette on the left side of 
the window:  

• From the Menu bar, select Windows > Side Bars > 
Spyder Library.  

 
 

Figure 305: Windows > Side Bars > Spyder Library 

The Spyder Library palette appears on the left side of 
the screen with the contents of the default library. Every 
library contains the default folders: Device(s), 
Application(s) and SBus_WM_Config(s). The 
application libraries present in the default parent folder 
path are displayed in the dropdown list as shown  
in Figure 305. 
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Figure 306: Application(s) Libraries 

To change the current parent folder path:  

1. Click the  side bar button on the library palette to 
get a drop-down list and select Select Parent Path. 
The Advance Options dialog box appears.  

 
Figure 307: Advance Options Screen to Change 

Current Path 

2. Click the browse button on the right side of the 
Advance Options dialog box. The Directory 
Chooser dialog box appears.  

3. Browse through to the location where the required 
library files are stored and click Choose.  

4. Select the Save as default parent path option if 
required to make this folder the default folder for 
future use. The libraries available in the default parent 
folder path are displayed when the workbench is 
restarted. On subsequent uses, the libraries available 
in the last selected parent folder path are listed. Even 
while uploading items, the default library path is 
invoked.  

5. Click OK. The drop-down list box in the Spyder 
palette, then displays the application libraries in the 
selected folder. If an application library is selected 
from the drop-down list box, all the devices and 
applications present in that library in the tree is 
displayed in the sidebar.  

 

 
Note:  

The parent folder path selected in a workbench 
is not applicable when the library is opened from 
a browser. The parent folder selected in the 
browser is applicable only when the library is 

opened from a browser and is not reflected when 
the library is opened from a workbench.  

 

Close Spyder Library Palette 
Click the down arrow on the menu bar of the Spyder 
Library palette and click Close to close the library 
palette.  

 
Figure 308: Click Close Button  

 

Open Spyder Library 
Macros, Applications and Devices that are created can 
be stored in a library for being reused in another project 
or scenario. Libraries can be created based on the 
requirement and store them. Selected items of libraries 
can be imported in the station (in LonNetwork or Device 
Logic). 

There is a default library shipped by Honeywell. 
However, required libraries can be created and saved, 
which contain macros, applications and or devices. Such 
user defined libraries can be modified, saved and shared 
across projects or across users. 

To open a user-created library:  

1. Click the options button on the library palette to get a 
drop-down list and select Select Parent Path.  

Figure 309: Select Parent Folder Option 

 
The Advance Options dialog box appears.  
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Figure 310: Advance Options Screen 

2. Click the browse button on the right side of the 
Advance Options dialog box and select a destination 
folder where stored libraries are located. The 
Directory Chooser dialog box appears.  

3. Browse through to the location where required library 
files are stored and select Choose. 

4. Select the Save as default parent path option to 
make this folder the default folder for future use if 
required. The libraries available in the default parent 
folder path are displayed when workbench is 
restarted. On subsequent uses, the libraries available 
in the last selected parent folder path are listed. 

5. The contents of the library are displayed in the library 
palette. Also, the path where the library files are 
stored is also displayed in the library palette. 

 
 

Figure 311: Path of Stored Libraries 

 
Note:  

If multiple libraries stored at a location are 
available, then use the down arrow next to the 
field displaying the library path and select the 
required library to open. 

The parent folder path selected in a workbench 
is not applicable when the library is opened from 
a browser. The parent folder selected in the 
browser is applicable only when the library is 
opened from a browser and is not reflected when 
the library is opened from a workbench. 

 

 

Close Spyder Library 
Click the button on the library palette (as shown below) 
and click Close to close the library. 

 
 

Figure 312: Click Close Button 

 
Note:  

The default library cannot be closed. 

 

Add Items to Spyder Library 
Devices, macros, S-Bus wall modules and/or applications 
can be added to a library. 

Add New Item to Library  
From the Spyder Library Palette 
To add a new Macro, Device, S-Bus wall module, 
ControlProgram, or Application to a library:  

1. To add the new application logic, open required 
Library. 

2. Click the options button on the library palette to get a 
drop-down list and select New > 
Application/LonDevice/BACnetDevice/Macro/ 
SBusWallModule. 

 
Figure 313: Drop Down List of Options 
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3. The 
App/LonDevice/BACnetDevice/Macro/SBusWallM
odule Name dialog box appears.  

4. Type a name for the item and click OK. The new item 
is added to the library in the Application(s) folder of 
the library in case of macros and applications and to 
the Device(s) folder in case of Lon and BACnet 
devices and displayed in the library palette. 

From the Nav Tree 
To add a new Macro, Device, Application or 
ControlProgram to a library:  

1. Right click the device, macro, application or 
ControlProgram in the Nav tree and select Save to 
Library. The Save Library Item dialog box appears. 

 
Figure 314: Save to Library Option 

 

 
Note:  

The Library list displays all libraries in the Parent 
folder. The Parent Folder Path indicates the 
Parent folder.  

The Save to Library function is possible only in 
the Engineering mode and applies to macros, 
applications, devices, S-Bus wall modules, and 
ControlPrograms. 

 

2. Following are the options for: 

Save as New App: If this item needs to add for the 
first time to a library, this is the only option available. If 
not saving an item for the first time, this option creates 
a new item in the specified library.  

OR 

Overwrite App (New Version): If an item needs to 
add for the first time to a library, this option is 

disabled. If not saving an item for the first time, this 
option overwrites the existing item and increments the 
version number. 

3. To save this item, select required library from the 
Library list and proceed to step 6 of this procedure.  

4. Alternatively, if required, create a new library and 
save the changes in the newly created library, click 
the Options button > New > Library. The Library 
Name dialog box appears. 

5. Enter the name of the library and click OK. The 
location where the new library is saved is displayed in 
the Parent Folder Path. The default location is 
<Drive>::/Honeywell\WEBStation-N4-x.x.xx.x\lib. 
To change the location if required, click Select Parent 
Folder, then Advanced Options dialog box will 
appear. 

6. Click the Browse to search through the location 
where it is required save this new library and click 
Choose. The new library is created at the location 
user has specified. 

7. Enter/select: (refer Figure 316) 

• Name: Enter a name to save the items. 

• Macro/Device/Type: Select the type of item to save 
them in controller. Macro/Device/Application, can be 
selected respectively.  

• Description: A brief description of the item with the 
changes made. 

• Version: This is auto-updated. The version number 
will not be changed. 

• Attachment: Click Add to browse through and attach 
document(s). The path of the attached document is 
displayed in the Attachment field. Select an 
attachment and click Remove to remove an 
attachment. 

8. Click OK. The new item is stored at the desired 
location. 

Saving Library Items 
Devices, applications, S-Bus WallModules, or macros 
can be added or modified to a library. Items such as 
Applications and macros are saved to the Application(s) 
folder in a library while a new device or changes to a 
device are added to the Device(s) folder in a library. 
Once all the changes are done to a library, then they 
should be saved so that they are available for 
subsequent use.  

 
Note:  

Options are not available to save these items to a 
different library. 
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To save the changes made to a library:  

1. Click the options button on the library palette to get a 
drop-down list and select Save Library. The Save 
Library Items dialog box appears with the unsaved 
changes listed.  

 
Figure 315: Save Library option 

2. Select required items on the list to save. A check 
mark appears across each item that is selected.  

3. Click OK. The Save Library Item dialog box appears 
with the library name and the folder where the library 
is being saved. The default library path is displayed in 
the Parent Folder Path field when the workbench is 
restarted. On subsequent uses, the last selected 
library is listed. 

 
Figure 316: Save Library Item Screen 

4. Select one of the two options to save the changes 
that are made. Following are options to:  

• Overwrite App (new version): This creates a 
new version of the existing library. By selecting 
this option, all changes are saved as a new 
version.  

• Save as New App: This creates a new library 
and saves the library with the changes as a new 
library.  

5. Following options are selected to: 

• Overwrite the existing version, enter/select: 

  Description: A brief description of the 
application with the changes made. 

  Type: Select the Application Type. 

  Version: This is auto-updated. The version 
number will not be changed. 

  Attachment: Click the Add to browse through 
and attach a document(s). The path of the 
attached document is displayed in the 
Attachment field. Select an attachment or 
click Remove to remove an attachment. 

• Save as a new application, enter/select: 

  Name: Enter a name to save the items. 

  Description: A brief description of the 
application with the changes made. 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 334  

  Type: Select the Application Type. 

  Version: This is auto-updated. User will not be 
able to change The version number. 

  Attachment: Click the Add button to browse 
through and attach a document(s). The path of 
the attached document is displayed in the 
Attachment field. Select an attachment and 
click Remove to remove an attachment. 

6. Click OK to complete saving the items to the library. 
The newly added items along with the attachments 
are displayed in the library palette. 

Alternatively, a device/macro/application/S-Bus wall 
module can be saved that are created from the Nav 
Tree. For details, refer From the Nav Tree section of this 
topic.  

Points to note: 

1. When an Application folder is saved to a library, all 
network variables/BACnet objects created on that 
folder are also saved. 

2. When an Application folder is saved to a library, an 
NV/Object whose field(s) is exposed on the same 
folder as point(s) is saved to the library in such a way 
that: 

• The network variable/object is saved. 

3. The fields are exposed as points the same way as in 
the application being saved  

4. When an Application folder is saved to a library, an 
NV/Object whose field(s) is exposed on a different 
folder other than the current one as points is saved in 
such a way that: 

• The network variable/object is saved. 

5. The fields exposed as points are saved as unexposed 
fields. The NV/Object configuration view indicates 
those fields as unexposed. 

6. Fields exposed as points on the same folder are 
saved as exposed points 

7. When an Application folder with exposed point(s) 
whose associated NV/Object is present in other 
folders other than the current folder and its child 
Application folders, is saved to a library, the 
associated NV/Object is also copied along with that 
folder. 

8. When an Application folder is saved to a library, the 
physical points (I/O points) in the logic are saved 
along with their assigned terminal IDs. 

9. When an Application folder is saved to a library, only 
the NVs/Objects created in that folder and its child 
Application folders are saved. No additional Fixed 
NVs/Objects are saved along with it. (This implies that 
the tool does not do anything in the background to 
make the application being saved a complete 
application based on the model because the 
application is independent of the model.) 

10. When an Application is saved to the library, all the 
fixed NVs/Objects, fixed IOs become of the type 
custom in the library, and they can be modified/ 
deleted. 

11. When a physical IO is added to an application under 
Applications category in the library, the physical point 
is not assigned to any pin. It should be in an 
unassigned state. 

12. When an application is created under Applications 
category in the application library, the tool does not 
warn users of the application going out of limits (This 
is because the application (in the absence of the 
device) is independent of the model and model based 
restrictions). As many NVs/Objects, and IOs can be 
created and drag as many FBs as per requirement. 

13. When an application is created under a device in the 
library, then the tool warns the user when the 
application goes out of limits based on the model 
selected. 

14. An S-Bus wall module can be added to an application 
logic and load the same to a library only if the Lon 
Spyder II, or Spyder Lon Micro, or Spyder BACnet 
Micro, or BACnet Spyder models are used. 

15. PX files created on the library item being saved are 
also saved to the library automatically. 
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Load Library Item 
This feature enables to load an application quickly or a 
macro that may be stored in a library to an application or 
macro currently working within the Nav tree. 

 

 
Note:  

The Load From Library function is possible only 
in the Engineering mode and applies to macros, 
applications, and ControlPrograms only. An S-
Bus wall module can be added to the application 
logic and load the same to a library only if user is 
using the Lon Spyder II, or Spyder Lon Micro, or 
Spyder BACnet Micro or BACnet Spyder models. 

 

1. Right click the macro/application on the Nav tree and 
select Load from Library.  

 
Figure 317: Select Load from Library 

 

2. The Load Library Item dialog box appears. Refer 
Figure 318. 

 
Figure 318: Load Library Item 

3. Select the required Library to load an item from the 
Library list. The Parent Folder Path displays the 
location of the library from which items are loaded. 

4. Select the Application or Macro from the 
Application/Macro/SBusWallModule list. This list 
displays the available applications, macros, or S-Bus 
wall modules in the library. 

5. Type a name for the loaded item. 

6. The Type and Version fields are not available for 
editing. The Version number is auto-generated. 

7. The Attachment field displays the attachments saved 
with the items that are loading, if any. 

8. Click OK to load the items to the macro/application. 
The newly loaded items are displayed in the Nav tree 
to the application/macro. 

Point to note: When an application is imported from a 
library:  

1. The application is added as a subfolder at that level in 
the target. 

2. The NVs/Objects with name clashes are removed and 
its exposed points, if any are converted to invalid 
points. 

3. If the IO being imported has no pin assigned, the tool 
assigns a pin to the IO, if available. If no pin is 
available, the IO is imported as an invalid IO. 

4. If the IO being imported has a pin already assigned, 
the tool retains the pin if it (the pin) is free on the 
target. If the pin has already been used on the target 
controller, the tool reassigns a pin to the IO, if 
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available. If no pin is available, the tool unassigns the 
pin from the IO (the IO is converted to an invalid IO). 

5. If the IO being imported has a fixed IO configuration, 
the tool assigns a fixed IO pin to the IO as per the 
target controller, if available. If not, the tool converts 
the IO to a custom type and reassigns a free IO pin, if 
available. If not available, the IO becomes an invalid 
IO. 

6. When an application is imported from a library to an 
empty controller (fresh controller with no changes 
made to the logic), both the ControlProgram and the 
imported application folder get the same GUID 
(Globally Unique Identifier). 

7. For the NVs/Objects whose NV/Object name, number 
of fields, field names and network data types matches 
that of fixed NVs/Objects on the target controller, the 
tool does the following: 

• If the target controller is a fresh device, the tool 
strips off the fixed NV/Object from the 
ControlProgram/Application folder of the target 
controller. The matching NVs/Objects on the 
target folder are marked as fixed. 

• If the target controller is not a fresh device, 
matching fixed NVs/Objects on the incoming folder 
are stripped off. Any incoming fixed NV/ Object 
points that are exposed on the incoming folder are 
remapped to point to the fixed NVs/ Objects on 
the target controller logic (provided the field 
configuration, including the value and the internal 
data type are matching).  

• If the target controller is not a fresh device and if 
any of the fixed NVs/Objects are exposed on the 
wiresheet as points, the tool strips off matching 
NVs/Objects from the incoming folder and the 
exposed points of those NVs/Objects are 
converted to invalid state. There is no effect on 
the exposed fixed NV/Object points on the target 
controller. 

8. The Lon Spyder tool checks for UNVT name clashes. 
The tool generates a unique UNVT name for those 
incoming NVs whose structure matches with UNVT 
name clashes with existing NVs. 

9. If the target controller is a fresh device, then analog 
output type (Current or Voltage) of the incoming AOs 
(if any) would be the default type. That is, any new 
AO that is dragged onto the wiresheet in the station 
has the analog output type set to be same as that set 
for incoming AOs. 

10. When loading from a library, PX files are also copied 
to the Station and can be accessed in the Station. 

11. Attachments can exist only in the library. They cannot 
be created or loaded from the library in Station. If 
trying to load or drag the library item which contains 
an attachment, then the attachment is discarded from 
the library item automatically. 

Delete Library items 
A library cannot be deleted using the 
HoneywellSpyderTool. However, the Windows 
mechanism can be used to delete the library file stored 
on the computer. To delete a library, the location can be 
browsed where the library is stored and use the 
Windows mechanism to delete the file. 

However, items can be deleted within a library.  

To delete items in a library:  

1. Right-click the required item(s) 
(device/macro/application) from the Library palette 
and click Delete. 

 
Figure 319: Click Delete Item > Delete Option  

2. A confirmation message is displayed. Click OK to 
delete the item from the Library.  

Export Library Items 
Items can be exported in a library to another file for 
purposes of distribution. To export items in a library: 

1. Click the options button on the library palette to get a 
drop-down list and select Export. The Export to File 
dialog box appears with all the items in the library 
listed. 
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Figure 320: Export to File Screen 

2. Select the required items on the list that needs to be 
exported. A check mark appears across each item 
user has selected. The File Path field displays the 
default location, the Niagara installation folder 
(Example: C:\...\ WEBStation-N4-x.x.xx.x \). Only 
those items have to be selected which are not 
modified. If for any reason, modified item is selected, 
then, the items have to saved before exporting. If 
exporting of an item is attempted that is modified but 
not saved, then an error message appears. The items 
must be saved before exporting.  

3. Select the browse button to display the File Chooser 
dialog box. 

4. Browse through to the folder to which is required to 
export these library items and click Save. 

5. Click OK to export the file to the desired folder. 

Import items to Library 
Items can be imported such as a 
device/macro/application to a library from an exported 
file.  

To import items to a library:  

1. Click the options button on the library palette to get a 
drop-down list and select Import. The File Chooser 
dialog box appears. 

 
Figure 321: Import option 

2. Browse through to the file user wants to import to this 
library and click Open. The items are imported to the 
library.  

 
Note:  

If the import fails, an error message appears, 
gives the following details: 

• An item of the same name already exists. 
You must rename the library object and 
import again. 

• An item with the same logic already exists. 
You must delete the similar object(s) in the 
destination library and import again. 

 

 
Figure 322: WARNING: Import Not Successful Screen 
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Note:  

An S-Bus wall module can be added to the 
application logic and import the same to a library 
only if the Lon Spyder II, or Spyder Lon Micro, or 
Spyder BACnet Micro, or BACnet Spyder models 
are used. 

Spyder Library Applications 
The applications and macros created and saved to the 
library are stored in the Application(s) folder in the 
library. Application(s) is one of the default folders in 
every library.  

To create a new application in the library:  

1. Click the options button in the Spyder Library 
sidebar. A list of options appears.  

2. Select New > Application. The Application Name 
dialog box appears. Refer Figure 313: 

 

Error! Reference source not found. 

3. Type the name of the application in the Application 
Name dialog box.  

 
 

Figure 323: Enter Name of Application  

4. Click OK. An application with the given name is 
created in the Application(s) folder in the library.  

5. Expand the Application(s) folder on the left pane to 
view the application file of the application that is just 
now created.  

6. Expand the application file under the Application(s) 
folder on the left pane to view the application that is 
just now created.  

To add any Spyder object such as an application, macro, 
physical IO, software IO, Function block to the 
application in the library:  

1. Browse to the application by clicking Station > 
Drivers > LonNetwork > LonSpyder > 
ControlProgram 

OR 

Station > Drivers > BacnetNetwork > 
BACnetSpyder > ControlProgram in the Nav side 
bar 

2. Right click any Spyder object such as application, 
macro, device, FB, or IO in the Palette sidebar and 
select Copy.  

 
Figure 324: Copy Option 

3. Right click the application in the Spyder Library 
sidebar and select Paste. 

OR 

Drag the object to the wiresheet of the application in 
the Spyder Library sidebar. The application, macro, 
device, FB, or IO appears on the wiresheet of the 
application. 

Point to note:  

1. When a software IO in Lon such as NVI, NCI, or NVO 
is added to the wiresheet, an NV is created in the NV 
Configuration View. The corresponding backend 
object is created in the Object Configuration View.  

2. When a software IO in BACnet such as Network 
Inputs, Network Setpoints, or Network Outputs is 
added to the wiresheet, a backend object is created 
in the Object Configuration View. The corresponding 
NV is created in the NV Configuration View. 

3. When a BACnet software input of type Constant is 
added to the wiresheet, no backend object or NV is 
created. 

4. When a physical input of type Modulating Input is 
added to the wiresheet, a backend object -AI, as well 
as a reference object -UICalOffset are created in the 
Object Configuration View. There is no NV created for 
the physical point in the NV Configuration View. 

5. When a physical IO such as Binary Input, Binary 
Output, or Modulating Output is added to the 
wiresheet, a backend object is created in the Object 
Configuration View. There is no NV created for the 
physical point in the NV Configuration View. 
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Application Conversion – Lon 
Applications to BACnet and vice-versa 
Lon to BACnet 

If an application created under Lon Spyder device is 
dropped onto a BACnet Spyder device: 

1. The Lon network interface will be removed and the 
BACnet network interface will be added. 

2. All Lon Network Variables will be removed. 

3. BACnet objects will be created for all the points on the 
wiresheet  

a. If the point on the wiresheet is of type Modulating 
Input, a corresponding AI object and a UICalOffset 
object will be created. 

b. If the point on the wiresheet is of type Network 
Setpoint and if it corresponds to a field of 
nciUICalOffset, then the tool will do the following 
automatically:  

i.  Create Modulating Input (MI) only if MI with 
the same terminal number as the exposed 
point is not available in the BACnet device. If 
the BACnet device already has an MI with the 
same terminal number, the tool will not create 
a new MI. 

ii.  Create the corresponding AI object and an 
UICalOffset object for the newly created MI. 

c. If the point is of type Modulating Output, Binary 
Input, or Binary Output the corresponding BACnet 
object will be created by the tool.  

d. If the point is of type Network Input and if it is 
attached to nviTimeSet, the tool will automatically 
map the exposed point to the corresponding 
DEV_DeviceObject field.  

4. If the logic has a TemperatureSetpointCalculator 
block, 6 BACnet objects will be created (only if the 
BACnet device does not already have one) 
representing the setpoint values of the block.  

Lon to Library application 

If an application created under Lon device is dropped 
onto the Library application: 

1. The BACnet network interface will be added. 

2. BACnet objects will be created for all points on the 
wiresheet.  

a. If the point is of type Modulating Input (MI), AI and 
UICalOffset objects will be created. If the BACnet 
device has any free terminal, MI added to BACnet 
device will be assigned to that terminal. If the 
BACnet device does not have any free terminal, 
the MI will remain unassigned. 

b. If the point is of type Network Setpoint and it is 
attached to nciUICalOffset then the tool will do the 
following automatically. 

i.  Create Modulating Input (MI) only if MI with 
the same terminal number as the exposed 
point is not available in the BACnet device. If 
the BACnet device already has an MI with the 
same terminal number, the tool will not create 
a new MI. 

ii.  Create the corresponding AI object and 
UICalOffset object for the newly created MI. 

c. If the point is of type Modulating Output, Binary 
Input, or Binary Output, the tool will create the 
corresponding BACnet object.  

d. If the point is of type Network Input and if it is 
attached to nviTimeSet, the tool will automatically 
map the exposed point to the corresponding 
DEV_DeviceObject field.  

3. If the logic has a TemperatureSetpointCalculator 
block, 6 BACnet objects will be created (only if the 
BACnet device does not already have one) 
representing the setpoint values of the block.  

BACnet to Lon 

If an application created under BACnet Spyder device is 
dropped onto the Lon Spyder device: 

1. The BACnet network interface will be removed and 
the Lon network interface will be added.  

2. All BACnet objects will be removed.  

3. Lon objects will be created for all points on the 
wiresheet  

a. If the point is of type Network Setpoint and if it is 
attached to UICalOffset object, the tool will 
automatically map the exposed NetworkSetpoint 
to the nciUICalOffset field based upon the terminal 
number used by the corresponding Modulating 
Input. 

b. If the point is of type Network Input and if it is 
attached to DEV_DeviceObject, the tool will 
automatically map the exposed point to the 
corresponding nviTimeSet field. 

4. If the logic has a TemperatureSetpointCalculator 
block, the network variable nciTempSetpoints will be 
created (only if the Lon device does not already have 
one) representing the setpoint values of the block. 
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BACNET TO LIBRARY APPLICATION 

If an application created under BACnet device is dropped 
onto the Library application: 

1. The Lon network interface will be added.  

2. Lon objects will be created for all the points on the 
wiresheet. 

a. If the point is of type Network Setpoint and if it is 
attached to UICalOffset object, the tool will 
automatically map the exposed NetworkSetpoint 
to the nciUICalOffset field based upon the terminal 
number used by the corresponding Modulating 
Input. 

b. If the point is of type Network Input and if it is 
attached to DEV_DeviceObject, the tool will 
automatically map the exposed point to the 
corresponding nviTimeSet field. 

3. If the logic has a TemperatureSetpointCalculator 
block, network variable nciTempSetpoints will be 
created (only if the Lon device does not already have 
one) representing the setpoint values of the block. 

Viewing and Editing BACnet Objects and 
Lon NVs 
1. Browse to the application in the Application(s) folder 

in the Spyder Library sidebar.  

2. Right click the application and select Views.  

3. Select NV Configuration View to view the Lon 
Network Variables available on the wiresheet of the 
application 

OR 

Select Object Configuration View to view the 
BACnet Objects available on the wiresheet of the 
application.  

 
 

Figure 325: View > NV Configuration View Option 

The configuration properties of the physical and software 
IOs in the application library now enables the editing of 
the points for both the network interfaces. The Advanced 
option under Configure Properties contains the two tabs, 
BACnet Object and Lon NV.  

To edit the physical and software IOs in the application 
library:  

1. Browse to application in the Application(s) folder in 
the Spyder Library sidebar.  

2. Right click the application and select Views.  

3. Select Wiresheet to view the Spyder objects such as 
application, macro, device, FB, or IO in the 
Application Library. Refer Figure 325. 

4. Right click any physical IO or software IO on the 
wiresheet and select Configure Properties. The 
Configure Properties dialog box appears.  

 
Figure 326: Configure Properties Option 

5. Click Advanced. The Advanced dialog box contains 
the two tabs BACnet Object and Lon NV.  

 
Note:  

The version of the tool installed must support 
both Lon and BACnet to be able to view the two 
tabs in the Advanced dialog box. 

 

 
 

Figure 327: Advanced Screen with BACnet Object 
and Lon NV Tabs 

If a Lon application is dragged onto the wiresheet of a 
BACnet device then,  

• All the Lon NVs that appear on the wiresheet are 
converted to the corresponding BACnet objects. 
During the conversion, the network data type of all 
points is removed.  

• The backend objects are created for the points on the 
wiresheet of the BACnet device.  
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• The assignment of pins in the Terminal Assignment 
View is also corrected. If the BACnet device has 
fewer terminals, then the physical points are 
unassigned.  

If a BACnet application is dragged onto the wiresheet of 
a Lon device then,  

• All the software points that appear on the wiresheet of 
the BACnet application are converted to the 
corresponding Lon NVs. The physical points on the 
wiresheet are mapped to the fixed NVs. During the 
conversion, the network datatype of all points are 
mapped to a standard NV type (SNVT).  

Points to note: For tools supporting both Lon and 
BACnet:  

1. When an application is saved to the library from a Lon 
Network, backend BACnet objects are created for the 
points on the wiresheet. Backend objects are not 
created for mandatory and fixed NVs. 

2. When an application is saved to the library from a 
BACnet network, the points are shown as invalid in 
the NV Configuration View. 

3. When a Lon NV is created in the NV Configuration 
View, the corresponding BACnet object is 
automatically created only when the Lon NV is shown 
on the wiresheet as point. 

4. When a BACnet object is created in the Object 
Configuration View, the corresponding Lon NV is 
automatically created only when the BACnet object is 
shown on the wiresheet as point. 

5. When a point is added to the wiresheet, the 
corresponding Lon NV and BACnet Object is created 
with the default settings. 

6. If the configuration details of the point on the 
wiresheet are modified, the changes are applied to 
both Lon and BACnet. 

7. Changing BACnet object details such as GPU, Fail 
Detect, Update Rate, or SenDelta does not affect the 
corresponding NV. 

Migrating Spyder Library from AX 
to N4 
AX Spyder library can be migrated to Niagara 4.2.36.34 
and above. 

Prerequisites 
• Spyder library files should be upgraded to  

AX 3.8.x. 
For example, for users currently using AX 3.6.x, 
need to first upgrade to AX 3.8.x. 

• The Niagara N4 version should be 4.2.36.34 
and above 

Steps to migrate 
1. Open 

<NIAGARA_4.2.36.34_HOME>\defaults\migra
tor.properties and add libbog as one of the 
value for BogMigrator.extensions. For example, 
BogMigrator.extensions=bog,libbog as 
shown in the following figure. 

 

2. Save the file and copy this to 
<NIAGARA_USER_HOME>\etc folder. 

3. Open Niagara 4.2.36.x console and enter the 
command plat installdaemon to install the 
platform daemon. 

4. Execute the following migration command 
n4mig –allowNonDist 
<Spyder_AX_library_folder> 
<N4_Spyder_library_folder_location> 
For example, n4mig -allowNonDist 
C:\Honeywell\AppLib_test 
C:\Honeywell\AppLib_test_migrated 

5. Now AX Spyder library will be migrated and 
placed in the new folder location specified 
above.  
User can now open the library in N4 SpyderTool 
for further use. 
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MODES OF OPERATION 

The different modes of operation in the 
honeywellSpyderTool include:   

Engineering Mode: Use this mode to build application 
logic. In this mode, engineering operations can be 
performed such as creating logic, linking blocks, and 
exposing fields of blocks, macros, and Physical points. 

Use this mode when the ControlProgram does not 
appear under the device in the Nav tree. Invoking this 
menu, creates ControlProgram node under the device 
and prepares ControlProgram for programming the 
Spyder 

Normal Mode: When the user invokes device in Normal 
Mode, the ControlProgram object under the device shall 
not be visible to the user anymore in the tool.  

Invoking the Normal Mode writes the ControlProgram 
logic to a separate file and removes the ControlProgram 
contents from the Station's memory.  

Put the device back to Normal Mode after the 
engineering the device. This will free up Station's heap 
memory for other resources. 

By default, the device is in Normal Mode. 

 
Note:  

Operations supported on the device in both 
Normal and Engineering Modes are - Save to 
Library, Cut, Copy, Paste, Paste Special, 
Duplicate, Delete, Import XML, Calibrate 
Sensors, Diagnose Outputs( For Lon Spyder), 
Set Outputs to Auto (For BACnet Spyder), Set 
Time, Flow Balancing, Spyder Download, 
Download, Upload. 

 

Online debugging Mode: In this mode, the application 
can be debugged after downloading, it to the controller. 
The points need to be debugged can be selected. Debug 
points can be forced and watched the true picture of the 
values that get executed in the controller.  

Simulation Mode: In simulation mode, user can test the 
created application logic in the ControlProgram offline. 
Here, user doesn’t have to download the program in the 
controller for testing. It is recommended to always test 
the program in simulation mode for confirmation of 
proper functioning and then download. Simulation helps 
to find out programming bugs and correct them before 
the program is actually tested on the field. 

Accessing Different Modes 

Pre-requisites  
• Network with Honeywell Spyder controllers 

• HoneywellSpyderTool is licensed. 

• The programmed logic is downloaded to the controller 
(This is applicable only to debug points and not to 
Engineering and Simulation).  
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ENGINEERING MODE 
Use this mode to perform engineering operations such 
as creating a ControlProgram, creating macros, 
creating Spyder libraries, linking blocks, selecting points 
to debug, force write points to controller, and so on.  

For a detailed discussion of how to perform the 
engineering operations mentioned above, Refer 
“ControlProgram Wiresheet View”  

The device is in Engineering mode when the 
ControlProgram is loaded into the station's memory and 
the workbench is synchronized with the station. 

To access Engineering Mode of the Application:  

1. On the Nav tree, browse Station > Config > Drivers 
> LonNetwork > LonSpyder > Engineering Mode 

OR 

2. Browse to Station > Config > Drivers > 
BacnetNetwork > BACnetSpyder > Engineering 
Mode 

 

 

 
 

Figure 328: Access Engineering Mode 

A progress bar showing Engineering mode download 
status appears. 

 
 

Figure 329: Status Bar shows Engineering Mode 
Switching 

3. Click Close. The Engineering Mode page appears. 

 
Note:  

Closing the Progress dialog will close the dialog, 
but transition to Engineering Mode is in progress 
in the background.  

 

 

 

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 344  

 
Figure 330: Engineering Mode Screen 

For details, Refer “Controller Summary View” 
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SPYDER CONTROLLER 
ONLINE OPERATION 

Spyder LON Controller 
1. To perform online operations on the Lon Spyder 

controller, 

Discover the Lon controller installed on the field and 
connected to the system over Lon network. Refer 
Figure 331. All online Lon devices will be discovered 
on the Discovered pane as shown in Figure 331. 

 
Figure 331: Discovering Lon controllers 

 

2. Match Operation: 

Select the discovered device and the device created 
in the database for that device, and click on Match 
button. This operation will match the subnet and 
node of both devices. Refer Figure 332. 

3. Commissioning Operation: 

 
After match operation, select the device and click on 
Commission button. The controller will go in 
commissioning mode.. 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 346  

After completing Commission Operation, user can 
perform operations such as, downloading, uploading 
(learning the logic) and testing the device online. 

 

 

 

 
Figure 332: Match Operation 

 

Spyder BACnet Controller 
To perform inline operations on the BACnet Spyder 
controller, 

1. Discover Operation: 

To discover the BACnet controller installed on the 
field and connected to the system over BACnet 
network. Refer Figure 331. All online BACnet 
devices will be discovered on the Discovered pane 
as shown in figure. 331. 

 

2. Match Operation: 

Select the discovered device and the device created 
in the database for that device, and click on Match 
button. This operation will match the Device ID and 
MAC address of both devices.  

After match operation, user can perform all other 
operations, such as downloading and learning logic.

 
 
After completing Match Operation, user can perform 
operations such as, downloading, uploading 
(learning the logic) and testing the device online. 
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Figure 333: Discovering BACnet controllers 
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Figure 334: Match Operation 
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ONLINE DEBUGGING MODE 
Use the Online Debugging mode to debug the output 
points of Functional Blocks, Network Inputs/Network 
Setpoints (NVIs and NCIs in Lon Spyder, Analog Value 
Objects, Binary Value Objects, and Multi-state Value 
Objects in BACnet Spyder, and physical input points 
such as binary inputs and modulating inputs) in the 
online mode. Write points to NVs or Objects and observe 
field values can be forced. Also select the points (in an 
application) which are require to debug. The 
prerequisites to work in this mode include creation of 
application logic and downloading it to the controller.  

To be able to debug function blocks, they must be linked 
to other function blocks or output points or configured as 
Out_Save, Out_Byte, Out_float, or constant. An 
exception, however, is the Alarm function block. If an 
Alarm function block is available with only its input linked, 
then still debugging can be performed. 

To be able to debug input points (NVIs or Network 
Inputs, NCIs or Network Setpoints, analog inputs, and 
binary inputs); they must be linked to function blocks or 
other output points.  

The point selected for debugging and with the view in the 
watch window option enabled appears in the watch 
window at the bottom of the wiresheet. Use the watch 
window if the points are required to watch are scattered 
between macros and sub-application logic. In such a 
situation, user do not have to view the container 
containing the point. The Watch Window feature can be 
used to watch the values of all the points that are 
selected, irrespective of where they are or are not on the 
wire sheet. 

Following operation can be performed in the Debug 
mode:  

• Force Values  

• Select Points to debug  

• Start debugging points  

Working in Online Debugging Mode 
The Online Debugging Mode can be accessed from 
either the Engineering or Simulation mode with the click 
of a button. To move to Online Debugging Mode from 
any mode: 

Click  on the Tool bar  

OR 

Right-click anywhere on the wiresheet and select Debug  

 
 

Figure 335: Debug Option 

The Debug button on the toolbar becomes unselectable 
and ControlProgram the following options are available:  

•  Force Values: To test a program, user can 
force the values of input network variable and 
network setpoint according to test requirement and 
can analyze or observe the program response to the 
forced values. 

•  Select Point: To select the points required to 
perform, debug. The selected points appear in the 
Watch Window with the field values. 

•  Stop: To stop debugging and access the 
Engineering Mode.  

•  Simulate: To enter the Simulation Mode.  

•  Simulation Settings: Click on the 
SimulationSetting button and Simulation Settings  
window appears. Set the fields as per the 
requirement and click OK. Refer Figure 344. 
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• Download Application Logic to Controller 

After required application logic is created and tested the 
logic using the simulation feature, the application logic 
can be downloaded to the controller. To download the 
application logic:  

1. In the Nav tree, right click the device and select 
Spyder Download from menu items. The Spyder 
Download dialog box appears. Refer Figure 29 and 
Figure 30. 

2. The Spyder Download dialog box appears. Click OK 
to download the logic to the controller. 

Point to note: 

• A Quick Download only downloads the modified 
items from a previous download whereas with a Full 
Download the entire configuration is downloaded to 
the controller replacing the existing configuration. 
However, if an operator or tenant has made changes 
to the S-Bus wall module locally from the display on 
the wall module, and a full download is performed, 
Spyder tool downloads the entire configuration to the 
controller except the S-Bus wall module 
configuration.  

This is done to avoid losing any changes made 
locally on the S-Bus wall module during the 
download. If the S-Bus wall module is being used, 
then the models selected should be Lon Spyder II, 
or Spyder Lon Micro, or Spyder BACnet Micro, or 
BACnet Spyder.  

When using the Lon Spyder and BACnet Spyder 
models, if S-Bus wall module settings are modified 
from the display in the wall module, then the same 
configuration can also be uploaded into the Spyder 
tool. 

• S-Bus wall module cannot be downloaded to the Lon 
Spyder I models. 

3. If setpoint values in the wiresheet are different from 
the values in the controller, a message appears 
stating, “A network setpoint or schedule change has 
occurred since the last download”. To cancel the 
download or proceed options are given and over-write 
wiresheet values to the controller. So that setpoints 
modified from a wall module or graphics are not lost 
due to an over-write of wiresheet values during a 
download, use the Sync From Field Device to 
Wiresheet option (Right-click controller > Sync From 
Field Device to Wiresheet). This option makes sure 
that the values in the controller are not over-written by 
wiresheet values when the two values are not in sync.  

Modify Application During Debugging 
The application logic can be modified, even during 
debugging of points. The following Table 214 
summarizes the actions and their effects on the points in 
the debugging mode. 

 

Table 214: Effects of Actions on Points in Debugging Mode 

Action Result 

Add/remove a block  Not allowed 

Add/remove a link  Not allowed 

Rename/Reorder a component (function block, physical/software points, 
composite slots, macros, applications, ControlPrograms, device)  

Not allowed 

Point Conversion  Not allowed 

All configuration changes for function blocks except Property description 
change and Output property type change  

Not allowed 

Change Constant value through Config properties and NOT through Force 
values/ Actions screen  

Not allowed 

Change Network Setpoint value through Config Properties dialog and not 
through Force values/Actions screen  

Not allowed 

Change Schedule configuration  Not allowed 

Change Property description of function block  Allowed 

Change Simulation settings  Allowed 

Change Model  Not allowed 
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Action Result 

Reassign/Unassign IO terminals in Terminal Assignment View  Not allowed 

Change Daylight settings in Controller Summary View  Not allowed 

Import XML  Not allowed 

Change IO configuration  Not allowed 

 

Changing Modes 
On changing the mode from Engineering/Online 
Debugging to Simulation the message appears as, “Do 
you wants to remove the overridden input points?”  

1. If Yes is selected: 

a. For Network Inputs, Override values are removed 
in the tool and values in the controller temporarily 
remain until updated.  

b. For Software Constants (NetworkConfigs) in Lon 
Spyder, and Network Setpoints in BACnet Spyder, 
Override values except the values that have been 
Set are removed and the Set value is retained in 
the controller and in the tool. 

2. If No is selected: 

a. For Network Inputs, Override values are retained 
in the tool and values in the controller temporarily 
remain until updated. 

b. For Software Constants (NetworkConfigurations) 
in Lon Spyder, and Network Setpoints in BACnet 
Spyder, the Override value are taken as the Set 
value and all the overridden values are removed 
and values in the controller temporarily remain 
until updated. 

c. Selecting Yes may take several minutes 
depending on the number of wiresheet objects. 

3. Whenever a Station is restarted, by default, the 
actions described on selecting No, is performed. 

4. On changing the mode from Engineering to Online 
Debugging or vice-versa, the message appears as, 
"Do you wants to remove the overridden input 
values?"  

5. If Yes is selected:  

a. For Network Inputs, Override values are removed 
in the tool and values in the controller temporarily 
remain until updated. 

b. For Software Constants (NetworkConfigs) in Lon 
Spyder, and Network Setpoints in BACnet Spyder, 
Override values except the values that have been 
Set are removed and the Set value is retained in 
the controller and in the tool. 

 

 

 

6. If No is selected:  

a. For Network Inputs, Override values are retained 
in the tool and values in the controller temporarily 
remain until updated. 

b. For Software Constants (NetworkConfigurations) 
in Lon Spyder, and Network Setpoints in BACnet 
Spyder, the Override value are taken as the Set 
value and all the overridden values are removed 
and the new Set value is retained in the controller 
and in the tool. 

c. Selecting Yes may take several minutes 
depending on the number of wiresheet objects. 

7. Whenever a Station is restarted, by default, the 
actions described on selecting No, is performed. 

 

This provision is provided to an user so that if 
required, user can utilize the previous overridden 
values during simulation mode and don’t have to 
override the values every time when switched to the 
simulation mode.  
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FORCE VALUES 
1. By forcing values to inputs (physical and network 

inputs as well as network setpoints) an application 
program can be tested for expected results as per 
the testing requirement. If results deviates, then 
logic can be modified and again can be tested.  

2. In the Engineering mode, forced values are not 
written to the controller, but are stored in the 
honeywellSpyderTool. However, in the Online 
debugging mode, the values forced are written to the 
controller and stored in the tool.  

3. Values can be forced to each field of Software point 
(Network Inputs and Network Setpoints), in the 
Engineering and Online debugging modes. 
However, in these modes, the Force values option is 
not available for physical points, and software points 
configured as constant. They are available only in 
the Simulation mode. 

 
Note:  

To force write all points that are exposed on the 
wiresheet, user can right-click the points on the 
wiresheet and use the Force Values option. 
Write values cannot be forced to any point of 
logic in an Application library. 

 

The Honeywell Lon Spyder tool does not support forcing 
value to a Many-to-one NVI. The Bindings feature can be 
used to test the Many-to-one NVI. 

To force write points to the controller:  

1. Right-click the NV/Object that are required to force 
value to, and select Force Values. In this case, only 
the selected point is available. Alternatively, click the 
Force Values button on the toolbar. The Forced 
Values dialog box appears. In this case, all points are 
available, that values can be forced to, on the 
wiresheet. The following Table 215 defines the fields 
shown in the Figure 337. 

 
Figure 336: Force Values Option 

 

 
Figure 337: Force Values Screen 

 

Table 215: Fields of Forced Values screen 

Name Definition 

Input Point Name Shows all the software points. It is non-editable 

Mode  The following options can be selected for the points as mentioned:  

• Network Input: 

 Emergency Override: Emergency Override has the highest priority and value 
written through an Emergency override is assigned to the point. 

 Emergency Auto: Use this option to remove the Emergency Override from the 
tool. In this case, the point is assigned a value based on the values defined by 
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Name Definition 

Override or Set, depending on whichever is defined. If both are defined, 
Override has the higher priority.  

 Override: This has the second highest priority. A point is assigned this value if 
Emergency Auto is selected and the Override value is already defined.  

 Auto: Use this option to remove the Override option from the tool. Auto clears 
off the Override state of the point and the point is assigned the Set value. 

 Set: This has the least priority. A point is assigned this value if Auto is selected 
and the Set value is already defined.  

 Clear Set: Use this option to cancel the Set value.  

Note:  

Auto or the previously set mode is the default mode displayed.  

• Network Setpoint: 
 Emergency Override: Emergency Override has the highest priority and value 

written through an Emergency override is assigned to the point and in case of 
online debugging it goes down to the controller. 

 Emergency Auto: Use this option to remove the Emergency Override. In this 
case, the point is assigned a value based on the values defined by Override or 
Set, depending on whichever is defined. If both are defined, Override has the 
higher priority. 

 Override: This has the second highest priority. A point is assigned this value if 
Emergency Auto is selected and the Override value is already defined. 

 Auto: Use this option to remove the Override option. Auto clears off the 
Override state of the point and the point is assigned the Set value. 

 Set: This has the least priority. A point is assigned this value if Auto is selected 
and the Set value is already defined.  

Note:  

Set or the previously set mode is the default mode displayed 

Units This is editable only when the Mode is an Emergency Override, Override or Set. It 
shows the selected unit. 

Value  This is editable only when the Mode is an Emergency Override, Override or Set. It 
shows the value that is required to write to the controller.  

Note:  

• Write invalid values can be forced to a point by keying in alphabets. Such an 
invalid value is displayed as Nan. Any value outside the specified range is also 
considered invalid.  

• For example, if the lower range is 0 and the upper range is 20, values such as 21 
or −1 are considered invalid. 

Upper Range This is non-editable. It shows the upper limit of the Network Variable.  

Lower Range This is non-editable. It shows the lower limit of the Network Variable 

Select point path Indicate the location of the component. It is a relative and not an absolute path. 

Select point ord Indicate the absolute path. It can be used to resolve the component. 

Clear All Invoke this option to put all the points to the default state. For an NVI, this sets mode 
to Auto (i.e. value = Null or to the current value in the controller) For an NCI, this sets 
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Name Definition 

the mode to Set with its value. 

OK Saves the entered information and closes the dialog box. 

Cancel Close the dialog box. Any information entered is lost. 

 

2. Click OK to close the dialog box. The value, in the 
Online Debugging mode, is directly written to the 
controller.  

 
Note:  

Many to one, NVs in Lon Spyder and physical 
IOs will be cleared on moving to the online 
debugging mode, always. 

 

Actions 
Use the Actions options to quickly force values to 
Network Input points. These options can be used to set 
values based on the priority: Emergency Override > 
Override > Set.  

Right click the point on the wiresheet and select Actions 
to get to this option. 

 

 
Note:  

The Actions option is not available for physical 
points, software points configured as constant in 
Online Debugging and Engineering modes, and 
in Lon Spyder, Many-to-one NV in Online 
Debugging mode. They are available only in the 
Simulation mode. 

 

An explanation of the actions allowed in the Online 
Debugging mode follows:  

• Emergency Override: Emergency Override has the 
highest priority and value written through an 
Emergency override is assigned to the point and in 
case of online debugging it goes down to the 
controller. 

• Emergency Auto: Use this option to remove the 
Emergency Override from the tool. In this case, the 
point is assigned a value based on the values defined 
by Override or Set, depending on whichever is 
defined. If both are defined, Override has the higher 
priority.  

• Override: This has the second highest priority. A 
point is assigned this value if Emergency Auto is 
selected and the Override value is already defined.  

• Auto: Use this option to remove the Override option 
from the tool. Auto clears off the Override state of the 
point and the point is assigned the Set value.  

• Set: This has the least priority. A point is assigned 
this value if Auto is selected and the Set value is 
already defined.  

 

 
Note:  

The value written to a Network Setpoint using the 
Set option changes the configuration of the point. 
That is, the value configured for the Network 
Setpoint can also be changed using the Set 
option in both Online Debugging and Simulation. 
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SELECT POINTS TO DEBUG 

 
Note:  

A many to one Network Input cannot be selected 
for debugging. 

 

To select points that are required to be  debugged:  

1. Click the  button. The Select Points 
dialog box appears. The following Table 216 
defines the fields shown in the dialog box. Refer 
Figure 338. 

 

 
Figure 338: Selection of Points for Watch Window 

 

Table 216: Fields of Select Points 

Name Definition 

Select Function Block Shows all the Function Blocks, S-Bus wall module, Conventional wall module, Physical IOs, 
Network Variables, BACnet Objects, and Network Inputs that are not constants that have 
output points and are connected to other functional blocks or network variables. It also 
displays all OUT parameters of both S-Bus and conventional wall modules. 

Select Output Points Shows all the output points of selected Function Blocks, S-Bus wall module, Conventional 
wall module, Physical I\O, Network Variables, BACnet Objects, and Network Inputs that are 
not constants and are connected to other functional blocks or network variables. 
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Name Definition 

Watch Window/ Show the selected output points that appear in the watch window. The option have to be 
selected to view points in watch window, check box to be able to see the values in the watch 
window.  

Point Name Show the values of the output points in the watch window.  

Select point path Indicate the location of the component. It is a relative and not an absolute path 

Select point ord Indicate the absolute path. It can be used to resolve the component. 

OK Saves the selected points to be debugged and closes the dialog box. 

Cancel Close the dialog box. Any operation done so far is cancelled. 

 
1. Select the Function Block or Network Variable from 

the Select Function Block section. The output points 
are shown in the Select Output Points section.  

2. Select the output points that needs to be viewed. The 
selected points appear in the Watch Window / Point 
Name section.  

3. Check the check box of the point need to be viewed 
in the watch window.  

 
Note:  

Use the Select All option to select all points 
selected for debugging to be displayed in the 
watch window.  

The left arrow button can be used to remove the 
selected points to the Select Output Points list. 
This removes the points from being selected for 
debugging or from being shown in the watch 
window.  

When all in the Select Function Blocks list Is 
selected, on double-clicking it, all points are 
shown in the third column with the watch window 
option checked. 

 

4. Click OK. The points appear in the watch window.  

View Values in Watch Window 
Points can be selected for debugging in the Engineering 
and Online Debugging modes. However, the selected 
points are displayed, in a watch window at the bottom of 
the wiresheet, only in the Online Debugging or 
Simulation modes. Use this to analyze the application 
logic and to find the field values being returned based on 
the logic that is defined. 

To hide/display the watch window:  

• Select WireSheet > Watch Window in the Menu bar 
or right click on the wiresheet and select Watch 
Window.  

Changes in Select Points Screen On 
Changing Modes 
1. If a point is selected for debugging and check the 

watch window option in Engineering/Online 
Debugging mode, then the same is retained in 
Simulation mode.  

2. If a point is selected for debugging and uncheck the 
watch window option in Engineering/Online 
Debugging mode, then the same is not retained in 
Simulation mode.  

3. If a point is selected in the Simulation mode, the same 
point is retained in the Engineering/Online Debugging 
mode with a watch window enabled.  

4. If a point selected for debugging and not for watch 
window in the Engineering/Debugging mode is 
selected in the Simulation mode, then the point will be 
retained in the Engineering/Debugging mode with 
watch window enabled.  

5. If a point is added and removed in the Simulation 
mode, the same point is displayed as selected for 
debugging but not for watching in the 
Engineering/Online Debugging mode. 

6. Select a point in Simulation mode. Move to the 
Engineering/Debugging mode and select the point for 
both debugging and watching. Now, remove the 
option for watching. Move to the Simulation mode. 
The point will not be shown in the simulation mode.  
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SIMULATION 
Honeywell Spyder provides the Simulation feature that 
enables the working of the ControlProgram. Use the 
Simulation Mode to test the working of the 
ControlProgram. Values can be given to Software 
points (Network Inputs, Network Setpoint), and Physical 
points.  

Write points can be forced to the controller and 
understanding the behavior of the application with the 
values that are entered and the effect it has on other 
points. 

Points to note: Application logic can be simulated with S-
Bus wall module, irrespective of the model selected. For 
example, if the Lon Spyder I models: PVL6436A, 
PVL6438N, or PUL6438 (these models do not support S-
Bus wall module) is selected, and S-Bus wall module is 
used in the application logic, user can still go ahead and 
simulate the application logic. However, the model type 
is need to be changed to one that supports S-Bus wall 
module before downloading to the controller. The 
following Spyder models support S-Bus wall module.  

• Spyder II models: PVL6436AS, PVL6438NS, or 
PUL6438S 

• Spyder Lon Micro models: PVL4024NS, PVL4022AS, 
PUL4024S, PUL1012S, or PVL0000AS 

• Spyder BACnet Micro models: PVB4024NS, 
PVB4022AS, PUB4024S, PUB1012S, or PVB0000AS 

• Spyder BACnet models: PVB6436AS, PVB6438NS, 
or PUB6438S 

The S-Bus wall module logic can be simulated alone 
using the Preview feature available in the S-Bus wall 
module wizard screen. 

Working in Simulation Mode 
The Simulation Mode can be accessed from either the 
Engineering or Online Debugging Mode with the click 
of a button. To move to the Simulation Mode from any 
mode: 

Click  on the Tool bar  

OR 

Right click anywhere on the wiresheet and select 
Simulate  

 
 

Figure 339:  Simulation Mode 

 

The Simulate button on the toolbar becomes  
un-selectable when moved to the Simulation mode and 
the following options are available:  
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•  Force Values: To Force write the own values 
to Software input points (Network Inputs, Network 
Setpoints). 
 

•  Select Point: To select the points that are 
required to be debugged.  
 

•  Simulation Setup: To select a Simulation 
Setting. If this button is clicked in the Online 
Debugging or Engineering Mode, the Simulation 
Settings dialog box appears and a simulation setting 
can be selected. However, the changes are only 
saved and are affected only when user moves to the 
Simulation mode. If this button is clicked in the 
Simulation Mode, then the current simulation type is 
overridden by the new selection and the selected 
options are lost.  
 

•  Stop: To stop debugging and access the 
engineering mode. 
 

•  Pause: To temporarily halt the simulation. 
 

•  Resume: This button becomes selectable only 
when the simulation is paused. If the Resume button 
is clicked, then it becomes disabled and will be 
available only after pressing the Pause button. 

Modify Application During Simulation 
The application logic can be modified even when 
simulation is going on.  

The following Table 217 summarizes the actions and 
their effects on points in the Simulation mode. 

 
Table 217: Summary of Actions and Effects on Points in Simulation Mode 

Action Result 

Add/remove a block Not allowed  

Add/remove a link Not allowed 

Rename/Reorder a component (function block, physical/software points, 
composite slots, macros, applications, ControlPrograms, device) 

Not allowed 

Point Conversion Not allowed 

All configuration changes for function blocks except Property description 
change and Output property type change  

Not allowed 

Change Constant value through Config properties and NOT through 
Force values/ Actions screen  

Not allowed 

Change NCI value through Config Properties dialog and not through 
Force values/Actions screen  

Not allowed 

Change Schedule configuration  Restart 

Change Property description of function block Allowed 

Change Simulation settings  Allowed and Simulation restarts 

Change Model  Not allowed 

Reassign/Unassign IO terminals in Terminal Assignment View  Not allowed 

Change Daylight settings in Controller Summary View  Restart 

Import XML  Not allowed 

Change IO configuration  Allowed 
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Change Modes 
Points to note: 

1. On changing the mode from Simulation to 
Engineering/Online Debugging, the message, "Do 
you want to remove the overridden input point 
values?" message appears.  

2. If Yes is selected: 

• For Network Inputs, "Override" values are 
removed in the tool and the values in the 
controller temporarily remain until updated. 

• For Software Constants (NCI) in Lon Spyder, and 
Network Setpoints in BACnet Spyder, Override 
values except the values that have been Set are 
removed and the Set value are retained in the 
controller and in the tool. 

3. If No is selected: 

• For Network Inputs, "Override" values are retained 
in the tool; and the values in the controller 
temporarily remain until updated. 

• For Software Constants (NCI) in Lon Spyder, and 
Network Setpoints in BACnet Spyder, the Override 
value are taken as Set value and all the 
overridden values are removed; and values in the 
controller temporarily remain until updated. 

• Selecting Yes may take several minutes 
depending on the number of wiresheet objects. 

4. Whenever a Station is restarted, by default, the 
actions described on selecting No, is performed. 
Always, Many to One NVs in Lon Spyder and 
physical IOs are cleared on moving to the online 
debugging mode. 

Example Scenario 
The entire simulation operation is explained with the aid 
of an example. 

1. Create application logic. Click the Simulate button to 
enter in simulation mode.  
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Figure 340: Click the Simulate Button Action 
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Figure 341: Options to Cleaning Overridden Values 

2. Select the points that need to be displayed in the 
Watch Window by clicking the button. Select the 
required points and click OK. 

 

 

 

 
Figure 342: Select Points to be Displayed in Simulation Log Window 
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3. The selected points are displayed with their values in 
the Watch Window. Use watch window to show the 
list of points.  

 

 

 

 
Figure 343: Point Values in Watch Window 
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4. Click the  button to select a Simulation Type. 

The Simulation Setup button appears. Continuous 
Simulation is the default selection. Enter the details 
and click OK.

 

 

 

 
 

Figure 344: Select Simulation Type 

 

 

5. A confirmation message appears. Click Yes. 

 
 

Figure 345: Simulation Type Change Confirmation 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 364  

Till the simulation is completed, the  button is 

enabled and the Resume button is disabled.  
 

 
 

 

 
 

Figure 346: Screen Indicates Pause Button 
After the simulation is completed, the Pause button is 

disabled and the Resume button  is enabled.  
 

 

 

 
Figure 347: Screen Shows Resume is Enable
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6. Click the Force Inputs button to force write Physical 
point values. 

 

 

 
Figure 348: Force Values Button and Force Values Screen 

 
The values appear in the Watch window.  
 

7. Click Stop to return to the Engineering Mode. 

 
 

 
Figure 349: Click Stop Button to Complete Action 
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8. Right-click on device item and select Spyder 
Download. 

 

 
Figure 350: Select Spyder Download 

 
9. Select Spyder Download Parameters. 

 

 
Figure 351: Select Download Parameters 

A status bar showing Spyder download progress 
appears. 

 

 
 

Figure 352: Status of Spyder Download 
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10. Click Debug to enter in debug mode.  
 

 

 
 

Figure 353: Click Debug Button 

 
Figure 354: Point Values in Watch Window
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SIMULATION SETTINGS 
The Honeywell Spyder has three Simulation Types that 
can be used for testing the applications that are created:  

• Time Simulation  

• Continuous Simulation  

• Step Simulation  

Following are the options to simulate at two speeds:  

• Simulate as fast as possible: Select this option to 
choose to simulate at the fastest possible time. In this 
case, the simulation may be executed at speeds 
greater than the usual  
1 sec per loop.  

• Simulate at the speed of the controller: Select this 
option to choose to simulate at the speed of the 
controller, which is at the rate of 1 second per loop.  

 

 
Note:  

If simulation settings are changed in the 
Simulation mode, then the current simulation is 
re-started to reflect the changes that are made. 
However, if changes are made to Simulation 
Settings in the Engineering or Online Debugging 
modes, then the settings are saved and take 
effect the next time when enter into the 
simulation mode. 

 

Time Simulation 
Use this simulation type to simulate the application for a 
specified time period. The output values are calculated 
continuously until the specified time period is reached. 
To select Time Simulation type: 

1. Click the  button. The Simulation Setup dialog 
box appears. 

2. Select Time Simulation. 

 
Figure 355: Time Simulation Settings Screen 

3. Enter the Time Period in Hours, Minutes, and 
Seconds. This specifies the time period over which 
the HoneywellSpyderTool simulates the application 
logic. 

4. Select the Set Start Time As option to modify the 
date and time. The Date, Month, Year, Hour, Minute, 
AM/PM can be modified by clicking it and use the up 
and down arrows on the keyboard. This option 
enables to define (not set) the starting time of the 
simulation. Example: To simulate required application 
logic in another time zone at 00:00 hrs, then the time 
zone, hours, and minutes can be selected. The start 
time of the simulation is taken as 00:00 hrs although 
the simulation itself begins once the OK button is 
clicked. 

5. Click OK, save the changes that are made. The 
simulation of the application begins and the values of 
all Physical points/NV points and function blocks are 
displayed on the wiresheet. Additionally, if selected 
points need to be displayed in the Simulation Log 
Window, the values of such points are displayed in 
the Watch Window at the bottom of the wiresheet. 

 

 
Note:  

The  Pause and  Resume buttons can 
be used to temporarily halt/resume the 
simulation. 

 

6. Click the  button to enter the Engineering 
Mode.  
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Continuous Simulation 
Use this simulation type to simulate the application 
continuously. The output values are calculated 
continuously until the simulation ends. To select the 
Continuous Simulation type: 

1. Click . The Simulation Setup dialog box 
appears. 

2. Select Continuous Simulation. 

 
Figure 356: Continuous Simulation Settings Screen 

3. The Time Period is disabled and  it cannot be 
modified. 

4. Select the Set Start Time As option to modify the 
date and time. The Date, Month, Year, Hour, Minute, 
AM/PM can be modified by clicking it and use the up 
and down arrows on the keyboard. This option 
enables to define (not set) the starting time of the 
simulation. 

Example: If simulation of the application logic is 
required in another time zone at 00:00 hrs, the time 
zone, hours, and minutes can be selected. The start 
time of the simulation is taken as 00:00 hrs although 
the simulation itself begins once the OK button is 
clicked. 

5. Click OK, save the changes that are made. The 
simulation of the application begins and the values of 
all Physical Points/NV points and function blocks are 
displayed on the wiresheet. Additionally, if selected 
points to be displayed in the Simulation Log Window, 
the values of such points are displayed in the Watch 
Window at the bottom of the wiresheet.  

 
Note:  

The  Pause and  Resume buttons can 
be used to temporarily halt/resume the 
simulation. 

6. Click the  button to enter the Engineering 

Mode. Click the  button to enter the Online 
Debugging Mode. 

Step Simulation 
Use this simulation type to simulate the application 
desired number of steps at a time. In this simulation type, 
the application logic that is defined is simulated based on 
a specified number of steps. In each step, the values of 
the application logic are calculated once. To select the 
Step Simulation type:  

1. Click . The Simulation Setup dialog box 
appears. 

2. Select Step Simulation. 

 
Figure 357: Step Simulation Settings Screen 

3. Type the Number Of Steps. 

4. Select the Set Start Time As option to modify the 
date and time. The Date, Month, Year, Hour, Minute, 
AM/PM can be modified by clicking it and use the up 
and down arrows on the keyboard. This option 
enables to define (not set) the starting time of the 
simulation.  

Example: If simulation of the application logic is 
required in another time zone at 00:00 hrs, the time 
zone, hours, and minutes can be selected. The start 
time of the simulation is taken as 00:00 hrs, although 
the simulation itself begins once the OK button is 
clicked. 

5. Click OK to save the changes that are made. The 
simulation of the application begins and the values of 
all Physical Points/NV points and function blocks are 
displayed on the wiresheet. Additionally, if selected 
points need to be displayed in the Simulation Log 
Window, then the values of such points are displayed 
in the Watch Window at the bottom of the wiresheet. 
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Note:  

The  Pause and  Resume buttons can 
be used to temporarily halt/resume the 
simulation. 

 

6. Click the  button to enter the Engineering 

Mode. Click the  button to enter the Online 
Debugging Mode. 

Force Values 
By forcing value to IOs, NVs or Objects, and Function 
blocks, the appropriateness of the application logic can 
be tested which is created. It can be verified if the output 
values return desired values. If there are discrepancies, 
the logic can be fine tuned by forcing values by trial and 
error to generate the desired output. The Force Values 
option can be used to force values on physical points, 
software points such as Network Inputs, Network 
Setpoints and Constants, and Function blocks. 

In the Simulation mode alone, Functional block outputs 
can be overridden.. Use the Force Values dialog box to 
display the list of outputs of all functional blocks. The 
right-click menu can also be used to invoke the output of 
the selected function block alone. The overridden values 
of functional blocks can be reset the Auto mode. 

 

 
Note:  

While forcing value to the S-Bus wall module, 
value from wall module and dynamic values 
which are not connected to any input slot can be 
overridden. 

 

When any one functional block output is overridden, the 
other outputs of that functional block also go into 
overridden state. The mode of all the outputs of that 
functional block is changed to Override state with a 
default value of Nan (invalid value) for non-Enums and 
the first item for Enums. 

Use the  button to force the values of each field in 
an NV, Physical point, Constant, or function block. 
Alternatively, right-click on the desired IO/NV/Function 
block and select Force Value. 

To force write points to the controller:  

1. Right-click the IO/NV user wants to force value to, 
and select Force Values. In this case, only the 
selected point will be visible. Alternatively, click the 
Force Values button on the toolbar.  

The Forced Input Screen dialog box appears. In this 
case, all points are visible, that values can be forced 
to, on the wiresheet. The following Table 218 defines 
the fields shown in the dialog box. Refer Figure 336 
and Figure 337. 
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Table 218: Fields of Forced Input Screen 

Name Definition 

Input Point Name Show all the inputs and NVIs. It is non-editable. 

Mode The following options can be selected for the points as mentioned: 

• Emergency Override: Emergency Override has the highest priority and value 
written through an Emergency override is assigned to the point.  

• Emergency Auto: Use this option to remove the Emergency Override. In this case, 
the point is assigned a value based on the values defined by Override, 
Sine/Cosine/Range or Set, depending on whichever is defined. If all three are 
defined, Override has the higher priority  

• Override: This has the second highest priority. A point is assigned this value if 
Emergency Auto is selected and the Override value is already defined  

• Auto: Use this option to remove the Override option. Auto clears off the Override 
state of the point and the point is assigned the Sine/Cosine/Range value, if it is set.  

• Set: This has the least priority. A point is assigned this value if Clear 
Sine/Cosine/Range option is selected and the Set value is already defined. 

Note: 

The value written to a Network Setpoint using the Set option changes the configuration 
of the point. That is, the value configured for the NCI point can also be changed using 
the Set option in both Online Debugging and Simulation.  

• Clear Set: Use this option to remove the Set value. It is not available for NCI.  

• Sine/Cosine/Range: This has the third highest priority. A point is assigned to this 
value if Auto is selected and the Sine/Cosine/Range value is already defined. The 
value specified is written to In9 slot of the point so that it goes to the point out slot.  

• Clear Sine/Cos/Range: Use this option to clear the Sine/Cosine/Range value. This 
option removes the Sine/Cosine/Range value and assigns the Set value, if it is 
already defined.  

• Clear Set option is available for Network Inputs, Constants, and Physical inputs.  

The value set to the Network Setpoint through either Override, Emergency Override or 
Sine/Cosine/Range does not change the actual value configured for the point. 

Units This is editable only when the Mode is Emergency Override, Override, Set, Sine, 
Cosine, and Range. It shows selected the unit. 

This is not applicable o function blocks. 

Value This is editable only when the Mode is Emergency Override, Override, or Set. It 
shows the value that needs to be written to the controller. 

Note: 

Write invalid values that can be forced to a point by typing alphabets. Such an invalid 
value is displayed as Nan. Any value outside the specified range is also considered 
invalid.  

For example, if the lower range is 0 and the upper range is 20, values such as 21 or –1 
are considered invalid. 

Upper Range It shows the upper limit of the Network Variable. This is non-editable except for Sine, 
Cosine, and Range. 

Lower Range It shows the lower limit of the Network Variable. This is non-editable except for Sine, 
Cosine, and Range.  
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Name Definition 

Select point path Indicate the location of the component. It is a relative and not an absolute path  

Select point ord Indicate the absolute path. It can be used to resolve the component. 

Clear All Invoke this option to put all the points/Function blocks to the default state. 
NCIs/Network Setpoints go back to their configured value, NVIs/Network Inputs go to 
null, function block outputs go back to null. 

OK Saves the entered information and closes the dialog box. 

Cancel Close the dialog box. Any information entered is lost. 

 

2. Click OK to close the dialog box. 

Select Points to Display in 
Simulation Log Window 

Pre-requisites 
• To be able to simulate function blocks, they must be 

linked to other function blocks or output points or 
configured as Out_Save, Out_Byte, Out_float, or 
constant. An exception, however, is the Alarm 
function block. If an Alarm function block is available 
with only its input linked, still simulation can be 
performed. 

• To be able to simulate input points (Network Inputs, 
Network Setpoints, analog inputs, and binary inputs); 
they must be linked to function blocks or other output 
points.  

• To select the points being simulated that needs to be 
visible in the Watch Window:  

 

 
Note:  

All points in the logic will be simulated. However, 
only those points for which the View is enabled in 
Watch Window option are displayed in the watch 
window. 

1. Click the Select Points button  on the tool bar. 
The Select Points to be displayed in the Simulation 
Log Window dialog box appears. The following  
Table 219 defines the fields shown in the dialog box. 
Refer Figure 342. 

 

Table 219: Fields of Select Points to be displayed in the Simulation Log Window 

Name Definition 

Select Function Block Show all the Function Blocks, Physical IOs and Network Inputs, Network 
Setpoints, Physical inputs such as analog and digital inputs that have output 
points and connected to other functional blocks or Network Output points. 

Select Output Points Show all the output slots of the selected components in the Select Function 
Block list. 

Select point path Indicate the location of the component. It is a relative and not an absolute path 

Select point ord Indicate the absolute path. It can be used to resolve the component. 

Point Name Shows the points selected to be displayed in the watch window.  

OK Saves the selected points to be debugged and closes the dialog box. 

Cancel Close the dialog box. Any operation done so far is cancelled. 

 

2. Select the Function Block or Network Variable from 
the Select Function Block section. The output points 
are shown in the Select Output Points section. 
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Figure 358: Simulation Log Window

3. Select the output points that need to be viewed. The 
selected points appear in the Point Name section.  

4. Click OK. The points appear in the watch window with 
the values. 

View Values in Watch Window 
After points are selected that need to be displayed in the 
Simulation Log Window, the points appear in a Watch 
Window at the bottom of the wiresheet. Use it to analyze 
the application logic and to find the values being returned 
based on the defined logic. 

 

 
Note:  

All points in the logic will be simulated. However, 
only those points for which the View is enabled in 
Watch Window option are displayed in the watch 
window. 

 

Changes in Select Points Screen On 
Changing Modes 
After the points are selected that need to be debugged, if 
user is switched to another mode and select/unselect the 
points to be debugged and then get back to the Online 
Debugging Mode, the selected points are not selected to 
be displayed in the watch window. These points have to 
be selected again.  

1. If a point is selected for debugging and enables the 
watch window option in the Engineering/ Debugging 
mode, it is retained in Simulation mode.  

2. If a point is selected for debugging and uncheck the 
watch window option in the Engineering/ Debugging 
mode, the same is not retained in Simulation mode.  

3. If a point is selected in Simulation mode, it is retained 
in Engineering/Debugging mode with the watch 
window enabled.  

4. Select a point for debugging and with the watch 
window option unchecked in Engineering/Debugging 
mode. If the same point is selected in Simulation 
mode, then on returning to the Engineering/Online 
Debugging mode, this point will be found with the 
watch window option enabled.  

5. If a point is added and removed in Simulation mode, 
the same point is selected for debugging, but not for 
watching in the Engineering/Online Debugging mode.  

6. Select a point in Simulation mode. Go to the 
Engineering/Debugging mode and see that it is 
selected for both Debug and watching. Now, uncheck 
the watch window option. It will not be shown in 
Simulation Mode. 

Points to note: 

• The value written to a point and the mode last set (in 
Engineering/Online debugging/Simulation) will be 
available the next time when visited any other mode 
(Engineering/Online debugging/Simulation) with the 
following exceptions:  

 If Sine/Cosine/Range was selected for a point in 
Simulation mode and when entered in to the 
Engineering/Online Debugging mode, and invoke 
the Force Input screen, the mode for that point is 
shown as Set/Auto.  

 



HONEYWELL SPYDER USER GUIDE 

31-00089—02 374  

o  If OK button is clicked, after going to the 
Simulation mode, the Force Input screen 
indicates the mode as Set/Auto. 

o  If Cancel button is clicked and after visiting 
the Simulation mode, the Force Input screen 
will indicate the mode as Sine/Cosine/Range 
(depending on what was last selected). 

 The Force Input screen indicates the mode as 
Sine/Cosine/Range (depending on what was last 
selected) when 

−  Sine/Cosine/Range is selected for a point in 
Simulation mode and when entered in to the 
Engineering /Online Debugging mode 

−  Force Input screen is not invoked or any option 
in the right click menu on that point, and go to 
the Simulation mode again 

 The values set for constant blocks are not saved 
across mode revisits. After exited from the 
Simulation mode, the actual value configured for 
the constant block is put back on the out slot. 

GENERATE XIF FILE 
LonMark external interface files (.xif) are files that define 
the external interface for one or more LONWORKS® 
devices. The external interface is the interface to a 
device that is exposed over a LONWORKS® network. 
The external interface does not expose the internal 
algorithms of a device; instead, it only exposes the inputs 
to the algorithms and the outputs from the algorithms.  

The external interface file includes the program ID 
information of the device, application type information, 
self-documentation information, the configuration 
information of network variables. 

There are two benefits to using external interface files. 
First, an external interface file may include information 
that is not included in a device such as network variable 
names. Second, an external interface file can be used 
during network engineering when the device is not 
accessible from the network engineering tool. 

To generate an XIF file:  

• Right click the device in the Nav tree and select 
Actions > Generate XIF. The XIF file is generated 
and stored at the following location:  
Drive:\\Honeywell\WEBStation-N4-x.x.xx.x\ XIF 

 
Figure 359: Actions > Generate XIF option 
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ORDER OF EXECUTION 

The order of execution defines the sequence in which 
function blocks are executed by the controller. When 
function blocks are dragged onto a wire sheet to build 
application logic, by default, the tool sets the execution 
order of the functional blocks in the order they are 
dropped onto the wire sheet. However, user can alter the 
order in which the controller executes the function blocks 
by re-ordering the blocks. In the Simulation Mode, the 
order of execution that user sets is followed.  

 

 
Note:  

The execution of function blocks can be 
reordered only. Although NVs or BACnet objects 
and Physical points are shown in the Reorder 
screen, their order of execution cannot be 
reordered.  

When a block is removed, the order of execution 
gets affected. 

The order of execution cannot be changed for 
Built In function blocks. 

Execution order for blocks within a macro or 
Application is maintained based on the order in 
which the blocks are dragged within them. 

 

To change the order of execution:  

1. From the Spyder Palette, drag function blocks, 
macros or Programs on the wiresheet. The order in 
which the function blocks are dragged determines the 
execution order. The execution order is displayed on 
the container of each function block on the wiresheet.  

2. Right click the specific container or ControlProgram 
in the Nav side bar. Click Reorder. The Reorder 
dialog box appears.  

 
Figure 360: Reorder option 

3. Select the required application and click Move Up or 
Move Down to change the order of execution.  

 
Figure 361: Reorder ControlProgramScreen 

4. Click OK to close the dialog box. 
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CUSTOM PALETTE FILE 
Create and use a custom palette file to store any Spyder 
object application, macro, device, FBs, IOs from a 
station. This file can be used to share it across Stations 
and among multiple users. This custom palette file acts 
only as a repository, but an object cannot be configured 
that exists in the palette.  

User can later copy and paste or drag and drop these 
objects from the custom palette to the station. 

Create Custom Palette File 
To create a custom palette file:  

1. On the Nav sidebar, navigate to the drive where the 
custom palette file needs to be created. Right click the 
drive and select New Folder. A new folder is created. 

 
Figure 362: Click New to Create New Folder 

2. Enter a name for the new folder and click OK.  

3. Right click the new folder and select New > 
PaletteFile.palette 

 
Figure 363: Click New > PaletteFile.palette 

4. Enter a name for the palette file and click OK. A new 
palette file is created. Expand the newly created 
folder to view the palette file that is just now created. 

5. Double click the palette folder to open its wiresheet.  

6. On the Palette sidebar, click the Open Palette  
button. The Open Palette dialog box appears.  

7. Select, Baja module and click OK. Now, 
UnrestrictedFolder is available in the Baja Palette 
(Palette sidebar with Baja module selected).  

 
Figure 364: Select Baja Module 
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Figure 365: Unrestricted Folder in Baja Module 

 

8. Drag the unrestricted folder into the folder with the 
palette file that is created. A .bog file appears in the 
folder which contains the unrestricted folder.  

9. Double-click the UnrestrictedFolder.bog file that 
was added to the new folder, to open its wiresheet.  

 
Figure 366: Unrestricted Folder Structure 

10. Right click the folder to rename it. This is the 
Unrestricted folder where all Spyder objects can be 
stored.  

Point to note:  

• The folder can be double clicked on the wiresheet 
and drag the UnrestrictedFolder object from the 
Palette onto the wiresheet. This has the effect of 
nesting folders within the palette file. This enables the 
categorization of objects that are stored in the palette 
file.  

• For example, an UnrestrictedFolder can be dragged 
from the Baja palette (Palette palette with Baja 
module selected) on to the wiresheet of the palette 
file and name it Applications. Then double-click the 
Applications folder on the wiresheet, drag another 
UnrestrictedFolder object from the Baja palette, and 
name it VAV Applications. This creates the VAV 
Applications folder under the Applications folder in a 
tree structure in the custom palette file that is created. 

Add Items to Custom Palette File 
To add any Spyder object such as a macro, application, 
IO, Function block to the custom palette:  

1. Browse to the ControlProgram that needs to be 
saved in the custom palette file by clicking Station > 
Drivers > LonNetwork > LonSpyder > 
ControlProgram 

OR 

Station > Drivers > BacnetNetwork > 
BACnetSpyder > ControlProgram in the Nav side 
bar 

2. Right click any Spyder object such as application, 
macro, device, FB, or IO and select Copy.  

 
Figure 367: Copy Option 

3. Navigate to the folder that is created under the 
custom palette file (Applications or VAV Applications 
as given in the Point to note) and right click it and 
select Paste. 

OR 

Drag and drop the object to the wiresheet of the 
folder (Applications or VAV Applications as given in 
the Point to note) under the custom palette file 

OR 

Drag and drop a Spyder object directly onto the folder 
(Applications or VAV Applications as given in the 
Point to note) under the custom palette file in the Nav 
side bar.  

4. The object is saved under the folder in the custom 
palette file.  

5. Right click the file in the custom palette file and click 
Save.  

6. Right click the custom palette file and click Close to 
close the custom palette file.  

Close Custom Palette File 
To close the custom palette file, right click the custom 
palette file and click Close.  

 
Note:  

If a custom palette file is closed without saving 
the contents of the custom palette file or close 
the Workbench without saving the contents of 
the custom palette file, the newly added contents 
are not saved and will not be available when this 
folder is accessed the next time. 

 

Components can be reused from the custom palette file 
in any application logic that is created by dragging and 
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dropping the desired object from the custom palette file 
to the wiresheet of the ControlProgram. 

Add Device to Custom Palette File 
Adding a device to the custom palette file is similar to 
adding a Spyder object, but it has some specific steps 
need to be performed additionally. To add a device to the 
Custom palette file:  

1. Browse to the device that needs to be saved in the 
custom palette file by clicking Station > Drivers > 
LonNetwork > LonSpyder 

OR 

Station > Drivers > BacnetNetwork > 
BACnetSpyder in the Nav tree.  

2. Double-click the ControlProgram under the device 
once. It opens the wire sheet of the ControlProgram. 
This makes sure that ControlProgram is loaded (all 
device objects are available in memory while 
copying).  

3. Right click the device and select Copy.  

4. Navigate to the folder that is created under the 
custom palette file (Applications or VAV Applications 
as given in the Point to note) and right click it and 
select Paste.  

5. Right click the device and select Enable Saving 
ControlProgram.  

Point to note:  

• The Enable Saving ControlProgram option makes 
the ControlProgram under device non-transient, so 
that it can be saved to the bog file. If this option is not 
invoked or before invoking this option, then close the 
bog file or the workbench, the device looses the 
ControlProgram configuration in the custom palette 
file.  

• This option appears on the device only when the 
device is in the custom palette and the 
ControlProgram under the device is transient. Once 
the option is invoked, the next time onwards the same 
device option does not appear on that particular 
device object. 

• This option appears only when required. If it does not 
appear, it means the ControlProgram of the device 
is already in a non-transient state. This may happen 
when copy-pasting/duplicating a saved device 
within/across palettes occurs or when device object is 
copied-pasted from the Spyder library to the custom 
palette folder. 

 
Figure 368: Enable Saving ControlProgram 

6. Right click the custom palette file and select Save. 
The device is saved under the folder in the custom 
palette file. 
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Sylk BUS 

Introduction 
SYLK BUS: The Spyder controller family is Sylk bus 
enabled. Spyder controllers supports Sylk Bus.  

Sylk is a two wire, polarity insensitive bus that provides 
both 18 VDC power and communications between a 
Sylk-enabled sensor and a Sylk-enabled controller. 
Using Sylk-enabled sensors saves I/O on the controller 
and is faster and cheaper to install since only two wires 
are needed and the bus is polarity insensitive. Sylk 
sensors are configured using the latest release of the 
Spyder Tool for WebPro-N4™ and WEBStation®. 

Following devices can be added on the Sylk bus of the 
Spyder controller. 

1. Sylk Enabled actuators 
2. C7400S (Sylk enabled Temperature and Humidity 

sensor) 
3. Expansion modules (SIO6042, SIO4022, 

SIO12000). These expansion modules can be 
added on only Spyder Relay modules (PUB6438SR 
and PUL6438SR) 

Configuration of Sylk Actuator to 
the Spyder Controller 

Description 
MS3103, MS3105, MS4103, MS4105, MS7403, 
MS7405, MS7503, MS7505, MS8103, MS8105 Spring 
Return Direct Coupled Actuators (DCA) are used within 
heating, ventilating, and air-conditioning (HVAC) 
systems. They can drive a variety of quarter-turn; final  

control elements requiring spring return fail-safe 
operation. 

Applications includes: 
• Volume control dampers, mounted directly to the 

drive shaft or remotely (with the use of accessory 
hardware). 

• Quarter-turn rotary valves, such as ball or butterfly 
valves mounted directly to the drive shaft. 

• Linear stroke globe or cage valves mounted with 
linkages to provide linear actuation. 

• Available with cable on select models 

Configuration 
Spyder controllers are Sylk Enabled controllers. Sylk 
enabled sensors and actuators cab be added to the 
Spyder controller. These devices communicate with the 
Spyder controller through two wires, polarity insensitive 
Sylk bus. By using the Sylk bus devices physical Inputs 
and outputs on the controller cab be saved. 

The installation is faster and cheaper since only two-wire 
polarity insensitive bus is required. 

 

This section explains how to configure the Sylk enabled 
actuators to the Spyder controller. 

Inputs and outputs of the Sylk enabled 
actuators 
• As shown in Figure 1, Sylk actuator has two inputs 

and five outputs. All these inputs and outputs 
communicate with the Spyder controller over a Sylk 
bus. 
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Figure 369: Inputs and Outputs of Sylk enabled actuator 
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Inputs 
Actuator Command:  
Actuator command comes from controller output. An 
Actuator moves as per the command. 

Actuator Travel Time: 
This is the stroke time or time required to travel from full 
close position to full open position 

 

Outputs 
Actuator Position:  
This is a feedback from the actuator’s current position, and 
can be mapped into the Spyder controller for monitoring. 

Actuator Cycle Count: 
It shows how many time actuator is cycled from open to 
close position. 

Actuator Status:  
It shows OPEN or CLOSE position of an actuator. 

Actuator Overridden: 
It provides actuator overridden status if actuator is 
overridden externally. 

Power Report: 
All the required points should be created as Sylk 
Input/Output on the Spyder controller’s wire sheet. 

 

Configuration Steps 
 

Step 1: Adding Spyder controller to the network 
 
Add the Spyder controller to the required network. Spyder 
controller supports two networks: 

1. BACnet 
2. LON 
A special palette is developed in the WEBStation-N4, 
named ‘HoneywellSpyderTool’. From this palette, a 
Spyder controller can be added to the required network. 
This palette also has all function blocks and points required 
to perform programming. 

Figure 370 shows, a LonSpyder is dragged and dropped 
on LonNetwork.

 

 
Figure 370: Adding Spyder controller to the LON® network
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Step 2: Naming of the controller 
 
After adding the controller on the network, a window pops 
up to name the controller as shown in Figure 371 .Name 
the controller and click on OK button 

 

Figure 371: Naming Controller 

After adding the controller, it will appear under the network 
as shown in the Figure 372. 

Step 3: Setting device Model and switching to 
‘Engineering Mode’ 

 
By double clicking on the Spyder controller, a ‘Normal 
Mode’ screen will appear as shown in Figure 373. From 
the drop down list, of ‘Device Model’, select a Spyder 
model as per the requirements. Refer Figure 373. 
(PUL6438S model is selected in the figure for an 
illustration.)  

After selection of proper controller, Click on the 
‘Engineering Mode’ button to enter Engineering mode form 
the current (Normal) Mode. 

 
Figure 372: Added controller under network 

 

 
Figure 373: switching to ‘Engineering Mode’ from ‘Normal mode’
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Creating Sylk Inputs 
 
Step 1: Adding Sylk Input: 
 

In the ‘Engineering Mode, a wire sheet interface will open. 
Drag the ‘Modulating Input’ object from palette and drop it 
on wire sheet as shown in the Figure 375. 

 

Figure 374: Adding 'Modulating Input’ to the Wire 
sheet 

After adding the ‘Modulating Input’ on the wire sheet, a 
window will pop up for naming. Name the modulating point 
and click ‘OK’ button. (In Figure 375, a modulating input is 
named as ‘SylkActPos’.) 

 

Figure 375: Naming a 'Modulating Input’ 

 
 
 
Step 2: Configuring properties of ‘Sylk input’ 
 

Right click on the created input and select ‘Configure 
Properties’ as shown in the Figure 376. 

 

Figure 376: Selecting ‘Configure properties’  

After selecting ‘Configure Properties’, a ‘Configure 
properties’ window will appear on the screen as shown in 
Figure 378. 

 

Figure 377: ‘Configure properties’ of an Input 
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From the drop down list of ‘Type’, Select ‘FixedSylkInput’ 
option and click ‘OK’ button. 

After clicking on ‘OK’ button, the first Sylk input 
(‘SylkActPos’) will be created on the wire sheet as shown 
in Figure 378. 

 

Figure 378: Sylk Input (‘SylkActPos’) 

Step 3: Creating  other required Sylk Inputs 
 
Follow Step 1: and Step 2: (Creating Sylk Inputs) to create 
other required inputs on the wire sheet. 
 
Figure 379 shows all the required Sylk inputs for the Sylk 
actuator created on the wire sheet 

 

Figure 379: Sylk Inputs

Creating Sylk Outputs 
 
Step 1: Adding Sylk output: 
 

Drag the ‘Modulating Input’ object from palette and drop it 
on wire sheet as shown in the Figure 380. 

 

 

Figure 380: Adding 'Modulating Output’ to the Wire sheet 
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After adding the ‘Modulating Output’ on the wire sheet, a 
window will pop up for naming. Rename the modulating 
point as per the requirement and click ‘OK’ button. (Here a 
modulating output is named as ‘SYLK_ACT_CMD’.) 

 

Figure 381: Naming a 'Modulating Output’ 

 
Step 2: Configuring properties of ‘Sylk Output’  
 
After renaming, right click on the created Output and select 
‘Configure Properties’ as shown in the Figure 382. 
 

 

Figure 382: Selecting ‘Configure properties’  

After selecting ‘Configure Properties’, a ‘Configure 
properties’ window will appear on the screen as shown in 
Figure 383. From the drop down list of ‘Type’, Select 
‘FixedSylkOutput’ option and click ‘OK’ button. 

 

Figure 383: Configure properties’ of an Output  

When ‘FixedSylkOutput; is selected, no other setting is 
required on the ‘Configuration Window’. 
 
After clicking on ‘OK’ button, the first Sylk output 
(‘SYLK_ACT_CMD’’) will be created on the wire sheet as 
shown in Figure 384. 

 

Figure 384: Sylk Output (‘SYLK_ACT_CMD’) 
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Step 3: Creating  other required Sylk Outputs 
 
Follow Step 1: and Step 2: (Creating Sylk ) to create other 
required outputs on the wire sheet. 
 
Figure 379 shows all the required Sylk Inputs and Outputs 
for the Sylk actuator created on the wire sheet 

 

Figure 385: Sylk Inputs and Outputs 

Adding of the Sylk actuator to the Spyder 
controller 
 
After creating required Sylk inputs and outputs on the wire 
sheet, next step is to add a Sylk actuator to the Spyder 
controller and assign these inputs and outputs to the Sylk 
actuator 
 
Step 1: Switching to ‘Terminal Assignment View’ 
 
Right click on the Spyder controller, select ‘Views’ and 
from the extended menu,  select ‘Terminal Assignment 
View’ submenu and click on it.(Refer Figure 386) 
 
Terminal assignment Window will open as shown in 
Figure 387. 
.

 

Figure 386: Switching to ‘Terminal Assignment View’
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Step 2: Adding Sylk device 
 

In ‘Terminal Assignment Window, click on the ‘Add Sylk 
device’ button as shown in Figure 387.

 

 

Figure 387: Adding Sylk device from ‘Terminal Assignment View’ window

Step 3: Configure the Sylk Device 
 

In the ‘Sylk Device Screen (refer Figure 388), add the ‘Sylk 
device name’, Select the ‘Sylk Device Model’ as 
‘SYLK_ACTUATOR’. 

Assign the Sylk actuator address. (In Figure 388, Sylk 
device address of 1 is assigned) 

Step 4: Assigning Sylk inputs and outputs 
 

Figure 389 shows a window for the Sylk actuator’s 
input/output terminal assignment. For each terminal, a drop 
down menu button is provided. 

The right hand side of the actuator shows the input 
terminals of the actuators. Signal to these terminals are 
receiving from SYLK_OUTPUTS created on the Spyder 
wire sheet. (Refer Figure 389) 

The left hand side of the actuator shows the output 
terminals of the Sylk actuators. These are transferred to 
the SYLK_INPUTS created on the wire sheet. 
(Refer Figure 389) 
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Figure 388: Configuring Sylk device 

 

Figure 389: Assigning Sylk Inputs and Outputs
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• Assigning Sylk Outputs to the Sylk Actuator Input 
Terminals 

 

As shown in Figure 390, select actuator input terminal. On 
every terminal, all SYLK_OUTPUTS created on the wire 
sheet will appear.  

Assign appropriate SYLK_OUTPUTS (created on the wire 
sheet) to the Sylk actuator input terminals. Follow the 
same procedure for another Sylk Actuator input.

 
.

 

Figure 390: Assigning Sylk Outputs to the Sylk Actuator Input Terminal

• Assigning Sylk Inputs to the Sylk Actuator Output 
Terminals 

 

As shown in the Figure 391, select output terminal of the 
actuator. (Data is transferred to SYLK_INPUTS created on 
the wire sheet of the Spyder controller). 

In the drop down menu, all Sylk Inputs (created on the wire 
sheet) will appear. After selecting appropriate Sylk input for 
a particular output terminal, assign that input to the 
selected output terminal. 

Follow the same procedure for remaining actuator output 
terminals.

 
 



Configuring Sylk Actuator to Spyder Controller 

 
31-00089—01 389  

 

Figure 391: Assigning Sylk Inputs to the Sylk Actuator Outputs Terminal

Figure 392 shows the Sylk actuator after all Sylk inputs 
and outputs are assigned to the Sylk actuator terminals. 

 

After completion of the terminal assignment, click on the 
‘Save’ button. After clicking on the save button the Sylk 
actuator with given Sylk address (in the example, Sylk 
address is 1) is added.
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Figure 392: Assigned Sylk Inputs and Sylk Outputs to Actuator Terminals 

 

 

Figure 393: Data transferred between Spyder Controller and Sylk Actuator
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Figure 393 represents how data is transferred between 
Spyder controller and Sylk actuator through a Sylk bus.  

• Left hand side shows, the data transfer from Sylk 
outputs created on wire sheet to the Sylk actuator 
inputs. 

• Right hand side shows the data transfer from Sylk 
actuator outputs to Sylk inputs created on wire sheet. 

 

COV, Rate and Fail Detect 
Parameters 
 
For every input and output terminal of the Sylk actuator, 
COV, Rate and Fail Detect parameters are available.  
Click on the blue colored drop down menu option for 
setting of these parameters Figure 394.  

Figure 394: Setting COV, Rate and Fail Detect 
Parameters 

Click on the ‘Help’ button for more details about these 
parameters.  
After clicking on the ‘Help’ button, screen shown in  
Figure 395 will appear.

 

Figure 395: Help page for COV, Rate and Fail Detect Parameters 
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Configuration of C7400S Sensor 
 

Description 
The C7400S Sylk Bus sensor is a combination 
temperature and humidity sensor, which is intended to be 
used in commercial roof top units for sensing air. The 
sensor is powered by and communicates on the Sylk Bus. 
The C7400S communicates temperature and humidity 
separately digitally on the Sylk Bus Communication 
Protocol. 

A separate controller such as the JADE™ Economizer 
System  (Model W7220) provides power and 
communications on the  Sylk Bus for the C7400S Sylk Bus 
sensor.  
 

Configuration 
Step-1: Create the Sylk input on the wire sheet for 
temperature. 
Drag the ModulatingInput object from 
honeywellSpyderTool and drop it on the controller’s 
wiresheet.  
 
Name window will pop up. Enter the appropriate name.  
Then right click on the input and select, 
Configure_Properties. Configure_Properties window 
will open as shown in Figure 396. 
 

 

Figure 396: Configuring properties of C7400Ssensor 

 
 
 
Step-2: Select the ‘FixedSylkInput; option from the Point 
Type drop down menu and click OK. 
 
Step-3: Follow the steps from 1 to 2 to created Sylk 
Network Input for humidity. for the Sylk inputs created on 
the wiresheet. 

 

Figure 397: Sylk Inputs 

Step-4: Right click on the Spyder Controller, click on 
Views>Terminal Assignment View.  
Terminal assignment view of that controller will open as 
shown in . Click on Add Sylk device button 
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Figure 398: Terminal Assignment View of C7400S 

 
 

Step-5: Select Sylk Device Mode as C7400S from the drop 
down menu. Enter the required Sylk Address. C7400S 
terminal layout will appear with two terminals, one for the 
temperature and one for the humidity.  

Step-6: Assign inputs to the input terminals as shown in 
Figure 399. In drop down menu, sylk inputs created on the 
wire sheet (step-3) appears. After completion of input 
assignment, click on SAVE button. 

 

Figure 399: Assigning inputs to the input terminals
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Configuration of the Sylk IO 
Moduel 
Application 
The Sylk IO devices are part of the Spyder family. The 
three IO modules are designed to seamlessly integrate 
with Spyder with relay controllers using only Sylk® for 
communication.  

These devices expand the footprint of a single Spyder, 
increasing the controller's ability to be applied in 
applications that require a large amount of physical I/O. 
The Sylk IO devices are programmable using existing 
Spyder wire sheets through the Niagara Framework® 
software. Since the Sylk IO devices are extensions of the 
Spyder Lon and Spyder BACnet controllers, the same 
Spyder feature will be leveraged in the WebPro workbench 
tool and the WEBs-N4™ JACE controller. 

The Sylk IO devices are intended for use in HVAC 
applications that require a programmable controller where 
the IO count is more than the full sized Spyder point count. 
All devices provide flexible, universal inputs for external 
sensors while SIO6042 and SIO4022 provide a 
combination of analog and digital outputs. 

Description 
The Sylk IO devices are available in three models, as 
described in Table 220. 

Each device is programmable because the user selects 
which function blocks to use and how to connect them. It is 

configurable because each function block has user-defined 
behavior. 

Table 220: Three model of Sylk IO Devices 

Devices UI 
(Universal 
Input) 

DI 
(Digital 
Input) 

AO 
(Analog 
Output) 

Do 
(Digital 
Output) 

SI06042 6 0 4 2 
SI04022 4 0 2 2 
SI012000 12  0  0  0 

Configuration 
 

 
Note:  

Sylk IOs are only applicable to the Relay Spyder 
(PUB6438SR and PUL6438SR). 

 
Step-1: Right click on the controller. Select 
Views>Terminal Assignment Views. It navigates to 
Terminal Assignment View screen. Click on Add Sylk 
device button. 
Step-2: Select any of the three available Sylk IO modules 
from Sylk Device model drop down menu.. Here SIO6042 
module is selected for demonstration. (These options in 
drop down are only available is the controller is 
PUL6438SR or PUB6438SR).

 

Figure 400: Terminal Assignment View of Sylk Device model 

Step-3: Enter name in the System Device Name field. 
Select a Sylk IO module from the available three 
modules as per the requirement from the Sylk Device 
Model drop down list. Enter the required Sylk Device 
address also in the Sylk Address field. 

Step-4: Assign the inputs and outputs to the selected 
sylk IO modules input and output terminals. These inputs 
and outputs are need  to be created on the wire sheet of 
the controller in order to assign. When terminal 
assignment is complete, click SAVE button.
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